ORACLE
PeopleSoft

PeopleSoft Interaction Hub 9.1: Portal
and Site Administration

July 2024

ORACLE



PeopleSoft Interaction Hub 9.1: Portal and Site Administration
Copyright © 1988, 2024, Oracle and/or its affiliates.

This software and related documentation are provided under a license agreement containing restrictions on use and
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement
or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute,
exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or
decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you
find any errors, please report them to us in writing.

If this is software, software documentation, data (as defined in the Federal Acquisition Regulation), or related
documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government,
then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software,

any programs embedded, installed, or activated on delivered hardware, and modifications of such programs) and
Oracle computer documentation or other Oracle data delivered to or accessed by U.S. Government end users

are "commercial computer software," "commercial computer software documentation," or "limited rights data"
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such,
the use, reproduction, duplication, release, display, disclosure, modification, preparation of derivative works,
and/or adaptation of i) Oracle programs (including any operating system, integrated software, any programs
embedded, installed, or activated on delivered hardware, and modifications of such programs), ii) Oracle computer
documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the license contained
in the applicable contract. The terms governing the U.S. Government's use of Oracle cloud services are defined by
the applicable contract for such services. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is
not developed or intended for use in any inherently dangerous applications, including applications that may create a
risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible
to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation
and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous
applications.

Oracle®, Java, MySQL, and NetSuite are registered trademarks of Oracle and/or its affiliates. Other names may be
trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used
under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Epyc, and the AMD
logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The
Open Group.

This software or hardware and documentation may provide access to or information about content, products, and
services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all
warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an
applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any
loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as
set forth in an applicable agreement between you and Oracle.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle
Support. For information, visit https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit https://
docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.



https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=info
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs

Contents

Preface: Preface xiii
Understanding the PeopleSoft Online Help and PeopleBooKs............ccceevviiiiieniieiieeieeieeeeeeenn xiii
Hosted PeopleSoft Online HeElp........coovieiiiiiiiiiieceeeee ettt e xiii
Locally Installed PeopleSoft Online Help.........ccooveeeiiieeiieiiiiiiicceeeee et xiii
Downloadable PeopleBook PDF Files........ccccieiiiiiiiiiiieeiiecieeciee st sveesvee s es xiii
Common Help DOCUMENTATION. .........ccciieriieiiieiieeeieeecieeeiteesieeesteeesbeesreesbeessseessseessseeenseeesseeans xiii
Field and Control DefiNitions. .......c.eerueeriierieirieiieieeie ettt Xiv
TypographiCal CONVENTIONS.......ccvieiiieriieitieeiteeeiteeesteeesreesreesbeesseeesseeessaeesseessseessseessseessseesssenns Xiv
ISO Country and CUurrenCy COAES........ueeviieriiiiriiieiiieiieerteesree st eeteeeteeeteeesseeesereessseessseessseessnes XV
Region and Industry IAentifIers........cccuveiiieiciiieie ettt eree e seveeeees XV
Translations and Embedded Help........ccoooiiiiiiiiiiiece et e XVi
Using and Managing the PeopleSoft Online Help.........cccccvveeiiiiiiiiiiiciece e XVi
About PeopleSoft Interaction HUD..........c.ccocuiiiiiiieiiiciecee ettt e Xvi
PeopleSoft Portal Solutions Product Family.........cccceevvieiiieiiiiiiiecieee et XVi
PeopleSoft Interaction Hub and PeopleTools Portal Technology..........cccceevevveviienciieecieeiieennnn. Xvii
Related DOCUMENTAtION. ....c..iiitiiitiitieiieiee sttt ettt sb e bt sbtesbeesbtesbeesbeesbeesatesateeneeeaeas Xvii
PeopleSoft Interaction Hub DOCUMENTALION. .........eccviiiiieiiieeiie ettt eeee e e sve e Xvii
PeopleTools DOCUMENTALION. .. ..cccviieiiieiiieeiie ettt e ereeeteeeteeeteeeebeesebeeseseesaseeesseeesseessseessseenes XVviii
PeopleSoft Portal Solutions Related Links.........cccueeeiiiiciiiiiiiiiiiecieecieecee et XiX
COMEACE S, ettt ettt ettt e bt e bt e bt et e e bt et e e bt e bt ea bt embeemteenteenbeeabeenbeenteenteenteans Xix
FOLLOW S, ettt ettt et et e bt e bt e bt eat e enteembeeabeeabeembeeateeneeenteens Xix
Chapter 1: Getting Started With PeopleSoft Interaction Hub 21
PeopleSoft Interaction HUD OVEIVIEW.......cccvieiiiiiiieiiieciieeiee ettt eveesve e veesreessreeesbeeenseeesneens 21
My Page HOomepage Tab.........ccocciiiiiiiiiicii ettt e te e s et e et eeaaeessseessbeennseas 22
Administration HOmMePage Tab..........cccuiiiiiiiiiiiiie ettt et veesre e eveeeeaeessaeees 23
PeopleTools Portal TeChNOIOZY........cccuiiiiiiiiiiiiiieciee ettt et e e e sereeeans 24
PeopleSoft Portal PacCKS........c.ccciiiiiiiiiiicie ettt ettt et e et eeeb e e snbaesereeenraaen 25
PeopleSoft Interaction Hub INte@rations..........ccuieevieriieiiiieeiiieeiie et esreeeveeereeeeeeeeveeseveeseseeenneas 25
PeopleSoft Interaction Hub Implementation Tasks.........ccccuevvieiiiieciieeiiieniiecieeciee e 26
Using Third-Party Images Provided with Sample Data...........c.ccccueereiiiiciiiiiieciieceeceecee e 26
Chapter 2: Administering Portals and Sites 29
Understanding Portal AdminiStration..........ceeecieeriieriieriieerieeiieesieeeseeesreesveesreeesseeessseessseesssessssenas 29
Understanding Sit€ AdmMINIStratiON.........c.eeivvieiiiieriiieeeiieeiieesteesteesreesereeesreeesereessseessseesssesssseessseessseeans 29
Understanding Administration of Specific Features.........ccovvvviveiiiiiiiiiiieeiieeie e 29
Chapter 3: Configuring PeopleSoft Interaction Hub 31
Setting the Default Style SHEET.........ccciiieciiiiiiee e e e reeeeaeeseseesenas 31
Page Used to Set Default Style Sheet........oooiieiiiiiiieiiieeie ettt 31
PeopleTools OPtions Page.........cueeciiieciiiiiiieiiiecie ettt et et ve e s ree s raeeaeeensaeesneennns 31
Defining INStallation OPtiONS........cccvveeeieerieeeiieeiiecieeereeeeeeesteesbeesteesseeeseeesseeessaeessseessseesssesssseesnses 33
Pages Used to Define Installation OpPtionsS..........c.eecvieiieeeciieeciieeieeiee e esveesveesveesseeeseeesneenes 33
Installation OPtioNS Page.........cccuiiiiiiiiiieiiieciie ettt ettt e sv e e sbeeereesteeesaeessseesnseenns 33
Portal and Security Defaults Page........ccccocviiiiiiiiiiiiiceee ettt 39
Last ID VaAlUES PAZE........cooiiiiiiieiieciiece ettt sttt e eve e seveessbaessbaesnseeensseesneensns 42
FEATUIES PAZE....ccciiiiiieiii ettt ettt e et e et e e ta e e tbeessbeesaseeesbaeessaeensseensseessseennses 43
Enabling or Disabling MY LINKS.........ccccuiiiiiiiiiiiiieriieciee et esteesveesteesbeeeeeeesaeessseessseessseaans 44
Understanding MY LINKS........ccviiciiiioieiiiieiie et esteestee ettt e eie e esiveesbeessaeessseeessaesssseessseesssens 45

Copyright © 1988, 2024, Oracle and/or its affiliates. iii



Contents

ENabling MY LINKS.......ccocciiiiiiiiiiiiiieciis ettt steestee st e e bt estaeeebeeseseessseessseesssaessssesnsseenes 45
Enabling My Links in the PeopleTools Favorites Feature...........cccoeeviieriieniiieniieciee e 46
Disabling My Links in the PeopleTools Favorites Feature..........cccoceeeereeiviiriiieenii e 47
Enabling the Signon PeopleCode..........cuiiiiiiiiiiiiiiiiecie ettt ettt st eeaeesibeesabeessrea e 47
Page Used to Enable Signon PeopleCode.........cociiiiiiiiiieiiiiciieciieciee ettt svee s 47
Understanding Enabling the Signon PeopleCode..........c.cocuviiiiiieiiiiiiieieeciiecieecieeeee e 47
Signon PeopleCode Page........c..occuiieiiiiiiiiieeie ettt ettt s b e st e aae e araennaeas 48
Setting Up MCF For PeopleSoft Interaction Hub...........ccocoviiiiiiiiiiiiiieccceeeece et 49
Viewing Menu Item DeEtailS.........ccecciiiciiiiiiiiiie ettt et eesve e sbeeeeaeeebeessseessseesssaeans 49
Pages Used to View Menu Item Details..........cccvieeiiiiiiiiniiciiiecieecee e e 50
Using PeopleSoft Interaction Hub Content Reference Attributes..........cccveevveeeiieniiiencieeeciie e 50
Navigation Content Reference AtriDULES..........cccuviiriiiiiieiiiecieeeee e erve e sveeevee e ens 50
Context Manager Content Reference AtribULES..........cocvieviiiriieiiieciie e 51
Collaborative Workspace Content Reference Attributes.........cccveeevieeeieeriieniierie e cieeeiee e 51
Site Manager Folder Reference AttribULES.........cccuiiriieriieiiieciieeiee et eve e e e e e s 52
DefiNINg PrivIIEEE SeUS.....ccciiiciiieiiieeiie ettt ettt et e et e et eetbeesebeessseessseeessaeessseessseessseenssens 53
Pages Used to Define Privilege Sets........ccciiviieiiiiiiiiiiiiieeie ettt eree e e teeeeeeesveeseveessree e 53
Understanding Privile@e SetsS........ccioviiiiiiiiiiiiiiieccie ettt e teeetaeesaaeeseaeessbeessbeeesneeenees 53
PrivIIEge St PAgE....c.viiciiiiiiiiciie ettt et ste e st e e et e et e e ab e e tb e e areeeebaeentaeeaaeanns 55
PrIVIIEEES PAZE....cciiiiiiiiii ettt e et e et e e et e e st e e e bt e e taeetbeensbaeenbaeearaeenraeans 56
Chapter 4: Managing Guest User Accounts 59
Understanding GUESt USET ACCOUNTS........cueevvieriieiiieriieeiieesiteesreesteesseesseessseeesseeessseessseesssesssesssnes 59
Setting Up Security for GUEst USEr ACCOUNLS........cciuieriieeiieeiieeriieerieesreesreesseeeseeesseeessseessseesseenns 59
Accessing the GUESt HOMEPAZE.........eevviiiiieiiieciie ettt ettt e steeeteeeeeeestaeessaeessbeessbeesnseeens 60
Setting Up the Guest Default LOGIn.........cccviiiiiiiiieiiieeiie ettt 61
Creating @ GUESt USET ID......cciiiiiiiciii ettt ettt et et e e ba e e taeessaeessbaeesseeensaeensaeas 62
Configuring the GUESt HOMEPAZE.......cccvieiiiiiiieiiieciieetteete ettt esteesveeeveesbeeesbaeessaeesseessseesnseeesseanns 62
Pages Used to Configure the Guest HOMEPAZE.........cevvieriieiiieiiieeiie ettt vee e 63
Preventing Guest Users from Changing Personalizations.............ccceecvveeeveeenieenieenveenveesreesneeens 64
Setting Homepage Security fOr GUESES........cccviiiiiiiiieiiieeiie et eee e sreeereeesreeetaeesene e 64
Selecting Pagelets for the Guest HOMEPAZE.......ceeevviiiiiiiiieciiecieeee ettt 65
Personalizing Pagelets for Guests Using the User Personalization Component.............c.ccccveeevveennenn. 65
Pages Used to Personalize Pagelets for Guest Using the User Personalization Component.......... 66
Understanding Personalizing Pagelets for Guest Using the User Personalization
(070711101021 1S) 1 L APPSR 66
Personalizing Guest Pagelets Unavailable by Way of the User Personalization Component............... 67
Pages Used to Personalize Guest Pagelets Unavailable By Way of the User Personalization
(070711101021 1S) 1 L APPSR 67
Understanding Personalizing Guest Pagelets Unavailable by Way of the User Personalization
(070711101021 1S) 1 L APPSR 68
Making the Pagelet Available for Personalization on the Guest Homepage............ccccoeeveereveennen. 68
Editing the Pagelet Personalization on the Guest Homepage..........ccceeeveeeerieeciieeciieecie e, 69
Managing the PeopleSoft Fluid User Interface for a Guest USeT.........cccceeveeviieniienciieciieeiee e 69
Pages Used to Manage the Fluid Guest Landing Page............cccceeeiiieiiiniieniieciieciee e 70
SIGN TN THLC.c..eiieiiieeeee ettt ettt e e st e e st e e sabeeestae e tbeessbeessbaessseeesseesnsseessseensses 70
Language Selection Tile........ccuiiiiiiiiieciie ettt ettt e et e b e e b e e sabeessbaeeasaeesaeesneas 70
Chapter 5: Administering Portal Homepages 73
Understanding Homepage AdminiStration...........cccuveevieriiieeciieeitieerieeseeesveesveeseveesveesseessseesssseessseees 73
Managing Homepage Tabs through the Portal RegiStry........cccoocvieviiiiiiiiiciiieie e 74
Enabling a Homepage Tab That Has Been Disabled...........cccoecvieeciiieiieiiieciieceecee e 74
Managing Homepage Tabs in Custom Tabs Navigation Collections...........cccccueevviererenieencveencreeenennn 75

iv Copyright © 1988, 2024, Oracle and/or its affiliates.



Contents

Chapter 6: Enabling the Account Sign On Utility 77
Understanding the Account Sign On Ut ........cooieiiiiiiiieiiiecieecieecieeeee e e ve e e sevee s 77
Creating and Maintaining Signon Data............ccceeciieiiiiiiieiiieeic et ereeeeee e seveeseaeeseaeas 77

Pages Used to Create and Maintain Signon Data............cccceeveviiiciiiiciieecieeiecreeee e 77
Extracting URL Sign On INformation...........ccueerciiirciieiiiieeiie et esteeeveeeveeeieeeeveeseveeseseessneeens 78
Account Sign On UtHEY Page........ccciiiiiiiiiieiii ettt e e eaeeeebeeseseesnneas 78
Edit Account Sign On Page........c.ccccuiieciiiiiiiieieeie ettt teeeee e ae e ve e baesreessbeeennaaens 80

Chapter 7: Administering the Alerts Framework 83
Understanding EmMail ALCIES........ccueeiiiiiiiiiiiieiie sttt ettt e eteesveesveesbeessbaeessaeessseessseessseens 83
SENG UP ALCTES....eviieiieeiieeiieete ettt et e st e e bt e e teeessbeessaeessseesssaesssaeassaeessseessseesssesassesssesenseeans 83

Pages UsSed t0 SEt UDP ALCTES......iiiiieeiieeiie ettt eteeetteeee et eeeteesebeesbeeebeeesaeesseessseessseesssenans 83
ALCTES SELUP PAZE...ccuiiiiiii ettt ettt e st e e s b e e ssbeeesbeeesteeestaeesseensseenanes 84
Define Alerts EMail Pae........c.coocuiiioiiiiiiiiie ettt st e e enneas 86
Managing AleTt SUDSCIIPIIONS. ... ..civieiieeeciieeetieestteerteesteesreeebeeereeeteeesaeessseessseessseessseessseesssseessseenses 88
Pages Used to Manage Alert SUDSCIIPHIONS.......ccveeiiierciieeiieeieeeieeesiee et esreeeveesreeereeesreeeeneesens 88
LB QAN [ £ o T OSSPSR 88
Scheduling Alert NOTHICATIONS. ......ccviiiiieeiieiiieetieerteerte et eereesteeesreeeteeesebeesaeessseessseesssaeesssaessseenes 91
Page Used to Schedule Alert NOtIfICAtIONS.......cccuievvieriieeiieiiieeiieeieeeieeerreesreesveesreeeaeeseeeenes 91
Understanding the Send Alerts Notification ProCess.........cccuvevviieiiieriieriiesiieeieecieeeiee e 91
Send Alerts NOtIfiCations Pae..........cevcviiiiiiiiieiiie ettt ettt e ree et staeeereeseveesebeessbee e 92

Chapter 8: Administering the Tagging Framework 93
Understanding the Tagging Framework..........cccccoviiiiiiiiiiiiie ettt 93
ENaDIING WED S@IVICES.....cuuiiiiiiiiieiiieeiie et ettt esteesteeeteeesteeetaeessbeessseessseessseeassseessseesseesssesssseesssenans 94
Managing the Tagging FrameWoOTK...........ccceoviiiiiiiiiiiiiie ettt et e e e b e 94

Pages Used to Managing the Tagging Framework...........ccccceeviiiiiiienciieecie et 94
Tagging Application Domain Page...........ccecviiiiiiiiieiiie ettt 95
Tag@ing NameESPACE PAZE......c.cciiiiiiiieiiicee ettt ettt e e e e tr e e stae e s abeessbeeesbeeesseeensaeens 96
Implementing Tagging WED SEIVICES.......cuieciiiriiiiiiieiieerieeeteeeieeetee et eetaeesbeesbeeeseessseeessaeesseensns 98
AAING @ TAGoeitiiiiiieeieeeee ettt et e st e e et e e e bt e e bae e tae e tbe e sbae e baeenbeeentaeensaeetaeenebeennraans 98
Configuring Tagging Web SeIVICES........ccivuiiriiiiiiiiiiieeiie et eteerteeriteesreesreesreesreeeseeeeseessseenns 99
Web Services Command FOIMAL..........cooiiiuiiiiiiiiiiiie et 99
TG BIOWSET .. ceiuviieiieeiieeeieeetee et e et e et e e stte e ta e e tte e ebeessbeessseeesseeassaeessseesssaessseessseessseeasseesnsseessens 110

Chapter 9: Managing Menu Item Requests 111
Understanding the Menu Item Requests Feature..........ccoovvvieieiieiiiiiciiieeie et 111
Common Elements Used in Menu Item ReqUESES........cccevcviiiiiiiiiieiiie e ecieecieesreesveesveesveeeeee e 112
Setting Up Menu Item Request Email Notifications........c..cccvveeciiiiiiieecieeeieeeieecieecree e 112

Page Used to Set Up Menu Item Request Email Notifications...........cccccveevveeviienieeecieeecieeeenenn 112
Menu Item Request Notification Page.........cc.vecvieiciiriiiieiiiccieecieecee et ens 112
Managing Menu [tem REQUESES........c.cecciiiiiiiieiiieie ettt eteeeteeeeaeesbeesebeessbaeesbaeessaeesseensseas 113
Pages Used to Manage Menu Item ReqUESES.........cccviieiiiiiieeiiieeie e 113
Manage Menu Item Requests Page.........coovuiiiiiiiiiiiiiiie ettt e 114
Edit Menu Item Request PaAge.........cc.oeeiiiiiiiiiieciic ettt et ve e sera e 115
Delete Menu Item Requests Page........c.eeecuiiiiiiiiiiiiiii ettt 118
Approving and Registering the Menu Item Requests........c.ccceieiiiiiiiieiiieniieciieeiee e eseve e 119
Pages Used to Register Approved Menu Item Requests........ccceccveeecieeieieeiieeniienieeeieesree e 119
Administer Menu Item Requests Page........c..cccuvieiiiieiiiiiieiieceeeeeeee e 119
Define Menu Item Registry Page.......cc.cooiiiiiiiiiiicie ettt et s 121
Define REGISIIY Pae......cccuiiiiiiiii ittt ettt e et e et eeta e e ebeessbeesareeenneas 124
Select Menu FOIAEr Page........cocoviiiiiieiiieieee ettt et e e be e re e e beeenaeeneae s 125
Confirm RegISIIY Pa@E.......cooiiiiiiiiiie ettt ettt et e e e sbe e st e e esteeessbeessseessseeesseas 126
Registry Details Page........cccviiiiiiiiiiciieeie ettt ettt et e et e e s b e s beesbaesbeeeaaeessaaeesnaens 127

Copyright © 1988, 2024, Oracle and/or its affiliates. v



Contents

Chapter 10: Using the Portal Registry Load Process 129
Understanding the Portal Registry Load ProcCess........cceciiiciiiiiiiiiieiieeciie ettt 129
Understanding the Portal Registry Load Files.........cccoviiiiiiiiiiiiiiecee et 130
Creating a Portal Registry Load File........cccoociiiiiiiiiiiiiiecie et 136
Preparing to Run the Portal Registry Load Process.........c.cccuiiieiiiiiiieiiiieiiecieecieecee e 137

Pages Used to Prepare to Run the Portal Registry Load Process........cccccvvevvierciienieenieecieeenen, 137
Activating a Routing for the PORTAL REG LOAD Service Operation..........ccceccveereveerveennnenns 138
Defining Inbound File ProCeSSING.........cccuiiiiiiiiiieiiieeiieeitecieeeieeesieeetee e sve e beesreesveeeseeenes 138
Running the Inbound File Publish Process..........ccccuvieiiiiiiieiiieiiicciee e 138
Monitoring the Service OPETatiON..........ceeccvieriieeeriieeriierieerreesteeereeesseeesseeessseesseesseesssessssesssnes 139
Running the Registry Load PrOCESS.......ccccuiiiiiiiiiiicie ettt et tae e eseveessbeessbeesnneeens 139
Pages Used to Run the Registry Load Process.........cccoccvieiiieiiiiiiiiieeiie et 139
Run Registry Load Page........c.coooiiiiiiiiieciieceecee ettt et tae et e e b e e sevaesnns 139
Registry Load Data Page.........cccuiiiiiiiiiieiieeie ettt stee ettt e et sire e baeeseeeesaveesaneesnneas 140

Chapter 11: Understanding Search in PeopleSoft Interaction Hub 143
Understanding PeopleSoft Search Framework..........cccccciveeiiiiiiiiiiiiiiiccieecee et 143
Understanding the Search InfrastruCture.........ccvieeiiiiiiiiiecie e e 143
Understanding Search in PeopleSoft Interaction Hub............cccocviiiiiiiiciiiiciiiiic e 144
Understanding Search Definitions and Categories.........ccveevreerriierriieerieerieeereeeieesreeesreeeereeseveessnes 145
Delivered Search Definitions and CateZOTies. ........cccuieriieriiereieeeriieeiieereeesreesreesreesseeeseeeeseessseenes 145

Delivered Search Definitions.........cceeiieiiiiiiriiirieeieereeieee ettt et sbe e b sbeenaeas 146
Delivered Search Cat@@OTies.......cccuiiiriiirieeriieiiieeieeeiteerteeesaeesereesreesseesseessseeessseesssesssseessenans 148
Understanding Search INAEXES.........cuieciiiriiiiiieiiieciie et sre e veesreesteeetaeessaeessseessseessseesssenas 152
Understanding S€arch COMEEXLS.......cccuuiiiiiiriiieiieeriieeiieeiteeesteeesteesreesseeeseessseeesseeessseessseessessssesennes 153

Chapter 12: Administering Search Indexes 155
Understanding Search Index AdminiStration...........cccveeevieeiieenieenieerieeeieeeeieeeeeeseeeseveeseveeeveeesveeas 155
o (e (T |13 L F SRS 156
Deploying Search Definitions and Cat@ZOTies.........iecuurerriercrieriiieeiieeieeesreesreeereesreeereeesseeessveesenes 157

Pages Used to Deploy Search Definitions and Categories..........cccvevveerreeeireeeiiieenieeereeenveesnens 157
Deploy Search Definition Page..........cceeviiiiiiiiiiiiiie ettt ettt e sveesevee e 157
Deploy Search Cate@ory Page........cocuiiiiiiiiiiieiie ettt eire e v e svaeereeeaaeeeneenes 159
Building Search INAEXES.......ccccuiiiciiiiiiiiciiecie et stee et e ete et eesteesteesbeeetaeetaeessaeessseessseessseeenseeensns 160
Page Used To Build Search INAEX........c.ccooviiiiiiiiiiiiie ettt e e e 161
Build Search INdeX Page........cccioiiiiiiiiiiicie ettt ettt sbe e s re e e beeesaaeeseneenes 161
Adding Users t0 SEArCh GIOUPS.......ecccviieriiieiiiiiiieiiiesteeeteeetteesteeeseeeesbeesseesseessseessseeessessssesssseenns 162
Importing Remote Search Groups from Content Providers..........cccveeveeeviiiniiesciieciiecie e 163
Remote Search Groups Page.........cccuiiiiiiiiiiiiiiciecces ettt ettt e eseveessbeeearee s 163
Maintaining SEArCh CONTEXLS......ccuiireiiieeiieiiieiieerte et e et e et e eteeetaeestbeessseessbeeesseeessaeessseessseessseessses 164
Define Search ConteXt Page.........cccuiieciiiiiiiiiiiecie ettt et ve e beesveesneeeeae s 164
Creating Custom Search Definitions and Categories.........cccuveeruieeriirerieenrieereeeieeesieeeeeeesereesveesenens 165
Setting Up Unified Navigation Menu S€arch...........cccccuieeciieriieiiiieeiie e esie e eseveesveesveesveesnneens 166
Administering Search for Content Management Business Attribute Security..........ccccveeevveecveenneens 167
Delivered Search DefiNitions.........cceeiieiuiiiiiiniiiieereereetee ettt ettt et sbe e nbeenaeas 167
Delivered Search Cat@@OTies.......cccuuiiriiiriieiiieiiieeteeeitteertteesaeesreesreesseesseesssaeessseesssesssseesseenns 168
Deploying Search Definitions and Categories..........ccuvvrviervieriieriieerieeieeeieeeseeeseveesreesereeseneas 169
Defining Business Data Attributes for COntent...........cccvevviercieeeciieeiiierie e eree e 170
Building Search INAEXES.......cccuieiiiieiieiiieeie ettt ree st eereeetee e tbeessbeessaeessbaeessaeesseeesseenens 170

Chapter 13: Site Management Overview 173
Understanding Sit€ Management...........ccueeeuieeriieeriireiieesrieeiteeeieeesteeestreessseessseessesesseesssesessseesssesssses 173
Using Portal FEatures 0N SILES.......ccuieiiiiriieiiieiiieeiieeieeeeteeesreesreeseveesseeesseessseessseeessseesssesssseessseenns 174

Chapter 14: Navigating in PeopleSoft Interaction Hub Site Management 177

vi Copyright © 1988, 2024, Oracle and/or its affiliates.



Contents

Navigating in PeopleSoft Interaction Hub Site Management............cccceeveveeecieeiiiieesieeeneeenveeeveesennn 177
Using the Site Manager CONLET..........cccuuiiriierieerieerieeereeereeesteeesseeessreessseesseessseesssesasseeessesessees 177
Using the Site PUblISher Center.........cciiiiiiiiiiiiieiiiecieeeiee ettt re e sre e s reeeaeeeeneenes 178

Chapter 15: Managing Sites 179

Understanding Site Creation and Management............cccueeeieerirerreeriienreeereeesteeeseaeessreessseesseessseeas 179

Common Elements Used in Site Management............cceeecveeeiiieeiiieesieerieenieesreeereeeseeeseeessveessveesenes 180

CTEALING STLES....uuiiiuiieiiieetie ettt eieeerteestteesteeebeesbeeesbeeasseeessseessseessseesssaeassaeasseeassseassseensseesssesssseesseeans 181
Pages USed t0 Create SiteS.......ccciiiiiiireiieiiiieiiiieeitieesteesreesreesteesveesseesseeessaeessaeessseesssessssessssens 181
Site Wizard - Site Definition Page..........ccccviiiiiiiiiiieiiieiieeete ettt 182
Site Wizard - Authorize Site Branding Page...........cccoovveviiiiiiieiiiece et 184
Site Wizard - Appoint Site AdminiStrator Page............cccvevvieiiiiiiieeciiecie e 184
Site Wizard - Select Site Features Page.........ccveeviiiiiiieiiiiciiecieeceeeee et 185
Site Wizard - Specify Site Templates Page........c.ccocvveviiiiiiiiiieiiiecee et 186
Site Wizard - Specify Site Pagelets Page........cccvviiiiiiiiiiiiiciecee et 188

IMANAZING STEES.....vtiiririeiiieiiieeitieeette ettt esteesteesteeeseeaseeessseessseessseessseeassseassseassssessseesssesssssesssesensesenses 189
Page Used t0 Mana@e SITES.......c.cercuieiiieriiieeiiieesieeesieesteesteesseesseessseeessseessseesssessseesssssesssssssses 189
MaANA@E STLES PAZEC....cuiiiiiiiiiiieciie ettt e et e et e et e et e et e e sab e et eeenbeeenbaeetaeeraean 189

Chapter 16: Administering Sites 191

Understanding Site€ AdmMINIStratiON........cuieviiiiiieriieriieeiieeieeeseeeseeesreesereesreeeseeesseeessseessseessseessses 191

DEfiNING SItE SECUITLY...ccuviiietiiiitiieiie et eriee et te et e eteeetteesteesbeessbeessseeesseeassseesseessseessseessseessseessseeanes 191
Page Used to DEefiNe Sit€ SECUIILY.....uieiviiiiiiieeiieeiieeie et ere et e sreesteeeseaeesreesereesseessseeensneenes 191
Site SECUIILY PAZE....eiiceiiiiiieiiie ettt ettt e et e e ta e e ta e e sbeessbeesabeeesseeessaeensseensseensses 191

Defining Site Publication Defaults..........ccueecuiiiiiiiiiiiiiecieeciee e sbee e e e e 193
Pages Used to Define Site Publication Defaults............ccccoeiieiiiiniiiniiicieceeceecee e 193
Set Publishing Defaults Page........c.ccccviiiiiiiiiieeiie ettt ve s ve e s reesaaeeane e 193

Configuring the Sit€ HOMEPAZE. .......cccvieiiieiiieciee ettt eeree et e eteeetaeeebeessseessseesnseeans 194
Pages Used to Configure the Site HOMEPAZE.......cccveeviieeeiiiiiiieie ettt cree e eaeeeereenes 194
Configure Homepage - Tab Content Page..........cccevvieiiiiiiieiiieeiee et 194

Chapter 17: Publishing to a Site 197

Using the Site PUBLISher Center........cccviiciiiiiiiiiiiie ettt et sve e s esbe e e beeeraeesneenes 197

Managing Site€ NaAVIGAtION........cccuiiiiiieeiieeiieeeitiesteeeteeeteeetreestaeeseeeseseesseeasseeesseeessseessseesssessssesssees 197
Pages Used to Manage Site NavigatiOn.........ccvereviercvieeerieeiiieeiieesieeesreesreesseesseessseessseeessseessnes 197
Manage Navigation Page..........cceeviiiiiieiiieiiiecieeeie et esteesteesteeeaeeeaaeeseseessseessseessseeesseeessens 197
Select New Parent FOIAEr Page.........cccviiiiiiiiiiiiicceecee ettt en 206

Updating Site HOmMEPAZE CONLENL.........cccvieeiiieiiieiiieecieerteeeteeereeereeereeeeaeesereessaeessaeessseessseessseeensns 207
Pages Used to Update Site Homepage COontent...........cceevvieiiieiiiieiciieeciie e e esiveesveesveeseveens 208
Understanding Updating Site Homepage COontent..........ccoecvveervieriieeirieeiieeeeenieesveesveeseveeennens 208
Content Pagelets Page........cc.vciiiiiiiiiiicie ettt ettt st e et e e sab e e esbaeearaeens 208
Edit Content for Pagelet Page........c.coocviieiiiiiiiiie ettt ens 209

Chapter 18: Moving Sites Between Databases 211

Moving a Site BetWeen Databases.........cccveeeuiiiiiieiiiiiiiie ettt e et stae e staeeseaeessbaeenreeennes 211

Chapter 19: Setting Up Integration with Third-Party Email and Calendar Systems..........ccceeuuee. 213

Understanding Basic Email and Calendar Setup Steps........ccceevveeeeiieeiieeriieciiecieeeiee e eee e 213

Understanding Application and Mail Server Configuration...........cceccveeerererieenieescieesiee e eseee e 214

Integrating With Microsoft Exchange 2003 and 2007..........cccevcvieeiiienieerieeeiee ettt 214
Understanding Integration with Microsoft Exchange...........cccocveviiieciiiiciiiiieccic e 215
g (e (T | L T RS RTR 215
Installing and Configuring Active Server Page Files for Exchange...........cccccooevivveiiiciiiinennen. 215
Implementation Tips for Configuring EXchange...........ccccccuveriiiiiiiiiiiieeieecieecee e 217

Integrating With Lotus Notes Email and Calendar..............c.ccooveeiiiiiniieniiccieeceecee e 219
Understanding Integration with Lotus Notes Email and Calendar..............ccccccvvevvrenieenveennnnn. 219

Copyright © 1988, 2024, Oracle and/or its affiliates. vii



Contents

viii

g (e (T |1 L F RSP R 220
Integrating With LotuS INOTES......cccviiiiieiiieeiie e eieeete et e estte v e saeesbeesbeessbeeessaeesseeeeseesssennns 220
Completing the Lotus NOtes INteEration..........cccvieeiireiiieeiiieiieesieerieeereeeieeereeeeeeesereesveeseveens 220
Configuring the Lotus DOMINO SEIVET........cccuiiriiiiiieeiieeieeeteeeieeesreesveesreeereeeseeeeneessseessseas 221
Integrating With @ POP S@IVET......cccuiiiiiiiiiieiieceeeee ettt svee et e e teeetae e saeessbeeesveesnseeas 223
Understanding POP Configuration............cccveecuieeriiieniieniiecieesieeecreeeieeesneeseveesveesveessveesseeenes 223
Extracting .jar Files for POP Email Integration...........cccceeviiiiieriieiiieriee e e 224
Integrating With an IMAP S@IVET.......cc.cooiiiiiiiiiiie ettt et et eeveestreessseessreesnseeens 225
Designating the Primary Mail SYStEM.......ccccevuiiiiiiiiiieeiieciee et este e e eree e e eaeeetaeeseaeesssaesaveeas 225
Pages Used to AsSign Mail SEIVETS.......ccciiiiciieiiiiiiiii ettt et e et e et e eteeeaaeeseseessveees 225
Email and Calendar Defaults Page........c.ccccueiiiiiiiiieiiicieeet ettt 226
Configuring the Primary Email System to Use Microsoft Outlook Web Access.........cccceuveeneee. 227
Configuring the Primary Email System to Use Lotus NOteS........ccccvrevvieriieriieniieerie e 228
Configuring the Primary Email System to Use POP........c.ccccieviiiiiiieciieieeeeeeee e 229
Configuring the Primary Email System to Use IMAP.........cccoociivciiieciieeee e 230
Email and Calendar by USer Page...........ccovuiiiiiiiiiiiiiicie ettt 230
Support for SSL-Enabled Web Servers.........cccooviiiiiieiiieiiieciiecieesee ettt esveesvee s 231
Setting Up Additional Mail SYStEMS.......cccuuiiiiiiiiiiieiiieeiiieeiieeieesreeereeeteeeseeeesereeseveeseseessseeeseeenseeens 232
Pages Used to Set Up Additional Mail SyStems...........cccueeviiiriiiriieiiie e 232
URL Maintenance Pae...........cociieiiiiiiiieiiieeiiecieestee ettt etve e te e s b e e ssveestaeesseeensaeesneensnens 232
Chapter 20: Setting Up Instant Messaging in PeopleSoft Interaction Hub 235
Understanding Instant Messaging in PeopleSoft Interaction Hub............cccooevieiiiiiiiinecii i, 235
o (e (T |13 L F SRR RPS 235
Setting Up INStant MESSAZING........cccveervreriierrieiieeeireeesteeesteesseessseesseessseeessseessssessssesssessssessssesssseees 235
Pages Used to Set Up Instant Messaging in PeopleSoft Interaction Hub.............ccccecvvviiinnnnnnnn. 236
Import Instant Message USEIS Pa@e.......cccovviiiiiiiiiiieiiieciie ettt eiee e esive e v e sveeseree e 236
Loading Instant Messaging Information Using a Component Interface............cccceecvvevcveerreennen. 238
Maintain Instant Messaging USers Page........cccvevcviiiiiiiiiiiiiiieie ettt 238
Chapter 21: Working With Internet News Content 241
Understanding Internet NEeWs CONENL.........cueeiiieiiieriieeiieetieesieeesieeesreesreeereeeseeesseeessseessseesssessnses 241
Common Elements Used in Internet News CONtent..........ccooeeuieiiiinieenieeiennieeieeieeieeieeee e 241
Understanding News Feed Configuration..........c.ccccueeivieecieeeciieeiie e eeieeesreesveesveesneesneeeveeeeneesens 242
Understanding Internet News Content Providers.........c.ccccveeciiiiiieiiiieesiie et 242
Defining Internet News Content Providers.........c..cocuiiiiiiiciieicieiiieeie ettt eevee v esene e 243
Page Used to Define Internet News Content Providers..........ccveeeveeecieeerieenieeniierveesveeevee e 243
News Provider Maintenance Page...........cccccviiiiieriiieeiiiiciie et esreesreesveesreeeeeeeeveessseessvee e 243
Defining External News Pagelets.......c.coviiiriiiiiiiiiieciieciie ettt ete e sve et e et e eseaeesene e e 244
Pages Used to Define External News Pagelets.........cccovviiiiiiiiiieciiieieeieee e 245
Understanding Defining External News Pagelets........c.covviiiiiiieciieeiieeieeeieecieeciee et eee e 245
External News Pagelet Publications Page...........cccceeeviiiiiiiiieciiecceeeeee e 245
News Group Maintenance Page..........ccceeccuiiiiiiiiiiiieie ettt ettt saeesbeesaree s 247
News Category Maintenance Page...........cccveeviiiiiiiiiieciie et ee e e eenes 248
Managing EXternal NEeWS OPtIONS........ccccueeerireriieriiesreesieesreesseeeseeesesessseessseessseesssesssseesssesessessnses 250
Page Used to Manage External News OPtions..........cccveeviieriierieeniiieeiieeireeeieeeseveesveesveesveens 251
Manage External NEWS Page.......ccccccviiiiiiiiiiieiecie ettt ettt 251
Scheduling @ News Feed Load.........ccuiiiiiiiiiiiiiecieecee ettt et e eaaeeseve e e ebeeesraeenns 253
Page Used to Schedule a News Feed Load........c..cocvveiiiiiiiiiiiiciiecee e 253
Schedule External News Feed Page........cccovviiiiiiiiiiii ettt 253
Managing Loaded News ATtiCle CONtENL..........cccuiiiiieiiiieeiieeieeiie e esteesree e e sreeereeeseeeeveeseseenes 254
Pages Used to Manage Loaded News Article CONtent.........cccueevvrervrerieerciiesiiesieeeieeeeeeeseneenes 254
News Article Maintenance Page...........cccvieviiiiiieiiieeiic ettt eeteeesaeeesveesebee e 254

Copyright © 1988, 2024, Oracle and/or its affiliates.



Contents

Chapter 22: Working With Internet Content Pagelets 257
Creating HTML- and JavaScript-Based Pagelets.........c.ccccovviviiiiiieiiiecieeceeceecee s 257
Page Used to Create HTML- and JavaScript-Based Pagelets...........cccoeeveeviieniieniieniieecieeeen 257
Manage HTML Pagelets Page........cccoevvieiiiiiiieiieeciie ettt ettt tae e ae e vaesevaeeens 257
Chapter 23: Using the Integrated Task List 261
Understanding Integrated Task List Configuration Requirements............ccceeeveervieeecieeeceeenveenveenenen. 261
Understanding Integrated Task List Integration Setup.........ccccccveevevieriiieeciieiieeeieee e 261
Chapter 24: Publishing Content from Third-Party Applications 263
Understanding Web Services for Incoming Third-Party Content...........ccccceevevieeviieeneeenieenieesveeenen. 263
g (e (T |1 L TSR 263
Publication of Content from Third-Party Applications to the PeopleSoft Interaction Hub.......... 264
Content Publication Process FIOW.........cooiiiiiiiiiiiiiiiieeeeeeeeee e 265
PeopleSoft-Delivered ObBJECES.......cccuiiiiiieiiieiieciiecreeeieeeeeeteesreesreesreeeraeeraeesseeseseessseessseas 265
Setting Up on the PeopleSoft Side........coocviiiiiiiiiiiiee ettt et e e e 266
Setting Up the Publish/SubSCribe SEIVETS........ccccviiiiiiiciiieiiieeieesteertee ettt 266
Setting Up the PeopleSoft Integration Broker Gateway..........cccceevvrervieriieniieeniieeiie e eseve e 266
Defining An External Message NOGE......c.uieiiiiiiieiciieeiieecie ettt eee e seveessreesreeeneee s 267
Activating SeTVICE OPETALIONS......c.ueervierrierireereeetieerteesreesseesseessseessseeessseessseessseesssessssesesseeenes 267
Setting Up on the Third-Party Side.........ccccuiiriiiiiiiiiiecie ettt e sere e e 267
Creating the XIML File......cccuiociiiiiiiiieceeeeee ettt ettt et ae e e tbeessveessbeesaneesnraeens 267
Posting XML Content from Third-Party Applications to PeopleSoft Integration Broker............ 270
Viewing Published Content in the PeopleSoft Interaction Hub...........ccccoovveviiiiciiiniiecieeieeieee, 271
Pages Used to View Published Content in the PeopleSoft Interaction Hub...........c..cccveeeevennenn. 272
Understanding Enterprise Integration Points for the PeopleSoft Interaction Hub............c..ccveenee. 272
Chapter 25: Using Public Web Services 275
Understanding PUDIIC WebD SEIVICES.......ccccuiiiiiiiiiiiiieiiieeiie e eieeeiteesiteeseseesveesseessaeeseeesseessseenns 275
Enabling Public WED SeIVICES......cuiiiiiiiiiiiieciie ettt ettt ve e sve e sbeeeteeestaeesaeessseesnns 275
Using Content Management Public Web Services Schemas...........ccccoeeeieviieniieiciieciecee e 276
Adding Content with a Save SOAP ReqUESL.........cccciiiiiiiiieieeeeeee e 276
Getting Content with a Get SOAP REqUESL......cccvieiiiieiiiiiiecieceeetee e 277
Getting Content with a Find SOAP ReqUEST........ccccuiviuiiiiiiiiieciiecee et 277
Chapter 26: Administering Unified Navigation in PeopleSoft Interaction Hub 279
Understanding Unified NaVIGatiON..........cccvieiiviieiiireiiieeiieesieeeieesieesreeesteeeseeeeseseessseessseesssessssesesseeans 279
Unified Navigation in PeopleSoft Interaction Hub..........ccccccvieeoiiiiiiieniiiciieceeeeeee e 279
The Unified Navigation WOrKCENTET........c.vievviiriieiiieitieeieeeciee et e eveesveesreeeseeeeeeeseseessseessseas 281
Default Local Nodes and Portal HoSt NOAES.......ccc.eeiuiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeee e 282
Remote Content References and Templates..........ceeevvieiiiiiiieniieeiie e 283
Remote DashbDOArds...........cooiiiiiiii ettt et 285
Limitations and Additional Considerations in PeopleTools 8.54........cccccevviieviieviieniienieeeieenee, 286
Support Information for Customers Who Have Not Installed PeopleSoft Interaction Hub......... 287
Completing Initial System ConfigUration..........cc.cccveercvieeiieirieerieerteerreeereeereeeeeeereeesreesseessreeennes 287
Configuring the INtegration GatEWAY.........ccveevuieeriieerieerieeerieeteeesteeesteeesreesseesseeeseesseeesseessseessses 288
Setting Up SINGIE SI@NOM.....ccciiiiiiieiiieieeeieeeie et eieeeeeeste e eesbeesbeeebeeessaeesaeessseesssaesssessssessnnns 295
Understanding Single Signon for Unified Navigation............cceevveeeriieerieenieenieesveeeveeeveesveens 295
Understanding Remote NOAES........ccuiiiiiiiiiiiiieciie ettt e s e sreeebeeeseaeesveessseessseas 295
Defining RemOte NOGES......cccuiiiiiieiiieeieeciee sttt et e seae e beesbeesteeestaeessseesseessseesssens 297
Identifying All Trusted NOGES......cccuiiiiiieiiieie ettt et et e b e et e e seveesaseessseas 302
Adding Remote Nodes to the Integration NetWork..........ccccveeeviieriiiniiiiniieciecee e 303
TeStiNg SINGIE SINOM.....ccciiiiiiiiieiiieciie et eee ettt ere e st e e st eeebeeestae e saeessaeessseesssaessseessseeennns 304
Setting Up Unified NaVIGAtION........cccuiiiiieiiiieiiiecieesieeeeteeeiteesieeesiteeseteesseessseesseeessaeessseesssesssseesnses 305
Pages Used to Setup Unified Naviation.........ccceeecuiiiiiiiiieerie et eieeeveeeiee e eseveesveesveeevee s 305

Copyright © 1988, 2024, Oracle and/or its affiliates. ix



Contents

Unified Navigation Node NetwWork Page........c..cccvieeiiiiiiiiiiiiciieiieciee et 305
Configure Drop Down Menu Page..........ccoeviiiiiiiiciiiiiiiecie ettt evee et e veesiveesveesereeennee s 306
Completing Configuration of Remote COontent..........cceccvieriieiiiienciieeiie e eseeesveeeveeevee e 309
IMPOTEING PAZEIELS. ... oiiiiiiiiieciie ettt ettt e e s te e st e e e bt e e taeesaeessseesssaessseesnseeanes 309
Additional Setup for FIUid MOde.........ccoooiiiiiiiiiiiiecee et svee e e n 309
Selecting Portal HOSt NOGE.......c..iiiiiiiiiiciie ettt re e s re e ere e eereesaseesnneas 310
Assigning Remote Grouplets/Tiles to Delivered Landing Pages..........ccccoeevveveiieiciieicieeecieeieens 310
Troubleshooting Unified Navigation SEUP.........cccccieiiieiciieiiie e esee et esree e e sveeeveeeeeeeeveesene e 311
Pages Used to Troubleshoot Unified Navigation Setup.........ccceeveveercieeiciieeiiieniecrieeeieeevee e 311
Unified Navigation Configuration Status Page..........ccccoevieriieiiiiniiieeie e 312
Integration Broker Diagnostics Page........c.ccccviiiiiiiiiiieiiieiiecieecteesee et 313
Setting Up Related CONENL........cc.eiiiieeiieeieecie ettt eeteeeree et e e stee et e eseveesbeesseeesseeesseeessseensseesssens 315
Understanding the Setup of Related Content Within Unified Navigation.........c.ccccceeeeveeeevveennnn. 315
Creating a Service to Manage Related Content for a Content Provider System.............c.ccc....... 316
Creating and Assigning Related Content Within the Unified Navigation Framework................ 318
Importing Pagelets from Content Provider SyStems..........ccccuveriieiiieriieeiie et 321
Pages Used to Import Pagelets from Content Provider Systems..........ccccceevevenirencieencieenreeennen. 321
Pagelet IMPOTt PA@E......cccuviiiiiiiieeiecee ettt e et e e eb e e tr e e taeessbaeeebaeeareean 321
Pagelet SEarch Pae........c.coooiiiiiiiiiicieeee ettt et e e e baeearee s 322
Defining Source Application Page..........cccviieiiiiiiiieiii ittt 323
Add Pagelet Pae......ccooeeiiiiiiicie ettt s e et e e e nraeetaeesnaeenaaes 325
Unified Navigation Support for FIuid Mode.........ccciiiiiiiciiiiiiiiiee ettt 327
Understanding Unified Navigation Support for Fluid Mode...........cccoeeeiiiiiiiiiiiieii e 328
Personalizing Remote Landing Pages and Navigation Bar...........ccccccoveveiiiiviiicieecie e, 330
Add Tile Page (FIuid HOMEPAZE).......ccccveieiieeiiieciieeiie ettt ettt evee et eetaeeeaeesveeseraeenns 330
Add Tile Page (INAVBAT)......cuiiiiieiiieciieeiie ettt ettt s e e te e et e etaeesebeessseessbaessseeensseessseenssens 331
Setting Up the Notification WINAOW..........cccueiriiiiiiiiiieciie ettt sree st ereeeseeesseesenas 333
Chapter 27: Administering Multiple Application Instances in Unified Navigation..........ccceeueeueenee 335
Understanding Multiple Application Instances in Unified Navigation..........ccccceeeveevveerieencreesneeenne 335
Setting Up Multiple Application INStANCES.........ccciierireriieiiieciieeiee e e e e ereeereeereeeeeeeseveesenes 335
PrOIEQUISIEC. ..eeuvveeetieetieeite et ettt e et e et e et e e et e e tbeeesbeesabeessseaessaeessseessseesssaesssaeassaeansseesseenssennns 336
CUStOM Properties Page........ccccuiiiiiiiiiiecieeceeeee ettt e st e e e e taeesbe e sbaessreesaseeens 336
Multi Instance Configuration Page...........cccvieviiiiiiieiiiiiiicceecee et 337
SYNCHATONIZING SECUITEY ... .eiiitiieitiiiiiieitieeetteeitteeseeesteeestteesbeesbeesbeessaessseeesseessseessssesssesssseesssennns 342
Configuring Pagelets for Multi-Instance CIUSEEr..........ccueeviiiiiiiriieciee et 343
Configuring Related Actions for Multi-Instance CIUSter...........cccuveviieriierciieiiieciee e 343
Chapter 28: Maintaining Business Attributes on User Profiles 345
Understanding Business Attribute USAZE.........ccueiviiiiriiiiiieeiiesiieeteeeieeeieeesiveesiveeseaeessseessseessveeennes 345
o (e (T |13 L F SRS 346
Maintaining Business Attribute Definitions..........ccceccueeicieiiiieiiiesiieciee e 347
Pages Used to Maintain Business Attribute Definitions..........c.ccccveeeiieecieeniiieniiesieeciee e 347
Profile Configuration Page...........cccuieiiiiiiiiiiiecie ettt ettt ettt e e eveesveeebeeenaeeensaeens 347
User Business Data Attributes Page.......c.cccuveiiiieiiiiiiiiciieceececs et e 348
Loading Business Attribute Tables........cccccuiiiiiiieiiiieiieeriiectee ettt ve e reeseseeeeaeeeaes 349
Understanding the Business Attribute Table Loading Procedure..........c.ccccovevviieviieniieniiecien, 350
Using a DataMover Script to Load Business Attribute Data...........cccceeveeviieniieniieciie e 350
Using the PeopleSoft Publish Utility to Load Business Attribute Data...........c.ccccveveiveecieennnnens 351
Synchronizing Business ATIIDULES........cueevviiiiiieiiieie ettt e sereesae e b e e esbeeenreeenees 353
Populating the PeopleSoft Interaction Hub User Profile Table...........ccceovieeciiiiciiiiiicieeieeeee, 353
Adding New Business AtIIIDULES.........cccvieriieiiieiiiecieeeieeeciee e eseeesaeesreesebeeesbeesssaeessaeessseenssesssnes 355
Chapter 29: PeopleSoft-Delivered Security Data 359

X Copyright © 1988, 2024, Oracle and/or its affiliates.



Contents

Summary of Delivered SeCurity Data..........ccccueiviiieiiiiiiieciieciee ettt sreesreesaeeeraeens 359
Permission Lists and Roles Cloned When Creating Sites.........cccvevviercieeeciieeiiieeniieeneeesveesveeevee s 360
Permission Lists Cloned When Creating Sites..........cccviiiieeiieeiieeniienieeeieesreeesieeeseveeseveessneens 360
Roles Cloned When Creating Sites.......c..cccieeriieerieeerieeniiesreesreesveeeseessseeessseessseessseesssesssseessses 360
PermiSSION LLISES. . .eeutiiiiiiieieeie ettt ettt ettt ettt st e et eae e sat e saeesat e st e et eaeas 361
Permission Lists With SPecial USES.......ccciiiiiiiiieiiiieiieeiie ettt eveeseveeseree e 361
Delivered Permission LAStS........couiiierieiieiieiieiiest ettt ettt et sb et ae e 362
RIS .ttt ettt et ettt e bt et et e bt et e e bt e bt e bt eabeeteebeenteens 376
ROIES With SPECIAL USES....cccuviiciiieiiieiiieeciieeiieete e esteesteesbeesbeesbeeebeeesseesseesseesssesssseesssenans 376
Roles Associated with Major PeopleSoft Interaction Hub Areas........c.cccccvevvvveeciieeceeenveenreenee. 377
VIBWET ROIES. ...ttt ettt et e bt e s bt e bt e s bt e sbe e bt e sbeesbeesbeenbeeees 378
DElIVered ROIES........oiiieiieieee ettt et ettt ettt et et an 379
Delivered Roles and Associated Permission LiSts.........cceoierierieiiiniiieeieeiceieeeeeeeee e 383
USET ISttt ettt h e e bt e sh e sh e e s h e e a e e e bt e e bt e sht e sat e e aeeeae e eae e eaeesate et e eateeaeas 384
User IDs With SPECIAl USES.....c.uiieciiiiiieiiiiieiie ettt ettt sieeeeeesbeesbeesbeeesaeesaeesseessseesssenas 384
Delivered PeopleTools ROIES........cccciiiiciiieiiieciieceeeee ettt e e tae e tae e taeesabeesebeesnreeas 384
Adding the Portal User Roles to All USET IDS........ccccuiiieiiiiiieiiecieeciee ettt 385
Chapter 30: Using Common Functions That Reference a Password Data Store 387
Understanding Common Functions that Reference a Password Data Store..........ccccccvvevvvercieenneennne. 387
Understanding the Interactive Flow for a Sign On Password Data Store............cccevcvvevviencreenneenne. 388
COMIMON FUNCHIONS. ...ttt ettt ettt et et e e et e bt et et e eaeesateeateeateeaeas 389
InsertUpdatelUSINAMEPSSWA........ccciiiiiiieiieciie ettt ettt e e taeeseaeesebeesaree s 389
GEtUSINAMEPSSWA. ...ttt ettt sb ettt et e sbe e bt e bt e beenbeenaeens 390
DeleteUSINAMEPSSWA. ......oiiiiiieieieee ettt et et ettt et et saeesate e eae 391
Chapter 31: Sample Business Attributes Service Operation Handler PeopleCode................cc..... 393
Case 1: A Nonrowset-Based Message Does Not Exist for the Service Operation in PeopleSoft
INEETACTION HUD. ....iiiiiiiii ettt b e b e b e bt et e e sbe e sbeesbeesbeenbeeneean 393
Case 2: A Nonrowset-Based Message Exists in PeopleSoft Interaction Hub for the Same-Name
Service Operation in PeopleSoft HCM.........c.coocuiiiiiiiiiiiie ettt ettt e 394

Copyright © 1988, 2024, Oracle and/or its affiliates. Xi



Contents

Xii Copyright © 1988, 2024, Oracle and/or its affiliates.



Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed PeopleSoft Online Help

If you’re setting up an on-premises PeopleSoft environment, and your organization has firewall
restrictions that prevent you from using the hosted PeopleSoft Online Help, you can install the online help
locally. Installable PeopleSoft Online Help is made available with selected PeopleSoft Update Images and
with PeopleTools releases for on-premises installations, through the Oracle Software Delivery Cloud.

Your installation documentation includes a chapter with instructions for how to install the online help

for your business environment, and the documentation zip file may contain a README.txt file with
additional installation instructions. See PeopleSoft 9.2 Application Installation for your database platform,
“Installing PeopleSoft Online Help.”

To configure the context-sensitive help for your PeopleSoft applications to use a locally installed online
help website, see Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

* Application Fundamentals
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» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.

In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

Xiv

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.
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Typographical Convention Description

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
¢ Latin America

¢ North America

Industry ldentifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

» USF (U.S. Federal)
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* E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.

Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

»  Using the PeopleSoft Online Help.
» Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

About PeopleSoft Interaction Hub

This section discusses:
* PeopleSoft Portal Solutions product family.

e PeopleSoft Interaction Hub and PeopleTools.

PeopleSoft Portal Solutions Product Family

This section discusses the products that are part of the PeopleSoft Portal Solutions product family:

PeopleSoft Interaction Hub

Oracle's PeopleSoft Interaction Hub is a world-class portal solution with many robust content and
collaborative features. The PeopleSoft Interaction Hub is ideal for customers wishing to deploy an
unlimited number of communities across an enterprise that focusses on PeopleSoft application business
processes.

PeopleSoft Interaction Hub 9.1 contains a rich set of Web 2.0 features. For instance, collaborative
workspaces and related content services can be keyed to PeopleSoft application transactions providing
contextually relevant collaboration.

Two key characteristics distinguish PeopleSoft Interaction Hub as a rich Web 2.0 platform:
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» First, PeopleSoft Interaction Hub is a traditional portal framework that can be used for aggregating
and managing content from multiple applications and sources. With unified navigation, it is now
simple to configure PeopleSoft Interaction Hub to federate multiple PeopleSoft application systems.

» Second, its collaborative capabilities make PeopleSoft Interaction Hub a functional application that
complements the features found in PeopleSoft applications.

PeopleSoft Interaction Hub and PeopleTools Portal Technology

To understand the functionality of PeopleSoft Interaction Hub, Oracle recommends that you familiarize
yourself with PeopleTools, focusing especially on the subject areas and sections that are devoted to portal
functionality. Because PeopleSoft Interaction Hub builds upon the basic internet architecture that is
delivered with PeopleTools, this information gives you an excellent foundation of knowledge upon which
the PeopleSoft Interaction Hub suite of documentation builds.

PeopleTools portal technology is built on top of PeopleSoft Pure Internet Architecture and enables you to
easily access and administer multiple content providers, including PeopleSoft databases such as Oracle's
PeopleSoft HRMS or Oracle's PeopleSoft CRM, as well as non-PeopleSoft content. It enables you to
combine content from these multiple sources and deliver the result to users in a unified, simple-to-use
interface.

The main elements of the PeopleTools portal technology are a portal servlet and an application server.
These two elements work together to provide common portal processing features such as page assembly,
search, content management, navigation, and homepage personalization.

Product documentation for PeopleTools covers the PeopleSoft Pure Internet Architecture and PeopleTools
portal technology in detail.

See PeopleTools.: Portal Technology.

Related Documentation

This section discusses:
*  PeopleSoft Interaction Hub documentation.

* PeopleTools documentation.

PeopleSoft Interaction Hub Documentation
PeopleSoft Interaction Hub documentation includes:
e PeopleSoft Interaction Hub: Branding

This subject covers PeopleSoft Interaction Hub’s branding feature, which is built on the PeopleTools
branding framework. Branding enables you to create branding definitions and apply branding themes
to portals, sites, and workspaces allowing you to create a differentiated appearance for specific user
audiences.

*  PeopleSoft Interaction Hub: Collaborative Workspaces
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This subject covers setup, administration, and use of collaborative workspaces, which are virtual team
rooms that facilitate collaboration on a variety collaborative projects and processes.

PeopleSoft Interaction Hub: Content Management System

This subject describes the content management system, which includes features to help you manage,
create, and organize content. The resulting content is ready and available for placement in various
portal pagelets and news publications; reuse in workspaces, calendars, and other portal features; or
available just for browsing.

PeopleSoft Interaction Hub: Portal and Site Administration

This subject covers tasks for administering portals and sites including product configuration, system-
wide setup and administration, integration with third-party systems, and so on.

PeopleSoft Interaction Hub: Using Portal Features

This subject covers setup and usage of items such as blogs, calendars, discussion forums, feeds,
tagging, searching, related content services, and other features of PeopleSoft Interaction Hub.

PeopleTools Documentation

XViii

PeopleSoft Online Help for PeopleTools contains the complete set of subject areas covering PeopleTools
8.53. In particular, several of these subjects are useful to the setup, administration, and use of PeopleSoft
Interaction Hub including:

Peoplelools: Feed Publishing Framework

The PeopleTools Feed Publishing Framework supports the publication of PeopleSoft Interaction Hub
data as feeds. In addition, the framework can be used to develop custom feed types.

Peoplelools: Integration Broker

PeopleSoft Integration Broker facilitates the exposure of PeopleSoft business logic as services
and the consumption of external web services. Integration Broker also supports synchronous and
asynchronous messaging between PeopleSoft applications and with third-party systems.

PeopleTools: Portal Technology

PeopleTools portal technology is the foundation of the PeopleSoft Interaction Hub product. This
subject covers critical portal technologies such as portal implementation, PeopleSoft Pure Internet
Architecture, Pagelet Wizard, the PeopleSoft Related Content Framework, and others.

PeopleTools: Security Administration

This subject covers important security-related topics including PeopleTools user profiles, roles,
permission lists, single sign-on (SSO), and others.

PeopleTools: Applications User's Guide

This subject provides general information about PeopleSoft applications useful to all users of
PeopleSoft systems. Topics include an introduction to the PeopleSoft Pure Internet Architecture,
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explanation of how to navigate through the system, how to perform searches, elements of application
pages, and so on.

Note: These subjects and others in the PeopleSoft Online Help are referenced as needed.

PeopleSoft Portal Solutions Related Links

PeopleSoft Interaction Hub 9.1 Documentation Home Page [ID 887960.1]

PeopleSoft Information Portal

My Oracle Support

PeopleSoft Training from Oracle University

PeopleSoft Video Feature Overviews on YouTube

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

Watch PeopleSoft on YouTube

[-]

Follow @PeopleSoft Info on X.

>

Read PeopleSoft Blogs

0]

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started With PeopleSoft Interaction
Hub

PeopleSoft Interaction Hub Overview

Reviewing all elements of the PeopleSoft portal offerings helps you better understand how the PeopleSoft
Interaction Hub fits within your own portal strategy. The PeopleSoft offerings focus on providing you
with products that can be combined in multiple ways to produce the enterprise portal configuration that
addresses your organization's requirements. The fact that the PeopleSoft Interaction Hub and PeopleSoft
business applications share a common PeopleTools technology base makes integration easy. While our
portal packs provide this prepackaged integration to PeopleSoft applications, you can also integrate with
any web-enabled application by using the PeopleTools integration technologies.

This topic discusses each element in the overall PeopleSoft portal infrastructure:
* PeopleSoft Interaction Hub.
* PeopleTools portal technology.

* PeopleSoft portal packs.

Note: This subject area documents the functionality of the PeopleSoft Interaction Hub only. Detailed
documentation for PeopleTools portal technology and the PeopleSoft portal packs is delivered separately
with the respective products.

PeopleSoft Interaction Hub provides a selection of out-of-the-box features that enable you to quickly
implement the portal. You can deploy enterprise-wide access to internet-based applications, unstructured
content, a searchable resource repository, and collaborative services through an internet browser.

Deploying PeopleSoft Interaction Hub provides you with peace of mind, knowing that your software
investment is protected against rapidly changing technology standards through our full-service support,
maintenance, and upgrade programs.
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My Page Homepage Tab

This example illustrates the My Page homepage tab of PeopleSoft Interaction Hub, which has been
personalized to include multiple delivered homepage pagelets.

Favorites v iain Wenu =
X Home | AddtoMyLinks | Sign out
ORACLE Al ~ | searcn 7| Advanced Search
My Page Guest My HR Manager Dashboard Company Directory Recruiting Dashboard | ¥¢
Personalize Content | Layout 2 Help
5} My Events & o~ | F&Discussion Forums & ov | [Blogs S e~
August 2014 v B Employee Kiosk 5 from e ve
sun non Tue wea Thu Fri sat Do we offer new employee gatnerings? An oveniiew of my respensibilities
N . . . N : : = Re: Do we offer new employee gatherings? Welcome 1o VF's Blog
2 5 W - - Re: Welcome to VP's Biog
1 1 vy 5 . 15 16 What are the office hours’
17 18 19 20 21 22 7 - Re: What are the office hours?
2 25 26 7 2 2 3 " A -
5 7 3 e W )
2 2 26 2 28 29 0 - Re: What are the office hours? Crests Blog Administer Blogs iy Blogs Search Biogs ) Feed
3
Click Customize to select Calendars. . Guest Column £ Company News S &~
Full Page View W s
0 Why don'tyou putNo Smoking signs atyour campus Save the Date to Celebrate
My Workspaces o (o< o replies entered for this topic: { Bring your family and come celebrate on Thursday, September 7 at
b Headaquarters. Weve gotlots in store for you including food, drink, and special
1 musical guests
Compensation Manager Workspace B How we make ourselves B‘”;:é" Tags: celebrate, event, party
Wik W
oMM pixopcce e Grand Opening in Milano
Demo Workspace i
- The grand opening will be held in a ‘magic,” themed location (Umanitaria
Performance Management Wrkspc N . where guests will be invited to experience the Middle Ages with a fairy-tale
Sun Micrasystems Opportunity No replies entered for this topic flavor.
\iew All Workspaces Tags: even, press release
Creats Workspace Graate Forum Administer Forums My Forums Search Forums () Feed = Headline News
= . Aisitors Guide to the San Francisco area
&8 Tag Cloud el [F ]ty Focas ~ o~ | - BingYourParenis toWork Day
. Getihe Weather Report
Compensation Talent Management smart
- My Team Blo Hore.
goals ziora Sun Microsystems Qw 9 X
CollabEx Selling Tips Presentations Data () My Personal Biog Submit Article | Update Submitied Articies | E§ Feed ~
Sheet GontactInformation forecasting HCM ) Employee Kiosk View Al Articles and Sections
objectives Performance Management
goals employee handbook conference HR ) Company News
refirement benefits content administration
blog Financeteam Finance Workspace News View All Feeds [Search ®
publication buyer workspace HR taxonomy
VPTsBlog discount autoparls califoria
office hours employee construction mobile
demo department event press release
celebrate  party
search

Users can personalize their PeopleSoft Interaction Hub homepages to display a variety of pagelets.

Numerous pagelets are delivered with the PeopleSoft Interaction Hub product. See “Homepage Pagelets”
(Using Portal Features).

The following features are available in the default homepage header of PeopleSoft Interaction Hub:

Term Definition

Favorites Use the Favorites menu to access recently used menu items,
favorites, and My Links items.

Main Menu Use the cascading drop-down menu navigation to view menu
folders and navigate to a menu item.

Home

Click to return to your default homepage tab (typically, the My
Page tab).

Add to My Links Click to access the Add to My Links page, where you can add

a My Link to the currently accessed component of your My
Links collection.

See “Add to My Links Page” (Using Portal Features).

Sign out Click to sign out of the PeopleSoft Interaction Hub system.

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 1 Getting Started With PeopleSoft Interaction Hub

Term Definition

Search Submit a portal search request and access the Search Results
page.
See “Understanding Searching in the Portal” (Using Portal
Features).

My Page Select to access My Page homepage tab.

Guest Select to access a homepage tab that is configured for guest

Users.

See Understanding Guest User Accounts.

My HR Select to access a sample tab that integrates content from
PeopleSoft HCM, PeopleSoft CRM, and PeopleSoft
Interaction Hub.

Depending on the configuration of your system, other homepage tabs may be visible:

» Additional homepage tabs such as Manager Dashboard, Company Directory, and Recruiting
Dashboard shown in the previous example are defined in a custom tabs navigation collection. See
“Custom Tabs Navigation Collection” (Branding) for more information.

* In addition, the Administration tab or the Investor tab may be enabled on your system. See the
following section for more information on the Administration tab.

Administration Homepage Tab

The Administration homepage tab displays homepage pagelets for administrative tasks.

Note: The content reference definition for the Administration tab is delivered as disabled. SeeEnabling a
Homepage Tab That Has Been Disabled for more information on enabling the Administration tab.
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The following example illustrates the Administration homepage tab, which displays pagelets for

administrative tasks.

Our menu has changed!

The menu s now located across the top of the page. Click on Main Menu to get
started

Highlights

Recently Used pages now appear under
the Favorites menu, located at the top lef

Breadcrumbs visually display your
navigation path and give you access to the
contents of subfolders

WMenu Search, located under the Main
Menu, now supports type ahead which
makes finding pages much faster.

;]E Site Manager Center c
‘Administration
Create New Sites, Maintain Existing Sites, Con figure Homepage

site Publishing
Waintain Navigation, Update Content Pagelets

Favorites Main Menu -
ORACLE’ Al ~ | Search
My Page Guest My HR Administration Manager Dashboard
Top Menu Features Description S ov

> | Advanced Search

Gampany Directory Recruiting Dashboard | %€

F5] content Manager Center o

Managed Content

Browse Folders, Search Folders, Maintain Content, Hy Content Status, Pubish as Menu tem, Pubish

as Pagelet
=] Content WorkCenter
Categorized Content

Browse Folders, Search Folders, Maintain Content, My Content Status, Unpublish Crawled
Content, Categorize Crawled Content

News Publications

Brows Publications, Search Sections, Waintain Content, My Content Status, Publh
Atticles, Unpublish Articles, Choose Top Stories, Administer Content

Advanced Options

Browse all Folders, Search all Folders, aintain allContent, Maintain al Foiders, Uniock
Content, Review Content, Render Content URL.

Administration

Purge /Inactivate, Priviege Sets, Viewer Roles, Fik Storage, Feature Defintions, Top
Administrators, Migrate Content, View Content ligration Log

o~

Home Add to My Links Sign out.
Personalize Content | Layout 2 Help
3 context Manager Center S sv

Template Pagelets
Related nformation, Related Contacts, Related Resource, Content Rating Questions

Menu tem Templates

Structure and Content

Template Pagelet Assignments

Choose Defautted Pagelets, Add Pagelets to enu ems

Contextual Content Managers

Reiated hformation, Related Contacts, Related Resources, Gontent Ratings

Contextual Content Management

Look up WMenu Kems, Assign Questions to Menu ems, Assign Tracker to Itenu tems, Sample Menu
tem

Contextual Data Review

Template Pagelets, Related information, Related Contacts, Related Resources, Content Ratings
Resuls, Usage Tracker Resuts

R Resource Finder Center T o~

Core Objects
Valid Value Groups, Atributes, External Asset Types, Participant Types
Mappings

Data Sources, Participant Mappings

Profile Management

Dispiay Groups, Farticipant Profies.

Administration

Organization Charting, Search Options

Batch Processing

Configure Fils Import, Load Participant User Ids

These homepage pagelets display the same content as the navigation collection pages that appear as menu
items under the Portal Administration menu:

» Site Manager Center.

See “Understanding PeopleSoft Interaction Hub-Delivered Pagelets” (Using Portal Features).

* Content Management Center.

See “Understanding Managed Content” (Content Management System).

* Context Manager Center.

Important! As of PeopleSoft Interaction Hub 9.1 Revision 2 and PeopleTools 8.53, the Context
Manager feature and associated pagelets have been deprecated. The PeopleSoft Related Content
Framework provides a broader and more flexible framework for contextually related content.

See “Context Manager Center Pagelet” (Using Portal Features).

Similar to any homepage tab, users can select which pagelets appear by personalizing content for their

Administration homepage tab.

PeopleTools Portal Technology

All PeopleSoft applications are developed using PeopleTools application development technology.
PeopleTools, an object-oriented development environment, allows for the rapid and efficient development
of applications by storing application design as metadata. The PeopleTools development and runtime
environment includes the basic technology features on which PeopleSoft Interaction Hub is built.

24
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PeopleSoft Portal Packs

PeopleSoft portal packs are a convenient packaging of pagelets that provide access to content from the

Getting Started With PeopleSoft Interaction Hub

corresponding PeopleSoft application. PeopleSoft portal packs are optional products and are not required

to access data from a licensed PeopleSoft application.

Note: WorkCenters and dashboards delivered in PeopleSoft application databases along with the pagelet

import feature of the unified navigation framework provide alternative mechanisms for accessing content

from PeopleSoft application databases.

This table lists optional PeopleSoft portal pack products:

Product PeopleSoft Application
PeopleSoft ALM Portal Pack PeopleSoft FSCM
PeopleSoft CRM Portal Pack PeopleSoft CRM

PeopleSoft EPM Portal Pack

PeopleSoft EPM

PeopleSoft ESA Portal Pack PeopleSoft FSCM
PeopleSoft Financials Portal Pack PeopleSoft FSCM
PeopleSoft HCM Portal Pack PeopleSoft HCM
PeopleSoft Supply Chain Portal Pack PeopleSoft FSCM
PeopleSoft Interaction Hub Integrations

PeopleSoft Interaction Hub can integrate with all of the following:

* PeopleSoft applications.

* Non-PeopleSoft applications.
*  Third-party internet services.
e Internet content.

* Extranet content.

¢ Intranet content.
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PeopleSoft Interaction Hub Implementation Tasks

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on
the features that you are implementing. The setup tasks include the components that you must set up,
listed in the order in which you must enter data into the component tables, and links to the corresponding
PeopleBook documentation.

Other Sources of Information

In the planning phase of your implementation, take advantage of all PeopleSoft sources of information,
including the installation guides, table-loading sequences, data models, and business process maps.

See the product documentation for

PeopleTools: Setup Manager

Using Third-Party Images Provided with Sample Data

The PeopleSoft Interaction Hub demo database includes sample images that are provided under a
restricted use license for demonstration purposes only, such as product demonstrations and conference
room pilots. The specific images are listed below. If you want to use these sample images in a production
environment, you must contact the image owners directly to purchase the images. You can find contact
information for the owners in Licensing Notes for Oracle's PeopleTools 8.54, Document 1905898.1 on
My Oracle Support.

Oracle does not provide a license for you to use the sample images in your production environments or
for other non-demonstration uses.

Image Content ID Where Used Owner Owner’s Media
(in PS91 ID for Image
Database)
1155 My HR homepage tab | Corbis 42-47299349
1156 My HR homepage tab | Getty 79670128
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Image Content ID Where Used Owner Owner’s Media

(in PS91 ID for Image
Database)
1712 Company News tile Getty 485209613
1713 Company News tile Getty 452760723
1714 Company News tile Getty 184827434
1715 Company News tile Corbis 42-57166951
1716 Company News tile Getty 454983451
1717 Company News tile Corbis 42-39352088
1718 Company News tile Corbis 42-33029280
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Image Content ID Where Used Owner Owner’s Media
(in PS91 ID for Image
Database)
1720 Company News tile Corbis FAN9003734
1721 Company News tile Getty 175137889
1722 Company News tile Corbis 42-39351359
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Chapter 2

Administering Portals and Sites

Understanding Portal Administration

This PeopleBook covers portal-wide and site-wide administration tasks only, and is not intended to be an
all-encompassing administration guide. Administration of specific features remains with the other content
on those features.

The Portal Administration portion of this PeopleBook details how to perform these functions:
» Configuring and Managing PeopleSoft Interaction Hub
*  Administering the Search Infrastructure

* Administer Integration with Third-Party Systems, Messaging, and Internet Content

Understanding Site Administration

Site Management facilitates the creation and management of multiple sites from within one installation of
PeopleSoft Interaction Hub. Each site is managed separately.

The Site Administration portion of this PeopleBook discusses:
* Managing and administering sites.

* Defining site security.

e Defining Site Publication Defaults.

» Configuring the Site Homepage.

* Managing Site Branding.

* Publishing to a Site.

* Moving Sites Between Databases.

Understanding Administration of Specific Features

Specific features such as the Content Management system, Workspaces, Calendars and Discussion
Forums also require administration. However, such administration is typically at the level of the specific
instance of each feature, not site-wide.
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30

Here is a list of feature-specific administration topics within the PeopleSoft Interaction Hub PeopleBooks,
followed by links to these topics.

Administering Action Items

See “Administering Action Item Lists” (Using Portal Features).
Administering a Blog

See “Managing Blogs” (Using Portal Features).

Administering Community Calendars

See “Administering Community Calendars” (Using Portal Features).
Administering a Discussion Forum

See “Managing Discussion Forums” (Using Portal Features).

Administering Polls

See “Administering Polls” (Using Portal Features).

Setting Up PeopleSoft Interaction Hub Branding

See “Enabling the Revision 3 Branding Features” (Branding)

Administering Collaborative Workspaces

See “Understanding Workspace Administration” (Collaborative Workspaces).
Administering the Content Management System

See “Administering the Content Management System” (Content Management System).
Administering News Content

See “Administering News Content” (Content Management System).
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Configuring PeopleSoft Interaction Hub

Setting the Default Style Sheet

This section discusses how to set the default style sheet in the PeopleTools Options component

(PSOPTIONS).

Page Used to Set Default Style Sheet

Page Name

Definition Name

Usage

PeopleTools Options Page

PSOPTIONS

Set the default style sheet.

PeopleTools Options Page

Use the PeopleTools Options page (PSOPTIONS) to set the default style sheet.

Navigation:

PeopleTools > Utilities > Administration > PeopleTools Options
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This example illustrates the fields and controls on the PeopleTools Options page.

Chapter 3

PeopleTools Options

Ervironment Long Name

Environment Short Hame

System Type | Undefined Datahase

bl | O Right Align Field Labels

Language Settings

Language Code English

L Multi-Company Organization
Multi-Currency
Use Business Unit in nvision

E Multiple Jobhs Allowed

Allow DB Optimizer Trace
Grant Access

Platform Compatibility Mode

Ol save Error is Fatal
[Cset Focus on Save Button
‘Case Insensitive Searching
Style Sheet Name
Branding Application Package

Branding Application Class

Tree Manager Options

L Translation Change Last Update

Background Disconnect Interval |30

Use Secure Rep Rqgst in nVision

Allow NT batch when CCSID=<=>37

"Sort Order Option | Binary Sorting w

Temp Table Instances (Total)

Temp Table Instances {Online)
‘Maximum Message Size 10,000,000
Maximum number of Segments 10
Base Time Zone |FST @,

Last Help Context & Used 100222

‘Data Field Length Checking

Cuse Tree Update Reservation

Max Tree Inactivity Period,min

RoleBasedBranding

20

‘Maximum Attachment Chunk Size 28,000
Uparade Project Commit Limit 50
‘Enable Switch User | All b
o i | Max rows in search results
EFPFPETYLEDEF_TAMGERIME ] g
Default rows in search results
EFFBR_BRAMDIMG ana

Default rows in SES results
al

The PeopleSoft system delivers various style sheets for use with PeopleTools and PeopleSoft Interaction
Hub. Style sheets control the various display elements of target pages and pagelets, and the overall
branding of the portal. The Style Sheet Name field on the PeopleTools Options page stores a default style

sheet name.

You can create your own style sheets and use one of them in place of the delivered style sheet by selecting
it in the Style Sheet Name field on the PeopleTools Options page.

Note: You can also create your own alternate style sheet and have browser specific adjustments. Create
an additional style sheet, including the adjusted styles, and define it with the exact same name with ALT
appended to it. For example, PeopleSoft Interaction Hub sets the style sheet name in PSOPTIONS to

EPPSTYLEDEEF; therefore, EPPSTYLEDEF ALT is automatically applied to alternate browsers.

32
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Defining Installation Options

This section discusses how to define PeopleSoft Interaction Hub installation options in the Installation
Options component (EO_PE_OPTIONS).

Pages Used to Define Installation Options

Page Name Definition Name Usage

Installation Options Page EO_PE OPTIONSI1 Define PeopleSoft Interaction Hub
installation options.

Portal and Security Defaults Page EO_PE OPTIONS2 Select the portal and security defaults
used when creating portal registry
structures.

Last ID Values Page EO_PE_OPTIONS3 Displays the last ID created for a given

feature. This data is used in generating
the next available ID.

Features Page EO_PE _OPTIONS4 Enable specific features delivered in
revisions (formerly known as feature
packs).

Related Links

Summary of Delivered Security Data

Installation Options Page

Use the Installation Options page (EO_PE OPTIONSI) to define PeopleSoft Interaction Hub installation

options.
Navigation:

Portal Administration > System Data > Installation Options

Copyright © 1988, 2024, Oracle and/or its affiliates.

33



Configuring PeopleSoft Interaction Hub Chapter 3

This example illustrates the fields and controls on the Installation Options page. You can find definitions
for the fields and controls later on this page.

Installation Options Portal and Security Defaults LastID Values Features

Selectthe Portal Solutions installation system options. The Image Attachment URL Path is used to
dynamically look up where the content management image attachments are on the web server. This
path is used to render the image. The maximum email notifications limits the number of notifications
that can be sent.

Resource Finder
i:?Enahle Resource Finder

" Use Resource Finder for Profile Pages
Content Management (7

*Image Attachment URL Path |/psimages/portal_pal

Default Poll DEF_RATINGS Q,

M Enable Content in WorkCenter
v Auto-open attachment and URL

Discussion Forums

*Discussions Viewing Default|Threaded Wiew j
¥ site specific

Collaborative Workspaces

Maximum Email Notifications

*Default Module Image PS_EPFPCW_WELCOME_ICM &}
I Default Presence Indicators in Members Module
I Enable External Users

Calendar Events / Action ltems

*Export Option | Open Calendar Program =l

*Alerts iCal Aﬂachment| Mo iCal attachment on Alerts j

Work Week
I sun I mon ™ Tue ™ wed ™ Thu I Fri ™ sat

iTracker

I Enable Content Tracking

Save

Use the Installation Options page to configure your installation of PeopleSoft Interaction Hub.
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Field or Control

Description

Enable Resource Finder

Select to use the Resource Finder feature. It is not selected by
default.

Use Resource Finder for Profile Pages

Select to use Resource Finder participant profiles as the source
for participant information for Collaborative Workspaces and

Content Management.

In Collaborative Workspaces, these Resource Finder
participant profiles will be used as the source for member
profiles accessible from the Members module. When a user
clicks a member name link in the Members module, the
member profile that appears will be based on the member's
Resource Finder participant profile.

In Content Management, these Resource Finder participant
profiles will be used as the source for user profiles accessible
by clicking user name links in the components. For example,
fields such as Created By, Checked Out By, and so forth will

contain user name links.

For this option to work as designed, you must have the

following setup in place:
»  Resource Finder is set up and loaded with data.

This setup includes the generation of associated Resource

Finder search collections.

*  Resource Finder participants are loaded with their
associated user IDs, where applicable, using the Load
Participant User IDs Application Engine process (EPX
LOAD_OPR).

If you leave this option blank, when a user clicks a member
name link in the Members module, the member profile that
appears will be based on information from these tables:
PSOPRDEFN, PSUSEREMAIL, EPPCW_MEMBERS, and
PS_EPPRC_IM_USERVW.

See “Member Profile Page” (Collaborative Workspaces).
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Field or Control

Description

Image Attachment URL Path

Enter the web server’s relative or absolute URL of the
extended path that will contain the image files from the FTP
server. The choice of URLs is based on the information
from the URL Maintenance page that is found in the
PeopleTools > Utilities > Administration > URLs
menu path, for the URL ID EPPCM_IMAGE.

See “Setting Up an FTP Service for Image Attachments”
(Content Management System).

Default Poll

Select ID for the default ratings poll. This poll is used to rate
pieces of content and is made available in the Related Content
frame of the WorkCenter template.

See “Configuring Content Display in a WorkCenter” (Content
Management System).

Enable Content in WorkCenter

Select this option to enable viewing of content in the
WorkCenter template.

See “Configuring Content Display in a WorkCenter” (Content
Management System).

Discussion Forums

Field or Control

Description

Discussions Viewing Default

Select Flat View to display all discussion postings in

chronological order with details.

Select Threaded View to display the hierarchy of the discussion
without the details.

Site Specific

Select to make a discussion forum viewable only within the
site in which it was created. For example, if Site Specific

is selected and a user is in the Customer portal, then in the
Discussions pagelet, that user will see discussion forums that
were created in the Customer portal only.

Deselect this option to make all discussion forums appear
regardless of the portal in which it was created. For example,
if the user is in the Customer portal, then in the Discussions

pagelet the user will see discussion forums created in the
Customer portal, Employee portal, Supplier portal, and so on.

36
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Field or Control

Description

Maximum Email Notifications

Enter the maximum number of email messages you want to be
able to send in the member invitation notification process for a

Collaborative Workspace.

If the number of email messages sent in the notification
process exceeds this number, an error appears and the system

sends no email.

Default Module Image

Enter the name of the image that you want to display by
default in the Collaborative Workspace menu to the left of

module names.

Default Presence Indicators in Members Module

Select to display instant messaging presence indicators in the
Members module. If you decide to display presence indicators,
keep in mind that one server trip is executed per indicator per

member.

See Understanding Instant Messaging in PeopleSoft
Interaction Hub.

Enable External Users

Select this option to enable workspace owners to invite

external users to participate in the workspace.
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Field or Control

Description

Export Option

Select the option for the Export link on the Event View page
and the Add to Personal Calendar link on the Action Item
Details page. Valid options are

*  Not Used, which will hide the link on the page.

*  Open Calendar Program, which will open the file with
the default local calendar application that is associated
with the *.ics extension.

*  Send as Email Attachment, which sends an email with the
iCal attachment.

»  User Prompt, which enables the user to either open the
file or send an email.

See “Event View Page” (Using Portal Features), “Personal
Calendar link Page” (Using Portal Features).

Alerts iCal Attachment

Select settings for iCal attachments and for event alert

notification email messages. Valid options are:
*  No attachment with Alerts

*  Attach iCal file with Alerts

Field or Control

Description

Work Week Select days to define the default work week for all calendars in
the system. These defaults can be overridden by the properties
of each calendar.

See “Calendar Properties Page” (Using Portal Features).
iTracker

Field or Control

Description

Enable Content Tracking

Select this option to enable automatic invisible usage tracking
(iTracker) for content management system content, discussion
forum posts, and blog posts.

See “Understanding Usage Tracking (iTracker)” (Using Portal
Features).
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Use the Portal and Security Defaults page (EO_PE_OPTIONS?2) to select the portal and security defaults
used when creating portal registry structures.

Navigation:

Portal Administration > System Data > Installation Options > Portal and Security Defaults

This example illustrates the fields and controls on the Portal and Security Defaults page. You can find

definitions for the fields and controls later on this page.

Installation Options

Portal Registry Structures

‘Menu Template Pagelet
‘Base Workspace Template Name

‘Base Wiki Space Template Name

Site Manager Security
'Administrator Perm Template
‘Publisher Permission Template

‘Wiewer Permission Template

Workspace Security
'Administrator Permission List
‘Manager Permission List
‘User Permission List

*Administrator Role

User Base Role

‘Logged-In User Base Role

Related Discussion Forum

‘Moderator Role

‘Contrilnmtor Role

Content Migration

Approver Role

Portal and Security Defaults

LastID Values

‘Registry Object Prefix (A0 MM

FAPP_FT_MNAVIGATION_SCR

FAPP_BASE_WORKSPACE_TMFL

PAPF_BASE_WIKI_TMPL

PAPPS000
PAPPSOED
FAFFSOYO

PAPPS350
FPAPPSIED
FAFFS300
FAPP_WORKSFACE_MAMNAGER

FAPP_LSER

Update Privilege Sets on Save

FAPP_DISCUSSIONS_ADMIMN

Features

ISy 5]

&

&

&

SRy STl s

&

o]

)

FAPP_DISCUSSIONS_CONTRIBUTOR |Gy

FAPF_COMNTENT_ADMIN

Selectthe portal and security defaults used when creating portal registry structuras. Define the logged-in user base rale for your systam.
Itis recommended to use the role PAFP_LUSER. The base user role is used on systemn iterms secured by privilege sets. Ifyou change
the rale name, you should alzo selectthe option to update the privilege sets an save.

Base Woarkspace Template

Base VWarkspace Template Wiki

Adrminister Sites - Template
Fuhblish in Sites - Template

YWiew Sites - Termplate

Administer Warkspaces
Manage Workspaces
Access Warkspaces

Workspace Manager

Interaction Hub User

Discussions Administrator

Discussions Contribwtar

Content Administrator

Select the portal and security defaults for creating portal registry structures and define the user base role

for your system.

Since the base user role on system items is secured by privilege sets, PeopleSoft recommends that you use
the delivered role PAPP_USER. If you change the role name, you should also select the option to update

the privilege sets on save.
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Registry structures are the stored menu items, pagelets, templates, and such. Many features automatically
create portal registry structures, including Pagelet Wizard pagelets, News Publication pagelets, Submitted
Menu Items, Manage Navigation, and Shortcut Collections.

Field or Control

Description

Registry Object Prefix Enter a value to use as a prefix for all automatically created
portal registry structures.
Note: This value allows easy identification of the objects that
are in PeopleSoft Application Designer.

Menu Template Pagelet Enter the menu template pagelet value that is to be used when

rendering target pages by using Context Manager.

Note: PAPP PT NAVIGATION_SCR is the delivered default
value. If you want to customize and use your own menu

template pagelet, enter its value here.

Base Workspace Template Name

Select the portal registry template on which all Collaborative
Workspace templates and their portal registries are based.

Base Wiki Space Template Name

Select the portal registry template on which all Wiki Space
templates and their portal registries are based.

See “Installation Options Page” (Collaborative Workspaces).

Site Manager Security

The created site uses these permissions to limit access to the navigation and administration of the new

site.

Field or Control

Description

Administrator Perm List Template (Administrator

Permission List Template)

Enter the administrator template permission lists that are

cloned during the creation of a new site.

Publisher Permission Template

Enter the publisher template permission lists that are cloned
during the creation of a new site.

Viewer Permission Template

Enter the viewer template permission lists that are cloned

during the creation of a new site.
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Field or Control

Description

Administrator Permission List

Select the permission list for administrators of the workspace.
The delivered permission list is PAPP5350.

Manager Permission List

Select the permission list for managers of the workspace. The
delivered permission list is PAPP5360.

User Permission List

Select the permission list for users of the workspace. The
delivered permission list is PAPP5300.

Administrator Role

Enables you to select a different role name that is
automatically used as the workspace instance portal
administrator. This role is granted to users who are listed as
workspace managers.

See “Understanding Workspace Privilege Sets” (Collaborative Workspaces).

User Base Role

Field or Control

Description

Logged-In User Base Role

Select the role that enables access to the base objects in the
PeopleSoft Interaction Hub features that use privilege sets.
The delivered role is PAPP_USER. Every user in the system,
other than Guest, must be assigned this role along with the
PeopleSoft User role.

Note: If you select a role other than PAPP__USER, make sure
to select Update Privilege Sets on Save to automatically
update the privilege set assignments to the new role.

Update Privilege Sets on Save

Select this checkbox to update all privilege set assignments to
the base user role when you select Save. This option enables
you to change the role name in the privilege set assignment for

all the features that have the concept of privilege sets.

This enables you to use your own 'base' role instead of the
delivered role. So, if you change your base role, it's not a
customization. This setting lets you update all the privilege set
assignments to your role. We deliver some system data using
this role, but some of these privilege set assignments (like for
discussions) are not accessible online.
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See Roles with Special Uses.

Related Discussion Forum

Field or Control Description
Moderator Role Select a role for the moderator.
Contributor Role Select a role for contributors.

Content Migration

Field or Control Description

Approver Role Select a role for approvers.

Last ID Values Page
Use the Last ID Values page (EO_PE _OPTIONS3) to displays the last ID created for a given feature.
This data is used in generating the next available ID.
Navigation:

Portal Administration > System Data > Installation Options > Last ID Values
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This example illustrates the fields and controls on the Last ID Values page.

Installation Sptions

available 1D,

Last ID Walues

Fortal and Security Defaults

Last CM Folder ID

Last CM Content 1D

Last CM Migration 1D
Last Related Content ID
Last Related Publication 1D
Last Discussion Forum ID
Last Discussion Post 1D
Last Action ems List ID
Last Action fem ID

Last Calendar 1D

Last Event ID

Last Event Recurrence ID
Last Package ID

Last Wiki ldentifier

Last Service ID

Last Instance ID

Last Profile Id

Last Profile Attribune 1D
Last Content Artribute ID

The last D values store the last created 1D far a given feature. This data is used in generating the next

2112
2100
2100
2100
2100
2108
2108
2102
2100
2102
2100
2100
2100
2100
2100
2100
2100
2100
2100

Last ID Values

Features

The Last ID Values page displays the current greatest value for IDs that are used by other features in
PeopleSoft Interaction Hub such as content management, related content, discussion forums, and so on.

Each time a new item is added, the counter is automatically increased by one. This feature eliminates

locking issues.

Features Page

Use the Features page (EO_PE_OPTIONS4) to enable specific features delivered in revisions (formerly
known as feature packs).

Navigation:

Portal Administration > System Data > Installation Options > Features
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This example illustrates the fields and controls on the Features page.

Chapter 3

Installation Options

Feature Definitions

Feature Pack Feature

Feature Pack

Identifer Identifier
1 FP1 Feature Pack 1 CMo02
2|\FP2 Feature Pack 2 SES001
3 REV3 Revision 3 BRO01
& save

Portal and Security Defaults

LastID Values

Feature Summary

Filter Content by
Attributes

Search using 3ES

Tools Branding
Framework

Installation Options | Portal and Security Defaults | Last ID Values | Features

Features

Feature Description

Secure content based on

business attributes

Using Oracle Secure Enterprise
Search to build search collections

Enable the 8.54 (or higher)

branding framework

Select the feature(s) that are to be enabled. An enabled feature cannot be disabled. Enabling a feature thathas a
prerequisite feature will automatically enable the prerequisite feature (if it is not enabled). Afeature cannot be enabled ifthe
tools release is less than the minimum tools release required for the feature

Personalize | Find | View All | @| Lﬂ_ﬁ

Tools Prerequisite
Feature Pack ID

e Enabled

8.50 {
253 F
8.54 F

First 4/ 1-30f3 '}/ Last

Prerequisite Feature ID

Ensure that your system meets the minimum PeopleTools release listed in the Tools Release column. Then

select the Enabled option to enable a specific feature.

The currently available features are:

branding framework.

Feature Pack Feature ID Description For More Information

FP1 CM002 Secure content based on See “Administering Content
business attributes Management Business

Attribute Security” (Content
Management System).

FP2 SES001 Enable the use of Oracle See Understanding Search in
Secure Enterprise Search to PeopleSoft Interaction Hub.
build search collections.

REV3 BRO001 Enable the PeopleTools See “Enabling the Revision

3 Branding Features”
(Branding).

Not all features delivered in a revision are enabled through this page. Other features delivered in
revisions, while not specifically identified as such, can be enabled on the Installation Options page.

Related Links

Installation Options Page

Enabling or Disabling My Links

44

This section provides an overview of My Links functionality and discusses how to:

* Enable My Links.

* Enable My Links in the PeopleTools Favorites feature.
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Understanding My Links

Disable My Links in the PeopleTools Favorites feature.

My Links functionality can be:

Configuring PeopleSoft Interaction Hub

Available in the header only (My Links link, Add to My Links link, or both).

Integrated with the PeopleTools Favorites menu only.

Available in the header and as part of PeopleTools Favorites menu.

Available in the NavBar and as part of PeopleTools Favorites menu
(PAPPBR_HEADERY9 TANGERINE ALT header definition only).

Disabled and not available in either location.

Most aspects of the My Links feature are available from either location such as adding, editing, or
navigating to any links defined as My Links.

Related Links
“Understanding My Links” (Using Portal Features)

Enabling My Links

To enable My Links functionality in the header, do one of the following:

Select a delivered branding theme definition that includes a header definition that includes My Links
functionality. The following table lists the branding theme and header definitions delivered with
PeopleSoft Interaction Hub and the My Links functionality available with each:

OOWDEMO

OOWDEMO

Theme Header Add to My Link | My Links Integrated
link drop-down with
menu PeopleTools
Favorites
PAPPBR_THEME _ PAPPBR_HEADERY9 PT Yes No Yes
TANGERINE TANGERINE
PAPPBR THEME PAPPBR HEADERY9 No No Yes
TANGERINE ALT TANGERINE ALT
PAPPBR_ THEME CW_ | PAPPBR HEADERY No Yes NA
TANGERINE WORKSPACE TANG
PAPPBR THEME PAPPBR HEADERI10 Yes No Yes

The default branding theme, PAPPBR_ THEME TANGERINE, includes My Links functionality.
Therefore, no explicit action is necessary to enable My Links after you install PeopleSoft Interaction

Hub.
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* Add My Links functionality to a header definition:

* To add the Add to My Link link and integrate with PeopleTools Favorites, add these
two branding elements to the header definition: ADD_TO_MY_ LINKS LINK
and ADD TO _MY_LINKS WIDGET. For an example, see the
PAPPBR HEADER9 PT TANGERINE header definition.

* To add the My Links drop-down menu and integrate with PeopleTools
Favorites, add these two branding elements to the header definition:
MY _LINKS DROPDOWN_ MENU and ADD TO MY _LINKS WIDGET. For an example, see
the PAPPBR_ HEADER9 WORKSPACE TANG header definition.

Related Links
“Themes, Headers, and Skins” (Branding)
“Branding System Elements” (Branding)

Enabling My Links in the PeopleTools Favorites Feature

46

My Links is enabled in PeopleTools Favorites by default. However, if My Links has been disabled as part
of the PeopleTools Favorites feature, you can re-enable it. To re-enable the use of My Links as part of the
PeopleTools Favorites feature:

1. Access the General Settings page (PeopleTools, Portal, General Settings).

2. In the Navigation Options section, ensure that the Navigation Type is set to Drop-down.
3. Ensure that the Display My Favorites folder option is selected.

4. Save your changes.

5. Access the Structure and Content page (PeopleTools, Portal, Structure and Content).

6. Click the Interaction Hub - Hidden link.

7. Click the Edit link for the Interaction Hub Profile item.

Important! When defining attributes on this page, the attribute values are case sensitive.

8. In the Content Reference Attributes section, ensure that the attribute value for the MYFAVORITES
attribute is set to Y.

9. In the Content Reference Attributes section, ensure that the attribute value for the
MYFAVORITES CLASS attribute is set to EPPSC MY SHORTCUTS: Links.

10. For the MYFAVORITES_CLASS attribute, ensure that the Translate option is unselected.
11. Save your changes.

See the product documentation for PeopleTools: Portal Technology, "Administering Portals," Managing
General Portal Settings, Managing General Settings for Portals.

See the product documentation for PeopleTools: Portal Technology, "Administering Portals,"
Administering Content References, Defining Content References.

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 3 Configuring PeopleSoft Interaction Hub

Disabling My Links in the PeopleTools Favorites Feature

In PeopleSoft Interaction Hub, by default, the My Links feature has been enabled to display as part of the
PeopleTools Favorites feature. The following steps document the procedure to disable My Links as part of
the PeopleTools Favorites feature, thereby restoring the default PeopleTools behavior.

To disable the use of My Links as part of the PeopleTools Favorites feature:
1. Access the Structure and Content page (PeopleTools, Portal, Structure and Content).
2. Click the PeopleSoft Interaction Hub - Hidden link.

3. Click the Edit link for the PeopleSoft Interaction Hub Profile item.

Note: Important. When defining attributes on this page, the attribute values are case sensitive.

4. In the Content Reference Attributes section, ensure that the attribute value for the MYFAVORITES
attribute remains set to Y.

5. In the Content Reference Attributes section, change the name of the MYFAVORITES CLASS
attribute to  MYFAVORITES CLASS.

6. Save your changes.

Note: No changes are necessary on the General Settings page.

See the product documentation for PeopleTools: Portal Technology, "Administering Portals,"
Administering Content References, Defining Content References.

Enabling the Signon PeopleCode

This section provides an overview of enabling the signon PeopleCode and discusses how to enable the
signon PeopleCode in the Signon PeopleCode component (SIGNONPPC PAGE COM).

Page Used to Enable Signon PeopleCode

Page Name Definition Name Usage

Signon PeopleCode Page SIGNONPPC PAGE Enable the StoreUserLogonInfo function
to update the portal statistics table and
enable the tracking and storage of data
needed to feed the User Logon Statistics
pagelet.

Understanding Enabling the Signon PeopleCode

You must enable the signon PeopleCode to be able to view logon statistics on the User Logon Statistics
pagelet. The portal administrator can add the User Logon Statistics pagelet to her homepage to provide
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convenient access to the number of users who log on to the portal during each month and the number of
distinct user logons.

By enabling the signon PeopleCode, you enable the portal database to track and store user login
information each time that a user logs on to the portal. Portal administrators can view this data to obtain
statistics about portal traffic and which users are contributing to the traffic. Data that is viewed can pertain

to which users log on to the portal, along with logon statistics for the months of the year, days of the
month, and hours of the day.

When using pagelets and pages, the tracking of user logon times is recorded in minute increments. If a
user logs out and then logs back in within the same minute, that login instance is not recorded. But if a
user logs in and then logs out, and then, one minute from the time that the user originally logged in, the
user logs in again, that login instance is recorded.

Note: The distinct number of users eliminates the counting of the same user logging on to the portal more
than once during the specified period. For example, if 30 logons access the portal during one day but 10
are the same user, then the number of distinct users for that day is 21.

Related Links
“Working With the User Logon Statistics Pagelet” (Using Portal Features)

Signon PeopleCode Page

48

Use the Signon PeopleCode page (SIGNONPPC_PAGE) to enable the StoreUserLogonInfo function to
update the portal statistics table and enable the tracking and storage of data needed to feed the User Logon
Statistics pagelet.

Navigation:

PeopleTools > Security > Security Objects > Signon PeopleCode

This example illustrates the fields and controls on the Signon PeopleCode page.

Signon PeopleCode

Signon
@ Invoke as user signing in
Omvoke as  User ID: Password:
Signon PeopleCode Personalize | Find | View Al | LE | =] First' 4 1-Gof6 b Last
'Sequence Enabled ['Record 'Field Hame Event Hame Function Hame E:;c Auih
110 FUNGLIB_PYWDCHNTL @, | PWDCNTL @, |FieldChange Fassword_Contrals [+ [=]
21O FUMCGLIB_LDAP @, ||LDAPALUTH @, |FieldDefault WY _Authentication O [+ |[=]
31O FUMCLIB_LDAP @, ||LDAPAUTH @, |FieldDefault LOAP_Authentication [+ [=]
410 FUMCLIB_LDAP @, ||LDAPALTH @, |FieldDefault S80_Authentication O ]| [=]
510 FUMCLIB_LDAP @, | LDAPAUTH @, |FieldDefault LOAP_ProfileSynch O [+]|[=]
4 ECQ_PE_STATS_WRK |@, | FUNCTION_FIELD @, |FieldFormula StorelserLogoninfo #]|[=]

Enable the row that contains the Function Name field value of StoreUserLogonlnfo. When a user logs on

to the portal, a row is inserted into a portal statistics table. The table stores the user ID, date, and time of
logon.

See the product documentation for PeopleTools: Security Administration, "Employing Signon
PeopleCode and User Exits."
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Setting Up MCF For PeopleSoft Interaction Hub

Special considerations exist when using the MCF with PeopleSoft Interaction Hub. Typically, this feature
is leveraged directly within a PeopleSoft application database, such as CRM, HCM, or SCM. If you use
PeopleSoft Interaction Hub to log on to these databases, then MCF-related content references must be
modified in the PeopleSoft Interaction Hub registry so that they point to your PeopleSoft application
database, such as CRM.

Note: The PeopleSoft system delivers MCF-related content references in all databases as part of
PeopleTools; therefore, as delivered, they point to components that are local to the PeopleSoft Interaction
Hub database.

To modify MCF-related content references:
1. Go to PeopleTools > Portal > Structure and Content.
2. Navigate to the content references.
The content references follow this list.
3. Change the Node Name value from A/ways use local to the appropriate content provider.
4. Click Save.
The content references that need to be modified are.
¢ Root, Tools - Hidden, MCF Console.
¢ Root, Tools - Hidden, CTI Console.
* Root, PeopleTools, MultiChannel Framework, Universal Queue - All CREFs in this folder.
* Root, PeopleTools, MultiChannel Framework, CTI Configuration - All CREFs in this folder.
The MCF is now able to access the setup that is performed in the content provider database.

See the product documentation for PeopleTools: MultiChannel Framework.

Viewing Menu Item Details

Copyright

This section discusses the pages used to view menu item details.
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Page Name

Definition Name

Usage

Menu Item Detail

PT_IQREGITEM

Review the portal registry (menu
navigation) information for a menu item.

See the product documentation for
PeopleTools: Portal Technology,
“Administering Portals,” Reviewing
Menu Item Information, Viewing Menu
Item Details.

Menu Folder Structure

PT _IQREGFOLDERS

Provides a list of content references

for a selected portal registry folder.

See the product documentation for
PeopleTools: Portal Technology,
“Administering Portals,” Reviewing
Menu Item Information, Viewing Menu
Folder Structure Information.

Menu Security

PT_IQREGSECURTY

Provides a list of folders or content
references that a user ID, role, or
permission list has access to.

See the product documentation for
PeopleTools: Portal Technology,
“Administering Portals,” Reviewing
Menu Item Information, Viewing Menu
Security Details.

Using PeopleSoft Interaction Hub Content Reference Attributes

This section discusses the content reference attributes recognized by the following PeopleSoft Interaction

Hub features:

* Context Manager

* Content Management

* Navigation

* Collaborative Workspaces

» Site Manager

See the product documentation for PeopleTools: Portal Technology.

Navigation Content Reference Attributes

50

This section discusses content reference attributes used for navigation.
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Content Reference Attribute Description

NAVNEWWIN Launches a content reference in a new window when the
content reference link is selected. A value in the attribute is not
required.

Leave the Translate option clear.
You do not need to enter a Label value.

Enter an Attribute Value of true.

NAVEXTENSIONFOLDER Defines a virtual folder (different from
NAVVIRTUALFOLDER). Specify the Application Package
that will process the virtual folder.

Context Manager Content Reference Attributes

This section discusses the content reference attributes used by Context Manager.

Content Reference Attribute Description

CLASS _STR Enables Context Manager to execute a template pagelet
directly for improved performance. For example, you can
execute the template pagelet on the application server instead
of through the psc servlet. You can use this only on the
database on which the Context Manager feature resides.

CANBEINVISIBLE Enables a template pagelet to hide itself completely when no
keys are passed to it.

Collaborative Workspace Content Reference Attributes

This section discusses content reference attributes used by Collaborative Workspaces.

Content Reference Attribute Description

EPPCW_MOD NAME Specifies that a CREF is a Collaborative Workspace module.
This is the key attribute in identifying that a content reference
is a Collaborative Workspace module. Enter the value in the
Attribute Value field.

EPPCW_MOD LABEL Specifies the name of the Collaborative Workspace module
displayed in the modules list and in the Collaborative
Workspace menu.

EPPCW_MOD_ DESCR Provides the description of the Collaborative Workspace
module.
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Content Reference Attribute

Description

EPPCW MOD_IMG

Specifies the name of the image used in the Collaborative
Workspace menu to the left of the Collaborative Workspace
module name.

EPPCW_MOD_REQ

Specifies whether or not the Collaborative Workspace module
is required. A value of Y implies that it cannot be removed
from the Collaborative Workspace by way of the creation
wizard. A value of N implies that it can be removed from the
Collaborative Workspace by way of the creation wizard. Enter
the desired value in the Attribute Value field.

EPPCW_MOD_APPCLASS

Specifies the application class for a Collaborative Workspace

module used for adding, deleting, and archiving module data.

Enter the value in path format delimited by : in the Attribute
Value field.

EPPCW_MOD_ADM

Specifies whether or not this is an Collaborative Workspace
administration module. This setting affects the security
placed on the content reference. Enter a value of Y or NV in the
Attribute Value field.

EPPCW_PAGELET

Identifies a pagelet as a Collaborative Workspace related
pagelet.

EPPCW_REL_MODE

Specifies the contextual mode in which a pagelet is related

to a Collaborative Workspace. Entering a value of KEYS
passes the Collaborative Workspace keys and their values

to the pagelet. Entering a value of WORKSPACE passes the
Collaborative Workspace name to the pagelet. Enter this value
in the Attribute Value field.

EPPCW_KEY MAPPING

This content reference attribute applies to related

pagelets on templates only. It enables the mapping

of Collaborative Workspace key names to names

within the related pagelet. Enter valid value

formats of KEYIORIGNAME=KEYINEWNAME;
KEY2ORIGNAME=KEY2NEWNAME;
KEYNORIGNAME=KEYNNEWNAME, and so forth in the
Attribute Value field.

EPPCW_IGNOREKEYNAME

Enables the skipping of specified keys as parameters passed
to links within Collaborative Workspaces. Key names listed
in the Attribute Value field will not be passed to the link

as query string parameters. Enter valid value formats of
KEYINAME; KEY2NAME; KEYNNAME; and so forth in the
Attribute Value field.

Site Manager Folder Reference Attributes

This section discusses the folder reference attributes used by Site Manager.
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Folder Reference Attribute

Description

PAPP SITE

This folder reference attribute applies to the root folder of
a portal registry. Specifies that the portal registry is a Site
Manager-created site.

PAPP_SITE PUB_TMPL

This folder reference attribute applies to the root folder of

a portal registry site created by Site Manager. Specifies the
publishing template behavior within the Manage Navigation
component of a site. Enter valid values of OWN (publishers
can select their own template) or DFT (publishers must use the
site default template).

PAPP_SITE PUB DATE

Specifies the default publication (effective) date for content
created through the Manage Navigation component of a site.

PAPP_SITE_EXP_DATE

Specifies the default expiration date for content created
through the Manage Navigation component of a site.

Defining Privilege Sets

This section provides an overview of privilege sets and discusses the pages used to define privilege sets.

Pages Used to Define Privilege Sets

Page Name

Definition Name

Usage

Privilege Set Page

EO PE PRIVSET DEFN

Select a feature and define a privilege
set.

Privileges Page

EO_PE_PRIVSET PRIV

Select privileges for the privilege set.

Understanding Privilege Sets

A privilege set is composed of base privilege definitions that define the actions a member can take in the

feature.

Privilege sets are used with these features:

* Action Items
* Blogs
*  Community Calendars

* Collaborative Workspaces
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* Discussion Groups
* Polls

*  Wiki Pages

The following table lists the privilege sets according to feature.

Chapter 3

Feature

Privilege Set Name

Privilege Set ID

Action Items Administrator EPPAI_ADMINISTRATOR
Action Items Contributor EPPAI CONTRIBUTOR
Action Items Viewer EPPAI VIEWER

Blogs Administrator EPPBL_ADMINISTRATOR
Blogs Author EPPBL_AUTHOR

Blogs Reader EPPBL READER
Collaborative Workspaces Administrator EPPCW_ADMIN
Collaborative Workspaces Approver EPPCW_APPROVER
Collaborative Workspaces Contributor EPPCW_CONTRIBUTOR
Collaborative Workspaces Moderator EPPCW_MODERATOR
Collaborative Workspaces Owner EPPCW_OWNER
Collaborative Workspaces Viewer EPPCW_VIEWER
Community Calendars Administrator EPPCA_ADMINISTRATOR
Community Calendars Contributor EPPCA_CONTRIBUTOR
Community Calendars Viewer EPPCA_VIEWER
Discussion Forums Contributor EPPDF_CONTRIBUTOR
Discussion Forums Moderator EPPDF_MODERATOR

54
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Feature Privilege Set Name Privilege Set ID
Discussion Forums Viewer EPPDF VIEWER

Question Polls Administrator EPPSP_ADMIN

Question Polls Author EPPSP_AUTHOR

Question Polls Moderator EPPSP_ MODERATOR
Question Polls Publisher EPPSP_PUBLISHER
Question Polls Viewer EPPSP VIEWER

Wiki Administrator EPPWI_ADMINISTRATOR
Wiki Contributor EPPWI_CONTRIBUTOR
Wiki Viewer EPPWI_VIEWER

Privilege Set Page
Use the Privilege Set page (EO_PE PRIVSET DEFN) to select a feature and define a privilege set.
Navigation:

Portal Administration > Define Privilege Set
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This example illustrates the fields and controls on the Privilege Set page. You can find definitions for the
fields and controls later on this page.

Privilege Set Frivileges
Frivilege Sets are made up of hase privileges that list the actions a member can perform. Privilege
Sets are used to secure row level access far the feature. Only non-system Privilege Sets ar Privilege
Sets not assigned to any member can be deleted.
Privilege Setllx  EPPAI_ADMIMISTRATOR
‘Description: Administrator
‘Sumimarny: An administratar has all privileges far the action iterm list.
Feature Code: Action tems
Active
System kem
Assigned
Field or Control Description
Feature Code Select the feature for which you want to define privileges.
Active Displays the list of definitions that you can view.
System Item Select to make this privilege set available for use.

Privileges Page
Use the Privileges page (EO_PE PRIVSET PRIV) to select privileges for the privilege set.

Navigation:

Portal Administration > Define Privilege Sets Access the Privileges tab.
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This example illustrates the fields and controls on the Privileges page.

Frivilege Set Privileges

Selectthe appropriate privileges for the Privilege Set. Click the infarmation icon for a description of
the listed privilege.

Privilege SetlD: EPPAL_ADMIMISTRATOR

Add / Edit Any Action temn @ Action [tems

Delete Any Action fem @ Action ltems
Delete List i Action ftems
Delete Own Action ltems @ Action ltems
Edlit List 0 Action ltems

View Action ltems 0 Action ltems

[E]) save ||[E@F Returnto Search | 4B PreviousinList | |45 MestinList ||[=] Motify [C4 Add

Select the privileges for this privilege set. The list of available features varies depending on the feature
selected.
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Managing Guest User Accounts

Understanding Guest User Accounts

The guest user account is an optional configuration that enables any public user to access the portal as a
guest. You can configure the guest homepage with pagelets and transactions that are suitable for guests.
By setting up the guest user security properly, you can limit which aspects of the portal guests can access.

PeopleSoft Interaction Hub includes GUEST, the guest user ID, which allows access to a limited subset of
portal features as well as selected portal applications. The PeopleSoft system delivers a Guest homepage
that contains the pagelets that are suitable for guest users.

Note: For guest users, the Guest homepage does not include personalization options. Therefore, the
navigation header does not display the Favorites menu, the Personalize Content and Personalize
Layout links, the Add to My Links link and the Sign out link, or other homepage tabs.

The following example illustrates the Guest homepage as viewed by a guest user.

Main Menu ~

Home
ORACLE - =

View Al Articles and Sections.

Note: The Guest homepage tab is also visible to authenticated users of the system. When the Guest
homepage tab is accessed by an authenticated user, then the pagelet content and portal header features
reflect the privileges of that authenticated user and not the limitations of the guest user.

Setting Up Security for Guest User Accounts

This section discusses how to:
*  Access the Guest homepage.

*  Set up the guest default login.
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Accessing the Guest Homepage

Access to portal features and applications for the guest user is based on the roles and permission lists that
are attached to the guest user ID. The PAPP_GUEST and PeopleSoft Guest roles are attached to the guest
user ID that is delivered. The following table lists the permission lists that are included in these guest
roles.

Note: The delivered Guest homepage displays the database pagelets and iScripts that are attached to these
permission lists.

Guest Roles Permission Lists Comments
PAPP_GUEST PAPP000O - Base PeopleSoft Interaction | Provides access to the PeopleSoft
Hub Objects. Interaction Hub base applications.

Note: Should not be removed from the
PAPP_GUEST role.

PAPP0001 - Base Guest Objects. Provides access to the Guest homepage.

Note: Should not be removed from the
PAPP_GUEST role.

PAPX0000 - Base Repository Objects. Provides access to the resource
repository.

Note: Should not be removed from the
PAPP GUEST role.

PAPP1100 - Company News pagelet. Provides access to view company news
content from the Guest homepage.

PAPP1110 - Promotions pagelet Provides access to view promotions
content from the Guest homepage.

PAPP1120 - Web Magazine pagelet Provides access to view web magazine
content from the Guest homepage.

PAPP1500 - Internet Information Provides access to view internet
pagelets. information content from the Guest
homepage.
PeopleSoft Guest PTPT1400 - Base Access Provides the base access to the

homepage and navigation menu.

Note: Should not be removed from the
PeopleSoft Guest role.

To add new pagelets to the delivered Guest homepage:
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* Ensure that the pagelets are attached to a permission list that is included in a guest role.

» Ensure that the menu items that are accessible to a guest are attached to a permission list that is
included in a guest role, or add the role to the guest user ID.

Note: Be sure that the guest user does not include the role PeopleSoft User or any role that includes the
permission list PTPT1000. Also be sure that the Guest user does not include the role PAPP_USER or any
role that includes the permission list PAPP0002. The role of PAPP_USER specifically gives a signed-in
user access to the links on the homepage for personalizing content and layout. Guest users should not be
able to personalize anything.

See the product documentation for PeopleTools: Security Administration.

Related Links
Configuring the Guest Homepage

Setting Up the Guest Default Login

Users should access the Guest homepage with a uniform resource locator (URL) that is based on the
following format:

http://server:port//psp/ps/defaultportalname/registrynode/h/?tab=guesttabname

where:
« server is the PortalServlet web server host name.
* port is the PortalServlet web server port number

* defaultportalname is the defined default portal name for the portal application database
(EMPLOYEE, SUPPLIER, or CUSTOMER).

* registrynode is the portal registry definition hosted node (EMPL, CUST, or SUPP) that matches the
defined default portal name.

*  guesttabname is the defined guest tab portal object name.

An example of the URL is:
http://janedoescomputer/psp/ps/EMPLOYEE/EMPL/h/?tab=PAPP_GUEST

This URL bypasses the initial login and uses the default login, which you set to GUEST in the web
profile.

To set up auto sign-on with the guest account:

1. Go to PeopleTools > Web Profile > Web Profile Configuration > Security to access the web
profile for your portal.

2. Access the Public Users group box and ensure that options are set as follows:
*  The Allow Public Access option is selected.

¢ The User ID field is set to GUEST.
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¢ The Password field is set to GUEST.

Chapter 4

These settings apply to portal databases that enable guests to log on to the system.

See the product documentation for PeopleTools: Portal Technology.

Related Links
“Working With the Signon Pagelet” (Using Portal Features)

Creating a Guest User ID

The PeopleSoft system delivers a guest user ID with the two guest roles assigned. The sample Guest
homepage displays the database pagelets and iScripts that are attached to the permission lists that are
included in the guest roles.

Note: The following procedure is for informational purposes only.

To create a guest user ID:

1.

2.

Navigate to PeopleTools > Security > User Profiles > User Profiles.

Add a new user ID for guests by clicking Add.
The User Profiles - General tab appears.
Access the Logon Information group box.

* Select a symbolic ID for the database.

* Enter the password GUEST.

*  Confirm the password GUEST.

Click the ID tab and select an ID Type field value of None.

Click the Roles tab and insert the following role names:
* PAPP_GUEST

*  PeopleSoft Guest

Click Save.

Configuring the Guest Homepage

62

This section discusses configurations to set the Guest homepage security and select pagelets for the Guest
homepage.
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Pages Used to Configure the Guest Homepage

Page Name Definition Name Usage

Content Ref Administration - General PORTAL_CREF_ADM Hide pagelet action buttons to

Page prevent guest users from accessing
personalization options for displayed
pagelets.

See the product documentation

for PeopleTools: Portal
Technology,” Administering Content
References”.

Content Reference Security Page PORTAL CREF _SEC Limit access to the guest homepage to
only guest users.

(for the Guest homepage)
See Setting Homepage Security for
Guests

Alsosee the product documentation

for PeopleTools: Portal Technology,
“Administering Content References”,
Setting Content Reference Permissions.

Content Reference Security Page PORTAL_CREF_SEC Prohibit guest access to the My Page
homepage.

(for the My Page homepage)
See the product documentation for

PeopleTools: Portal Technology,
“Administering Content References”,
Setting Content Reference Permissions.

Tab Content PORTAL TAB CON_ADM Select pagelets to display on the guest
homepage.

PeopleTools > Portal > Structure
and Content > Portal Objects >
Homepage > Tabs

In the Content References scroll area,
click the Edit link for the Guest value.

Click the Tab Content tab.
See the product documentation for

PeopleTools: Portal Technology,
“Managing Homepages”.

Tab Layout PORTAL TAB LAY ADM Position pagelets on the guest homepage.

See the product documentation for
PeopleTools: Portal Technology,
“Managing Homepages”.
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Preventing Guest Users from Changing Personalizations

The Content Ref Administration - General tab contains a special attribute you can use to prevent guest
users from changing the personalization of a displayed pagelet. Selecting this option hides the following
action options for any pagelet on the Guest homepage:

Examples of action options on a pagelet.

5

R -
)

Personalize
Minimize

Remove

To prevent guest users from changing pagelet personalizations:
1. Access the Content Ref Administration - General page.
2. Select the Hide pagelet action bar option in the Homepage tab attributes group box.

See the product documentation for PeopleTools: Portal Technology, “Administering Portal Homepages
and Pagelets.”

Setting Homepage Security for Guests

64

To set security for the Guest homepage:

1. Access the Content Reference Security page for the Guest homepage.
2. Insert a row in the Security Authorizations scroll area.

3. Set the Type field value to Permission List.

4. Set the Name field value to PTPT1400 or PAPP00O0].

Adding either the PTPT1400 or the PAPP0001 permission list to the Content Reference Security page
for the Guest homepage limits access to the selected homepage to only guest users. You can add both
permission lists as a precaution just in case the attributes for one are changed.

To prohibit guest users from accessing the My Page homepage:
1. Access the Content Reference Security page for the My Page homepage.

2. Insert a row in the Security Authorizations scroll area.

W

Set the Type field value to Permission List.

4. Set the Name field value to either PTPT1000 or PAPP0002.
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The PTPT1000 permission list is attached to the PeopleSoft User role, which is the counterpart to the
PeopleSoft Guest role. PAPP0002 is attached to the PAPP_USER role, which is the counterpart to the
PAPP GUEST role.

Selecting Pagelets for the Guest Homepage

To select pagelets for the Guest homepage:

Important! Do not select the Include all? option to display all pagelets from the portal registry for a
pagelet category unless you want all pagelets in the category to be available to a guest user.

1. Access the Tab Content page for the Guest homepage.

2. Select the pagelets that you want guest users to be able to access on the Guest homepage.

Note: The guest user account must have security access to the pagelet component or iScript for
pagelets to be properly displayed on the homepage.

3. Use the drop-down list boxes to set pagelet behaviors.

Optional. The pagelet will not automatically appear on the homepage. However, it is available for
selection when users personalize their homepages. This setting should not be used for guest homepage
pagelets because guest users do not have personalization privileges.

Opt-Dft (optional-default). The pagelet will appear on all user homepages if they have access to the
pagelet. The pagelet can be removed when users personalize their homepage. This setting should not
be used for guest homepage pagelets because guest users do not have personalization privileges.

Reg-Fix (required-fixed). The pagelet will appear on all user homepages if they have access to the
pagelet. The placement of the pagelet cannot be changed and the pagelet cannot be removed from the
homepage.

Required. The pagelet will appear on all user homepages if they have access to the pagelet. The
placement of the pagelet can be changed, but it cannot be removed from the homepage.

4. Click Save.

See the product documentation for PeopleTools: Portal Technology.

Personalizing Pagelets for Guests Using the User Personalization
Component

This section provides an overview of personalizing pagelets for a guest using the User Personalization
component and discusses the pages used to personalize pagelets for guest users.
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Pages Used to Personalize Pagelets for Guest Using the User
Personalization Component

Page Name Definition Name Usage
Personalize <Pagelet Wizard Pagelet PTPPB_USER PREF Configure available personalization
Name> Page options for guest users of pagelets

generated by Pagelet Wizard.

Portal Administration > Pagelets >
User Personalization > Pagelet
Wizard

Select the GUEST user ID and the
Pagelet Wizard-generated pagelet for
which you want to define guest user
personalizations.

“Personalize Discussion Posts Page”
(Using Portal Features) explains
Discussion Posts pagelet customization,
which is similar to Personalize <Pagelet
Wizard Pagelet Name> Page.

“Personalize Company Promotions EO_PE_PR_PERS Filter the content available on the
Page” (Content Management System) Company Promotions pagelet displayed
for guest users. If all promotion
categories are required, the system
displays a message indicating that
personalization is not available.

Portal Administration > Pagelets >
User Personalization > Promotions .

“ Personalize Feed Reader Page ” (Using | EO_PE RSS NEWS Specify URLs to RSS news content
Portal Features) you want to display on the Feed Reader
pagelet that displays for guest users.
Define display pagelet options.

Portal Administration > Pagelets >
User Personalization > Feed Reader

Understanding Personalizing Pagelets for Guest Using the User
Personalization Component

66

Based on the roles and permission lists that are assigned to the guest user ID, as well as settings on the
Guest homepage, the guest user cannot personalize the layout, content, or even the individual pagelets on
the homepage.

Because guest users cannot perform their own pagelet personalizations, we provide the
PAPP_GUEST ADMIN role that you can attach to a user who you want to perform the role of Guest
User Administrator.

See Setting Up Security for Guest User Accounts.
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PeopleSoft Interaction Hub includes the User Personalization component, which can be used to
personalize individual pagelets with the guest user in mind. This is especially useful when used with
Pagelet Wizard with News Publications. You can use personalization options to force the display sections
that are not set to required or that you only want a guest user to see.

Note: All pagelets accessible by way of the User Personalization feature can be personalized by the guest
user administrator.

Personalizing Guest Pagelets Unavailable by Way of the User
Personalization Component

This topic discusses personalizing guest pagelets unavailable by way of the User Personalization
component.

Pages Used to Personalize Guest Pagelets Unavailable By Way of the User
Personalization Component

Page Name Definition Name Usage

Query Viewer Page QUERY_VIEWER_SRCH Run a query that lists the pagelets that
already have edit URL information
defined.

Reporting Tools > Query > Query
Viewer

Select the PAPP_PAGELET
PERSONALIZATION value.

See the product documentation for
PeopleTools: Query, “Using Query
Viewer”.

Tab Content Page PORTAL TAB CON_ADM Make the pagelet available for
personalization on the Guest homepage.
(for the Guest homepage)
PeopleTools > Portal > Structure
and Content > Portal Objects >
Homepage > Tabs

Click the Edit link for the Guest value.
Click the Tab Content tab.
SeeConfiguring the Site Homepage

where the fields and controls of the Tab
Content page.

Also see the product documentation
for PeopleTools: Portal Technology,
Managing Homepages, “Selecting the
Pagelets That Appear on Homepages”.
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Page Name Definition Name Usage

Tab Layout Page PORTAL TAB LAY ADM Set the layout position of the pagelet you
just made available for personalization

(for the Guest homepage) on the Guest homepage.

PeopleTools > Portal > Structure
and Content > Portal Objects >
Homepage > Tabs

Click the Edit link for the Guest value.
Click the Tab Layout tab.

See the product documentation for
PeopleTools: Portal Technology,
“Managing Homepages”, Arranging
Pagelets on Homepages.

Content Ref Administration Page PORTAL CREF _ADM Make the pagelet action buttons available
on the pagelet title bar of the pagelet

(for the Guest homepage) you just made available on the Guest
homepage.

PeopleTools > Portal > Structure
and Content > Portal Objects >
Homepage > Tabs

Click the Edit link for the Guest value.

See the product documentation for
PeopleTools: Portal Technology,
“Administering Content References”.

Understanding Personalizing Guest Pagelets Unavailable by Way of the
User Personalization Component

If a pagelet that you want to personalize for the guest user is not available by way of the User
Personalization component, you can still set personalization options for it. However, you can only
personalize a pagelet that lists an edit URL to a personalization page in its content reference definition.

You can run a query to find pagelets that are available for personalization. To do this, access the Query
Viewer page and run the PAPP. PAGELET PERSONALIZATION query.

Making the Pagelet Available for Personalization on the Guest Homepage

68

To make the pagelet available for personalization on the Guest homepage:

1. Access the Tab Content page for the Guest homepage.

2. Select the pagelet you want to display on the Guest homepage and select the Required option.
3. Access the Tab Layout page for the Guest homepage.

4. Select the layout position you want for the pagelet.
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5. Access the Content Ref Administration page and clear the Hide pagelet action bar option.

Important! This action displays the pagelet action buttons on the pagelet and should only be
performed when guest user access is minimal.

6. Click Save.

Editing the Pagelet Personalization on the Guest Homepage
To edit the pagelet personalization on the Guest homepage:
1. Click the Sign out link and log back in to the PeopleSoft Interaction Hub as a guest user.
2. Click the Customize button on the pagelet title bar of the pagelet you just added.
Clicking this button accesses the personalization page you defined for the pagelet.
3. Set the pagelet personalizations.
4. Repeat for each new pagelet.

5. Save your changes and sign out.

Important! As soon as the personalizations are complete, log back in to the PeopleSoft Interaction Hub
as a portal administrator. Access the Content Ref Administration page for applicable guest homepage
pagelets and reselect theHide pagelet action bar option. Selecting this option hides the action buttons on
the pagelet title bars.

You can create more than one homepage tab for a guest user. Personalizations cannot be enabled or
disabled at the role level, so Oracle recommends enabling or disabling them at the tab label.

Managing the PeopleSoft Fluid User Interface for a Guest User

PeopleSoft Fluid User Interface now has a new landing page for the Guest user. This page has two
system-delivered tiles: Sign In and Language Selection. You can personalize the landing page by adding
more tiles.

Note: The enhancements related to the Guest landing page are made available to the PeopleSoft
Interaction Hub release 9.1. These enhancements use the Macro Set definitions and Activity Guide
Framework delivered in PeopleTools 8.55.

For more information on Macro Sets, see PeopleTools: Portal Technology, Administering System
Branding.
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Pages Used to Manage the Fluid Guest Landing Page

Page Name

Definition Name

Usage

Sign In Tile

PT_SIGNIN_SCR_FL

(this is the cref for the tile)

Tap this tile to access the system as a
Guest user.

Language Selection Tile

PAPP_EPPLS_LANGSEL FL

(this is the cref for the tile)

Tap this tile to access the Language
Selection modal window and switch to
another available language.

For more information regarding the PeopleSoft Fluid User Interface, see PeopleTools: Applications User's
Guide, Working With PeopleSoft Fluid User Interface.

Sign In Tile

Language Selection Tile

70

Use the Sign In tile (PT_SIGNIN_ SCR_FL) to access the system as a Guest user. When you tap the Sign
In tile, a Sign In modal window opens. You can enter a Guest User ID and Password and tap the Sign In
button to access the system s a Guest user.

Navigation:

The Sign In tile is available on the Guest landing page.

This example illustrates the Sign In title.

Signin

<

Use the Language Selection tile (PAPP_EPPLS LANGSEL FL) to switch to another available language.
When you tap the Language Selection tile, a Language Selection modal window opens. You can use the
Language drop-down menu to select another language from the options available.

Navigation:

The Language Selection tile is available on the Guest landing page.
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This example illustrates the Language Selection Tile.

Language Selection

English
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Administering Portal Homepages

Understanding Homepage Administration

Standard PeopleTools features provide you with two mechanisms for creating and maintaining homepage
tabs:

* Portal registry

The Portal Objects folder in the portal registry provides a standard mechanism for creating and
maintaining homepage tabs as content references. Managing homepage tabs in this manner allows
you to create the tab, manage permissions for the tab, specify the pagelets and layout of the tab, and
determine the order of the tabs.

*  “Custom tabs” navigation collections

PeopleTools allows you to use specially designed navigation collections as definitions for custom
homepage tabs. These navigation collections allow you to create links to local or remote content
references that are then rendered as homepage tabs.

In the following example, the PeopleSoft Interaction Hub displays multiple homepage tabs. The My Page,
Guest, and My HR tabs are standard homepage tabs defined in the PeopleSoft Interaction Hub system.
The other three tabs are defined in the Custom Tabs navigation collection. The Manager Dashboard,
Company Directory, and Recruiting Dashboard tabs are custom homepage tabs defined on the remote
HRMS node of the PeopleSoft HCM system.

Favortes = | Main Menu ~
Home | AddtoMylinks | Sign out
ORACLE Al ~ | searcn > | Advanced Search
My Page Guest My HR Manager Dashboard Company Directory Recruiting Dashboard | ¥
Personalize Content | Layout 2 Hep
Top Menu Features Description S ov | &g Company News S ov
Our menu has changed! Save the Date to Celebrate
| Bring your family and come celebrate on Thursday, September 7 at Headquarters. Weve got lots in store for you inclucing fo0d, drink, and special musical guests.
The menu is now located across the top of the page. Click on Main Menu to get Tags: celebrate, event, pary
starte Grand Opening in Milano
Highlights

The grand opening will be heldin a “magic,” themed location (Umanitaria), where quests will be invited to experience the Middle Ages with a fairy-tale flavor
Tags: event, press release
Recently Usad pages now appear under
the Favorites menu, located at the top left. Headline News
AVisitors Guide tothe San Francisco area
Bring Your Parents to Work Day
Getthe Weather Report

More.

Submit Artce | Up Avtices | ) Feed +
Headine News | Human Resources News | nformaton Technobogy News | Events

Breadcrumbs visually display your
navigation path and give you access to
the contents of subfolders.

Menu Search, located under the Main
Menu, now supports type ahead which
makes finding pages much faster.

Homepage tabs are displayed in the following order:

» All standard homepage tabs appear before any homepage tabs defined in the custom tabs navigation
collection.

» Standard homepage tab order is governed by the sequence numbers specified in the content reference
definitions for each tab.
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* Custom tab order is governed by the order of the links in the navigation collection definition.

Managing Homepage Tabs through the Portal Registry

The portal registry provides a standard mechanism for creating and maintaining homepage tabs as content
references. Managing homepage tabs in this manner allows you to create the tab, manage permissions for
the tab, specify the pagelets and layout of the tab, and determine the order of the tabs.

PeopleSoft Interaction Hub is delivered with the following homepage tab definitions:
* My Page — The My Page tab is the default homepage tab in PeopleSoft Interaction Hub.

See My Page Homepage Tab.

* Guest — Guest is a homepage tab that is configured for guest users.

See Understanding Guest User Accounts.

* My HR — My HR is a sample homepage tab that integrates content from PeopleSoft HCM, PeopleSoft
CRM, and PeopleSoft Interaction Hub.

*  Administration — The Administration tab displays homepage pagelets for administrative tasks. The
Administration tab is disabled by default.

See Administration Homepage Tab.

The product documentation for PeopleTools provides more information on managing homepage tabs.

See the product documentation for PeopleTools: Portal Technology, "Administering Homepages,
Dashboard Pages and Pagelets," Managing Homepages.

Enabling a Homepage Tab That Has Been Disabled
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The Administration tab and the Investor tab are delivered as disabled. This was accomplished by setting
the Valid To date in the content reference definition to 01/01/1900.

To enable a homepage tab that has been disabled:

1. Access the Structure and Content page (PeopleTools, Portal, Structure and Content .
2. Click the Portal Objects link.

3. Click the Homepage link.

4. Click the Tabs link.

5. Click the link for the tab definition that you want to modify.

6. Clear the 01/01/1900 date from the Valid to date field:
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The following example displays a portion of the Content Ref Administration page for a disabled
homepage tab definition.

General Security Tab Content Tab Layout
Foot = Poral Objects = Homepage = Tabs =

Content Ref Administration y
CreatedBy VP1
Name PAPP_ADMIMNISTRATION_TAB Parent Folder Tabs

*Label |Administration
Select Mew Parent Folder
Long Description Contains pagelets for managers and administrators of the Interaction Hub features
(254 Characters)

Product PAPP
*Valid from date |01/01/1900 |[5]

Sequence number| 100
Valid to date |01/01/1900 |5

OwnerID|CPA |Q Interaction Hub

7. Save the definition.

Managing Homepage Tabs in Custom Tabs Navigation Collections

Copyright

PeopleTools allows you to use specially designed navigation collections as definitions for custom
homepage tabs. These navigation collections allow you to create links to local or remote content
references that are then rendered as homepage tabs. Because simple content references can be added

to these collections, you can designate any content reference or WorkCenter as a homepage tab. The
requirement for creating such a “custom tabs” navigation collection is that the links must reside in the root
folder of the navigation collection; links in subfolders will not be displayed as homepage tabs. Once a
navigation collection has been created, it can be designated for use as homepage tabs in the Custom Tabs
field on the Branding System Options page or on the Assign Branding Themes page.

PeopleSoft Interaction Hub delivers the Custom Tabs (PAPP_CUSTOM _TAB) navigation collection,
which provides examples of how to link to remote content as custom homepage tabs. See “Custom Tabs
Navigation Collection” (Branding) for more information.

In addition, you can create and maintain your own custom tabs navigation collections. For more
information on a custom tabs navigation collection, see PeopleTools: Portal Technology, “Using
PeopleTools Branding Features,” Additional Branding Tasks, Understanding Navigation Collections Used
to Create Custom Homepage Tabs.
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Understanding the Account Sign On Utility

Portal users might need to access other websites, such as external email accounts or news sites that
require additional user IDs and passwords. To enable a seamless transition from the portal to the external
site, PeopleSoft Interaction Hub can bypass external login screens by using URL sign-in functionality.

Note: This feature works only for sites that use simple POST sign on forms. It does not work for sites that
perform special encryption of sign on credentials or use any advanced sign on methodology.

Sites that require their own user IDs and passwords display information requests in their source code. You
can view this source code, determine the information is needed, and register that information in the portal.
Once users sign on to the site, the portal can store their passwords and user IDs so that they don't need to
sign on again to access the external site from within the portal.

Using the Account Sign On utility to connect to websites with built-in frame breakers (such as My Oracle
Support) does not work using the standard default frame template. For these types of websites, you can
select the No Template option on the Content Ref Administration page for the entry generated by the
Account Sign On utility. This forces the website to open without the portal wrapper, and the Account Sign
On utility then logs in automatically.

Note: Selecting the No Template option on the CREF may require that you restart your application server
and web server after stopping them and clearing their respective caches.

Creating and Maintaining Signon Data

This section discusses how to use the Account Sign On Utility component (EO PE _EXT SIGNIN) and
Edit Account Sign On component (EO_PE_EXT USRIDPWD).:

Pages Used to Create and Maintain Signon Data

Page Name Definition Name Usage

Account Sign On Utility Page EO PE EXT URL ADMN Create seamless links to external
websites that require user IDs and
passwords. Register external URLs
within the portal registry.
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Page Name Definition Name Usage
Add Account Sign On Information for EO_PE EXT USR ADMN Enter your user ID and password the first
the Site time that you use the portal to access an

external URL with registered account
signon information.

These values are used to automatically
authenticate access when you access the
site from the portal in the future.

Use the Edit Account Sign On page
to edit your user ID and password
information.

Edit Account Sign On Page EO PE EXT USRIDPWD When a portal administrator accesses
this page from the Edit Account

Sign On menu link, this page is ideal
resetting user passwords to external
sites registered using the account signon
utility.

When accessed from the My Account
Sign On link, this page can be used to
update your own account signon data for
external sites you have registered using
the account signon utility.

Extracting URL Sign On Information
To extract the URL sign on information:
1. Determine the field names and values the external site uses for authentication.
a. Examine the signon page for the site by viewing the HTML source from a browser.
b. Determine whether the site uses a simple POST authorization form for signon.
If it does not, you cannot use this feature with this site.

c. Search the authorization form and make a note of the input parameter names that are needed for
authentication.

If the site uses additional parameters, beyond user ID and password fields, make a note of those
parameters and values.

2. Enter the data from step 1c into the Account Sign On Utility page.

Account Sign On Utility Page

Use the Account Sign On Utility page (EO_PE_EXT URL _ADMN) to create seamless links to external
websites that require user IDs and passwords, and to register external URLs within the portal registry.

Navigation:
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Portal Administration > Account Sign On > Account Sign On Utility

This example illustrates the fields and controls on the Account Sign On Utility page. You can find
definitions for the fields and controls later on this page.

Account Sign On Utility

are no edits performed against the external site.

Menu ltem Hame:

*URL:

PAPP_MYTIMES
http:ffwww.nitimes.com
*Menu Label: Mew York Times
*User Field Name: |YSER_ID

*pwd Field Name: |PASSWORD

Additional Form Fields and Values
Order Field Name

1
Register and Save URL
Menu Folder:

Fegister URL

Enter the values the external site requires in its =form= section foar the post when users sign on to
their account. Once you have entered the appropriate information, register the UREL. Mote that there

Field Value

| &

Bl [=]

Field or Control

Description

URL Enter the URL to the external site's sign on page.
Menu Label Displays as the link text used to access the site.
User Field Name Enter the user ID field name as displayed in the external

website's code.

Pwd Field Name (password field name)

Enter the password field name as displayed in the external
website's code.

Additional Form Fields and Values

Field or Control

Description

Order

Displays the order in which any necessary field names and
values are passed to the external website.
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Field or Control Description

Field Name Enter each field name for which a field value is required by the
external site.

Field Value Enter each field value that is required by the external site.

Register and Save URL

Field or Control

Description

Menu Folder

Enter the name of the menu folder in which you want the link
to the external site to appear.

Creation Date, Updated by, and Updated on

These fields display information once the URL is registered.

Registered

Displays as selected once the URL is registered.

Register URL

Click to register the URL in the portal registry.

Edit Account Sign On Page
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Use the Edit Account Sign On page (EO_PE_EXT USRIDPWD) to when a portal administrator accesses
this page from the Edit Account Sign On menu link, this page is ideal resetting user passwords to external

sites registered using the account signon utility.

When accessed from the My Account Sign On link, this page can be used to update your own account
signon data for external sites you have registered using the account signon utility.

Navigation:

* Portal Administration > Account Sign On > Edit Account Sign On

* My Account Sign On
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This example illustrates the fields and controls on the Edit Account Sign On page.

Edit Account Sign On

Update yvour accourt sign on User ID and or Password for the site.

URL: PAFP_MYTIMES
Menu Label: mYTIMES

*User ID: psmith

*Password:

Enter user ID and password information to be used to access the external sites registered using the

account signon utility.
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Understanding Email Alerts

Configuring your Alerts framework enables users to subscribe to email alerts from the discussion forums
and calendars. Administrators and users can configure the Alerts framework to send text- or HTML-
based emails to users to alert them of updated information. For example, users can subscribe to alerts that
notify them when discussion forums and topics in which they are interested are updated. These alerts can
be configured to be sent daily or weekly. Administrators use an Application Engine process to send the

alerts.

Related Links

“Maintaining Alert Subscriptions” (Using Portal Features)

Setting Up Alerts

This topic discusses how to use the Alerts Setup component (EPPAN ALERTS SETUP) and Email
Options component (EPPAN_EMAIL OPTNYS) .

Pages Used to Set Up Alerts

Page Name

Definition Name

Usage

Alerts Setup Page

EPPAN_ALERTS_SETUP

Define alert options by feature.

Define Alerts Email Page

EPPAN EMAIL OPTNS

Define email alert options.

Preview Alerts Email - Header Text

EPPAN_EMLPREV_SEC2

Preview the email alert header text
entered on the Define Alerts Email -
Header Text page.

See Define Alerts Email Page.

Define Alerts Email - Header Text

EPPAN_EMLTXT SEC

Enter default header text that you want to
send out in text-based email alerts.

See Define Alerts Email Page.
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Page Name

Definition Name

Usage

Preview Alerts Email - Footer Text

EPPAN_EMLPREV_SEC2

Preview the email alert footer text
entered on the Define Alerts Email -
Footer Text page.

See Define Alerts Email Page.

Define Alerts Email - Footer Text

EPPAN_EMLTXT SEC

Enter default footer text that you want to
send out in text-based email alerts.

See Define Alerts Email Page.

Preview Alerts Email - Header HTML

EPPAN_EMLPREV_SEC

Preview the email alert header HTML
entered on the Define Alerts Email -
Header HTML page.

See Define Alerts Email Page.

Define Alerts Email - Header HTML

EPPAN_EMLHTML_SEC

Enter default header HTML that you
want to send out in HTML-based email
alerts.

See Define Alerts Email Page.

Preview Alerts Email - Footer HTML

EPPAN_EMLPREV_SEC

Preview the email alert footer HTML
entered on the Define Alerts Email -
Footer HTML page.

See Define Alerts Email Page.

Define Alerts Email - Footer HTML

EPPAN_EMLHTML SEC

Enter default footer HTML that you want
to send out in HTML-based email alerts.

Send Test Email

EPPAN_EMAIL TEST

When you click the Send Text Test
Email button, you can send a test email
to a desired email address using the
default text header and footer definitions.

When you click the Send HTML
Test Email button, you can send a test
email to a desired email address using
the default HTML header and footer
definitions.

See Define Alerts Email Page.

Alerts Setup Page

Use the Alerts Setup page (EPPAN_ALERTS SETUP) to define alert options by feature.

Navigation:

Portal Administration > Alerts > Alerts Setup

84
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This example illustrates the fields and controls on the Alerts Setup page. You can find definitions for the

fields and controls later on this page.

Alerts Setup
Feature: Community Calendars
[¥] Active
Feature Details Personalize | Find I@ | it First B 1-2 or 2 B | ast
Type *Description Image Type Image Object Name URLID
CALEMDAR  |Calendar Catalog | |[PT_CALEMDAR Q El
EVEMNT Event Catalog v | |[EQCF_ANALYTIC_EVENTG, =
Field or Control Description

Feature Displays the name of the feature for which you are setting up
alerts options.
Active Select to enable alerts for the feature.

Feature Details

Field or Control

Description

Type

Displays the aspect of the feature for which alerts can be
configured.

Description

Enter a description of the aspect of the feature for which alerts
can be configured. This description text appears on the Add
Alerts Subscription page and Update Alerts Subscription page
within the selected feature.

Image Type

Select the type of image source that you want to use to provide
the image for the alert subscription. Available values are
Catalog and URL.

Image Object Name

If you have selected an image type of Catalog, select the
image that you want to appear with the description text on the
Add Alerts Subscription page and Update Alerts Subscription
page within the selected feature.

URL

If you have selected an image type of URL, enter the URL
to the image that you want to appear with the description
text on the Add Alerts Subscription page and Update Alerts
Subscription page within the selected feature.
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Use the Define Alerts Email page (EPPAN_EMAIL_OPTNS) to define email alert options.

Navigation:

Portal Administration > Alerts > Email Options

This example illustrates the fields and controls on the Define Alerts Email page. You can find definitions
for the fields and controls later on this page.

Define Alerts Email
[¥] Allow HTML Email
Header and Footer Setup
ltems
Header Text
Footer Text
Header HTML
Footer HTML
Email
Subject: Alert Motification
Reply Toe ALERTADMIN@ORG.COM
Send Text Test Email Send HTML Test Email

Prewview Edit
Edit
Edit
Edit

You must have an SMTP server set up to send email alerts. When sending test emails using the Define
Alerts Email page, the system uses the SMTP server specified in the application server configuration file.

Field or Control

Description

Allow HTML Email

Select to enable the Alerts framework to send HTML-
formatted emails depending on each user’s defined alert
preferences.

Note: This check box has no bearing on the test emails that
can be sent from this page.
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Field or Control

Description

Items

Header Text. Click the Preview button to access the Preview
Alerts Email - Header Text page, where you can preview the
email alert header text entered on the Define Alerts Email -
Header Text page.

Click the Edit button to access the Define Alerts Email -
Header Text page, where you can enter email alert header text.

Footer Text. Click the Preview button to access the Preview
Alerts Email - Footer Text page, where you can preview the
email alert footer text entered on the Define Alerts Email -
Footer Text page.

Click the Edit button to access the Define Alerts Email -
Footer Text page, where you can enter email alert footer text.

Header HTML. Click the Preview button to access the
Preview Alerts Email - Header HTML page, where you can
preview the email alert header HTML entered on the Define
Alerts Email - Header HTML page.

Click the Edit button to access the Define Alerts Email -
Header HTML page, where you can enter email alert header
HTML.

Footer HTML. Click the Preview button to access the Preview
Alerts Email - Footer HTML page, where you can preview the
email alert footer HTML entered on the Define Alerts Email -
Footer HTML page.

Click the Edit button to access the Define Alerts Email -
Footer HTML page, where you can enter email alert footer
HTML.

Email

Field or Control

Description

Subject Enter the default subject text that you want to send out with
email alerts.
Reply To Enter the default reply email address that you want to provide

in email alerts.
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Field or Control Description

Send Text Test Email Click to access the Send Test Email page, where you can send
a test email using the header and footer text you have defined
in the Header and Footer Setup group box.

Send HTML Test Email Click to access the Send Test Email page, where you can
send a test email using the header and footer HTML you have
defined in the Header and Footer Setup group box.

Related Links
“Maintaining Alert Subscriptions” (Using Portal Features)

Managing Alert Subscriptions

Managing Alert Subscriptions

This topic discusses methods to administer and maintain ser alert subscriptions.

Pages Used to Manage Alert Subscriptions

Page Name Definition Name Usage

User Alerts Page EPPAN_MY_ ALERTS Manage user alert subscriptions.

Update Alerts Subscription EPPAN_ALERTS Portal administrators can update alert
subscription preferences for users.

User Alerts Page
Use the User Alerts page (EPPAN_MY ALERTS) to manage user alert subscriptions.
Navigation:

Portal Administration > Alerts > User Subscriptions
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This example illustrates the fields and controls on the User Alerts page. You can find definitions for the

fields and controls later on this page.

User Alerts

Yice President of Finance

existing alert.

Below is a list ofthe current alert subscriptions and delivery preferences. Click Editto make any changesto an

‘Display Subscriptions for: Al

Alerts Subscriptions

Dielete All Subscriptions

Delivery Preferences

Include Overview /Outline

Save

Title Delivery
EJ Company Calendar Immediate Edit Delete
HR Calendar = Spring equinox (Wednesday, March 20, 2013) Immediate Edit Dielete
Ernplovee Kiosk Daily Edit Delete
(;2) Guest Column = Why don'tyou put Ko Smoking signs at yvour campus Daily Edit Delete

Email Address: vplEexample.corm
Email Format: @ Text Only O HTML
Content: @ Links only O Links with Summaries

Personalize | Find |G | B8 First B 1.4 or4 [ Last

A user ID description displays if you access this page for a user other than the current user.

Alerts Subscriptions

Use the drop-down list to filter the alerts that appear by feature.

Field or Control

Description

Title

Displays the title of the item to which the user has subscribed
to email alerts.

When used with the Collaborative Workspaces Discussions
module and calendars, these are the titles of the forums and
topics to which a user has subscribed to email alerts.

Delivery

Displays the frequency at which the user selected to receive
email alerts.

Edit

Click to access the Update Alerts Subscription page, where
you can update alert subscription preferences.

Delete

Click to delete the alert subscription. You will be prompted to
confirm the deletion.
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Field or Control

Description

Delete All Subscriptions

Click to delete all alert subscriptions displayed in the Alert
Subscriptions group box. You will be prompted to confirm
your deletion. If you do not want to complete the deletion, do
not click Save.

Delivery Preferences

Field or Control

Description

Email Address

Displays the email address to which the email alerts are being
sent. This email address is defined on the General Profile
Information page.

See the product documentation for PeopleTools: Applications
User's Guide, “Setting User Preferences,” Setting User
Personalizations, Setting Up Your System Profile.

Email Format

Select the format in which email alerts should be sent to the
user.

Text Only. Select to indicate that text-based email alerts should
be sent to the user. The contents of the email will use any text
header and footer definitions you have entered on the Define
Alerts Email page.

HTML. Select to indicate that HTML-based email alerts should
be sent to the user. To use this option, the Allow HTML
Email option must be selected on the Define Alerts Email
page. The contents of the email will use any HTML header
and footer definitions you have entered on the Define Alerts
Email page.

Content

Links Only. Select to indicate that the email alert should
contain only links to the items about which the user is being
notified.

Links with Summaries. Select to indicate that the email alert
should contain links to and summaries about the items about
which the user is being notified.

Include Overview/Outline

Select to have email alerts sent with an overview at the
beginning of the email. The overview contains an outline of
email contents.
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Related Links
“Maintaining Alert Subscriptions” (Using Portal Features)

Scheduling Alert Notifications

Page

Unde

Copyright

This section provides an overview of the Send Alerts Notifications processes and discusses how to use
the Send Notifications component (EPPAN_ALERT RUN) to configure and run the processes to send
email alert notifications. The Send Notifications component is only used for daily and weekly alerts
subscriptions, such as Discussions. Calendar subscriptions are sent real-time and do not require set up
using this component.

Used to Schedule Alert Notifications

Page Name Definition Name Usage

Send Alerts Notifications Page EPPAN ALERT RUN Configure and run the Send Alerts
Notifications process.

rstanding the Send Alerts Notification Process

The primary process used to send email alerts to subscribed users is the Send Alerts Notification
Application Engine process (EPPAN_ALERTS). This process should be run at least once a day to process
any requested daily alert notifications.

The Send Alerts Notification process (EPPAN_ALERTS) is the parent process of the EPPAN_ALRTST
child process. This secondary process performs the actual work of constructing and sending alert emails.

The administrator sets the number of child processes to spawn from the parent process using the Number
of Parallel Processes ficld on the Send Alerts Notifications page. The parent process works to derive the
appropriate range of notifications that need to be sent by each child process and spawns them with the
appropriate run control settings.

First, this involves getting the number of unique users who have qualifying subscriptions. This means
selecting daily subscriptions whose last notification date reflects a date of one or more days ago, or
weekly subscriptions whose last notification date reflects a date of seven or more days ago. Based on
this count of how many users have qualifying subscriptions, the range of users can then be split into the
appropriate number of sets to be handled by each child process.

These child processes send out one email for each subscribed user for each process run. Multiple
qualifying subscriptions for a user are consolidated into one email message.

Email alert notifications are sent by way of the PeopleTools-supplied Notification class. This class uses
the same SMTP server as configured in PeopleTools.

You must have an SMTP server set up to send email alerts. When sending emails using the Send Alerts
Notification Application Engine processes, the system uses the SMTP server specified in the Process
Scheduler configuration file.
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See the product documentation for PeopleTools: System and Server Administration, “Setting Application
Server Domain Parameters,” SMTP Settings.

Send Alerts Notifications Page

92

Use the Send Alerts Notifications page (EPPAN_ALERT RUN) to configure and run the Send Alerts

Notifications process.

Navigation:

Portal Administration > Alerts > Send Notifications > Send Alerts Notifications

This example illustrates the fields and controls on the Send Alerts Notification page. You can find
definitions for the fields and controls later on this page.

Send Alerts Notifications

subscribed to alers.

Run Control ID: ALERT_MOTIFICATION

Last Run Date:

*Number of Parallel Processes:

Create Loq File

Enter the number of child processes with which you would like to divide the parallel processing. Select Create Log File to
create a log during processing. Click Run to launch the process to send qualifying notifications to users who have

Report Manager

Process Monitor Run

Field or Control

Description

Last Run Date

Displays the date on which this process was last run.

Number of Parallel Processes

Select the number of child processes to spawn and run in
parallel.

See Understanding the Send Alerts Notification Process.

Create Log File

Select to indicate that you want additional process information,
beyond the information in the message log, to be generated
into a log file. The log file is generated and placed in the
Process Scheduler directory; <tools>/appserv/prcs/<database
name>/files, for example.
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Understanding the Tagging Framework

A tag is a relevant keyword or term associated with a piece of information such as a picture, a geographic
map, a blog entry, a video clip, and so on. In this way tags describe an item and enable keyword-based
classification and searching. Tags are commonly used as means for users to store, organize, search,

and manage bookmarks of web pages. The bookmarks can be viewed and searched chronologically, by
category or tags, or using a search engine.

Tagging provides the means for PeopleSoft Interaction Hub and applications users to store, organize,
search, and manage content bookmarks. It enables both publishers of content and consumers of that
content to classify the material in a way that is meaningful to them. Significantly, users are able to

share their tags or bookmarks with other users, thus benefitting the user community from the shared
information--in this case tags. This increases the probability of properly characterizing the content and
hence its discoverability and use. Tags are also a way to measure what particular topics are of relevance to
the user community.

Tagging capability also provides for navigation to other content that is related through the same tags
without the need to hard-code those connections.

Thus, tagging is both a means of classifying things and a way of creating ad hoc navigation paths among
related items.

The PeopleSoft Interaction Hub tagging framework enables users to tag Portal content and search the
Portal using tags. Tags appear in the search results of the Portal search page and also in the search pages
for various PeopleSoft Interaction Hub features, such as Content Management, Discussion Forums,
Workspaces, and so on. Users can also perform searches using tags. A search using tags returns all the
content tagged for that tag.

Private tags are not searched and are not returned with search results. The exception is in the Tag Browser
page the user's own private tags are returned with the search results when a search scope of All My Tags is
selected.

A PeopleSoft Interaction Hub tag search page uses a database search. A user can immediately search for
newly created tags because the tag search is not dependent on the indexes being refreshed. Search results
are filtered based on the users security permissions before being displayed.

The exception is that on the Portal search page and the search pages for Portal features. After new tags are
added, the corresponding index has to be rebuilt before a the new tags will be returned in a search on the
Portal search page.

Tags on any page are hyperlinks to the tag browser page with default search results of the tag selected.
For instance, clicking on a tag labeled Community in a managed content item redirects the user to the tag
browser page with search results for Community displayed.
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Related Links
“Understanding Tagging in PeopleSoft Interaction Hub” (Using Portal Features)

Enabling Web Services

PeopleSoft Interaction Hub is delivered with tagging enabled for Content Management, Discussion
Forums, and Workspaces. To use tagging with applications outside of PeopleSoft Interaction Hub you will
need to enable tagging through web services.

Enabling web services requires single signon between the consuming application, such as HCM,)and
PeopleSoft Interaction Hub, and user profile synchronization. The web services interface provided
through Integration Broker contains the following services:

Add tags
Remove tags
Clear tags
Modify tags
Get tags
Search

Tag Cloud

See the product documentation for PeopleTools: Security Administration, PeopleTools. Integration Broker
Administration.

Related Links
Understanding Public Web Services

Managing the Tagging Framework

This topic discusses methods to define tagging domains and tag namespaces and mapping namespaces to
search index groups.

Pages Used to Managing the Tagging Framework

Page Name Definition Name Usage
Tagging Application Domain Page EPPTG_APPDOMAIN Define application tag domains.
Tagging Namespace Page EPPTG_NAMESPACE Define application tagging namespaces.
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Page Name Definition Name Usage
Search Index Page EPPTG _NSSRCHIDX Associate index groups with tagging

namespaces.

Portal
Administration > Tagging > Tagging
Namespace > Search Index.

Tagging Application Domain Page

Use the Tagging Application Domain page (EPPTG_APPDOMALIN) to define application tag domains.

Navigation:

Portal Administration > Tagging > Tagging Domain

This example illustrates the fields and controls on the Tagging Application Domain page. You can find

definitions for the fields and controls later on this page.

Tagging Application Domain

The domain defines the largest scope to which the tag will belong to.

Fortal would all be in their own damain).

Application Tag Domain LOCAL_TAG_DOMAIMN

Description Local Tag Domain

Tag Browser URL

Typically atag domain is associated with an application (e.g. HEME, FMS,

Modes | Ed First M 1-2 of 2 B Last
*Meszsage Node Name Description
1 [EMPL @, Portal Node - EMPL [=]
2 [PSFT_PA @, PS PA-Local Node [=]
Field or Control Description
Description The description text entered here appears as the Search Scope
name in the Scope dropdown list on theTag Browser.
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Tagging Namespace Page
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Field or Control

Description

Tag Browser URL

Specify the URL for the tag browser page for this domain.
This URL will be prepended to the tags.

If this is specified, it is assumed that the domain has its own
tag browser page to display search results of the tags. If this
field is left blank the domain will use the default PeopleSoft
Interaction Hub tag browser.

Note: If the PeopleSoft Interaction Hub tag browser is used,
there will only be limited support for the search results of
remote tags because of the limited amount of information
that is stored for the tags in the repository. The search will
not be able to query the source database for additional title or
description information.

Message Node Name

Identifies the node in the PeopleSoft Interaction Hub
environment with which the tag domain is associated.

Tag namespaces prevent conflicts among unique identifiers in different features and enable categorizing
tags at the namespace level. For instance, suppose both Discussion Forums and Managed Content have a
content with an ID of 3421. To prevent these conflicts, each should reside in its own namespace.

A domain can contain many tag namespaces, but each namespace can only be associated with one

domain.

Use the Tagging Namespace page ( EPPTG_NAMESPACE) to define application tagging namespaces.

Navigation:

Portal Administration > Tagging > Tagging Namespace
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Local Interface

This example illustrates the fields and controls on the Tagging Namespace page.

Tagging Namespace

Tagging Namespace

The namespace allows tags to be categorized within a domain.
*Application Tag Domain |LOTAL_TAG_DOMAIN Q

Tag Hamespace ContentManagement

Description |Content

@ Local Interface (O Remote Interface
Package Name [EPFTG_TAGS
path |Handlers

Application Class 1D |ContentManagement

Use a local interface to implement tagging within the PeopleSoft Interaction Hub application. Use the
Package Name, Path, and Application ID fields to identify the application class that will be used with
the namespace. The application class specifed here must implement the EPPTG_TAGS:TaggedContent
application class.

Remote Interface
The following page shows the Tagging Namespace page with the Remote Interface option selected.

This example illustrates the fields and controls on the Tagging Namespace page.

Tagging Hamespace
Tagging Namespace

The namespace allows tags to be categorized within a domain.

*Application Tag Domain ERF Q
Tag Hamespace RC_TAGS

Description |RC_TAGS

O Local Interface (® Remote Interface
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Implementing Tagging Web Services

A PeopleSoft application can incorporate tagging in its pages by configuring the tag service using the
related content framework. However, these tags are primarily tied to the transcation instances of the
business component and do not give the flexibility to add tags to data elements that are available across
the various levels of the page. Using the tagging web service, developers can add tags to any data element
at any level in the page.

Adding a Tag

98

The following parameters are required to add a tag:

Field or Control Description

Node Node corresponds to the tag domain. Nodes can be associated
with a domain using the Tagging Application Domain page in
PeopleSoft Interaction Hub (Portal Administration, Tagging,
Tagging Domain). Nodes used in tagging web service must
be of the type External. When a search is performed, this
differentiates between the tags added through the web service
and those added through the related content framework.

Portal This corresponds to the portal name of the application.

The Portal value can be any string.

Namespace Namespace is like a Java package. It helps in logical grouping
of tags. If the namespace is not preconfigured in PeopleSoft
Interaction Hub then a namespace is automatically created in
the name of the domain.

URL URL acts as a key. URL maps directly to content. If two URLs
are the same then the tags are added to the same content. It

is the user's responsibilty to provide unique URLSs for the
content that is to be tagged. Unique URLSs can be generate

by concatenating the relative URL of a component with the
necessary keyvals. The URL supplied for tagging a PeopleSoft
application must be a relative URL and not an absolute

URL. This way if the server name changes then the URL

also changes. When the user tries to retrieve the tags for
content tagged prior to the server name change the operation
will fail as the new url will not point to the tags previously
added. Use the GenerateComponentRelativeURL function

or GenerateComponentPortalURL function to generate the
relative URL. The relative URL that is passed with the input
message is concatenated with the node URI set in the node
definition page to get the complete URL.

See the product documentation for PeopleTools: PeopleCode
Language Reference, PeopleCode Built-in Functions,
GenerateComponentRelativeURL, PeopleTools: PeopleCode
Language Reference, PeopleCode Built-in Functions,
GenerateComponentContentRelURL.
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Ideally a content reference (CREF) corresponds to a namespace, but it is not necessary. A namespace is
just a logical grouping of tags, just as a domain is a logical grouping of tags in an application.

Tagging an External Application

Tags can also be used by external (non-PeopleSoft) applications using the tagging web service. However,
in this case the complete URL has to be sent in the input message instead of the relative URL. The
important point to note here is that the URL string must start with HTTP: //.

This differentiates external application tags from PeopleSoft system tags. The differentiation is needed
to prevent the suffixing of a portal URI to form an absolute URL, which occurs in the case of PeopleSoft
system tags. In this case the portal name is just a string.

Configuring Tagging Web Services
Follow these steps to configure tagging web services:

1. Create a tag domain using the Application Tag domain page (Portal Administration > Tagging >
Tagging Domain) before using the web service.

2. Create a separate domain that is mapped to a node for each PeopleSoft and each non-PeopleSoft
application.

The node type of the node used in the web service must be External.
3. Create unique URLs.
The URL for different content in a PeopleSoft system or non-PeopleSoft system must be unique.

With a PeopleSoft system you must use the GenerateComponentRelativeURL function to provide a
relative URL. This will be concatenated with the portal URI of the node assigned to the system. Use a
relative URL instead of an absolute URL to address the issue of possible change of the server.

With external system tags you must provide the absolute URL. The URL provided for external system
content must start with http://. A URL is identified as belonging to an external system only by the
presence of the string http: // at the beginning.

Web Services Command Format

Tagging web services use the following command format:

<?xml version="1.0"?>
<tagging>
<tagop lang="ENG" userid="VP1">
<cmd>ADD TAGS</cmd>
<id> B
<node>PSHR</node>
<portal>EMPLOYEE</portal>
<ns>JOBS</ns>
<url>s/JOBPAGE.GBL/?ID=1</url>
</id>
<tags>dream</tags>
<type>public</type>
<label>Job Page</label>
<descr>Job Details Page</descr>
</tagop>
</tagging>
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Command Format Parameters

Field or Control Description

lang This corresponds to the language the user has entered their

tags in. Use PeopleSoft language codes. The default is the
system default (%language base).

userid The user ID that entered the tag. The user ID must be a valid
PeopleSoft user.
cmd The command value.

Possible values are:

ADD_TAGS

- MODIFY_TAGS
.« CLEAR_TAGS

- REMOVE_TAGS
- GET_TAGS

«  SEARCH_TAGS

- TAG CLOUD

Basic Tag Commands

This section describes the implementation of the basic tag commands:

ADD TAGS
MODIFY TAGS
CLEAR_TAGS
REMOVE_TAGS

GET _TAGS

Basic Input

This is an example of input for a basic tag command:

<?xml version="1.0"?>
<tagging>

<tagop lang="ENG" userid="VP1">

<cmd>ADD TAGS</cmd>

<id> N
<node>PSHR</node>
<portal>EMPLOYEE</portal>
<ns>JOBS</ns>
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<url>s/JOBPAGE.GBL/?ID=1</url>
</id>
<tags>dream</tags>
<type>public</type>
<label>Job Page</label>
<descr>Job Details Page</descr>
</tagop>
</tagging>

This is an example of input for a basic external system tag.

<?xml version="1.0"?2>
<tagging>
<tagop lang="ENG" userid="VP1">
<cmd>ADD TAGS</cmd>
<id> N
<node>Tag</node>
<portal>EMPLOYEE</portal>
<ns>JOBS</ns> [ case sensitive]
<url>http://Monster.com/?ID=2</url>
</id>
<tags>bad, low-paying</tags>
<type>public</type> [ public or private ]
<label>Find Jobs</label>
<descr>You can search for Jobs here...</descr>
</tagop>
</tagging>

Basic Input Parameters

Field or Control Description

id This is a required parameter for the following commands:
« ADD_TAGS

+ MODIFY_TAGS

+ CLEAR_TAGS

- REMOVE TAGS

 GET _TAGS
node The name of the node that sent the command
portal The portal name. If the tagging system is non-PeopleSoft,

define a standard value that is used by all your tag commands.

ns The tagging namespace.

url The URL the tags are associated with.

Copyright © 1988, 2024, Oracle and/or its affiliates. 101



Administering the Tagging Framework Chapter 8

Field or Control Description

tags The comma separated list of tags that are being manipulated.
This is a required parameter for the following commands:

- ADD TAGS

+ MODIFY_TAGS

- REMOVE_TAGS

type Valid values are:

*  public —these tags are viewable by all users for the
content.

»  private — these tags are viewable only by the user who
created the tags.

This is a required parameter for the following commands:
- ADD TAGS

- MODIFY TAGS

+ CLEAR_TAGS

- REMOVE_TAGS

- GET _TAGS

label The label parameter is used for tag searching in the tag
browser. This value is shown as the link title of the piece of
content that contains the tag that has been searched.

This is a required parameter for ADD TAGS.

It is an optional parameter for MODIFY_TAGS.

descr This is the description for tag searching in the tag browser.
This value is shown as the short description below the title for
the piece of content that's been searched.

This is a required parameter for the following commands:
+ ADD_TAGS

+ MODIFY TAGS
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Basic Output

The following xml is an example of output for these commands:
+ ADD TAGS

« MODIFY_TAGS

+ CLEAR TAGS

« REMOVE TAGS

<?xml version=""1.0""7?>
<TagResponse>
<Status>1</Status>
<ErrorMsg>Invalid Node</ErrorMsg>
</TagResponse>

Basic Output Parameters

Field or Control Description

Status The status of the command.
* (- Success

*  Non 0 - Error. (All errors default to 1.)

ErrorMsg If Status is a value other than 0, then the xml node is returned
with a message detailing the error.

Get Ouput

This is an example of output for the GET TAGS command:

<?xml version=""1.0""7?>
<TagResponse>
<Status>0</Status>
<Tag type="public">
<a class="EPPTGTAGTEXT" href="http://localhost/psc/ps_newwin/EMPLOYEE/EMPL/c/
EPPTG TAGGING.EPPTG_TAG BROWSE.GBL?
Page=EPPTG_TAG BROWSE&amp;Action=U&amp; EPTG=1&amp; TAG=dream"
target="newwin">dream</a>
</Tag>
<Tag type="private">
<a class="EPPTGTAGTEXT" href="http://localhost/psc/ps_newwin/EMPLOYEE/EMPL/c/
EPPTG TAGGING.EPPTG TAG BROWSE.GBL?
Page=EPPTG_TAG BROWSE&amp;Action=U&amp;EPTG=1&amp; TAG=private"
target="newwin">private</a>
</Tag>
</TagResponse>
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Get Output Parameters

Field or Control Description

Status The status of the command.
e 0-Success

*  Non 0— Error. (All errors default to 1.)

ErrorMsg If Status is a value other than 0, then the xml node is returned
with a message detailing the error.

Tag One tag node is returned for each tag.

type Valid values are:

»  public — these tags are viewable by all users for the
content.

»  private — these tags are viewable only by the user who
created the tags.

The anchor tag is a standard HTML link for the tag to the
defined tag browser page.

Add Operation

The Add operation adds tags to content. Repeated invocation of Add on the same content URL will
append tags to the existing list of tags for the content.

Modify Operation

Modify is similar to Add except that each invocation of Modify on a content URL will overwrite the
existing tags for the content. Add and Modify have the same message format.

Clear Operation
The Clear operation is used to clear all the tags of a content for a particular user.

The Clear operation has a <t ype> parameter that can take the values public, private, and all. Invoking
Clear with <type>all</type> is equivalent to invoking clear twice, once with <t ype>public</
type> and once with <type>private</type>.

Clear Input

This is an example of input for Clear:
<?xml version="1.0"?>

<tagging>
<tagop lang="ENG" userid="VP1">
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<cmd>CLEAR TAGS</cmd>
<id> N
<node>TAG</node>
<portal>EMPLOYEE</portal>
<ns>JOBS</ns>
<url>S/JOBPAGE.GBL/?ID=4</url>
</id>
<type>public</type> [ public or private or all ]
</tagop>
</tagging>

Remove Operation

The Remove operation removes the tags specified in the request message. Tag removal can be performed
for a particular user or for all users using the <all user>node.If<all user> is setto Y then tags
will be removed for all users. Type = privateandall user=Y isan invalid combination and will
be captured in the validation.

Remove Input

The following is an example of input for Remove:

<?xml version="1.0"?>
<tagging>
<tagop lang="ENG" userid="VP1">
<cmd>REMOVE TAGS</cmd>
<id> -
<node>TagHR</node>
<portal>EMPLOYEE</portal>
<ns>JOBS</ns>
<url>s/JOBPAGE.GBL</url>
</id>
<tags>Colloborative, Best, dram, Schrewd</tags>
<type>public</type>
<all user>y</all user> [ y or n]
</tagop>
</tagging>

Get Operation

The Get operation returns the public and private tags available for a particular content URL.

Search Operation

A search can be performed at the domain or namespace level. While domain is mandatory for any search
operation, namespace is an optional parameter for the Search web service.

The number of results that are returned is set using the optional node <num results>. Output contains
a search result label, description, URL, and related tags information. A tag browser URL (which can be
set in the Application Domains page) is provided once in the output message at the same level as the
results node.

Search Input

This is an example of input for Search:

<?xml version="1.0"?>
<tagging>
<tagop lang="ENG" userid="VP1">
<cmd>SEARCH_TAGS</cmd>
<domain>PSHR</domain>
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<ns>PSHR</ns>
<num_results>5</num results>
<search>dream</search>
</tagop>
</tagging>

Search Input Parameters

Chapter 8

Field or Control Description

system default (%language_base).

lang This corresponds to the language the user has entered their
tags in. Use PeopleSoft language codes. The default is the

This is a required parameter.

userid The user ID that entered the tag. The user ID must be a valid
PeopleSoft user.

cmd The command value - SEARCH_TAGS.

domain The tagging domain that is being searched.

ns The namespace that is being searched.

This is an optional parameter.

The default is to search all namespaces within the domain.

num_results The maximum number of results to return.

This is a required parameter.

search The tag that is being searched.

Search Output

This is an example of output for Search:

<?xml version="1.0"?>
<TagSearchResults>
<Status>0</Status>
<Result>
<Label>Job Page</Label>
<Description>Job Details Page</Description>
<RelatedTags>dream</RelatedTags>
<Url>http://ape.peoplesoft.com/psp/ps_newwin/S/JOBPAGE.GBL</Url>
</Result>
<Result>
<Label>BenefitsPage</Label>
<Description>BenefitsPage Details Page</Description>
<RelatedTags>dream</RelatedTags>
<Url>http://ape.peoplesoft.com/psp/ps_newwin/S/JOBPAGE.GBL/ID=2</Url>
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</Result>

<Result>
<Label>Movies</Label>
<Description>Great Movies</Description>
<RelatedTags>Sequel, dream</RelatedTags>
<Url1>HTTP://WWW.YAHOO.COM/ID=2</Url>

</Result>

</TagSearchResults>

Search Output Parameters

Field or Control Description

Status The status of the command.
* (- Success.

*  Non 0 - Error. (All errors default to 1.)

ErrorMsg If Status is a value other than 0, then the xml node is returned
with a message detailing the error.

Result Each row of data is returned as a Result.
*  Label — The short description of a search result.
»  Description — The long description of a search result.

*  RelatedTags — Any tags associated with the search result
are listed here, comma separated.

e Url - link to the search result.

Tag Cloud Operation

The tag cloud is a visual representation of tags currently used in the system. Different font sizes help
visualize the usage patterns of tags. Larger fonts depict more frequently used tags, while smaller fonts
depict less frequently used tags.

Tag Cloud Input

This is an example of input for Tag Cloud:

<?xml version="1.0"?>
<tagging>
<tagop lang="ENG" userid="VP1">
<cmd>TAG_CLOUD</cmd>
<scope>DOMAIN=PSFT HR,TAG NS=JOBS</scope>
<num_results>100</num_results>
<sOort>ALPHA-D</sort>
<period>90</period>
<personal cloud>true</personal cloud>
</tagop>
</tagging>
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Field or Control

Description

lang This corresponds to the language the user has entered their
tags in. Use PeopleSoft language codes. The default is the
system default (%language base).

userid The user ID that entered the tag. The user ID must be a valid
PeopleSoft user.

cmd The command value — TAG_CLOUD

scope This defines where tags are retrieved to generate the cloud.

Specify values in KEY=VALUE pairs separated by a comma.
Valid Keys are:

*  DOMAIN — The tagging application domain. This key is
required.

* TAG NS - A namespace associated in the domain.
This key is optional.

If no namespace is defined, all tags from the domain are used.

num_results

The maximum number of results to show in the tag cloud.

This is a required parameter.

search

The tag that is being searched.
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Field or Control Description

sort The sort order of the tag cloud.

Possible values are:

*  ALPHA-A — Alphabetical ascending A-Z.

*  ALPHA-D — Alphabetical descending Z-A.

*  COUNT-A — Count ascending 0-X.

*  COUNT-D - Count descending X-0.

*  ATIME-A —: List tags oldest added time first.
*  ATIME-D — List tags newest added time first.
This is an optional parameter.

The default is ATIME-D.

Tag Cloud Output

This is an example of output for Tag Cloud:

<?xml version="1.0"?>
<TagSearchResults>
<Status>0</Status>
<TagBrowserUrl>http://localhost/psc/ps_newwin/EMPLOYEE/EMPL/c/
EPPTG TAGGING.EPPTG TAG BROWSE.GBL?
Page=EPPTG_TAG_BROWSE&amp;Action=U&amp; EPTG=1&amp; TAG=</TagBrowserUrl>
<TagCloud>
<Tag Count="1" Size="80%" Weight="normal">VP</Tag>
<Tag Count="10" Size="120%" Weight="normal">Sequel</Tag>
<Tag Count="5" Size="100%" Weight="normal">Mobile</Tag>
<Tag Count="5" Size="100%" Weight="normal">Manager</Tag>
</TagCloud>
</TagSearchResults>

Tag Cloud Output Parameters

Field or Control Description

Status The status of the command.
* (- Success.

*  Non 0 - Error. (All errors default to 1.)

ErrorMsg If Status is a value other than 0, then the xml node is returned

with a message detailing the error.
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Field or Control

Description

TagBrowserUrl The URL to the tag browser.
TagCloud Contains all the tags in the tag cloud.
Tag The tag with these attributes:

*  Count — How often the tag is used to link a piece of
content.

*  Size — The default suggested sizing of the tag.
*  Weight — Suggested weighting of the tag.

Possible values are:

o lighter
e normal
e bold

Tag Browser

110

The search result links that correspond to tags added using web service must open in a new window.

For search results that correspond to PeopleSoft system tags, the portal URI entered at the node definition
page must be concatenated with the relative URL provided in the input message. The complete URL
that is obtained by appending the node's portal URI and relative URL should give a complete and valid

PeopleSoft URL.

The search results corresponding to non-PeopleSoft system tags will have the same URL as supplied in
the input message. In the case of external system tags the URL supplied must be a full URL and must start
with http://. The URL is used as such in the search results in tag browser as it is a complete URL.

Each domain in the application domain page will have a scope corresponding to it in the tag browser

page.
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Managing Menu Item Requests

Understanding the Menu Iltem Requests Feature

Menu items are pages, websites, or files accessible from the navigation menu. PeopleSoft Interaction
Hub's Menu Item Requests feature enables portal users to contribute information to their organization's
intranet by submitting a menu item request for a file attachment, managed content, a website Uniform

Resource Locator (URL), or a PeopleSoft URL.

The Menu Item Requests feature contains three levels of security, which allow users to submit menu item
requests, managers to approve or reject the requests, and the portal administrator to register approved
requests. Security for this feature is based on the following three permission lists, which are delivered

with your software:
*  PAPP4100.
Submit menu item requests.
*  PAPP4020.
Approve and manage menu item requests.
*  PAPP4025

Register menu item requests.

PeopleSoft also delivers user roles that are configured to perform PeopleSoft Interaction Hub functions.
The following three roles have been configured to include menu item functions:

Role

Role Description

PAPP_AUTHOR

Content Author

PAPP NAVIGATION MANAGER

Navigation Manager

PAPP_NAVIGATION_ADMIN

Navigation Administrator

The Menu Item Requests feature can be set up to send email notifications of status changes to menu
item requests. Manager notifications are sent for newly submitted requests pending review and approval.
Administrator notifications are sent for approved requests pending portal registration.

See the product documentation for PeopleTools: Security Administration.
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Common Elements Used in Menu Iltem Requests

Field or Control

Description

Status

Displays the current status of the associated request.

Content Type

Displays the content type of the associated request.

Creation Date

Displays the creation date of the request.

Created By

Displays the user ID of the person who created the request.

Setting Up Menu Iltem Request Email Notifications

This section discusses how to use the Request Notification component (EPPMI_NOTIFY) to set up users
to receive email notification of status changes to menu item requests.

Page Used to Set Up Menu Item Request Email Notifications

Page Name

Definition Name

Usage

Menu Item Request Notification Page

EPPMI NOTIFY

Set up menu item request email
notifications.

Menu Item Request Notification Page

Use the Menu Item Request Notification page (EPPMI _NOTIFY) to set up menu item request email

notifications.

Navigation:

Portal Administration > Menu Item Requests > Request Notification
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This example illustrates the fields and controls on the Menu Item Request Notification page. You can find

definitions for the fields and controls later on this page.

Menu ltem Request Notification

naotification is sent for approved Menu ltems pending portal registration.

Motified Users

The listed users will receive e-mail notification of status changes to a Menu ltem Request. Manager
notification is sent for newly submitted Menu lterm requests pending review and approval. Administrator

Find | 2 | &8 1-3 of 3

*User ID Manager Administrator *Email Address
PAFF_AUTHOR Q ] ] psmith@company.com (=]
PAPP_MAVIGATIONADM |G F ljones@company.com =]
PAPP_MAVIGATIOMMGR|CL ] F jthomas@company.com [=]
Field or Control Description
User ID Select the ID of the user to which you want to send email

notifications of menu item request status changes.

Manager Select if the user is a navigation manager and requires
notifications for newly submitted requests pending review and
approval.

Administrator Select if the user is a navigation administrator and requires

notifications for approved requests pending portal registration.

Email Address If available, the email address will default from the user
profile, but can be overridden. Menu item request notifications
will be sent to this address.

Managing Menu Item Requests

This topic discusses approving, updating and deleting menu item requests.

Pages Used to Manage Menu Iltem Requests

Page Name Definition Name Usage

Manage Menu Item Requests Page EPPMI_MANAGE LST Approve or reject submitted menu item
requests.

Edit Menu Item Request Page EPPMI_ITM_EDIT SEC Edit a menu item request.

Copyright © 1988, 2024, Oracle and/or its affiliates.

113



Managing Menu Item Requests Chapter 9

Page Name Definition Name Usage
View Menu Item Request EPPMI _ITM_VIEW_SEC View the details of a menu item request.
Delete Menu Item Requests Page EPPMI DEL LST Delete rejected menu item requests.

Manage Menu Item Requests Page

Use the Manage Menu Item Requests page (EPPMI. MANAGE LST) to approve or reject submitted
menu item requests.

Navigation:
Portal Administration > Menu Item Requests > Manage Requests

This example illustrates the fields and controls on the Manage Menu Item Requests page. You can find
definitions for the fields and controls later on this page.

Manage Menu ltem Requests

Use the search criteria to filter the Menu ltem requests, then click "Search’. Click the Menu ltermn
Request link to update the request status. Only ‘Approved’ Menu ltem Requests can be registered by

the Partal Administrator.

= Status: “Ment ItemType:| All Content Types v| Search

Menu ltem Requests Find | view All [ & | B8 First ] 1-3 or 2 [ ast
Menu Item Request Status Type Created By Publigh Date
Configuration Red Paper Submitted Managed Content WP 0330/2001
Portal Solutions Overview Submitted Webh Site URL VP 09/02/2002
Schwah Site Submitted Web Site URL WP 1100212000

Save Menu ltems

Menu Item Requests

Field or Control Description

Menu Item Request Click the Menu Item Request link to access the Edit Menu
Item Request page, where you can access and edit information
about the selected menu item request.

See Edit Menu Item Request Page.

Publish Date Displays the date on which the submitter wants to publish the

requested menu item.
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Field or Control Description
Save Menu Items Click to save changes made on the Edit Menu Item Request
page.

Warning! Although you clicked the OK button on the Edit
Menu Item Request page to update the request, your changes
will not be saved until you click the Save Menu Items button.

This action triggers an email notification to the submitter with
a link to the Submit Menu Item page.

Note: Requests with a status of Rework can be resubmitted,
deleted, or saved as draft. Requests with a status of Rejected
can be viewed or deleted. Requests with a status of Approved
can be viewed.

Approved menu item requests will also trigger an email
notification to the navigation administrator with a link to the
Administer Menu Item Requests page.

Edit Menu Item Request Page
Use the Edit Menu Item Request page (EPPMI_ITM _EDIT_ SEC) to edit a menu item request.
Navigation:

Click the Menu Item Request link for a menu item request in Rejected, Submitted, Rework, or Approved
status on the Manage Menu Item Requests page.
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This example illustrates the fields and controls on the Edit Menu Item Request page. You can find

definitions for the fields and controls later on this page.

Manage Menu ltem Requests

Edit Menu ltem Request

Creation Date: 02/08/2002 Created By:  VP1

Menu ltem Request

*Request Status: Submitted |»

Email Address: test@peoplesoft.com

Comments:

Menu ltem ldentifier

“Menu ltem Label: Configuration Red Paper

“Menu [tem I0: DEMO_COMFIGURATION_RED_PAPER
Long Description:

Publish Date: 03/30/2001 |

Expiration Date: E‘j

Menu ltem Content

Menu ltem Author:  |Yice President of Finance

Menu ltem Type: Managed Content
Content Title: Portal Configuration Tips
Content [D: 1047

Content Type: File Attachment

- Search Key Words

Ok Return to Menu [tem List 30 to Adminster Requests

Chapter 9
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Menu Item Request

Field or Control Description

Request Status Update the status of the request based on your review and
updates. Available values include:

Approved.
Rejected.
Rework.

Submitted.

Email Address Displays the email address of the person who submitted this
request.

Comments Add any comments based on your review of the menu item
request. For example, you can enter details about the changes
you made to specific fields, as well as the reasons why the
menu item request was rejected or needs to be reworked.

Menu Item Identifier

Changes can be made to all fields in this section.

Menu Item Content

Click the Content Title or File Attachment link to view the content.

Search Key Words

Changes can be made to all fields in this section.

Field or Control Description

OK Click to update your changes to the menu item request and
return to the Manage Menu Item Requests page.

Warning! You must click the Save Menu Items button on the
Manage Menu Item Requests page to save any changes you

made on this page.
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Field or Control

Description

Return to Menu Item List

Click to return to the Manage Menu Item Requests page.

Warning! Any changes you made on this page will not be
saved.

Go to Administer Requests

After saving your changes by clicking the Save Menu Items
button on the Manage Menu Item Requests page, you can
return to this page and click this link to access the Administer
Menu Item Requests page, where you can register the menu
item, once it has been approved.

Note: This link displays only if you have been granted

permission to register menu item requests.

See Approving and Registering the Menu Item Requests.

Delete Menu Item Requests Page

Use the Delete Menu Item Requests page (EPPMI_DEL LST) to delete rejected menu item requests.

Navigation:

Portal Administration > Menu Item Requests > Delete Requests

This example illustrates the fields and controls on the Delete Menu Item Requests page.

table.
Delete All

Menu ltem Request

Delete Menu Item Requests

Only those Menu ltems with a request status of ‘Rejected’ can be deleted from the Menu ltermn requests

Rejected Menu ltem Requests

All My Children Soap Updates

k|
Find | View All | (B | e First B 1 of 1 [ | ast
Status Menu ltem Type Created By

Fejected Web Site LRL WP Delete

Only menu item requests with a status of Rejected are available for deletion.

Click the Delete button to delete the associated menu item request.

Click the Delete All button to delete all menu item requests.

You will be prompted to confirm your deletion.
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Approving and Registering the Menu Item Requests

This topic discusses methods to define menu item registry entry and view details. It also discusses how to
register approved menu item requests.

Pages Used to Register Approved Menu Iltem Requests

Page Name

Definition Name

Usage

Administer Menu Item Requests Page

EPPMI_REG_LST

Register approved menu item requests.

Define Menu Item Registry Page

EPPMI_REG DFO

Register approved menu item requests.

Edit Menu Item Request Page

EPPMI_ITM_EDIT SEC

Access and edit details of a menu item
request.

View Menu Item Request

EPPMI_ITM_VIEW_SEC

View menu item request details.

Define Registry Page

EPPMI_REG_DFN

Determine how the menu item will
be rendered online, such as the site
and menu folder to which it will be
published.

Select Menu Folder Page

EPPMI_REG_FLD

Choose the parent folder in which you
want to register the menu item.

Confirm Registry Page

EPPMI_REG _CNF

Confirm menu item registration.

Registry Details Page

EPPMI REG_VIEW

Review registry information for the
menu item, or remove the menu item
from registry.

Administer Menu Item Requests Page
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Use the Administer Menu Item Requests page (EPPMI_REG_LST) to register approved menu item

requests.

Navigation:

Portal Administration > Menu Item Requests > Register Requests
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This example illustrates the fields and controls on the Administer Menu Item Requests page. You can find
definitions for the fields and controls later on this page.

request.

Menu ltem Requests

* Status:

Administer Menu ltem Requests

Personalize | Find | view Al | B2 | B First 8 1.5 or5 B Last

Use the search criteria to filter the Menu ltem requests, then click "“Search’. Click the Menu tem
Request link to update the request status. Click ‘Register ltem’ to register an approved Menu ltem

*Menu Item Type:| All Content Types v I

Menu Item Request Status Type Publish Date
assistant Approved VWeb Site URL 02132013 Register ltem
Yice president Approved Web Site LRL Q212712013 Register lterm
Yice President of Oracle Approved VWeb Site URL 021212013 Register ltem
Full Table Publizh Rules Approved FPeople3oft URL 11/02/2000 Register lterm
Documentation Tips Approved Managed Content 03/08/2002 Renister lterm
Save Menu ltems
Field or Control Description

Menu Item Request

Click for a menu item request in Rejected, Submitted, Rework,
or Approved status to access the Edit Menu Item Request page.

Click for a menu item request in Registered status to access the
View Menu Item Request page.

Register Item Click to access the Define Registry page, where you can
register the menu item.
This button displays for menu item requests in Approved
status.

Registry Details Click to access the Registry Details page, where you can view

registry details for a menu item, or remove the menu item from
the registry.

This button displays for menu item requests in Registered
status.
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Field or Control Description
Save Menu Items Click to save the changes made on the Edit Menu Item
Request page.

Warning! Even though you clicked OK to update the request
on the Edit Menu Item page, your changes will not be saved,
until you click Save Menu Items.

This action will trigger an email notification to the submitter
with a link to the Submit Menu Item page.

Note: Only requests with a status of Registered have the
Registry Details option available.

Define Menu Item Registry Page

Access the Define Menu Item Registry page( EPPMI_REG DFO)(click the Approve & Register button
on the Edit Menu Item Request page).

Navigation:

My Content > Submit Menu Items > Register Requests
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This example illustrates the fields and controls on the Define Menu Item Registry page. You can find
definitions for the fields and controls later on this page.

Administer Menu ltem Requests
Define Menu Item Registry

Vice President of Oracle

Registry hierarchy if changing the default site.

Specify the portal registry data that determines how the Menu tem is rendered online. Click ‘Refresh’ to refresh the Fortal

“Site Name | EMPLOYEE

vl

Template Hame |

vl

Product
*Access Type
Refresh Return to Menu Item List
Left | Right
= Root
Iy Favaorites
Portal Ohjects

Common Portal - Hidden
Enterprise Components
PeopleZoft

My Content

Cantent Management
Investor Portal

Internal Controls Enforcer
Fortal Administration
Interaction Hub - Hidden
Intern Cirl Enfarcer - Hidden
Investor Portal - Hidden
Warklist

Application Diagnaostics
Tree Manager

Reporting Tools
FeopleTools

Tools - Hidden
FPackaging

[DemoSite Home]

[Take a Survey]

COOCHHHHAIHA I HE L

[Browse VWorkspaces]

Term

Definition

Site Name

Select the portal or site in which you want to register the menu
item. This value defaults to the current portal or site.
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Term Definition

Node Name This field displays when the Content Type field is set to
PeopleSoft URL.

Select the database node that contains the PeopleSoft page
that you want to register as a menu item. The node is used to
derive the web server URL used to access the content provider
database.

Select Always use local to indicate that you want to use the
current portal database.

Template Name This field displays when the Content Type field is set to
PeopleSoft URL or Web Site URL.

Select a template to determine how the URL content will

be displayed on the page. PeopleSoft delivers a number of
standard templates, or you can design your own. PeopleSoft
recommends leaving this field clear unless there is a special
circumstance. Leaving this field clear,allows the system to use
the default template.

Product Optionally, enter text to tag menu items for SQL queries
against the registry tables.

Access Type Select the type of security access you want to grant for the
menu item. Available values include:

Permission. Select to indicate that you want to specify
permission lists that define access rights to the menu item.

Public. Select to indicate that you want the menu item to be
accessible by all users.

Author Access This option displays when the Access Type field is set to
Permission.

Select to indicate that you want the user who submitted the
menu item request to have access to the menu item regardless
of any other permissions that are defined for the menu item.
However, if the user does not have access to the menu
component, the system will issue an authorization error.

Permissions This option displays when the Access Type field is set to
Permission.

Select the permission lists that you want to have access to the
menu item.

Click the folder icons to navigate through the portal registry hierarchy. Click a folder link to select the
desired folder and access the Confirm Registry page, where you can confirm the registration of the menu
item.
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Use the Define Registry page (EPPMI_REG DFN) to determine how the menu item will be rendered
online, such as the site and menu folder to which it will be published.

Navigation:

Click the Register Item button on the Administer Menu Item Requests page.

This example illustrates the fields and controls on the Define Registry page. You can find definitions for

the fields and controls later on this page.

Administer Menu ltem Requests

Define Registry

assistant

to choose the parent folder for the Menu Item.

*Site Name: EMFLOYEE
Template Name:

Product:
*Access Type: Public v

Select Menu Folder Return to Menu ltermn List

The portal registry data determines how the Menu lterm is rendered on-line. Click "Select Menu Folder

Field or Control Description

Site Name Select the portal or site in which you want to register the menu
item. This value defaults to the current portal or site.

Node Name This field displays when the Content Type ficld is set to

PeopleSoft URL.

Select the database node that contains the PeopleSoft page
that you want to register as a menu item. The node is used to
derive the web server URL used to access the content provider
database.

Select Always use local to indicate that you want to use the
current portal database.

Template Name

This field displays when the Content Type field is set to
PeopleSoft URL or Web Site URL.

Select a template to determine how the URL content will

be displayed on the page. PeopleSoft delivers a number of
standard templates, or you can design your own. PeopleSoft
recommends leaving this field clear unless there is a special
circumstance. Leaving this field clear, invokes the system to
use the default template.
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Field or Control Description

Product Optionally, enter text to tag menu items for SQL queries
against the registry tables.

Access Type Select the type of security access you want to grant for the
menu item. Available values include:

Permission. Select to indicate that you want to specify
permission lists that define access rights to the menu item.

Public. Select to indicate that you want the menu item to be
accessible by all users.

Author Access This option displays when the Access Type field is set to
Permission.

Select to indicate that you want the user who submitted the
menu item request to have access to the menu item regardless
of any other permissions that are defined for the menu item.
However, if the user does not have access to the menu
component, the system will issue an authorization error.

Permissions This option displays when the Access Type field is set to
Permission.

Select the permission lists that you want to have access to the
menu item.

Select Menu Folder Click to access the Select Menu Folder page, where you can
choose the parent folder for the menu item.

Select Menu Folder Page

Use the Select Menu Folder page (EPPMI_REG FLD) to choose the parent folder in which you want to
register the menu item.

Navigation:

Click the Select Menu Folder button on the Define Registry page.
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This example illustrates the fields and controls on the Select Menu Folder page.

assistant

Left | Right

[= Root

Waorklist

PP OHHMHHHHAIHMEHEHEAEE S E I

et

Administer Menu ltem Requests
Select Menu Folder

Click the folder icons to navigate through the Portal Registry hierarchy. Click the folder link to select
the parent menu folder for the Menu ltem.

Iy Favorites

Fortal Objects

Commaon Portal - Hidden
Enterprise Components
FPeople3oft

My Content

Content Management
Investor Portal

Internal Contrals Enforcer
Fartal Administration
Interaction Hub - Hidden
Intern Ctirl Enforcer - Hidden
Investor Portal - Hidden

Application Diagnostics
Tree Manager
Reporing Tools
FeopleTools

Tools - Hidden
Fackaaing

[Demosite Home]

[Take a Survey]
[Browse Workzpaces]
[My Account Sign On]
[My Ingtant Mes=saging]
[Uzage Monitoring]
[Changs My Password]
[My Perzonalizations]

Click the folder icons to navigate through the portal registry hierarchy. Click a folder link to select the
desired folder and access the Confirm Registry page, where you can confirm the registration of the menu

item.

Confirm Registry Page

Access the Confirm Registry page (EPPMI_REG_CNF) (Click a folder link to select the desired folder).

Navigation:

My Content > Submit Menu Items > Register Requests
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This example illustrates the fields and controls on the Confirm Registry page. You can find definitions for
the fields and controls later on this page.

Administer Menu ltem Requests

Confirm Registry
Vice President of Oracle

Portal Hame: EMFLOYEE
Template Hame:

Product:
Access Type: Puhblic

Menu ltem Name: ADMM_VICE_PRESIDEMT_OQF_OR
Menu Folder Name:  PAPP_COMTEMT
Portal Menu Path: = My Content

= Are you sure you wish to register this Menu ltem?

Yes - Register Mo - Do Mot Register
Field or Control Description
Yes - Register Click Yes - Register button to register the menu item
No-Do Not Register Click No — Do Not Register to cancel the registration and
return to Select Menu Item Folder page.

Registry Details Page

Use the Registry Details page (EPPMI_REG VIEW) to review registry information for the menu item, or
remove the menu item from registry.

Navigation:
* Click the Yes - Register button on the Confirm Registry page.

*  Click the Registry Details button on the Administer Menu Item Requests page.
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This example illustrates the fields and controls on the Registry Details page. You can find definitions for

the fields and controls later on this page.

Administer Menu ltem Requests

Registry Details

Vice President of Cracle

Site Name: EMFLOYEE
Hode Hame: (Mot Specified)
Template Hame: (Mot Specified)

Menu ltem:
Menu Folder: PAPP_CONTEMT
Menu Path; Haome = My Content =

Access Type: Fublic

Remove from Redistty | getym to Menu Item List

ADMM_VICE_PRESIDENT_OF_OR

Employee-facing registry content

Wice President of Oracle

My Caontent

G0 to Registry Structure & Content

Field or Control

Description

Site Name Displays the portal or site in which the menu item is
registered.
Node Name Database node that contains the PeopleSoft page.

Template Name

Determines how the menu item content is displayed on the
page. A value of (Not Specified) indicates that the default
template will be used to display the page.

Access Type

Valid values include:
Public. All users can access the menu item.

Permission. Only users who are associated with the selected
permission list are able to access the menu item.

Remove from Registry

Click to remove the menu item from the registry.

A new page displays confirming the removal.

Go To Registry Structure & Content

Click to access the Content Ref Administration page for the
menu item.

This link displays if the current user has security access to the
Structure and Content component.
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Understanding the Portal Registry Load Process

The Portal Registry Load process provides a file-based method to bulk-load content and folder references
into the portal registry.

The registry load process is one methodology for providing access to content from a content provider
system in a PeopleSoft Interaction Hub system. However, the content references available through this
methodology are only as current as the last registry load. Content references are not dynamically updated
as they are created or deleted. An alternative methodology, unified navigation, federates PeopleSoft
applications under a single portal system and dynamically provides access to content references on those
content provider systems.

See Understanding Unified Navigation.

Note: The information in this topic is for system administrators who implement and maintain the
PeopleSoft Interaction Hub.

Loading data into the portal registry involves two staging tables:
« EO PE LOAD DTL
« EO PE LOAD FLDR

The PORTAL REG LOAD Enterprise Integration Point (EIP) delivers both an application message and a
file layout in the form of a comma-separated value (CSV) file. You can:

» Use your own application programming interfaces (APIs) to match the PORTAL REG LOAD
message format.

» Export the data to a spreadsheet, save it as a CSV file, and follow the steps we provide for the
inbound flat-file utility.

See Preparing to Run the Portal Registry Load Process.

For the inbound flat-file definition, use the layout and message combination: PORTAL REG_LOAD.

The result of the flat-file utility is a published PORTAL REG LOAD message. When the
portal subscribes to the message, you see the data in the tables EO_ PE LOAD DTL and
EO_PE LOAD FLDR.

Note: The message subscription was set to generate a subscription ID. This subscription ID was used to
populate the Process Instance field in the EO PE LOAD DTL and EO_PE LOAD FLDR records.

After the file data is in the staging tables, run the Registry Load process to load the data into the portal
registry.
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Note: To research the technical details of any integration point used by PeopleSoft applications, refer
to information on the PeopleSoft Services Repository, which can be found on the My Oracle Support
website. See Oracle Support Document 735571.1 (Introduction to the PeopleSoft Interactive Services
Repository (ISR)).

Understanding the Portal Registry Load Files

130

The Registry Load process requires a CSV file. To work with the Registry Load process, the data in
the file must be in a specific order. We deliver two sample files to provide a basis for creating your
own data files for the Registry Load process. The sample portal registry load files can be found in the
PS_APP_HOME\data folder.

Note: If the PeopleSoft Interaction Hub files were not installed in a separate PS_APP_HOME location,
then these files will be found in PS HOME\data instead.

Delivered Sample File Name Usage

portal_reg load sample.xls Microsoft Excel spreadsheet file with column headings.

This file contains registry data for sample folders, sample
pagelets, and sample target pages.

portal reg load sample.csv Comma-separated value file without column headings.

This file is created by deleting the column heading row from
portal reg load sample.xls and saving the file as type CSV (*.
csv). The resulting data is in the format that is required by the
Registry Load process.

Note: The delivered files are samples only. You can load portal reg load sample.csv into a test or demo
database. The Registry Load process does not overwrite existing registry entries. After the file data is
loaded, you must delete the folder and content reference definitions manually from the portal registry in
order to reload the same data.

The portal reg load sample.xls file contains column headings that describe the data required for that
column. The column data reflects the data that is entered when you register a content reference in the
portal.

Each row in the file represents a different content reference. PeopleSoft components, PeopleSoft iScripts,
and external URLs are the only types of content that can be registered as content references using the
registry load file. In addition, only homepage pagelets and target pages can be registered using the registry
load file.

Note: Templates and template components cannot be registered using the portal registry load file. These
types of content references must be registered online.

With the Registry Load process, content can registered to a depth of six folder levels. The process starts at
the first level and works its way through the folders that are listed for the content reference. The content
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reference is registered under the lowest level folder that is not blank. If a specified folder label is not
found in the registry, the registry load process creates this folder. The object name for created folders is
formatted to match the uppercase value of the label. If this object name already exists, a numeric value is
appended to make the object name unique in the portal registry. If no folder is specified for a particular
content reference row, the content reference is registered at the root level.

The columns in the file must be in the exact order and format as delivered in the sample files for use by
the Registry Load process. The following table explains the format and use of each column. Failure to
provide a value for the required columns results in an error status for that content reference row during the
Registry Load process. Content reference rows with a status of £ in the staging table are not registered.
You can view the errors for your data using the View Registry Load Data page.

Note: You can use the View Registry Load Data page before or after you run the Registry Load process to
see what is in the staging tables.

Column Heading

Format

Use

Required?

Portal Name

30 characters, uppercase, no
spaces.

This value must match the
portal definition object
name. The valid values are
EMPLOYEE, CUSTOMER,
PARTNER, or SUPPLIER

Required

Content Provider

30 characters, mixed case, no
spaces.

This value must match the
exact spelling and case of

an existing content provider
node name. This is the content
provider node for the content
reference. Delivered content
provider nodes include BP,
CRM, EPM, ELM, ERP,
GFHA, HRMS, LOCAL
NODE, SA, and SAHA.

Required for components and
iScripts

Portal Template

30 characters, uppercase, no
spaces.

This value must match a
registered template object
name. This template is used
by the content reference. You
must specify the template
object name, not the template
label.

Optional

Product

4 characters, mixed case,
truncated after 4 characters.

Optional value that is

stored with the content
reference registry entry.
Select this value in the
registry load process to limit
the rows in this file that are
to be registered as content
references.

Optional
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Column Heading

Format

Use

Required?

Category

30 characters, uppercase, no
spaces.

Used for user organization of
the load file. Select this value
in the Registry Load process
to limit the rows in this file
that are to be registered as
content references.

Optional

URL Type

1 character, uppercase

Used to define the type of
content reference target page.
Values are:

S: iScript

C: Component

X: External

Required

Usage Type

1 character, uppercase

Used to define the use of the
content reference target page.
Values are:

P: Pagelet

T: Target

Required

Hidden

1 character, uppercase

Specifies whether the content
reference is hidden in the
menu navigation. Values are:

N: Not hidden

Y: Hidden

Required

Fldr 1 Seq (Folder 1
sequence)

4 digits, numeric

Specifies the display order of
the level 1 folder.

Optional

Fldr 1 Name

30 characters, free-form

Level 1 folder label.

Optional

Fldr 1 Desr (folder 1
description

254 characters, free-form

Level 1 folder description.

Optional

Fldr 2 Seq

4 digits, numeric

Specifies the display order of
the level 2 folder.

Optional

Fldr 2 Name

30 characters, free-form

Level 2 folder label.

Optional

Fldr 2 Desr

254 characters, free-form

Level 2 folder description.

Optional

Fldr 3 Seq

4 digits, numeric

Specifies the display order of
the level 3 folder.

Optional
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spaces

component (usually GBL).
Used only by components.

Column Heading Format Use Required?
Fldr 3 Name 30 characters, free-form Level 3 folder label. Optional
Fldr 3 Desr 254 characters, free-form Level 3 folder description. Optional
Fldr 4 Seq 4 digits, numeric Specifies the display order of | Optional

the level 4 folder.
Fldr 4 Name 30 characters, free-form Level 4 folder label. Optional
Fldr 4 Desr 254 characters, free-form Level 4 folder description. Optional
Fldr 5 Seq 4 digits, numeric Specifies the display order of | Optional

the level 5 folder.
Fldr 5 Name 30 characters, free-form Level 5 folder label. Optional
Fldr 5 Desr 254 characters, free-form Level 5 folder description. Optional
Fldr 6 Seq 4 digits, numeric Specifies the display order of | Optional

the level 6 folder.
Fldr 6 Name 30 characters, free-form Level 6 folder label. Optional
Fldr 6 Desr 254 characters, free-form Level 6 folder description. Optional
Cref Seq (content reference 4 digits, numeric Specifies the display order of | Optional
sequence the content reference in the

lowest level folder.
Cref Name 30 characters, free-form Content reference label. Required
Cref Desr 254 characters, free-form Content reference description. | Optional
Menu Name 30 characters, uppercase, no | Menu name that stores the Required for components.

spaces component. Used only by

components.

Market 3 characters, uppercase, no Market associated with the Required for components.

Panel group

18 characters, uppercase, no
spaces

Component name that stores
the pages. Used only by
components.

Required for components.
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Column Heading

Format

Use

Required?

Record Name

15 characters, uppercase, no
spaces

Record name that stores the
iScript. The record must begin
with WEBLIB_. Used only by
iScripts.

Required for iScripts.

Field Name

18 characters, uppercase, no
spaces

Field name that stores the
iScript. Used only by iScripts.

Required for iScripts.

Pcode Event Type
(PeopleCode event type)

14 characters, mixed case, no
spaces

PeopleCode function event
that stores the iScript (usually
FieldFormula). Used only by
iScripts.

Required for iScripts.

Pcode Function Name

30 characters, mixed case, no
spaces

PeopleCode function name
that is used to invoke the
iScript. This value might
contain appended query string
parameters if length permits.
The function must begin with
iScript. Used only by iScripts.

Required for iScripts.

Portal Object Name

30 characters, uppercase, no
spaces

Object name for the content
reference. If this column is
blank, the value in the content
reference label column (Cref
Name) is in uppercase and
used.

Optional

Default Column

1 digit, numeric

Defines the default column for
the pagelet in the homepage
layout. If this column is blank,
the default value is 1. Used
only by pagelets. Values are:

1: First column.

2: Second column

Optional

Edit URL Content Provider

30 characters, mixed case, no
spaces

Content provider for the edit
URL that is used to access the
Pagelet Personalization page.
The edit URL is listed in

the External URL/Edit URL/
Related Link column. If no
edit URL is specified, leave
this column blank. Used only
by pagelets.

Optional
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Column Heading Format Use Required?
External URL/Edit URL/ Unlimited long character, Use of this column depends Required for External URLs
Related Link free-form on the URL type and the

usage type of the content

reference:

*  Component or iScript
Pagelets: (Optional).
The URL that is used
to access the pagelet
personalization page.
The Edit URL value
for a PeopleSoft
personalization page
must be of the following
form (replacing
MENU, MKT, and
COMPONENT name
with the PeopleSoft
values:

e For an 8.44 content
provider:

c:/MENU.
COMPONENT.
MKT

¢ Foran 8.1x content
provider:

ICType=Panel&Menu=MENU&Market=MKT

NAME&PanelGroupName=COMPONENT

*  Component or iScript
Targets: (Optional).
The URL that is
used to access the
pagelet personalization
iScript. The Edit URL
value for a PeopleSoft
personalization page
must be of the following
form (replacing
RECORD, FIELD,
EVENT, FUNCTION
name with the PeopleSoft
values).

¢ For an 8.4x content
provider:

s/RECORD.
FIELD.EVENT.
FUNCTION

¢ Foran 8.1x content
provider:
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Column Heading

Format

Use

Required?

ICType=Script&ICSc
FIELD.EVENT.
FUNCTION

»  External Targets:
(required). URL that
is used to access
the external content
reference. If no content
provider is listed for this
content reference, state
the complete URL http.://.
.. If a content provider
is used, state only the
remaining portion of the
URL.

riptProgramName=RECORD.

Keyword List

254 characters, free-form

List of keywords, delimited
by spaces, that are used by the
search engine index to return
this content reference when a
user invokes the portal search.
You can enclose keywords

in quotes for the search to
handle the keywords as a
single phrase.

Optional

Permission Lists

254 characters, uppercase,
spaces allowed

List of up-to-30-characters-
long permission lists,
delimited by semicolons, that
are used to secure access to
this content reference.

Required

See Registry Load Data Page.

Creating a Portal Registry Load File

136

To be usable by the Registry Load process, the number of columns and format in your registry load file
must match those in the delivered portal reg load sample.xls file. The sample portal registry load files
can be found in the PS_ APP_ HOME\data folder.

Note: If the PeopleSoft Interaction Hub files were not installed in a separate PS_APP_HOME location,
then these files will be found in PS_ HOME\data instead.

To create a portal registry load file:

1. Open portal reg load sample.xls file.

2. Save portal reg load sample.xls with a different name.
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3. Replace the existing rows with your data. The number of rows of data is not limited.

Note: Do not put commas or tabs in any of the Microsoft Excel file cells, including the description
fields. Commas and tabs disrupt the data stored as a CSV file.

4. Save the file with your data.
5. Delete the row that contains the column headings.
6. Save the file again, with the file type CSV (*.csv).

7. Place the file in a directory that is accessible to the application server for your PeopleSoft Interaction
Hub database.

For example, you could place the CSV file in the PS_ CFG_HOME\appserv\APP_SRV _DOMAIN\files
folder.

Preparing to Run the Portal Registry Load Process

This topic discusses preparing to run the portal registry load process.

Pages Used to Prepare to Run the Portal Registry Load Process

Page Name Definition Name Usage

Node Definition - Routings Page IB_ NODEROUTINGS Activate a routing definition on the
default local node.

For additional information, see
PeopleTools: Integration Broker,
“Managing Service Operation

Routing Definitions,” Adding Routing
Definitions, Adding Routing Definitions
Using the Nodes Component.

File Inbound Page EO_FILE INBOUND Define inbound file processing.

For additional information, see
PeopleSofi Integration Interfaces,
“Using the Flat File Utility,” Initiating
File Processing, File Inbound Page

Inbound File Publish Page EO_FILETOMSG Initiate file-to-message processing. The
file-to-message processing function
reads the file rowset and publishes it as a
message.

For additional information, see
PeopleSoft Integration Interfaces,
“Using the Flat File Utility,” Initiating
File Processing, Inbound File Publish
Page
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Page Name Definition Name Usage
Monitor Overview Page IB_ MONITOR OVRVIEW Review the status of the service
operation.

For additional information, see
PeopleTools: Integration Broker Service
Operations Monitor, “Monitoring
Asynchronous Service Operations,

” Monitoring Asynchronous Service
Operation Transactions.

Activating a Routing for the PORTAL_REG_LOAD Service Operation

To set up the portal registry load message:

1. In the browser, access the Node Definitions page (PeopleTools, Portal, Node Definitions)..
2. Select the default local node for PeopleSoft Interaction Hub, which is PSFT _PA.

3. Select the Routings page.

4. Click the Find link in the grid and search for PORTAL REG LOAD.

5. Activate one of the generated routing definitions.

6. Click Save to save the node definition.

Defining Inbound File Processing
To define inbound file processing:
1. Access the File Inbound page (Enterprise Components, Integration Definitions, Inbound File Rule)..
2. Select the PORTAL REG LOAD file identifier.

3. In the Inbound File field, enter the directory information for the file location on the application server
machine.

Note: The inbound file portal reg load sample.csv must reside in a directory that is accessible to the
application server.

4. Set the Status field to Active.
5. Clear the Create Message Header and Create Message Trailer options.

6. Save the definition.

Running the Inbound File Publish Process

To run the Inbound File Publish Application Engine process (EOP_PUBLISHF):
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1. Access the Inbound File Publish page (Enterprise Components, Integration Definitions, Initiate
Processes, Inbound File Publish).

2. Add or enter an existing run control ID.

3. Enter a request ID and description.

4. In the Process Frequency group box, select Once .

5. Select the file identifier that you created on the File Inbound page.
6. Click Save.

7. Click Run. Record the process instance number.

8. Click the Process Monitor link to monitor the status of the process.

Monitoring the Service Operation
To monitor the service operation:

1. Access the Monitor Overview page (PeopleTools, Integration Broker, Service Operations Monitor,
Monitoring, Asynchronous Services.

2. Check the queue status for the PORTAL REGISTRY queue.

Running the Registry Load Process

This topic discusses running the Registry Load process and review and correct errors.

Note: The user running the Registry Load process should have the role of PeopleSoft Administrator. This
will ensure that they have the necessary security to successfully load any and all content references.

Pages Used to Run the Registry Load Process

Page Name Definition Name Usage

Run Registry Load Page EO_PE RUN_LOAD Run the Registry Load process.

Registry Load Data Page EO PE REG LOAD Review and correct loaded data or errors.

Registry Load Folders Page EO _PE FLDR SEC View the folder hierarchy for the folders
that were created by the Registry Load
process.

Run Registry Load Page

Use the Run Registry Load page (EO_PE_RUN_LOAD) to run the Registry Load process.

Copyright © 1988, 2024, Oracle and/or its affiliates. 139



Using the Portal Registry Load Process Chapter 10

Navigation:

Portal Administration > Navigation > Run Registry Load

This example illustrates the fields and controls on the Registry Load page.

Registry Load
Run Control ID: PORTAL_REG_LOAD Report Manager  Process Monitor
Register Content DUpdate Folder Permissions Registry Load Limit:
Request Parameters
*Portal Name: EMPLOYEE Q,
*Portal Effective Date: 01/01/2014 [
*Expiration Date: 12/31/9999 |5
Content Provider Name: Q
Product: o)
Content Category: Q
URL Type: El

To run the Registry Load process:

L.

2.

Select the Register Content option.

Deselect the Update Folder Permissions option to skip updating the parent folders with their
children's content reference permission lists.

Updating the folder permissions can be done at any time. The Registry Load process uses the portal
registry data to update the folder permissions for the entire portal registry. It does not use the data in
the staging tables.

Leave the Registry Load Limit field clear or enter /000 to limit the number of rows that are loaded.
Select the portal registry that matches your staged registry data in the Portal Name field.

The default portal definition is EMPLOYEE.

Enter an effective date.

Enter an expiration date.

Click Run.

After the process runs, view and correct errors to the data in the staging tables using the Registry Load
Data page. Rerun the process as needed.

See the product documentation for PeopleTools: Portal Technology.

Registry Load Data Page

Use the Registry Load Data page (EO_PE_ REG _LOAD) to review and correct loaded data or errors.
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Portal Administration > Navigation > View Registry Load Data

This example illustrates the fields and controls on the Registry Load Data page. You can find definitions

for the fields and controls later on this page.

Registry Load Data

*Portal Name: EMPLOYEE

Hode Name:

Content Category:
Search

Registry Load Details

Instance: Sequence Number:
Content Reference:

Description:

Q
a
Q

Wiew Folders

Load Status: | "|

URL Type: | W |

Product: Q Instance: Q
Find | View Al First 4 1 of 1 B | ast

Delete |

Default Column:

Menu Name:

Portal Object Name: Market: Q
*Portal Name: 58 Component:
Node Hame: Record:
Portal template name: Q Field Hame:
Product: PC Event Name:
Usage Type: | "l PC Func Name:
*URL Type: | V| Edit URL/URL:
Edit URL Node:
Field or Control Description

Portal Name

Enter the portal name that was specified when you ran the
process.

Load Status

Error in Load Data: Content references were marked in error

Not Registered: The load process did not pick up the content
references. For rows that were processed but have a Not
Registered status, check to see if the content references object
name already exists in the portal registry.

Successfully Registered: Load data was successfully entered

Select the load status of the rows that you want to view. Values
are:

during the load process and were not registered.

into the portal registry.

Leave this field clear to view all rows of the staging tables,
including those rows that have not been processed.

Search

Click to retrieve applicable registry load data to the page.
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Field or Control

Description

View Folders

Click to access the Registry Load Folders page, where you can
view the folder hierarchy. The page displays the folder created
as well as the folder reference.

Registry Load Details

Field or Control

Description

Error Detail

Click for rows that are returned with the load status criteria
set to Error in Load Data. A message box displays to provide
you with the data that prevented the data row from being

registered. Types of errors include:

* Invalid portal name. Use the prompt button to see valid
values.

*  Blank content reference name (label).
*  Blank URL type (component, iScript, or external).

*  Incomplete data required for each URL type (for example,
a menu name for a component URL type).

* Invalid content provider.

+ Invalid template name.
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Understanding Search in PeopleSoft
Interaction Hub

Understanding PeopleSoft Search Framework

PeopleSoft Interaction Hub delivers enhanced search functionality that is built on the PeopleSoft Search
Framework delivered in PeopleTools. This search framework consists of PeopleSoft components (pages
and records provided by PeopleTools), which provide a centralized interface for configuring PeopleSoft
integration with a back-end search engine, creating search artifacts like search definitions, search
categories, and building and maintaining search indexes.

The PeopleSoft Search Framework enables application developers and implementation teams, to create
search artifacts in a consistent, declarative manner and to deploy and maintain search indexes using one
standard interface, regardless of PeopleSoft application.

See the product documentation for PeopleTools: Search Technology, “PeopleSoft Search Technology
Overview.”

The search framework enables users to incorporate additional sources of content into search groups and
adds additional features for users:

* Users can perform a search from anywhere in the portal and retrieve links to documents, managed
content, websites, and transactions, all in one place.

» Searches can be performed across the entire portal, or content from other content provider systems.
» Search results are filtered for security to ensure that users see only content to which they have access.

* Searches can be limited to a search group.

Understanding the Search Infrastructure

The following process occurs when a user submits a search request:
1. A user enters a search request in the Search field located in the portal header.

Depending on access security and portal configuration, a user can search the entire portal or within a
search group.

2. The query text is submitted to the PeopleSoft Search Framework.
3. The query string is passed to the search engine server.

4. The search engine server performs the search and applies security.
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The search engine server makes a call back to the PeopleSoft Search Framework where the security is
configured for each search definition.

5. The search engine server filters the search results for security and returns the search results on the
search page.

The search administrator is responsible for defining, deploying search definitions and categories, building
and maintaining the search indexes, and defining security that are integral to the search functionality.

See the product documentation for PeopleTools: Search Technology.

Understanding Search in PeopleSoft Interaction Hub

You can perform searches in PeopleSoft Interaction Hub by specifying a search string and search group
in Global Search, which is available in the portal header. After the results are displayed, you can refine
your original search or specify entirely different search criteria and search group. In addition, PeopleSoft
Interaction Hub enables users to search content using feature-based search.

Note: Both the search options require that you deploy the necessary search definitions and categories.

Deploying Search Definitions and Categories

Global Search

Global Search, formerly called Application Search, provides a way for a user to search across all or a
specific group of search indexes. Global Search is available in the portal header throughout the user's
session irrespective of the content the user is accessing in the target frame. It allows the user to search
and drill down to a specific row and transaction from the search results without navigating to the classic

component search page. Global Search can be configured to search across indexes from multiple content
provider systems.

In the following example, Global Search has been configured for a PeopleSoft Interaction Hub system.

This example illustrates Global Search in the portal header.

Home | Add to My Links | Sign out
ORACLE Discussions ~ | Search » | Advanced Search (2l Last Search Results
All
My Page Guest  Investor  Administra

Action Ttems

Personalize Content | Layout
Top Menu Features Description c ov

Our menu has changed!
g on June 15, from 11 a.m.te 2 p.m., in the HQ parking lot for a rocking good time,

The menu is now lacated across the top of the page. Click on

get started arm aboutus

Highlights

)a your family al lebrate on Thursday, September 7 at Headquarters. We'

jotlots in store for you including food, drink, and special musical

Recently Used pages now appear
under the Favorites menu, located at
the top lef

st celebrate, event, party
nd Opening in Milano

d opening will be held in a “magic,” themed location (Umanitaria), where guests will be invited to experience the Middle Ages with a fairy-tale

Tags: event, press release
Headline News

Breaderumbs visually display your Alisitors

navigation path and give you access

to the contents of subfolders

the San Francisco area

lore.

Submit Article | Update Submited Articies | [E) Feed +
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Feature-Based Search

Many features in PeopleSoft Interaction Hub provide a Search link that allows you to search for content
within the scope of that feature. You can search within each of the following:

e Action item lists

* Blogs

e Calendars

* Content management folders
» Discussion forums

* Resource Finder

*  Workspaces

Related Links
“Understanding Searching in the Portal” (Using Portal Features)

Understanding Search Definitions and Categories

A search definition maps the PeopleSoft Query fields, web source, or file source, to searchable attributes
in the search engine.

The search definition also enables you to attach security attributes to restrict access to the search results.
The search definition provides the information required by the framework to enable the system to create
search results (search documents).

Search categories enable you to group search definitions logically. Since end users run searches against
search categories, not individual search definitions, a search definition must belong to at least one search
category. It is a requirement that at least one search category exists with exactly the same name as the
search definition.

Oracle delivers the required search definitions and search categories for the features of PeopleSoft
Interaction Hub.

Important! The delivered search definitions and categories must not be modified or deleted.

Delivered Search Definitions and Categories

See the product documentation for PeopleTools: Search Technology

Delivered Search Definitions and Categories

PeopleSoft Interaction Hub delivers the following search definitions and categories.
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Important! Oracle recommends that you do not modify or delete the delivered search definitions and
categories. The exception is the PAPP_SAMPLE WEBSOURCE search definition and category, which is
delivered as sample source for the PAPP. CONTENT CRAWLED search category.

For more information on the PAPP. CONTENT CRAWLED search category, see “Understanding the
Content Categorization Process” (Content Management System).

Delivered Search Definitions

PeopleSoft Interaction Hub delivers the following search definitions.

Search Definition Description Usage

PAPP_ACTION_ITEMS Action Items This search definition contains:
*  Content from action items.

*  Document-type content with
attachments from action items.

*  Remarks from action items.

PAPP BLOGS Blogs This search definition contains content
from blogs.

PAPP BLOG POSTS Blog Posts This search definition contains content
from blog posts.

PAPP_CALENDAR EVENTS Calendars This search definition contains content

from calendar events and attachments.

PAPP_CONTENT Content Author Index This search definition is an
administrator's index accessible from
the feature search page displays active
content, regardless of published status.

PAPP_CONTENT_ PUB Content This search definition is accessible from
Global Search and includes published
content only.

PAPP_CONTENT _PUB_ARC Content Archived This search definition is a published
archived content index accessible from
Global Search. This index is optional and
is provided for users who might want to
query archived content.

PAPP_DISCUSSION_FORUMS Discussion Forums This search definition contains content
from active forums of the general
discussion category.
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Search Definition

Description

Usage

PAPP_DISCUSSION POSTS

Discussion Posts

This search definition contains:

*  Content from posts to general
discussion forums.

»  Content from posts to action items
discussions.

+  Content from posts to content
management discussions.

PAPP_RESOURCE_FINDER_EXT
COMPONENT

Resource Finder External Component

This search definition contains external
information of participants.

PAPP_RESOURCE FINDER
PARTICIPANT

Resource Finder Participants

This search definition contains
participant content.

PAPP_SAMPLE _WEBSOURCE

Sample source

Warning! Do not deploy. Remove from
PAPP CONTENT CRAWLED search
category before you deploy the search
category.

This search definition is provided as

an example of how to define a web
source. You must create a custom search
definition of type web source only.

See the product documentation for
PeopleTools: Search Technology,
“Creating Web Source Search
Definitions.”

PAPP_WORKSPACES Workspace Portals This search definition contains
workspace content.
PTPORTALREGISTRY Menu This search definition contains content

references from the portal registry.

PAPP_CW_ACTION_ITEMS

Workspace Action Items

This search definition contains:

*  Content from collaborative
workspace action items.

*  Document-type content with
attachments from collaborative
workspace action items.

*  Remarks from collaborative
workspace action items.

PAPP_CW_BLOGS

Workspace Blogs

This search definition contains content
from collaborative workspace blogs.
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Search Definition Description Usage

PAPP_ CW_BLOG POSTS Workspace Blog Posts This search definition contains content
from collaborative workspace blog posts.

PAPP_CW_CALENDARS Workspace Calendars This search definition contains content

from collaborative workspace calendars.

PAPP_CW_DISCUSSION _FORUMS

Workspace Discussion Forums

This search definition contains content
from collaborative workspace discussion
forums.

PAPP_CW_DISCUSSION POSTS

Workspace Discussion Posts

This search definition contains content
from collaborative workspace discussion
posts.

PAPP_CW_DOCUMENTS

Workspace Documents

This search definition contains content
from the Documents module of
collaborative workspaces.

PAPP_CW_LINKS Workspace Links This search definition contains collection
of links to CREFs, external URLs, etc.
from collaborative workspaces.

PAPP CW_MEMBERS Workspace Members This search definition contains
collaborative workspace member data.

PAPP_CW_WIKI Workspace Wiki This search definition contains wiki

content from collaborative workspaces.

Delivered Search Categories

PeopleSoft Interaction Hub delivers the following search categories:

Search Category

Description

Usage

PAPP_ACTION_ITEMS

Action Items

This search category is deployed
automatically when the corresponding
search definition is deployed.
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Search Category

Description

Usage

PAPP_BLOG

Blogs

Note: This search category must be
deployed manually.

This search category is a composite of
the following search definitions:

«  PAPP_BLOGS

«  PAPP_BLOG POSTS

PAPP_BLOGS

Blog

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_BLOG POSTS

Blog Posts

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CALENDAR EVENTS

Calendars

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CONTENT

Content Author Index

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CONTENT_CRAWLED

Content Crawled

This is an empty search category. It must
be deployed manually.

System audits require that a search
category include at least one search
definition. This category includes one
example category (PAPP_SAMPLE
WEBSOURCE) to demonstrate how you
might configure a web source search
definition and to ensure that system
audits pass.

Important! Before deploying the
PAPP_CONTENT_CRAWLED search
category, ensure that you remove the
example search category and replace it
with at least one valid search category.

For more information on the PAPP
_CONTENT_CRAWLED search
category, see “Understanding the Content
Categorization Process” (Content
Management System).
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Search Category

Description

Usage

PAPP_SAMPLE_WEBSOURCE

Sample source

Warning! Do not deploy. Remove from
the PAPP_ CONTENT CRAWLED
search category before you deploy the
search category.

PAPP_CONTENT_PUB Content This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CONTENT PUB_ARC Content Archived This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_DISCUSSIONS Discussions

Note: This search category must be
deployed manually.

This search category is a composite of
the following search definitions:

«  PAPP_DISCUSSION FORUMS

*  PAPP_DISCUSSION_POSTS

PAPP_DISCUSSION_FORUMS

Discussion Forums

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_DISCUSSION_POSTS

Discussion Posts

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_RESOURCE FINDER EXT
COMPONENT

Resource Finder External Component

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_RESOURCE_FINDER _
PARTICIPANT

Resource Finder Participant

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_ WORKSPACES

Workspace Portals

This search category is deployed
automatically when the corresponding
search definition is deployed.
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Search Category

Description

Usage

PTPORTALREGISTRY

Menu

This search category is deployed
automatically when the corresponding
search definition is deployed.

Additionally, this menu search category
can be expanded to include menu search
indexes from multiple content providers,
so that, when you search using the
Menu search group in the PeopleSoft
Interaction Hub system, you will see
search results from multiple content
providers, such as PeopleSoft HRMS,
PeopleSoft FSCM and so on. Also,

the search results indicate the content
provider that provides the content in each
transaction.

See Setting Up Unified Navigation Menu
Search.

PAPP CW_ACTION ITEMS

Workspace Action Items

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_BLOGS

Workspace Blog

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW BLOG CATG

Workspace Blogs

Note: This search category must be
deployed manually.

This search category is a composite of
the following search definitions:

«  PAPP_CW _BLOGS

«  PAPP_CW _BLOG POSTS

PAPP_CW_BLOG_POSTS

Workspace Blog Posts

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP CW_CALENDARS

Workspace Calendars

This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_DISCUSSION FORUMS

Workspace Discussion Forums

This search category is deployed
automatically when the corresponding
search definition is deployed.
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Search Category Description Usage

PAPP_CW_DISCUSSION POSTS Workspace Discussion Posts This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_DOCUMENTS Workspace Documents This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_ CW_LINKS Workspace Links This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_MEMBERS Workspace Members This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_WIKI Workspace Wiki This search category is deployed
automatically when the corresponding
search definition is deployed.

PAPP_CW_WORKSPACES Workspaces Note: This search category must be

deployed manually.

This search category is a composite of
the following search definitions:

«  PAPP_CW_ACTION_ITEMS
«  PAPP_CW BLOG_POSTS

- PAPP_CW_CALENDARS

«  PAPP_CW_DISCUSSION POSTS
«  PAPP_CW_DOCUMENTS

«  PAPP_CW_LINKS

«  PAPP_CW_WIKI

+ PAPP_WORKSPACES

Understanding Search Indexes

PeopleSoft Interaction Hub uses the PeopleSoft Search Framework to define search definitions and build
search indexes for use with portal searches. Before end users can submit search requests against the
deployed search objects, the search indexes must first be built on the search engine. Prior to the index
being built, a deployed search category is an empty shell, containing no searchable data. A search index
needs to be built for each individual search category.
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PeopleSoft Interaction Hub delivers search definitions and search categories for use with portal searches.
You can build search indexes using the delivered search definitions and categories.

Important! PeopleSoft Interaction Hub content is not dynamically indexed. The search results are only as
current as the last time the search indexing process (or processes) ran. It is the responsibility of the portal
administrator to ensure that search indexing is performed on a regular schedule.

The PeopleSoft Search Framework enables you to generate search indexes using these source types:
*  PeopleSoft Query and Connected Query

This option provides a familiar and intuitive way to declare the fields relevant for end user searches.
With PeopleSoft Query you define your search meta data attributes. You use the Search Framework
Designer to map query fields to meta data attributes, save the search definition to the database, and
create search categories.

*  Web source

This option enables you to index content deployed on a website that you want to make available for
end user searches.

» File source
This option enables you to index files, such as reports, residing in your file system.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search
Framework,” Working with Search Indexes.

Related Links

Building Search Indexes

Understanding Search Contexts

Search contexts define which search groups appear in the Global Search Bar, depending on the context
of the user. That is, depending on where users are in the interface, which determines their context, you
can control what appears in the drop-down. Note that a search group is just another name for a search
category that you enable for the purpose of setting up search contexts.

Search groups can be added to each of these three search contexts:

* Home Page: These are set of search groups available to select when the user is viewing the home
page.

* Portal Node: These are the search groups available if the user is accessing content from a particular
node. There can be more than one search group for the same node.

*  Work Center: These are the search groups available when the user is accessing content that is part of a
WorkCenter template. When in a WorkCenter template, search groups associated with the underlying
node will not be part of the search group drop down.

At each of these levels, a default search group can be selected. It is not required to have a default search
group for any level.
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Use the Search Administration WorkCenter to define and view search contexts. See Maintaining Search
Contexts.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search
Framework,” Managing Search Context.
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Understanding Search Index Administration

PeopleSoft Interaction Hub uses the PeopleSoft Search Framework to define search definitions and build
search indexes for use with portal searches. Before end users can submit search requests against deployed
search objects, the search indexes must first be built on the search engine. Prior to the index being built,

a deployed search category is an empty shell, containing no searchable data. A search index needs to be
built for each individual search category.

To administer search indexes on a PeopleSoft Interaction Hub system, you must:
1. Complete prerequisite software installation and configuration.

See Prerequisites.
2. Deploy search definitions and categories.

See Deploying Search Definitions and Categories.

3. Build search indexes.

See Building Search Indexes.

4. Add users to search groups.

Adding Users to Search Groups.

5. Maintain search contexts.

See Maintaining Search Contexts

See the product documentation for PeopleTools: Search Technology, “Working with Search Indexes.”

PeopleSoft Interaction Hub provides the Search Administration WorkCenter that enables access to all
the transaction pages needed to deploy search definitions and categories, administer search indexes,
and perform tasks related to the search functionality. The Build Search Index pagelet (an activity guide
pagelet) lists the tasks that you need to complete to deploy search definitions and categories and build
search indexes. The PTSF Administration pagelet, presents administrative tasks, some of which are
necessary to complete setup of search on the PeopleSoft Interaction Hub system.
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This example illustrates the pagelets in the Search Administration WorkCenter and the target content area.

ORACLE
. . . - Target content area
tour Saarch Contart
— Build Search Index
PTSF Administration pagelet | | pagelet or Activity Guide
Prerequisites

156

To configure your PeopleSoft Interaction Hub system, complete the following prerequisite steps:

L.

Configure Oracle search engine for the PeopleSoft Search Framework. In addition, configure
Integration Broker and the integration gateway on your PeopleSoft Interaction Hub system.

See the product documentation for PeopleSoft 9.2 Application Installation for your database platform.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft
Search Framework,” Working with Search Instances.

Connect your PeopleSoft Interaction Hub system to the Oracle search engine instance.

Configure single signon (SSO) between your PeopleSoft Interaction Hub system and any content
provider systems that host search indexes that you want to include in Global Search.

See the product documentation for PeopleTools: Security Administration, “Implementing Single
Signon,” Implementing PeopleSoft-Only Single Signon.

Define the URI text for the default local node (PSFT PA) and all active local portal host nodes, such
as, EMPL, CUST, PART, SUPP, and ENTP (PeopleTools > Portal > Node Definitionsand click the
Portal tab).

If the URI text is not set for PSFT_PA, you will see errors when you attempt to access search results
for PeopleSoft Interaction Hub features such as action items, blogs, content, discussion forums and so
on.

If the URI text is not set for a particular portal host node, then you will see errors when you attempt
to access search results for the portal registry assigned to that node (EMPLOYEE for the EMPL node,
and so on).
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After completing these tasks, you have to deploy search definitions and categories and build search
indexes.

See Deploying Search Definitions and Categories, Building Search Indexes.

Deploying Search Definitions and Categories

PeopleSoft Interaction Hub delivers search definitions and search categories that need to be deployed
to the search instance so that the search engine can create the structure of the search index based on the
search definition, crawl the defined search criteria, and populate the index with the results of the search
definition query. Search categories enable you to group search definitions within logical, manageable
groups.

A one—to—one correspondence must exist between a search definition and a search category. For example,
the PAPP_ ACTION_ITEMS search definition must have a search category of the same name. When you
deploy a search definition, the corresponding search category is also deployed automatically.

When a search category is a composite of multiple search definitions, the search category must be
deployed manually after deploying each of the search definitions that it contains. For example, the
PAPP_BLOG search category must be manually deployed after deploying the PAPP_ BLOGS and the
PAPP_BLOG_POSTS search definitions.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search
Framework,” Administering Search Definitions and Search Categories.

Pages Used to Deploy Search Definitions and Categories

Page Name Definition Name Usage
Deploy Search Definition Page PTSF_DEPLOY_SBO To deploy search definitions.
Deploy Search Category Page PTSF_DEPLOY_CAT To deploy search categories.

Deploy Search Definition Page

Use the Deploy Search Definition page (PTSF_DEPLOY_ SBO) to deploy search definitions to the Oracle
search instance.

Navigation:

Portal Administration > Search Administration > Search Administration WorkCenter
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This example illustrates the Deploy Search Definition page.
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| Deploy Search Definition || Deploy Search Category |

Deploy Search Definition

Deploy definition to search server

Search Category Name Y
Filter by name

Deploy Search Definition Personalize | Find | 2] | First 4/ 1-24 of 24 ‘¥ Last

| Definition Description Deploy Status Crawl Status Run Date/Time User/Run Control ID

1| 1 |PAPP_ACTION_ITEMS Action ltems  |Deployed Successtul 02/08/2013 6:32:25FH VP PAPP_ACTION_ITEMS

0| 2|PAPP BLOGS Blogs Deplayed Successful 02/11/2013 3:04:28AM VP1/PAPP_BLOGS

[1| 3|PAPF_BLOG_POSTS Blog Posts  |Deployed Successful 02/11/2013 3:06:00AM VP1/PAPP_BLOG_POSTS

0| 4|PAPP_CALENDAR_EVENTS Calendars  |Deployed Successul 0211312013 9:14:05PH VP1/PAPP_CALENDAR_EVENTS

0| 5|PaPP_CONTENT Content Deplayed Successful 02/10/2013 8:41:22PH YP1/PAPP_CONTENT
Author Index

0| 6&|PAPP_CONTENT_PUB Content Deplayed Successful 02/10/2013 8:41:37PH YP1/PAPP_CONTENT_PUB
Content

1| 7|PAPP_CONTENT_PUB_ARC il Deplayed Not Crawled

0| &|PAPP_CW_ACTION_ITEMS :”;{:ﬁﬁzr:s Deplayed Successful 0211212013 3:25:18AM VP1/PAPP_CW_ACTION_ITEMS

O a|parr_cw_BLoGS E‘;gg‘;pace Deployed Not Crawled

[/ 10|PAPP_cw_BLOG_POSTS ;‘:g;k;g;'f: Deployed Successtul 02M212013 3:25:27AM VP PAPP_CW_BLOG_POSTS

[ 11|PAPP_CW_CALENDARS '(':V:Iﬁ%?rg Deplayed Successful 0211212013 3:25:35AM VP1/PAPP_CW_CALENDARS
Workspace

[ 12 |PAPP_CW_DISCUSSION_FORUNMS Discussion  |Deployed Not Crawled
Forums

This example illustrates the Deploy Search Definition page (page 2 of 2).

13 |PAPP_CW_DISCUSSION_POSTS

Workspace
Discussion
Fosts

Deployed

Successful

02M12/2013 3:25:43AM

VP
PAPP_CW_DISCUSSION_POSTS

14 |PAPP_CW_DOCUMENTS

Workspace
Documents

Deployed

Mot Crawled

15 | PAPP_CW_LINKS

Workspace
Links

Deployed

Mot Crawled

PAPP_CW_MEMBERS

Workspace
Members

Deployed

Mot Crawled

17 |PAPP_CW_WIKI

Waorkspace
Wiki

Deployed

Mot Crawled

18 |PAPP_DISCUSSION_FORUMS

Discussion
Forums

Deployed

Successful

02M10/2013 8:19:34PN

VP17
PAPP_DISCUSSION_FORUMS

ojo|o|jo|jo o] O

19 |PAPP_DISCUSSION_POSTS

Discussion
Fosts

Ceployed

Successful

0210/2013 8:21.00PM

VP1/PAPP_DISCUSSION_POSTS

O

20 |PAPP_RESOURCE_FINDER_EXT_COMPONENT

Resource
Finder
External
Component

Deployed

Successful

02/13/2013 4:01:43AM

VP17
PAPP_RESCR_FMNDR_EXT_COMP

FPAPP_RESOURCE_FINDER_PARTICIFANT

Resource
Finder
Participants

Deployed

Successful

02M12/2012 4:00:42AM

VP
FPAPP_RESCR_FNOR_PARTICIP

[ | 22 |PAPP_SAMPLE_WEBSOURCE

Sample
source. Do
not deploy.
Remove from
Crawled
Content
Search
Category
before
deploying

Undeployed

Mot Crawled

[ | 23|PAPP_WORKSPACES

\Workspace
Fortals

Ceployed

Mot Crawled

ra
i

O PTPORTALREGISTRY

Menu

| Select All || Feport Syne lssues ||

sudit |

| Cieploy | | Undeploy ‘ ‘ Update | |

Delete |

Deployed

Successful

0210/2013 8:01.57PM

VP 1/PTPORTALREGISTRY

To deploy the delivered PeopleSoft Interaction Hub search definitions:

1. Select Portal Administration > Search Administration > Search Administration WorkCenter.
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2. On the Deploy Search Definition page, select the delivered search definitions.

Warning! Do not deploy the PAPP. SAMPLE WEBSOURCE search definition. This search

definition is delivered as sample source for the PAPP. CONTENT CRAWLED search category.

3. Optionally, select the portal registry menu definition (PTPORTALREGISTRY).

4. Click the Deploy button to deploy the selected definitions.

When the deployment completes for each search definition, the Deploy Status for the search definition

will change to Deployed.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search
Framework,” Working with Search Definitions.

Deploy Search Category Page

Use the Deploy Search Category page (PTSF_DEPLOY_CAT) to manually deploy the composite search

categories.

Navigation:

1. Portal Administration > Search Administration > Search Administration WorkCenter

2. On the Deploy Search Definition page, click the Deploy Search Category tab.

This example illustrates the Deploy Search Category page (page 1 of 2).

Deploy Search Definition || Deploy Search Category
Deploy Search Category
Deploy category to search server

Filter by name
Deploy Search Category

Select |Definition

1|0  |PAPP_ACTION_ITEMS
2|0 |PAPP_BLOG
3|0 |PAPP_BLOGS
41O PAPP_BLOG_POSTS
510 PAPP_CALEMDAR_EVENTS
6| PAPP_CONTENT
710 FPAPP_CONTENT_CRAWLED
3 PAPP_CONTENT_FPUB
90 FPAPP_CONTENT_PUB_ARC
10| PAPP_CW_ACTION_ITEMS
11| [0 |PAPP_CW_BLOGS
12| [0 |PAPP_CW_BLOG_CATG
13| [0 |PAPP_CW_BLOG_POSTS

Description

Action ltems

Blogs

Blog

Blog Posts
Calendars

Content Author Index
Content Crawled
Content

Content Archived
Workspace Action ltems
Waorkspace Blog
Waorkspace Blogs

WWorkspace Blog Posts

Personalize | Find ||l:|

Search Instance
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT

PTSF_DEFAULT

First ‘& 1-29 of 29 &/ Last

Deploy Related )
Definition Deploy Status

SElORERET Auto Deployed

Definition
Dot [unteoeo
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This example illustrates the Deploy Search Category page (page 2 of 2).
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[0 |PAPP_CW_CALEMDARS

[0 |PAPP_CW_DISCUSSION_FORUMS
[0 |PAPP_CW_DISCUSSION_POSTS
[0 |PAPP_CW_DOCUMENTS

[0 |PAPP_CW_LINKS

[0 |PAPP_CW_MEMBERS

O |PAPP_CW_WIKI

[0 |PAPP_CW_WORKSPACES

[0 |PAPP_DISCUSSIONS

[0 |PAPP_DISCUSSION_FORUMS

[0 |PAPP_DISCUSSION_POSTS

O

[1 |PAPP_RESOURCE_FINDER_PARTICIPANT
[0 |PAPP_SAMPLE_WEBSOURCE

[0 |PAPP_WORKSPACES

[0 |PTPORTALREGISTRY

Select All Report Syne Issues

Deplay Undeplay Update

Workspace Calendars
Warkspace Discussion Forums
Workspace Discussion Posts
Warkspace Documents
Woarkspace Links

Warkspace Members
Workspace Wiki

Woarkspaces

Discussions

Discussion Forums

Discussion Posts

FAPP_RESOURCE_FINDER_EXT_COMPOMENT |Resource Finder External Component

Resource Finder Participant

Sample source. Do not deploy. Remove
from Crawled Content Search Category
before deploying

Woarkspace Portals

Ienu

Delete

PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT
PTSF_DEFAULT

PTSF_DEFAULT

PTSF_DEFAULT

PTSF_DEFAULT

PTSF_DEFAULT

Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition
Deploy Related
Definition

Deploy Related
Definition

Deploy Related
Definition

Deploy Related
Definition

Auto Deployed
Auto Deployed
Auto Deployed
Auto Deployed
Auto Deployed
Auto Deployed
Auto Deployed
Deployed

Deployed

Auto Deployed
Auto Deployed
Auto Deployed

Auto Deployed

Undeployed

Auto Deployed

Auto Deployed

To deploy the PeopleSoft Interaction Hub search categories:

1.

2.

Select Portal Administration > Search Administration > Search Administration WorkCenter.

On the Deploy Search Definition page, click the Deploy Search Category tab.

On the Deploy Search Category page, select the delivered PeopleSoft Interaction Hub search

categories.

Click the Deploy button to deploy the selected search categories.

When the deployment completes for each search category, the Deploy Status for the search category

will change to Deployed.

See the product documentation for PeopleTools: Search Technology, "Administering PeopleSoft Search
Framework," Working with Search Categories.

Building Search Indexes

160

After deploying the delivered search definitions and categories, you must build search index for each
search definition. If you deploy any custom search definitions and categories, you must also build search
indexes for these custom search definitions. These search indexes provide search functionality through the
Global Search and the feature-based search pages.
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Page Name Definition Name

Usage

Build Search Index Page PTSF_SCHEDULE SI

Set up and run the Build Search Index
process.

Build Search Index Page

Use the Build Search Index page (PTSF_SCHEDULE _SI) to build search indexes for the deployed search

definitions.

Navigation:

1. Portal Administration > Search Administration > Search Administration WorkCenter

2. On the Build Search Index pagelet, for example, click the Blogs link.

This example illustrates the Build Search Index page.

T —— Build Search Index

© Deploy Search Definition

O Portal Registry

Favarites = Iain Menu~= > Portal Administration = > Search Administration > Schedule Search Index

OoORACLE’ Al ~| Search
My Page Guest Investor Adrministration

Search Administration 0 «

Run Control ID: PAPP_BLOGS  Report Manager

» |Advanced Search (3l | ast Search Results

Frocess Monitor Run

*Search Definition [PAPP_BLOGS

O Action Rerng
v (O Digcugsion Forum IEETRE) 5155
Fullindex
Calendar
Incremental Index
v O Content
< O Blogs [Fl save | [Eh Returnto Search | |[S] Motify
) Blogs
Blog Posts
+ Workspace
+ Resource Finder
PTSF Administration o av
Administration

= Search Instance

[= Detine Search Context
E DeployiDelets Object
= Remate Search Groups
= View Search Contexts
= Schedule Search Indesx
= Attachmert URLID List
Designer

= view Search Aributes
Search Definition
Search Category

lities

Search Test Page
Daowenload search data
Diagnostics

il 1 1 5

Language Option
Base Language

All Languages

S+ Add

To build a PeopleSoft Interaction Hub search index:

1. Select Portal Administration > Search Administration > Search Administration WorkCenter.

2. On the Build Search Index pagelet, click a search category for which you want to build an index. As

an example, click the Blogs link.
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The Build Search Index page appears in the target content area. The Run Control ID and the Search
Definition fields are populated with values associated with the selected search category.

Note: The delivered run controls must not be modified, so you cannot change the Indexing Type and
the Language Option. To modify these options, you have to create new run controls.

3. Click Run.

4. Use Process Monitor to verify program completion and success.

5. Repeat steps 1 through 4 to build search indexes for search categories as needed.

Adding Users to Search Groups

PeopleSoft Interaction Hub delivers default assignments of search groups to permission lists. Therefore,
for your users to access any of the Global Search search groups defined in the portal header, you must add
these users to one or more relevant roles that contain the appropriate permission list.

Note: The assignment of users to roles that contain the permission lists provides the users with access to
the search groups on Global Search only. They can access the search results on the feature-based search
pages irrespective of whether they were assigned to the permission list through a role.

Search Group

Permission List

Permission List Description

Action Items PAPP5600 Access Action Items

Blogs PAPP5710 Access Blogs

Calendars PAPP5500 Access Community Calendars
Content Crawled PAPP2010 Access Content Management
Content Management PAPP2010 Access Content Management
Discussion Forums PAPP4810 Access Discussion Forums
Published Content PAPP2000 Access Published Content
Workspaces PAPP5300 Access Workspaces

To add a user to a role that contains the delivered permission list:

1. Access the User Profiles page. (PeopleTools > Security > User Profiles > User Profiles)

2. Select the user to whom you want to assign a role.
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3. Go to the Roles page.
4. Add the role or roles that contains the delivered permission lists to this user.

This example illustrates the fields and controls on the Roles page.

General D Roles Worldflow Audit Links UserID Queries
User ID: VP
Description: Vice President of Finance
Dynamic Role Rule User Rales Personalize | Find | View All | | First [ 211 of 35 B Last
Execute on QJ Role Hame Description Dynamic View Definition
Server: EOTF_ADMIN @, Tran_sf-:urm Framewark Route Control  View Definition =
Test Rule(s) Refresh Admin
P — ] Integration - R -
on A q@ e V] antro View o +
iz B0 Integration Administratgl, Administratar Route Control iew Definition =]
Brocess Wonitor PAPLEXTERNAL_ADN[@, Frernal investor Porta! Route Contral  View Definition =
Senvi anito .
Senice Wonitor PAPI_GUEST @, Investor Portal Guest Route Contral  View Definition =
; . Investor Portal o -
Al ADIMIT, @ L V] Contro View o +
FAPI_IP_ADMIN \ Adroistrator Route Confrol  View Definition =
PAPIIP_COMMGR  |@, Communications Route Control  View Definition =
manager
PAPI_IP_EXECMGR  [@, Executive Management Raoute Contral  View Definition =]
PAPP_CONTCATG_AD|@, ?dalt_l'?i?{jnzeci Content Route Contral  View Definition =
PAPP_COMTENT_ADM@, Content Administrator Route Control  View Definition =
@, Route Contral  Wiew Definition =]

5. Save your changes.

6. Repeat steps 1 through 5 for additional users as needed.

Importing Remote Search Groups from Content Providers

When you import remote search groups, you add remote search group definitions from content provider
systems to your PeopleSoft Interaction Hub system.

Remote Search Groups Page

Use the Remote Search Groups page (PTSF_IMPORTED_SG) to import remote search groups from
content provider systems.

Navigation:
1. Portal Administration > Search Administration > Search Administration WorkCenter

2. On the PTSF Administration pagelet, under Administration folder, click Remote Search Groups.
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This example illustrates the fields and controls on the Remote Search Groups page. You can find
definitions for the fields and controls later on this page.

Chapter 12

Remote Search Groups

Import new search groups from 1B in network remote nodes or remove existing search groups

Import from remote node

Content Provider | EG—G—N import
Imported Search Groups Personalize | Find | View Al | 22 | E First ‘4 1 of 1 ‘*/ Last
Search Category Name Description Message Node Name Delete
1 Delete
Field or Control Description

Content Provider

Select the remote node defined in your system from which you
want to import search groups.

Content providers must be defined as nodes known to your
system using Integration Broker.

Import

Click to invoke the import process. This will import all search
groups from the selected node.

Note: Importing remote search groups retrieves all the search
groups defined in that content provider system along with all
related search categories, associated search definitions, and the
list of faceted attributes.

Delete

Click to remove any unnecessary or obsolete search groups
from your system.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search

Framework,” Importing Remote Search Groups.

Maintaining Search Contexts

When you add search categories to a search context, you define which search groups you want to appear
in which context in your system. You can configure search contexts for the portal homepage, for each
portal node defined in the system, and for WorkCenter templates. In this task, you will define the search

categories that appear on the portal homepage.

Define Search Context Page

164

Use the Define Search Context page (PTUS CTX DEF) to define the search categories that appear on the

portal homepage.

Navigation:

1. Portal Administration > Search Administration > Search Administration WorkCenter
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2. On the PTSF Administration pagelet, under the Administration folder, click Define Search Context.

This example illustrates the fields and controls on the Define Search Context page. You can find
definitions for the fields and controls later on this page.

Define Search Context
Add search groups which can be displayed for this context.
Context Type Home Fage
Search Context Personalize | Find | view a1l | & | E First 4 1-2 of 10 [ Last
Default Sequence *Search Category Name Description
| [ 1| |PAPP_ACTION_ITEMS ., Action ltems (=]
2| I 2| [PAPP_BLOG @, Blogs =
aig 3| |PAPP_CALENDAR_EVENTS @, Calendars =]
4 [ 4| [PAPP_DISCUSSIONS @, Discussions =]
Save
L. Return to Search t Refresh
Field or Control Description

Default

Select for the category that should be the default if the end
user does not select a particular category.

Only one default search category can be selected for a search
context.

Note: If none of the categories is selected as the default
category, then "All" will be the default, which means users can
search across all search groups to which they have access.

Sequence

Specify a numerical sequence to define the order in which the
search categories will appear in Global Search.

Search Category Name

Select the search category to include for this search context.

See the product documentation for PeopleTools: Search Technology, “Administering PeopleSoft Search
Framework,” Managing Search Context.

Creating Custom Search Definitions and Categories

A search definition maps the PeopleSoft Query fields, web source, or file source, to searchable attributes
in the search engine. The search definition also enables you to attach security attributes to restrict access
to the search results. The search definition provides the information required by the framework to enable
the system to create search results (search documents).

Search categories enable you to group search definitions logically. A search definition must belong to
at least one search category. End users run searches against search categories, not individual search
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definitions. It is a requirement that at least one search category exists with exactly the same name as the
search definition.

The PeopleSoft Interaction Hub system delivers search definitions and search categories. You can also
create your own custom search definitions and search categories.

For creating custom search definitions, see the product documentation for PeopleTools: Search
Technology, “Creating Query and Connected Query Search Definitions,” PeopleTools: Search
Technology, “Creating File Source Search Definitions,” PeopleTools: Search Technology, “Creating Web
Source Search Definitions.”

For creating custom search categories, see the product documentation for PeopleTools: Search
Technology, “Creating Search Categories.”

Setting Up Unified Navigation Menu Search

166

The PTPORTALREGISTRY search category can be expanded to include menu search indexes from
multiple content providers.

Before you configure Unified menu search group, ensure that you complete the following prerequisites
for search framework implementation in PeopleSoft Interaction Hub:

1. Configure the PeopleSoft Search Framework and deploy the required search index in your PeopleSoft
Interaction Hub system and any content provider systems. A common Oracle search engine server
must be used by all systems.

2. Configure unified navigation between your PeopleSoft Interaction Hub system and any content
provider systems.

For the steps to complete the configuration of Unified menu search group, see the product documentation
for PeopleSoft Portal Solutions 9.1 Revision 2 Installation, “Configuring Global Search Using Oracle
Secure Enterprise Search”

The following example shows unified search menu and search results that display the source of the
content in the summary:
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This example illustrates the Unified search menu.

ORACLE Al | PeopleSoft employee » |Advanced Search 3] Last Search Results
My Page Guest Investar Administration Manager Dashboard Company Directory Contracts WarkCenter Supply/Demand WarkCenter

Search Results for "PeopleSoft employee”

Filter b :
v 1112 results matched your search criteria 12345 =
Category Employee Tahle
Interaction Hub Menu (1076) Last Updated Date: 2012-11-21 09:32:25

Map external payrall system empl Dsta system empl D=
Application: Human Capital Mansgement

Human Resource Menu (36)

User Profile Types

Last Updated Date: 201 2-12-30 20:23:40

Set L User D types, such as Employee, Customer, and Yendor types
Application: PeopleSoft Interaction Hub

Participant Types

Last Updated Date: 2004-10-05 03:44:50

Uss this to define the person or things that are relevant o the business. Typically particpant types will e
people (employees, customers, etc), orgsnizations, and organizational unts (departments,

User Profile Types

Last Updated Date: 201 2-12-30 20:33:44

Set up User IDtypes, such as Employee, Customer, and Yendor types.
Application: PeopleSoft Interaction Hub

User Profile Types

Last Updated Date: 204 2-12-30 20:32:17

Set up User IDtypes, such a5 Employee, Customer, and Yendor types.
Application: PeopleSoft Interaction Hub

Administering Search for Content Management Business
Attribute Security

PeopleSoft Interaction Hub implements content search based on content management business attribute
security (CMO002) in the Global Search bar and in the search within a content management feature. For
this purpose, PeopleSoft Interaction Hub delivers additional search definitions, search categories, and
indexes. These search definitions and search categories are delivered in addition to the existing search
definitions and search categories.

See Delivered Search Definitions and Categories.

The content search functionality that is based on business attribute security is applicable to users who
have implemented the content management business attribute security (CM002).

Note: The minimum PeopleTools release required for the delivered search definitions and categories for
the content management business attribute security is PeopleTools 8.53.

Related Links
Understanding Business Attribute Usage

“Administering Content Management Business Attribute Security” (Content Management System)

Delivered Search Definitions

PeopleSoft Interaction Hub delivers the following search definitions that help to search on content that is
secured based on content management business attribute security.
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Search Definition

Description

Usage

PAPP_CONTENT ATT

Content author index (Attributes)

This search definition is an
administrator's index accessible from the
feature search page that displays active
content, regardless of published status.

PAPP_CONTENT PUB_ATT

Content (Attributes)

This search definition is accessible from
Global Search and includes published
content only.

PAPP_CONTENT PUB_ARC ATT

Content archived (Attributes)

This search definition is a published
archived content index accessible from
Global Search. This index is optional and
is provided for users who might want to
query archived content.

Delivered Search Categories

PeopleSoft Interaction Hub delivers the following search categories that help to search on content that is
secured based on content management business attribute security.

Search Category

Description

Usage

Search Group

PAPP_CONTENT ATT

Content author index
(Attributes)

This search category is
deployed automatically when
the corresponding search
definition is deployed.

No

PAPP_CONTENT PUB_ATT

Content (Attributes)

This search category is
deployed automatically when
the corresponding search
definition is deployed.

PAPP_CONTENT PUB _
ARC_ATT

Content archived (Attributes)

This search category is
deployed automatically when
the corresponding search
definition is deployed.

PAPP_CONTENT GROUP

Content author index

This search category must be
deployed manually.

This search category is a
composite of an existing
search definition and a new
search definition:

« PAPP CONTENT
(existing)

«  PAPP_CONTENT ATT
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Search Category

Description

Usage

Search Group

PAPP_CONTENT PUB_
GROUP

Content

This search category must be
deployed manually.

This search category is a
composite of an existing
search definition and a new
search definition:

+ PAPP_CONTENT_PUB
(existing)

- PAPP_CONTENT PUB
_ATT

Yes

PAPP_CONTENT PUB_
ARC_GROUP

Content archived

This search category must be
deployed manually.

This search category is a
composite of an existing
search definition and a new
search definition:

+ PAPP CONTENT PUB
_ARC (existing)

«  PAPP_CONTENT PUB
_ARC_ATT

Yes

Related Links

Delivered Search Definitions and Categories

Deploying Search Definitions and Categories

PeopleSoft Interaction Hub delivers new composite search categories, which group the existing content
management search definitions with the new search definitions as described in the Delivered Search

Categories table.

Use the Search Definition page and the Search Category page to deploy the required search definitions

and categories.

The following steps describe how to deploy search definitions and categories. For example, the steps for
deploying the PAPP_ CONTENT PUB GROUP search category and its associated search definitions are

described here:

1. Select Portal Administration, Search Administration.

2. On the Deploy Search Definition page, select the PAPP. CONTENT PUB and the
PAPP_CONTENT_PUB_ATT search definitions, and click Deploy.

If the PAPP_ CONTENT _ PUB has been deployed previously, you must undeploy it before

redeploying it.
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3. Check whether the selected search definitions are deployed successfully.

4. Click the Deploy Search Category page. Check whether the corresponding search categories are
deployed automatically.

5. Select the PAPP_ CONTENT PUB_GROUP search category, and click Deploy. Check whether the

selected search category is deployed successfully.

Related Links

Deploying Search Definitions and Categories

Defining Business Data Attributes for Content

When content management business attribute security is enabled, the Business Data Attributes link
appears on the properties page of content. The link opens the Content Business Data Attributes page
where you can define business attributes for content.

See “Content Data Attributes Page” (Content Management System).

Note: Before you build the search index for the required search definitions delivered for the content
security feature, you must define business data attributes for content.

Use the Content Business Data Attributes page (EPPCM_CONT_ATT) to define business data attributes
for content. On the properties page of content, click the Business Data Attributes link.

Building Search Indexes

170

Note: Before you build search index, ensure that you define business data attribute for content. See
Defining Business Data Attributes for Content.

When content management business attribute security is enabled, a new Content With Business Attributes
link is available on the Build Search Index pagelet that enables you to build search indexes for the new
search definitions.

The Content With Business Attributes link on the Build Search Index pagelet is not available for users
who have not activated content management business attribute security.
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This example illustrates the Content with Business Attributes option on the Search Administration

WorkCenter.
Search Administration 0 «
Build Search Index - O

Deploy Search Definition

Portal Registry

Action ltems
’ Discussion Forum
Calendar
r Content
= (O Content'With Business Attributes

) Content Management
7 Published Content
) Archived Content

k Blogs

¥ Workspace

Because the new composite search categories contain existing search definitions and new search
definitions, you must build an index for the existing search definition and the new search definition.

Use the Build Search Index page to build indexes for the deployed search definitions.

The following steps describe how to build an index. For example, the steps for building an index for the
Published Content search definitions are described here:

1. Select Portal Administration, Search Administration.
2. On the Build Search Index pagelet, click the Content link and then click Published Content.
3. Click Run. Use Process Monitor to verify program completion and success.

4. On the Build Search Index pagelet, click the Content With Business Attributes link and then click
Published Content.

5. Click Run. Use Process Monitor to verify program completion and success.

Related Links

Building Search Indexes
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Understanding Site Management

Site Management facilitates the creation and management of multiple sites from within one installation
of PeopleSoft Interaction Hub. These sites can provide content to targeted audiences or focused content
to the general PeopleSoft Interaction Hub audience. Each site is managed separately and may have its
own branding. For example, an enterprise can create a site for each division or department with unique
branding themes, navigation, and content, and with their own site administrators and publishers.

The following graphic illustrates the Site Management process flow.

Branding |
themes |
|
|
Branding |
iddministrator |
Y
: Site - Site .| Templates Move site to
Create Site —» Branding ”| Administrators [ |and Pagelets production
|
Portal | Jv
Administrator : . Appoint
Override i
— ] Brandin » Publishers
g and Viewers
Site
Administrator
Manage
content
Site v
Publisher
> Wiew site
Site
Viewer

The functions of Site Management can be performed by users or roles appointed by the portal
administrator.

1. A branding administrator creates branding theme elements that can be used on sites.

2. A portal administrator creates a site, authorizes site branding, appoints site administrators, and selects
templates and pagelets available to the site.
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3. A site administrator can override branding themes (if authorized), appoint site publishers and viewers,
set default security and templates, and configure the site's front page.

4. A site publisher can manage site navigation and content.

5. A site viewer can view the site.

Using Portal Features on Sites

This section describes which features of PeopleSoft Interaction Hub are available for use on sites. We also
indicate whether the features available on sites can be configured uniquely for that site, or must be shared
across the entire PeopleSoft Interaction Hub.

Feature Site Specific Configuration?
Branding Yes
Context Manager: Content Ratings Yes
Context Manager: Related Contacts Yes
Context Manager: Related Discussions Yes
Context Manager: Related Information Yes
Context Manager: Related Links Yes
Context Manager: Related Resources Yes
Discussion Forums Yes
Email pagelet and Calendar Events pagelet No
External News pagelets No
Inquire Menu Item Yes
Tasks pagelet No
Internet pagelets (weather, stock, and so forth) No
Language Selection pagelet No
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Feature

Site Specific Configuration?

User Logon Statistics pagelet No
Manage Navigation Yes
Managed Content Yes
My Links Yes

News Publications (and News Publication pagelets)

Yes, with appropriate security.

Pagelet Wizard

Yes—Pagelet definitions are not site specific, but pagelets can
be registered to specific sites.

Portal Registry (Favorites, tabs, pagelets, content references,
and so forth.)

Yes

Portal Options

No—Not delivered to sites by default.

Resource Finder

No

Saved Searches

No

Search Results

Yes—Results can either be local or include all sites in the
portal.

Navigation Collections

Yes

Site Manager Center

Yes
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Navigating in PeopleSoft Interaction Hub Site Management

PeopleSoft Interaction Hub Site Management provides custom navigation pages that contain groupings of
folders that support a specific business process, task, or user role.

Note: In addition to the PeopleSoft Interaction Hub Site Management custom navigation pages, the
PeopleSoft system provides menu navigation and standard navigation pages.

See the product documentation for PeopleTools: Applications User's Guide.

Using the Site Manager Center
Navigation:
Access a site. Click the Site Manager Center link at the root level of the menu.
These options are also available from the Administration tab on the site's homepage.

This example illustrates the Site Manager Center page.

TS ForT At S
Site Manager Center Edit"Ste Manager Center” Collecton

nd maintain custom sites. Configure the content and layout of the current site

P

tom sites. Configure the homepage tab display of the current site nd Managed Content pagelets for the current ste.

Use the Site Manager Center accessed from within a site to manage the site's security, layout, and
publishing, and branding.

The following tables list the custom navigation pages and how to use them to navigate in PeopleSoft
Interaction Hub Site Management.

Site Administration

This table lists the features that you can access from Site Administration:

Page Name Usage

Define Site Security Specify who is authorized to publish or view site content.
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Page Name Usage

Define Publishing Defaults Specify the publishing defaults that apply to each new element
added to the site unless specifically overridden on that
element.

Configure Homepage Configure the layout and select the pagelets to be displayed on

the site's default homepage.

Specify Site Features Select the features that are accessible within the site.

Site Publishing

Maintain the navigation and Managed Content pagelets for the current site. This table lists the features
that you can access from Site Publishing:

Page Name Usage

Manage Navigation This utility is used to administer the menu folders and links for
this site.

Update Content Pagelets Edit the content ID associated with existing Managed Content
pagelets.

Using the Site Publisher Center
Navigation:
Access a site. Click the Site Publisher Center link at the root level of the menu.
These options are also available from the Administration tab on the site's homepage.

This example illustrates the fields and controls on the Site Publisher Center page.

Main Menu =

Site Publisher Center Edit "Site Publisher Center” Collection

Links to features within the site through which content can be created and published

E" Manage Navigation E Navigation Collections Pagelet Wizard
Manage the navigational menu tems for this site. Creats and Update Navigation Cellections for this site, Define Pagelet Wizard pagelets. Pagelet Wizard definitions
are not site epecific. The publizhed pagelet is site specific.

E" Content Pagelets E Action tems E Community Calendars
Edit the Content ID associated with existing Managed Access the Action em Lists and Action tems for this site. Access the community calendars for this site.

Content Pagelets for this site.

E" Discussion Forums E Create Discussion Forum Polls
Access the dizcussion forums where you are authorized. Creats a new dizcussion forum. Access the poll definttions where you are authorized

ﬁ" Managed Content ﬁ Categorized Content ﬁ Hews Publications
Access the Managed Content tems for this site. Access the Categorized Content tems for this site. Access the News Publication tems for this site.
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Understanding Site Creation and Management

The Site Manager Center page consolidates access to the activities required to create and manage sites.
Enterprises that require multiple sites within their main portal can use the Site Management tools to
quickly create and configure subsites to their portal. These sites inherit characteristics from the main
portal, but maintain their own navigation. Sites can also employ branding specifically designed to meet
the site's requirements.

Site Management enables a portal administrator to create new sites that inherit infrastructure properties of
the sponsor portal. The portal administrator initially specifies site branding, page templates, and pagelets,
and assigns site administrators. Subsequent site management can be delegated to site administrators who
set publishing defaults and lay out the site’s homepage. The site administrator also manages security for
site content publishers and site viewers.

See the product documentation for PeopleSoft Portal Solutions 9.1 Revision 2 Installation, “Creating
Content Provider Navigation Collections.”

Create and maintain a site by:
1. Creating a new site definition.
A portal administrator normally defines portal sites.
or:
2. Updating an existing site definition.
A portal administrator normally manages portal sites.
3. Selecting from available branding themes.
A branding administrator normally defines branding themes.
Administer a site by:
1. Setting site security.
2. Setting publishing defaults.
3. Configuring the site homepage.
A site administrator normally administers site navigation.
Publish content to a site by:

1. Managing site navigation.

Copyright © 1988, 2024, Oracle and/or its affiliates. 179



Managing Sites

2. Updating homepage content.

Chapter 15

If you choose a site administration or management task within the main portal, it takes effect for the
portal. To perform administration or to manage navigation for a site, you must first access the site. To do
this, select Go to Site on the Manage Sites page and then navigate to the task you want to perform. Within
a site, only site administration and site navigation management tasks will be available.

Common Elements Used in Site Management

Field or Control

Description

Branding theme

A branding theme definition consists of headers, an optional
footer, a theme style sheet and optional skins for classic
components, and theme style sheet mappings for fluid
components. Each site can use any branding theme defined in
the system. See “Themes, Headers, and Skins” (Branding).

In addition, you can use the PeopleTools branding features

to create header, footer, and theme definitions to distinctly
brand a site. See PeopleTools: Portal Technology, “Using
PeopleTools Branding Features,” Understanding PeopleTools
Branding.

Note: Branding user attributes—such as USER_ BASED

and ROLE BASED delivered with PeopleTools, and SITE
BASED delivered with PeopleSoft Interaction Hub—cannot
be used to brand Site Manager sites. The SITE_ BASED
attribute is to be used to brand PIA sites (also called PIA
domains). See “Branding User Attributes” (Branding) for more
information.

Portal

As used in the context of site management, the portal is the
default portal, as specified on the Portal Definitions page
(PeopleTools > Portal > Portal Definitions). The portal
is sometimes called the sponsor portal, because other sites can
inherit elements of the sponsor portal.

Create new sites using the Site Wizard only from the portal.
The delivered default portal is the EMPLOYEE portal.

PS_SITETEMPLATE

PS_SITETEMPLATE is a defined collection of templates,
pagelets, and menu items on which all new sites are based.
These values are stored in a portal registry of the same name,
and can be accessed in the Structure and Content component

using the corresponding portal URL address.

Site

A site is created using the Site Wizard. Each site is defined
in relation to the defaults and themes of its sponsor portal.
Each site could be considered a separate portal, but instead
PeopleSoft distinguishes between a portal and its sites.
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Field or Control Description

Site administrator A site administrator is the person authorized by a portal
administrator to manage security, publishing defaults, branding
overrides, and homepage layout for a site.

The site administrator can be assigned by role or by user ID.

Site management Site management is the set of tasks grouped together in
PeopleSoft Interaction Hub to create and manage sites.

Site publisher A site publisher is a person authorized by a site administrator
to manage site navigation and update homepage content. A site
publisher can be assigned by role or by user ID.

A site publisher is not a site viewer unless specifically
authorized as a viewer.

Site viewer A site viewer is a person authorized by a site administrator to
view site content.

A site viewer can be assigned by role or by user ID.

Creating Sites

This topic discusses fulfilling various requirements when creating a site.

Pages Used to Create Sites

Page Name Definition Name Usage

Site Wizard - Site Definition Page EPPSM_SITE DEFN Define portal sites.

Site Wizard - Authorize Site Branding EPPSM_SITE BRNDING Select the branding theme for the site.

Page

Site Wizard - Appoint Site Administrator | EPPSM_SITE ADMIN Specify the users or roles authorized to

Page administer this site.

Site Wizard - Select Site Features Page | EPPSM_SITE FEATURE Specify the features you want to enable
on the site.

Site Wizard - Select Site Features Page | EPPSM_SITE TEMPLTS Specify the templates available to site
publishers when adding links to the site
menu navigation.
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Page Name

Definition Name

Usage

Site Wizard - Specify Site Pagelets Page

EPPSM_SITE PAGELTS

Specify which pagelets will be available
to site administrators when configuring
the site homepage.

Site Wizard - Site Definition Page

Use the Site Wizard - Site Definition page (EPPSM_SITE DEFN) to define portal sites.

182

Navigation:

e Portal Administration > Site Management > Create New Sites

*  Click the icon for step 1 while you are on any page in the Site Wizard.

* Portal Administration > Site Management > Maintain Existing Sites. Click the Add New Site

button.

Portal Administration > Site Management > Maintain Existing Sites. Click the Edit button.

This example illustrates the fields and controls on the Site Wizard - Site Definition page. You can find
definitions for the fields and controls later on this page.

Site Wizard

O-0-0-0-0-@
Site Definition

*Site 1D PBDemo

Site Label: PeopleBook Demo

Step 1 of 6

et ==

Long Description:

*Default Template: 8.4y default template

Link to Site (Optional)

Label:

You may specify information to create a menu link to the site.

&

Navigation Folder:

v

patient as this may take a few minutes.

Create Site

Save

Before continuing to the next step of the wizard, you must create your new
site by clicking the "Create Site” button below. After you have done so, be
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Field or Control

Description

Site ID Specify a site ID to identify this site. The site ID cannot
contain spaces.
The site ID is used as the identifier for the portal registry
created to support this site.
The Site ID field value appears in the list of sites you can
select from on the Manage Sites page.

Site Label Enter the label you want to use for the site. This site label

appears in email alerts for the site.

Long Description

Enter a description of the site.

The long description appears as the link hover text for this site
in the sponsor portal's menu navigation.

The Long Description field value appears in the list of sites
you can select on the Manage Sites page.

Default Template

Select a default template for site content from the drop-down
list box.

The default template is used for all content pages within the
site unless overrides are authorized by the site administrator
in the Define Publishing Defaults component. The templates
available in the drop-down list box are those defined in PS
SITETEMPLATE.

Label

Specify a label that will appear in the sponsor portal's
navigation.

Navigation Folder

Select the navigation folder in which you want a link to this
site to appear on users' menus.

This link definition is optional. The link can be created later
using the Managing Navigation component within the portal to
add a link with the type Portal Site.

See Managing Site Navigation.

Folders available in the drop-down list box are those available
in the sponsor portal.

Note: If you choose to select a navigation folder for this site,
the link may not appear in the portal menu until the menu is
refreshed.
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Field or Control Description

Create Site After defining the new site, click to initiate the system
processing for site creation. This process can take several
minutes; do not interrupt it.

A message appears to indicate successful creation of the new
site and to prompt you to continue to the next step.

Related Links

Permission Lists and Roles Cloned When Creating Sites

Site Wizard - Authorize Site Branding Page

Use the Site Wizard - Authorize Site Branding page (EPPSM_SITE BRNDING) to select the branding
theme for the site.

Navigation:
» Click Next on the Site Wizard - Site Definition page.
*  Click the icon for step 2 while you are on any page in the Site Wizard.

This example illustrates the fields and controls on the Site Wizard - Authorize Site Branding page. You
can find definitions for the fields and controls later on this page.

Site Wizard Step 2 of B
OeO=O=02020 == Previous Mext ==
Authorize Site Branding

Select the branding theme for the site. By default, the site will inherit the default branding theme.

Branding Options

Theme Hame DEFALULT_THEME_TANGERIME_ALT |3
Save
Field or Control Description
Theme Name Select the branding theme to be used for the site from the
branding theme definitions in the system.

Site Wizard - Appoint Site Administrator Page
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Use the Site Wizard - Appoint Site Administrator page (EPPSM_SITE ADMIN) to specify the users or
roles authorized to administer this site.
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Navigation:
*  Click the Next button on the Site Wizard - Authorize Site Branding page.

*  Click the icon for step 3 while you are on any page in the Site Wizard.

Managing Sites

This example illustrates the fields and controls on the Site Wizard - Appoint Site Administrator page. You

can find definitions for the fields and controls later on this page.

Site Wizard Step 3 of 6
ORORORORORO zsbreous] o bodez
Appoint Site Administrator
Specify who is authorized to perform site administration tasks on the new site.
Security Privileges
Type *Authorization Entry Description
Role w | |PAPP_SITE_MGMT_ADMING,  Site Management Administrator =]

Field or Control Description

Type Select the type of site administrator you want to define for this
entry: User or Role.

Authorization Entry Based on the value you selected in the Type field, specify an

authorized administrator by user ID or role.

Site Wizard - Select Site Features Page

Use the Site Wizard - Select Site Features page (EPPSM_SITE _FEATURE) to specify the features you

want to enable on the site.
Navigation:
* Click the Next button on the Site Wizard - Appoint Site Administrator page.

*  Click the icon for step 4 while you are on any page in the Site Wizard.
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This example illustrates the fields and controls on the Site Wizard - Select Site Features page.

Site Wizard Step 4 of 8

®_®_®_®_®_® == Previols Mext ==

Select Site Features

Select the features to enahble on your site.

Features
Select Feature Name Description

Action ltems Access assignable task-based action items and lists
Categorized Content Access the Categorized Content itemns for the site
Community Calendars Access shared community-based calendars
Discussion Forums Access threaded discussions topics within forums
Manage Mavigation Manage the navigational menu items for the site
Managed Content Access the Managed Content items for the site
Mavigation Collections Create and update navigation collections
Mews Publications Access the Mews Publication items for the site
Fagelet Wizard Define Pagelet Wizard pagelets
Polls Create and access Poll definitions

Use this page to enable features for your site. Features that are not selected still exist in the system, but
will not be visible in the site unless they are selected. Data and content references are hidden from the
portal navigation, but not deleted. The list of features comes from PS_SITETEMPLATE and includes
content references, pagelets, and folders.

Site Wizard - Specify Site Templates Page

Use the Site Wizard - Specify Site Templates page (EPPSM_SITE _TEMPLTYS) to specify the templates
available to site publishers when adding links to the site menu navigation.

Navigation:
*  Click the Next button on the Site Wizard - Appoint Site Administrator page.

*  Click the icon for step 5 while you are on any page in the Site Wizard.
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This example illustrates the fields and controls on the Site Wizard - Specify Site Templates page. You can
find definitions for the fields and controls later on this page.

Site Wizard

O-0-0-0-0-6
Specify Site Templates

as required.

Templates
*Template Name

PT_84%_DEFAULT_TEMPLATE Q
DEFAULT_TEMPLATE Q
PT_85X_FRAMES_TEMPLATE Q
BPNAVTEMPLATE Q
PAPP_EPPCM_NWHTML3COL Q
EOPF_DEMO_TPRGLT_TEMFLATE |Q
PTCXM_DYNAMIC_CON_TEMPLATE|Q,
PTCXM_DYNAMIC_CON_TEMPLATE | @,
PTCHM_LN_MANAGER Q
PAPP_NAVFRAMETPL Q
PRTL_TEMPLATE_PASSWORD_EXF|Q,
PAPP_EO_PE_HOMEPAGE_DESIGN @
HOMEPAGE_DESIGNER_TEMPLATE|Q,

PT_HOVERMAY_TEMPLATE Q
PT_IFRAME_TEMPLATE Q
FAPP_DEFALULT_TEMPLATE Q

Label

8.4x default template

8.50 default template

8.50 frames template

BP Mav Template

Ch - Mews - HTML 3Column
Cemo Template Pagelet Template
Dynamic Content Template - FRM
Dynamic Content Template -IFRM
Dynamic Template Manager
EntPortalMavFrameTpl

Expired Passward Template
Header, hover menu and target
Header, target anly template
Hover nav iframe template

Inline Frame Template

Interaction Hub Default

N i B A S R A
00 00 O] O OO [0 0O O] 07 [0 [0 O] O 00 00 [

Step 5 of 8

== Preyvious

The following templates are currently available on your site. Adjust the list by adding or deleting templates,

Mext ==

This initial set of templates is the complete list of available templates based on the PS_ SITETEMPLATE
registry. All templates are initially assigned to new sites. You can add or delete templates as required.

Note: Site publishers can only apply templates if the site administrator selects the Can select own
template(s) option on the Set Publishing Defaults page accessed for the site. Otherwise, the default
template specified during site definition always applies.

Field or Control

Description

Template Name

This value is the content reference name assigned to the
template in the PS_SITETEMPLATE template folder.

When a site is created, all of the templates in PS_ SITETEMPLATE are copied to the site. You can
add site templates from the templates in PS_ SITETEMPLATE or from the default portal, but not from
another site. If you delete a template from the site, the template is deleted only from this site, not from

PS SITETEMPLATE.
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See the product documentation for PeopleTools: Portal Technology.

Site Wizard - Specify Site Pagelets Page

188

Use the Site Wizard - Specify Site Pagelets page (EPPSM_SITE PAGELTYS) to specify which pagelets
will be available to site administrators when configuring the site homepage.

Navigation:

* Click the Next button on the Site Wizard - Specify Site Templates page.

*  Click the icon for step 6 while you are on any page in the Site Wizard.

This example illustrates the fields and controls on the Site Wizard - Specify Site Pagelets page. You can
find definitions for the fields and controls later on this page.

Site Wizard

ONORORORORG
Specify Site Pagelets

pagelets, as required.

Pagelets
*Portal Pagelet Name

PTA_ACTGUIDE_IP_PGLT
PAPP_MENU_SCR
PT_SC_PGT_MAIN_MENU

MENU

PT_S4X_MENU
PT_PSRF_REPRT_PAGELET GBL
PT_MEMU_NEW_FEATURES
PSRF_RLIST_COMP_GBL
PAPP_RSS_NEWS_SCR
PAPP_EPPCM_FAV_PGLT_GBL

FAPF_SITE_WELCOME

PAPP_SITE_PUBLISHER_HOMEF

The following pagelets are currently available on your site. Adjust the list by adding ar deleting

Label
31, Activity Guides - In Progress
QL Enterprise Menu
1 WMain Menu
1 Menu
Q1 Menu - Classic
C My Reports
QL Top Menu Features Description
Q1 Report List
Q) Feed Reader
2 My Managed Content

FAPF_EPPCM_NWINBOX_PGLT_GB|Q, My MNews Content

Q1 Site Welcome

ADMM_EPFCM_CMFOLDERMAVIGATC, Browse Managed Content
PAPF_SITE_MAMAGER_HOMEPAGE |, Site Manager Center

QL Site Publisher Center

StepGofb

== Previous

e B B = R R
[0 00 0] O [0 00 00 0] O 0 00 00 00 @0 [

The initial list of pagelets is the complete list of pagelets based on the PS_SITETEMPLATE registry. All
pagelets are initially assigned to new sites. You can add or delete pagelets as required.
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Note: The portal administrator can copy any pagelet over from the default portal into the site using the
portal's Structure and Content copy feature. Before doing so, the portal administrator must ensure that a
pagelet's functionality is suitable for use on the site, both technically and functionally.

Field or Control Description

Portal Pagelet Name Specify the portal pagelets available from the sponsor site that
will be available to users of this site.

This value is the content reference name assigned to the
pagelet in the PS_SITETEMPLATE pagelet folder.

Making a portal pagelet available does not automatically
make the pagelet appear on a user's homepage. Each user can
configure the homepage by adding and arranging pagelets.

Related Links
“Understanding PeopleSoft Interaction Hub-Delivered Pagelets” (Using Portal Features)

Managing Sites

This section discusses how to maintain sites using the Maintain Existing Sites component
(EPPSM_SITE_WIZARD).

Page Used to Manage Sites

Page Name Definition Name Usage
Manage Sites Page EPPSM_MANAGE_SITES Access and manage portal sites.

Manage Sites Page
Use the Manage Sites page (EPPSM_MANAGE_SITES) to access and manage portal sites.
Navigation:

Portal Administration > Site Management > Maintain Existing Sites
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This example illustrates the fields and controls on the Manage Sites page. You can find definitions for the
fields and controls later on this page.

Manage Sites
Sites Find |0 88 First M 12 or 2 B L ast
Site Name Long Description
DEMOSITE Demonstration Site Edit Delete Goto Site
PBEDEMO Edit | | Delete Goto Site
Add Mew Site
Field or Control Description
Edit Click to access the Site Wizard - Site Definition page of the

Site Wizard, where you can edits values entered when the site
was created.

Delete Click to delete the site. You will be prompted to confirm your
deletion.

Go to Site Click to access the site.

Add New Site Click to access the Site Wizard - Site Definition page of the

Site Wizard, where you can create a new site.

190 Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 16

Administering Sites

Understanding Site Administration

Site administration activities can only be performed on a site created with the Site Wizard. The same
functionality is not suitable for portal administration on the default portal.

An authorized site administrator performs these site administration tasks. A portal administrator assigns
site administrators on the Site Wizard - Appoint Site Administrator page (step 3) when creating a site
definition or maintaining existing site definitions.

Defining Site Security

This section discusses how to define site security.

Page Used to Define Site Security

Page Name Definition Name Usage
Site Security Page EPPSM_SITE _SECURTY Specify site publishers and viewers by

role or user ID.

Site Security Page

Use the Site Security page (EPPSM_SITE _SECURTY) to specify site publishers and viewers by role or
user ID.

Navigation:

Portal Administration > Site Management > Define Site Security

Copyright © 1988, 2024, Oracle and/or its affiliates. 191



Administering Sites Chapter 16

This example illustrates the fields and controls on the Site Security page. You can find definitions for the
fields and controls later on this page.

Site Security
Specify who is authorized to publish or view site content.

The "Publisher” can view the site and update menu items and content for workgroup pagelets.
The "Viewer” can access the site and view all applicable content.

Site 1D: FS_SITETEMFLATE

Security Privileges

Site Privilege  Type Authorization Entry Description

Fublisher Role SITE_PS_SITETEMPLATE_FUB

Viewer Role SITE_PS_SITETEMPLATE_VWR

'Fublisher »||User || [FPAPP_DEMOADM @, Demo Test/ Site Administrator [=]
|Publisher »||User »| [PAPP_BRANDINGADM Q_ Branding Administrator [=]
|"-.-"iE'-.-u'er v||User v| TELMGR Q, Telemarketing Manager E|
|F'L|h|isher v||User v| WP ), Vice President of Finance =]
|"-.-"iE'-.-u'er v||User v| WP @, Vice President of Finance E|

An authorized site administrator sets site security by specifying which users and roles can publish to or
view the site.

Publishers can publish content on the site, post links to the site's menu navigation, and update content for
homepage pagelets.

Viewers can only view the site and its contents. A publisher cannot view the site unless specifically
defined as a viewer.

Site administrators do not have rights to view or publish to the site by default. Include the site
administrator by user ID or role in the list of authorized site publishers and viewers, as required.

When creating a site, a user is granted access to features and given permissions to publish for a that
specific site. Because PeopleTools will automatically propagate those permissions to all sites (including
Employee, Supplier, and so on), PeopleSoft Interaction Hub uses a filter to hide those content references
from the navigation to ensure that users do not have access to the content management content references
or folders in main sites. This keeps publishers from a specific site from having access to publishing
options on sites where they may not have specific permissions. Those links do not show in the navigation
or navigation collection. Only permissions on the native site apply.

Field or Control Description

Site Privilege Select from:
*  Publisher. A publisher can publish content on the site.

. Viewer. A viewer can view site content.
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Field or Control Description

Type Select the type of security authorization you want to define for
this entry: User or Role.

Authorization Entry Based on the value you selected in the Type field, specify a
user ID or role.

Defining Site Publication Defaults

This section discusses how to define site publication defaults.

Pages Used to Define Site Publication Defaults

Page Name Definition Name Usage
Set Publishing Defaults Page EPPSM_SITE DEFAULT Specify default content publication and

expiration dates and set the publisher
template option.

Set Publishing Defaults Page

Use the Set Publishing Defaults page (EPPSM_SITE_DEFAULT) to specify default content publication
and expiration dates and set the publisher template option.

Navigation:
Portal Administration > Site Management > Define Publishing Defaults

This example illustrates the fields and controls on the Set Publishing Defaults page. You can find
definitions for the fields and controls later on this page.

Set Publishing Defaults

Specify the publishing defaults that apply to each new element added to the site unless
specifically overridden on that element.

Site ID:  PES_SITETEMPLATE

Default Content Dates Fublisher Template Selection
Publication Date: Expiration Date. (& Can select own template(s)
011212012 |[5) 0113112013 ([ O Must use site default template
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An authorized site administrator can set site defaults. The defaults set by the administrator affect the
entries made on the Manage Navigation page accessed for the site.

Default Content Dates

Field or Control

Description

Publication Date

Specify the default publication date for new links created
using the Manage Navigation page for the site. An authorized
publisher can override the default publication dates of

individual content entries.

Expiration Date

Specify the default expiration date for new navigation links.
The individual content expiration dates can be overridden by

an authorized publisher.

Publisher Template Selection

Field or Control

Description

Can select own template(s)

Select to enable an authorized site publisher to select from the
templates supplied to the site during site creation.

Must use site default template

Select to require an authorized site publisher to use the default
template specified on the Site Wizard - Site Definition page
during step 1 of site creation.

Configuring the Site Homepage

This section discusses how to configure the site homepage.

Pages Used to Configure the Site Homepage

Page Name Definition Name

Usage

Configure Homepage - Tab Content Page | PORTAL TAB_ CON_ADM Specify the pagelets included in the

homepage definition for this site.

Configure Homepage - Tab Content Page

Use the Configure Homepage - Tab Content page (PORTAL _TAB CON_ADM) to specify the pagelets

included in the homepage definition for this site.
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Navigation:
* Access the site. Navigate to Portal Administration > Pagelets > Configure Homepage.

* Access the site. PeopleTools > Portal > Structure and Content. Click the Portal Objects link.
Click the Homepage link. Click the Tabs link. Click the Edit link for the My Page label. Click the
Tab Content tab.

This example illustrates the fields and controls on the Configure Homepage Tab - Tab Content page.

Content Layaut

Tab Content
Label: My Page

* Select the pagelets that can be used for this homepage tab definition.

* Selectthe "Include all?” checkbox to display all pagelets from the portal registry
for this category. This setting is used for the "Personalize Content” page.

* Setthe pagelet behavior with the drop down list next to the selected pagelet.

Search Pagelets (7

This pagelet search will allow the user to search the local and remote pagelet's based on the search criteria
and the node selection.

Fagelet Search

< PeopleSoft Applications = MNews
Clinclude alli? [l Include all?
[ Activity Guides - In Progress | Optional | Feed Reader
Enterprise Menu Optional  |w My Managed Content
] Main Menu Optional  |» My News Cantent
] Menu Optional v Site Welcome
[0 Menu-cClassic Optional “
O MWyRepors Optional | »
Iosmore oo
Report List Optional |

= Portal Administration
[l Include all?

Browse Managed Content Optional w

Site Manager Center Optional “

Site Publisher Center Optional w

Return to Home

Select the pagelets that you want to appear on the site's homepage and specify each pagelet's behavior.

Pagelets selected to appear on the site homepage create the default homepage. If authorized to personalize
their homepage, users can add pagelets and configure the homepage layout.

See the product documentation for PeopleTools: Portal Technology.
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Using the Site Publisher Center

The Site Publisher Center is a navigation collection that lists every feature that is used in publishing. Site
administrators will have additional links beyond what the site publisher can access.

Managing Site Navigation

This section provides an overview of site navigation management and discusses how to manage site
navigation.

Pages Used to Manage Site Navigation

Page Name Definition Name Usage
Manage Navigation Page EPPNA REG ADMIN Add, delete, and manage menu folders

and links for the site. Use the Manage
Navigation page instead of directly
addressing content references (CREFs)
in the portal registry or through the
Structure and Content pages. Provides
simplified access to the portal registry
for the current site. Provides a unified
interface for management of the menu
folders and links for the site.

Select New Parent Folder Page EPPNA_NEW_PRNT Use a hierarchical representation of
the portal registry to select the parent
folder into which you want to move the
selected element.

Manage Navigation Page

Use the Manage Navigation page (EPPNA REG_ADMIN) to add, delete, and manage menu folders and
links for the site.

Use the Manage Navigation page instead of directly addressing content references (CREFs) in the portal
registry or through the Structure and Content pages. Provides simplified access to the portal registry for
the current site. Provides a unified interface for management of the menu folders and links for the site.

Navigation:

Copyright © 1988, 2024, Oracle and/or its affiliates. 197



Publishing to a Site Chapter 17

198

Portal Administration > Navigation > Manage Navigation.

This example illustrates the fields and controls on the Manage Navigation page.

Manage Navigation

This utility is used to administer the menu folders and links for this site. To begin, you can find a specific menu item, or you can use the
tree to the left to manually select a menu item. Within the menu tree on the left, clicking on a folder icon will open or close that folder.
Clicking on a falder or link name will apen that menu item and display its details.

First | Previous | Next | Last | Left | Right b Find
(= PS_SITETEMPLATE Link Detail

E=Y y Favorites PS_SITETEMPLATE = My Cantent » Ly Polls

Administration

Utilities Add Folder Add Link Save Cancel Delete

Active Analytics Framework

Enterprise Components *Label; Iy Paolls

= "" Content i Long Description:  |#ccess the poll definiions where you are

[Browse by Category] (254 Characters) | autherized.
[Create Discussion Farum)
[Review Action ltems] Link Type: | PeopleSoft Generic URL w |
B [Submit News Articles] Mode Name: |.'—".I'-.-Va:-'5 use local v|
[My Action ltem Lists]
[ lerts] URL: C/EQ_PE_PORTAL_ADMIN.EPPSP_LST_POLL.
. : GBL

[My Community Calendars]
[My Discussion Forums] (Example: http:/hwww peoplesoft.com)
[My Polls]
B py managed Content Go to the Portal Registry Entry for this CREF
[My Categorized Content]
[My Mews Content] I Additional Options
Content Management - Placement in folder
Partal Administration
Waorkist b Select New Parent Folder

Tree Manager
Reporting Tools
FPeopleTools

HI HI EI HI EI HI

The Manage Navigation page provides an interface to the portal registry for tasks specific to the current
site based on site defaults.

It is a front-end to the portal registry, which stores site navigation. Site administrators may not be familiar
with the portal registry and may not have the security required to access portal administration functions.
Authorized site administrators can manage their site's content and navigation without having access to the
registry for other sites or to the default portal.

Site publishers can use the Manage Navigation page to post content to the site and manage its navigation.
Publishers can specify the content source, template (if authorized in the Define Publishing Defaults
component), and the content's placement in the site navigation, as well as create folders and delegate
folder administration.

Only site administrators (as authorized by the portal administrator) and site publishers (as authorized by
the site administrator) can manage site navigation. Site administrators can use the Manage Navigation
page to change the navigation menu's structure or to create folders for new content, for example. Site
publishers can use the Manage Navigation page to add or move folders for site content or add links to
content, for example.

The Manage Navigation page initially displays the site's navigation menu and a Find group box. You can
browse through the hierarchy by expanding and contracting folders. Alternatively, you can use the Find
group box to locate a menu item by name.
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Click on a folder or content reference link to select the item with which you want to work. The selected
item will appear highlighted in yellow anywhere it appears on the page.

Managing Folders and Links
After you select or add a folder, the Folder Detail group box appears.

This example illustrates the fields and controls on the Folder Detail group box.

I Find

Folder Detail
P5_SITETEMPLATE = Transportation

Add Folder Add Link Save Cancel Celete

*Label: Transportation

Long Description: | Transportation
(254 Characters)

30 to the Portal Reaqistry Entry far this folder
= Additional Options
Publish Date: 01/01/2000 |[3)

Expiration Date: Eﬂ

= Placement in folder

Placement in folder: | 03 - After Administration W

Selectthe items to move to a new location.
Select Bew Parent Falder

(= Transportation
Menu ltems
Shuttle Schedule

BART Schedule

After you select or add a link, the Link Detail group box appears.
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This example illustrates the fields and controls on the Link Detail group box. You can find definitions for

the fields and controls later on this page.

Link Detail
PS_SITETEMPLATE = Transportation = Office Infarmation

Add Falder Add Link Save Cancel

*Label: Office Information

Delete

Long Description: | ©ffice Information

(254 Characters)

Link Type: | External URL

Hode Hame: Always use local

URL: hitp:/fwww.oracle.com

(Example: http:/fwrwe peoplezoft.com)

o to the Portal Registry Entry for this CREF

= Additional Options

Template Name: |

[ Mo Template
(] open Link in New Window

Publish Date: 01/011900 (=)

Expiration Date: Eﬂ

Search Key Words:

= Placement in folder

Placement in folder: | 01 -First

= Select New Parent Folder
Selectthe items to move to a new location.
Select Mew Parent Folder
[] [= Transportation
Menu ltems
O

Office Information

Shuttle Schedule

Field or Control

Description

Add Folder

Click to add a folder within the selected folder.

Add Link

Click to add a new link within the selected folder.
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Field or Control Description

Save Click to save the new or modified folder or link.

Cancel Click to cancel the creation or modification of the folder or
link.

Delete Click to delete the folder or link. You will be prompted to

confirm your deletion.

Label Specify the label that will appear in the menu.
Long Description Specify a description that will appear as the hover text for the
label.
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Field or Control

Description

Link Type

This field displays in the Link Detail group box.

Select the link type from the drop-down list box, and specify
the required information for the selected link type:

Content Management Folder. Create a link to a content
management folder.

External URL. Create a link to a URL to an external site.
File Attachment. Create a link to a file.
Managed Content. Create a link to managed content.

PeopleSoft Query. Create a link to a predefined PeopleSoft
database query.

Portal/Site. Create a link to any site or main portal accessible

from the current site.

If you are a portal administrator managing navigation on the

default portal, the following additional link types are available:

PeopleSoft Component. Create a link to a PeopleSoft

component.

PeopleSoft iScript. Create a link to a PeopleSoft iScript, which
can return anything. Generally, iScripts are used to return
information placed on pagelets. In this case, you can point to
an iScript as a target.

PeopleSoft Generic URL. Create a link to a generic URL in
your PeopleSoft database. This option enables you to point
to any PeopleSoft object (iScript, component, and so forth)
as a generic URL. You may choose to use this option rather
than specifying an iScript or component when you are not
required to inherit the security specified on that object. You
can then place your own security on the target to which you
are pointing.

Portal Name

Select a portal that contains the folder you want to link to
using the Content Management Folder.
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Field or Control

Description

Node Name

Select the node through which the material to which you
want to create a link should be accessed. Available nodes are
comprised of defined content providers from which content

can be retrieved and rendered.

This field displays in the Link Detail group box for the
PeopleSoft Component, External URL, PeopleSoft Generic
URL, and PeopleSoft IScript link types.

Menu Name

Enter the menu in which the component to which you want to
create the link resides.

This field displays in the Link Detail group box for the
PeopleSoft Component link type.

Market

Select the market for the component to which you want to link.

This field displays in the Link Detail group box for the
PeopleSofi Component link type.

Component

Enter the name of the component to which you want to link.

This field displays in the Link Detail group box for the
PeopleSoft Component link type.

Additional Parameters

Enter any additional parameters you want to use to locate the

content to which you want to link.

This field displays in the Link Detail group box for the
PeopleSoft Component and PeopleSoft IScript link types.

URL Enter the URL to which you want to link, including the
leading http://.
This field displays in the Link Detail group box for the
External URL and PeopleSoft Generic URL link types.

Add Attachment Click to access a page where you can browse for and upload

the file attachment to which you want to create a link.

This button displays in the Link Detail group box for the File
Attachment link type.
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Field or Control Description

Select Content Click to access the Select Managed Content page, where you
can search for and select the managed content to which you
want to create a link.

This button displays in the Link Detail group box for the
Managed Content link type.

See “Importing Managed Content into Other Features”
(Content Management System).

Record (Table) Name Enter the name of the record to which the iScript you want to
link is associated.

This field displays in the Link Detail group box for the
PeopleSofi IScript link type.

Field Name Enter the name of the field to which the iScript you want to
link to is associated.

This field displays in the Link Detail group box for the
PeopleSoft IScript link type.

Event Name Enter the name of the event to which the iScript you want to

link to is associated.

This field displays in the Link Detail group box for the
PeopleSoft IScript link type.

IScript Name Enter the name of the iScript to which you want to link.

This field displays in the Link Detail group box for the
PeopleSoft IScript link type.

Query Name Enter the query to which you want to create a link.

This field displays in the Link Detail group box for the
PeopleSoft Query link type.

Site ID Select the site to which you want to create a link.

This field displays in the Link Detail group box for the Portal
Site link type.
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Field or Control

Description

Go to the Portal Registry Entry for this CREF

Select to access the Content Ref Administration page, where
you can access additional options for the selected link in the
portal registry.

This link displays in the Link Detail group box for an existing
link or a newly created link that has been saved.

See the product documentation for PeopleTools: Portal
Technology, “Administering Portals,” Administering Content
References.

Go to the Portal Registry Entry for this folder

Click to access the Folder Administration page, where you can
access additional options for the selected folder in the portal

registry.

Note: This option is only available to portal administrators.

This link displays in the Folder Detail group box for an
existing folder or a newly created folder that has been saved.

See the product documentation for PeopleTools: Portal
Technology, “Administering Portals,” Administering Folders.

Additional Options

Field or Control

Description

Template Name

Select a template to apply to the new link. This option is only
available if authorized by the site administrator.

This field displays in the Link Details group box.

No Template

Select if you do not want to apply a template to the link
content. When you select this option, the Template Name
field does not display.

This field displays in the Link Details group box.

Open Link in New Window

Select to indicate that you want the link contents to open
in a new browser window instead of in the current browser

window.

This field displays in the Link Details group box.

Publish Date

Specify an effective date for this element.
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Field or Control

Description

Expiration Date

Specify an expiration date for this element.

Search Key Words

Specify keywords you want to use to identify this link in a
search of this site. The search engine will pick up this text to
be able to include the link in a search collection for the site.

Placement in Folder

Field or Control

Description

Placement in Folder

Specify the placement of the element in the new parent folder.

Select the item or items that you want to move. The tree displays one level of the tree, enabling you to
select a folder within that level. To select all folder items displayed in the tree, select the parent folder. To
select one or more folder items in the tree, clear the check box for the parent and select the children items
individually. For content references, the tree shows the parent folder and all of the sibling folders. If you
select the parent, then all of the child items are selected.

Navigation:

Click the Select New Parent Folder button on the Manage Navigation page to access the Select New
Parent Folder page, where you can use a hierarchical representation of the portal registry to select the
parent folder into which you want to move the selected element.
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This example illustrates the fields and controls on the Select New Parent Folder page.

Publishing to a Site

mmmmmmmmal EI HI HI EI HI HI EIEEI

Manage Navigation
Select New Parent Folder

Select a folder from the tree below. Click the name of a folder to select that falder, or click the Cancel
button to return without making a new selection.

Left | Right

= ps
(= [y Favarites
Administration
(= Transportation

_SITETEMFLATE

[Office Information]
[Shuttle Schedule]
[BART Schedule]
Utilities

Active Analytics Framewark
Enterprise Components
Iy Content

Cantent Management
Portal Administration
Worklist

Tree Manager
Reporing Tools
PeopleTools

[Autharization Configuration]

[Signn Event Message]
[Algarithm Chain]
[Change My Passward]
[My Personalizations]
[My System Profile]

[My Dictionary]

[My Feeds]

Cancel

The items that you have selected to move to a new folder appear highlighted. Click the name of the folder
that you want to move the items to, and the system will display a confirmation message ensuring that you

want to proceed with the move. Click Cancel to not move the item.

Updating Site Homepage Content

This topic discusses Update Content Management-based site pagelet content.
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Pages Used to Update Site Homepage Content

Page Name Definition Name Usage

Content Pagelets Page EPPPB_ WRKGRP_SRCH Access Content Management-based
pagelets defined as site pagelets for the
current site.

Edit Content for Pagelet Page EPPPB. WRKGRP DET Update content for Content
Management-based site pagelets.

<Content Title> Page EPPCM_PUB_VIEWHTML Preview the content that you have
selected to display on the site pagelet.

Click the Content Title link on the Edit
Content for Pagelet page.

See “Related Information <Content
Title> Page” (Using Portal Features)

Look Up Managed Content Page EPPCM_PUB_SELECT Select the new content you want to
display on the site pagelet.

Click the Re-Select Content button on
Edit Content for Pagelet page.

See “Importing Managed Content into
Other Features” (Content Management
System)

Understanding Updating Site Homepage Content

A site administrator can use the Update Homepage Content page to update the content displayed on a site
pagelet if the pagelet meets the following criteria:

*  The pagelet was created with Pagelet Wizard.
e The pagelet's data source is Content Management.

For example, you can use this functionality in a scenario in which you prepare seasonal sales
announcements in Content Management in advance and then access this page to post the content to the
site pagelet on the date required.

Related Links
“PeopleSoft Interaction Hub Content Management System Features” (Content Management System)
Content Pagelets Page

Use the Content Pagelets page (EPPPB. WRKGRP_SRCH) to access Content Management-based
pagelets defined as site pagelets for the current site.

Navigation:
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Portal Administration > Pagelets > Content Pagelets

This example illustrates the fields and controls on the Content Pagelets page. You can find definitions for
the fields and controls later on this page.

Content Pagelets

The following lists the content pagelets registered in the current site. These pagelets render a
Managed Content HTMLText itemn. Click "Edit to assign new content to the pagelet definition.

Search Results | ()] 1 of 1
Pagelet Title Content Title
Mew Construction Update Mew Headquarters Construction Update Edit
Field or Control Description
Edit Click to access the Edit Content for Pagelet page, where you
can assign new content to the pagelet definition.

Edit Content for Pagelet Page

Use the Edit Content for Pagelet page (EPPPB. WRKGRP DET) to update content for Content
Management-based site pagelets.

Navigation:

Click the Edit button on the Content Pagelets page.

Copyright © 1988, 2024, Oracle and/or its affiliates. 209



Publishing to a Site Chapter 17

This example illustrates the fields and controls on the Edit Content for Pagelet page. You can find
definitions for the fields and controls later on this page.

Content Pagelets
Edit Content for Pagelet

Click the content title to review the currently published content. Click Re-Select Content far the pagelet
to display a different content item. Click Save to use the reselected content.

Pagelet Information

Pagelet ID: DEMO_FAC _BUILDIMG
Pagelet Title; Mew Construction Update
Description:

Content Information

Content Title: Mew Headquarters Construction Update
Content D 1399
Folder Title: Facilities Site Content
Re-Select Content Return to List
Field or Control Description
Content Title Click to access the Preview Workgroup Pagelet Content page,

where you can preview the content that you have selected to
display on the site pagelet.

Click the prompt button to select from a list of managed
content.

Re-Select Content Click to access the Look Up Managed Content page, where
you can select the new content you want to display on the site
pagelet.

See “Importing Managed Content into Other Features”
(Content Management System).
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Moving a Site Between Databases

This section discusses how to move a site and its associated data between databases. For example, you
might create and configure a new site on a development database before transferring the site and its
associated data to a production database.

This example illustrates the fields and controls on the Insert into Project dialog box.

Insert into Project

Definition Type: IF'n:nrtaI Reqiztry D efinitions j Irzert

— Galection Criteria — Related Definitions Close

Merie: I Paortal Begistry Structures

MHew Search

| Select Al
Dwner D I.é-.ll I =l :

Definitionz matching zelection criteria:

| el

Partal M ame
CUSTOMER

EMPLOYEE
MOBILE

PORTAL
PS_SITETEMPLATE
SUPPLIER

|? definition[z] found

To move a site and its associated data between databases:

1. In PeopleSoft Application Designer, create a project containing the entire registry definition for the
site.

a. Select Insert > Definitions into project.
b. Select the Portal Registry Definitions value in the Definition Type drop-down list box.
c. Select Portal Registry Structures in the Related Definitions area.

d. Click Insert.
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e. Select the name of the site in the Portal Name area.

f. Save the project.

2. Insert any additional structures associated with the site into the project.

These may include images, HTML objects, PeopleCode, and so forth, if such objects have been
created for a customized site.

3. Move this project to the target database by navigation to Tools > Copy Project.
4. Move branding definitions associated with this site, such as headers, footers, and themes.

The Themes page of the Branding WorkCenter provides mechanism to generate a Data Migration
Workbench project to migrate a branding theme and associated definitions to another database. See
“Themes Page” (Branding).

5. Move pagelet definitions for any pagelets associated with this site that were defined with Pagelet
Wizard.

See the product documentation for PeopleTools: Portal Technology, “Using Pagelet Wizard.”

6. If you have implemented any other features such as Content Management, News Publications, or
Discussion Forums, recreate them in the site on the target database.

See the product documentation for PeopleTools: Application Designer Developer's Guide.
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Setting Up Integration with Third-Party
Email and Calendar Systems

Understanding Basic Email and Calendar Setup Steps

Note: PeopleSoft Interaction Hub will not support newer versions of Lotus Notes. It will continue
to support Lotus Notes 8.0 or prior versions. If you are using Lotus Notes email client then you can
configure the IMAP mail defaults to setup email.

See Integrating With an IMAP Server for further information on integration with the IMAP server.

The following steps provide a roadmap for setting up the Email pagelet and Calendar Events pagelet.

Note: Detailed setup instructions for each third-party email system are described later in this topic.

1. The portal administrator configures application and email servers.

Lotus Domino.
Install the delivered PeopleSoft jar file, com.peoplesoft.pa.pp.jar on the application server.
Copy the Lotus Dominao NCSO.jar file to the application server.

Make the relevant changes on the Domino server end and perform other operating-system-related
setting changes.

See Integrating With Lotus Notes Email and Calendar.
Microsoft Exchange.

Install the delivered PeopleSoft Active Server Page files in the relevant places and change the
security.

See Integrating With Microsoft Exchange 2003 and 2007.
POP mail.
Download and install the required files from the Java site.

Install the delivered PeopleSoft jar file, com.peoplesoft.pa.pp.jar on the application server. Enter
the POP mail server name and the URL for the POP mail inbox on the Email and Calendar
Defaults page.

See Integrating With a POP Server.

IMAP mail.
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Download and install the required files from the Java site.
Install the delivered PeopleSoft jar file, com.peoplesoft.pa.pp.jar on the application server.

Enter the IMAP mail server name and the URL for the IMAP mail inbox on the Email and
Calendar Defaults page.

See Configuring the Primary Email System to Use IMAP.

2. The portal administrator and individual users complete the integration with the Email pagelet and
Calendar Events pagelet:

a. The portal administrator selects and sets up the primary email and calendar on the E-mail and
Calendar Defaults page.

See Designating the Primary Mail System.

b. Each user sets up the pagelet's user ID and password.

Understanding Application and Mail Server Configuration

In accordance with the primary email and calendar systems that are selected for the Email pagelet and
Calendar Events pagelet, system administrators must configure servers with special settings, files, and
views. It might also be necessary to configure the servers for any additional POP mail systems.

These topics provide information about setting up the following supported applications and mail server
configurations:

*  Microsoft Exchange/Outlook 2003 and 2007 Email and Calendar on Windows.
¢ Lotus Domino 6.5, 7.0, and 8.0 Email and Calendar.

*  POP mail.

e IMAP mail.

See the product documentation for PeopleTools: Portal Technology.

Related Links
Setting Up Additional Mail Systems

Integrating With Microsoft Exchange 2003 and 2007

This section provides an overview of prerequisites for integrating with Exchange 2003 and discusses:
* How to install and configure ASP files for Microsoft Exchange 2003 and 2007.

* Implementation tips for integrating with Microsoft Exchange 2003 and 2007.
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Understanding Integration with Microsoft Exchange

The Email pagelet on the portal homepage can display email from Microsoft Exchange when it is
designated as the primary mail system. It requires Outlook Web Access (OWA), which enables access
to Outlook using a browser. OWA requires that a Microsoft Internet Information Server (IIS) be running
with access to an Exchange server. PeopleSoft Interaction Hub supports integration with Microsoft
Exchange/Outlook 2003 and 2007 on Windows.

In the PeopleCode, an iScript makes a request to the ASPs on the Exchange server. The ASPs send back
a response in HTML format. PeopleCode then extracts the HTML to get the relevant email and calendar
data and then formats the information and displays it in the Email and Calendar Events pagelets.

On the Exchange server side, ASPs, based on the WebDAV (Web-based distributed authoring and

versioning) protocol are installed. You can search the Microsoft website to learn more about WebDAV.

Related Links
Integrating With Microsoft Exchange 2003 and 2007

Prerequisites
Before integrating Microsoft Exchange with the PeopleSoft Interaction Hub, you must:
* Plan for the functionality that you need.
* Install the Windows 2003 server and related systems.

Exchange must be installed in a domain that contains a Windows 2003 server that is configured as a
domain controller with a global catalog.

Note: During the Windows 2003 server setup, you must install the Network News Transfer Protocol
(NNTP) service.

* Install the Microsoft Exchange 2003 or Microsoft Exchange 2007 server. Refer to the installation
guide.

* Create mailboxes for users on the Exchange server.

Select Active Directory Users and expand the domain name to see the Users folder.

Installing and Configuring Active Server Page Files for Exchange
You can perform the following steps only after the Microsoft Exchange server has been installed.
To install and configure ASP files:
1. Create a new folder, such as c:\aspcode, on the Microsoft Exchange machine.
2. Copy the following files into the newly created folder:
* For Microsoft Exchange 2003:

Psmsinbox2003.asp
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Psmcal2003 1day.asp
For Microsoft Exchange 2007:
Psmsinbox2007.asp

Psmcal2007 1day.asp

3. Map the new folder to the Virtual Directory for Exchange 2003/2007 using Microsoft Internet
Services Manager (ISM):

a.

Access ISM from your Windows machine by navigating to Start > Programs >
Administrative Tools.

Expand the left-side Domain name folder to see the Default Web Site folder.
Right-click and select New > Virtual Directory.
This starts a wizard, which takes you through the relevant steps.

In the wizard, select the folder that contains all of the PeopleSoft ASP files as the source (for
example, c:\aspcode).

It is important that you select the same folder in which you installed the delivered PeopleSoft ASP
files.

For easy reference, give the virtual directory the same name as the folder in which you installed
the delivered ASP files (for example, aspfolder).

Note: Once you have mapped the folder to the virtual directory, you will see your virtual directory
and its contents in the ISM folder's Default Web Site.

4. Ensure that the Basic Authentication value is used as the directory security for the virtual directory.

a.

Access ISM from your Windows machine by navigating to Start > Programs >
Administrative Tools.

Go to the Default Web Site in the domain folder and find your mapped virtual directory, as
specified in step 3e.

Right-click and select Properties.
Select the Directory Security tab and select Anonymous Access and Authentication.

Select Basic Authentication.

Important! The URL that you use on the Email and Calendar Defaults page must use the format http.//
<servername>/<aspfolder>, where aspfolder is the folder name that is used in the virtual directory
specified above. If this folder name is not the virtual folder name, the integration will not work.

When the configuration of applications and mail servers is complete, proceed to assigning the primary
mail system in the PeopleSoft Interaction Hub.
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See Designating the Primary Mail System.

Implementation Tips for Configuring Exchange

If the pagelet cannot display the messages, but the Microsoft Outlook link on the pagelet works, check the
following:

1.

In the browser, enter a URL using the following format, replacing the domain and user ID with the
individual user's email account and user ID:

http://<Outlook Web Access server name>/aspfolder/Psmsinbox2003.asp?
mailbox=<userid>&exchsvr=
<Exchange Server name>&numrows=5

For Microsoft Exchange 2007 replace 2003 with 2007.

If there is an error on this website (that is, on an ASP page), then the folder in which you stored the
delivered PeopleSoft ASP files is not properly mapped as a virtual drive.

If the virtual drive is correctly mapped, but this URL site still generates errors that are MAPI-related,
then check the IMS security to ensure that the Basic Authentication value has been selected.

See Installing and Configuring Active Server Page Files for Exchange.

If after changing the security you still receive MAPI-related errors when trying to access the above
URL, then perform the following verifications on the Members Of tab of the User Properties in
Active Directory Users and Computers.

a. Navigate to the Members Of tab by going to Windows Start > Programs > Administrative
Tools > Active Directory Users and Computers.

b. Select the Users folder in the left-side domain folder.
c. Right-click the appropriate user and select Properties.

d. On the Members Of tab, look at all domains for which the user is a member and try to make the
user a member of the relevant domains and directories.

Correcting the Member Of properties can resolve several MAPI-related permission issues with
the above URL.

Identifying Typos in Output Parameters

Make the following setting changes to display debugging information on the pagelet. It displays data that
is being sent. Check the accuracy of this data.

To identify typos in output parameters:

L.

2.

In PeopleSoft Application Designer, open the record WEBLIB_EMAIL.
Open the FieldFormula PeopleCode.

Search for the following iScript function:

Function IScript mail ()
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Locate the second line of the function:

&Debug = False;

Set the value to True.

The set of statements should now look like the following:

Function IScript mail ()
/* Set the debug flag to True, for getting all the debug information,
/* otherwise set it to false */
&Debug = True;
&titleStyle = "PABOLDBLUETEXT";

Save.

The debugging information will display on the pagelet.

Ensuring That Microsoft Exchange is Working Over the Web

To ensure that Microsoft Exchange is working:

1.

2.

Click the Microsoft Outlook link that displays on the Email pagelet.
Supply the user ID and password in the dialog box.

Ensure that you use the <DOMAIN NAME>\<User Id> format when specifying a user outside of the
domain in which the Microsoft Exchange server resides.

If this link opens a web-based outlook, then proceed to the next section. If the link does not open, then
contact the Exchange server administrator.

Checking the Outlook Web Access URL

To verify that the Outlook Web Access URL is working:

1.

Use the following format for an Outlook Web Access URL:

http://<Outlook Web Access name>/aspfolder/Psmsinbox2003.asp?
mailbox=<userid>&exchsvr=
<Exchange Server name>&numrows=5

For Microsoft Exchange 2007 replace 2003 with 2007.

Open a new browser window and enter the appropriate URL for your version of Exchange. Login
when prompted. Tabular data consisting of mail headers should be returned.

If this step does not work, then the errors may possibly be the result of a setup issue. Return to the
Exchange administration steps to verify the setup issues.

See Installing and Configuring Active Server Page Files for Exchange.

If this step works, but email is still not accessible, then add a few emails to the account and try again.

If this is working, then try the next section.
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Understanding Browser Errors

This section explains several browser error messages that may display for the Email pagelet integration,
along with possible associated errors.

* Page cannot be found error.

This error screen could mean that the file psmsinbox2003.asp (or psmsinbox2003.asp) is not available.
This can happen because:

» Either the file is missing, or because the virtual folder is wrong or not mapped correctly.

* There's a typographical error in the file name.

* Network password error.

If the Enter Network Password dialog box displays after executing the OWA that was formed, it
may be because the domain name, user ID, or password entered for the user is missing or wrong.

* Page cannot be displayed error.
This page can display under two circumstances.

» If'this page appears when you place the OWA URL in the browser, verify that the OWA server
name is correct.

» This page can also appear when the URL tries to access a resource that does not exist due to a
wrong mailbox or a wrong Microsoft Exchange server name.
* You are not authorized to view this page.

This page appears if the either the user ID or password are incorrect.

Integrating With Lotus Notes Email and Calendar

This section provides overviews of the Lotus Notes email and calendar integration and prerequisites, and
discusses how to integrate with a Lotus Domino server to retrieve email and calendar information.

Note: PeopleSoft Interaction Hub Revision 3 and higher releases will not certify any newer version of
Lotus Notes. It will only support Lotus Notes 8.0 or prior versions.

Understanding Integration with Lotus Notes Email and Calendar

The Email pagelet on the PeopleSoft Interaction Hub homepage can display email from Lotus Domino
server when Lotus is designated as the primary mail system. Integration requires a specific configuration
of the portal application server and a hub Domino server.

How the Integration Works

PeopleSoft Interaction Hub integrates with Lotus Notes mail files to retrieve an individual’s email and
calendar appointment lists. To retrieve this information from each user’s mail file, PeopleSoft Interaction
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Hub uses the Notes Client Side Objects (NCSO) to interact with the Domino server. The NCSO uses
Internet Inter-ORB Protocol (IIOP) to exchange data and communicate internally. A server task needs to
be set up on the Lotus Domino server to work with the Domino Object Request Broker DIIOP (Domino
Internet Inter-ORD Protocol) to allow the internal communication.

Enabling iNotes

iNotes is the web-enabled solution for Lotus Notes. To enable users to launch iNotes from the Email

pagelet, you must specify the iNotes URL on the Email and Calendar Defaults page.
Prerequisites

The following prerequisites must be in place:

* All mail files at an organization must refresh from a single mail file template, or there must be some
other easy way for a Lotus Notes administrator to add two hidden custom views to each user's mail
file.

* There is a single Domino server that can run both the HTTP and DIIOP tasks for access by the portal.
This server should use Java security and have the corporate name and address book on it.

» All users at the organization have an internet password stored in their Person document in the Lotus
Name and Address Book on the Domino hub server.

* A custom view that is added to the address book provides the location and file name of each user's
mailbox.
Integrating With Lotus Notes

Complete the steps outlined in this section to configure the Lotus Notes email and calendar functions.

Placing the NCSO.Jar file on the Application Server Machine
To place the NCSO.Jar file on the application server machine:
1. Copy the Lotus Domino NCSO.jar file from LOTUS HOME\Domino\data\domino\java\NCSO jar.
2. Place the NCSO.jar file on the PeopleSoft application server in the appropriate directory.
For Windows-based application servers place the file in PS CFG_HOME\class\.
For UNIX-based application servers place the file in PS CFG_HOME/appserv/classes/.

3. Add the NCSO . jar and com.peoplesoft.pa.pp.jar files to the environment variable CLASSPATH.

Completing the Lotus Notes Integration

After setting up your Lotus Notes client application servers, complete the following Lotus Notes setup
steps.

This section discusses how to:
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Configure the Lotus Domino server.

Place custom views in Lotus templates.

Related Links
Designating the Primary Mail System

Configuring the Lotus Domino Server

To configure the Lotus Domino Server:

1.

2.

3.

4.

Configure Java/COM Restrictions on the Lotus Domino Server.
Enable I1OP.
Set up Session Based Authentication.

Verifying Web settings.

Configuring Java/COM Restrictions on the Lotus Domino Server

To configure Java/COM restrictions on the Lotus Domino server:

1. Access the Lotus Domino Administrator.

2. Select Configuration tab from the navigation bar.

3. Select Server.

4. Double click your server name from the list (or on current server document if you have only one
server).

5. Select Edit Server.

6. Select the Security tab.

7. Scroll to the section labeled Run restricted Java/Javascript/COM and enter an asterisk character (*) in
the text area provided.

8. Scroll to the section labeled Run unrestricted Java/Javascript/COM and enter an asterisk character (*)
in the text area provided.

9. Click the Save and Close link.

Enabling IIOP

The Lotus Notes Pagelets implementation uses the Notes Client Side Objects to communicate with the
Lotus Domino server. The Notes Client Side Objects internally use IIOP (Internet Inter-ORB Protocol) to
communicate and exchange object data. To allow this communication, a server task that runs on the Lotus
Domino Server and works with the Domino Object Request Broker DIIOP (Domino Internet Inter-ORB
Protocol) needs to be enabled.

To enable IIOP:

L.

Access the Lotus Domino Administrator.
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2. Select the Configuration tab.

3. Double click your server name from the list (or on current server document if you have only one
server).

4. Select the Ports: Internet Ports tab.
5. Click on the DIIOP tab to go to the IIOP Server screen.
6. Verify that TCP/IP Port number is 63148 (default port).
7. Verify that TCP/IP Port status is Enabled.
If not, then select Enabled and click Save and Close to save the changes.
8. Now, if it is not already started, start the DIIOP server task on the Lotus Domino Server.

To start the DIIOP server task, enter this command on Lotus Domino Server console: load diiop.

Setting Up Session Based Authentication

Before publishing the Lotus Notes Pagelets, you need to set up Session Based Authentication for Web
clients who have access to a Domino Web server.

To set up session based authentication:

1. Access the Lotus Domino Administrator.

2. Select Configuration tab from the navigation bar.
3. Select Server.

4. Double click your server name from the list (or on current server document if you have only one
server).

5. Select Edit Server.
6. Select Internet Protocols: Domino Web Engine.
7. Inthe HTTP Sessions section, for Session Authentication, select Single Server.

8. Click the Save and Close link.

Verifying Web settings

To verify web settings:

1. Access the Lotus Domino Administrator.

2. Select the Configuration tab from the navigation bar.
3. Select Server.

4. Double click your server name from the list (or on current server document if you have only one
server).

5. Select Edit Server.
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6. Select the Ports: Internet Ports: Web tab.

7. Under Authentication Options select Yes for the Anonymous option.

Placing Custom Views in Lotus Templates
To place custom views in Lotus templates:
1. The portal administrator sends the Portal Lotus Views.nsf file to the Lotus Notes administrator.

This file is provided on the PeopleSoft Interaction Hub CD and can be found in PS_ APP_ HOME/
scripts folder.

Note: If the PeopleSoft Interaction Hub files were not installed in a separate PS APP_ HOME
location, then this file will be found in PS HOME instead.

The Lotus Notes Administrator performs the following steps.
2. Open the Portal Lotus Views.nsf file in the Lotus Domino Designer.

3. Copy the two views, PS PORTAL MAIL and PS PORTAL CALENDAR, into the mail file template
that is used for all mail files in the organization.

4. Copy the view PS PORTAL MAIL LOCATION either into the Name and Address Book template
in the organization (if one is used) or into the Name and Address Book of the hub Domino server that
the portal application server accesses to retrieve user mail file information.

a. Ifthe organization uses customized Domino user names that are not any of the entries listed in
the User Name field of the Person document in the Name and Address Book, then customize the
PS PORTAL MAIL LOCATION view that you just copied.

b. To customize this view, open it in Lotus Domino Designer and change the first column of the view
to reflect the customized Domino user names used in the organization.

For example, if the entries in the User Name field are John Smith/ACME Corp and
John Smith, but a custom Domino user name of jsmith is used, the column formula is
@Left(FirstName;1)+LastName.

c. Change the first column of the PS PORTAL MAIL LOCATION view only if the system uses
custom Domino user names that are not any of the entries in the User Name field.

Integrating With a POP Server

This section provides an overview of post office protocol (POP) configuration and prerequisites, and
discusses how to extract .jar files.

Understanding POP Configuration

The setup for POP mail is optional. It is required only when the portal administrator has designated a
primary mail system that is POP-based or has set up additional email selections for the email pagelet.
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POP mail requires correct placement of third-party .jar files from the Sun website to the portal application
server.

POP mail integration requires the following:
* If you access POP mail on an internal mail server, that mail server must be POP-enabled.

e Ifyou access POP mail from an external mail system, the remote POP mail server to which you point
must be POP-enabled.

Also, users must set up their external mail accounts to POP forward.

Extracting .jar Files for POP Email Integration

224

This section discusses how to extract the following Sun jar files into the <PS_ CFG_HOME>\class
Directory of the NT portal application server:

e mail jar
* activation.jar

* pop3.jar

Note: When you transfer .jar files, be sure to use binary transfers, not ASCII transfers. Also, you must
install the required Java files in the proper directory for each portal application server.

Extracting mail.jar (JavaMail)
To download mail jar:

1. FTP download mail.jar (JavaMail) from http://www.Jjavasoft.com/products/
javamail/index.html.

2. Extract the mail jar file into the PS_ CFG_HOME!\class directory on each portal application server.

3. Delete the javamaill 1 3.zip file.

Extracting activation.jar (JavaBeans Activation Framework)
To download activation.jar:

1. FTP download activation.jar (JavaMail) from http://www.javasoft.com/products/
javamail/index.html.

2. Extract the activation.jar file into the PS CFG_HOME-\class directory on each portal application
server.

3. Delete the jafl 0 1.zip file.

Extracting pop3.jar (POP3 Provider)

To download pop3.jar:
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1. FTP download pop3.jar (POP3 Provider) from http://www.javasoft.com/beans/
glasgow/jaf.html.

2. Extract the pop3.jar file into the PS_ CFG_HOME-\class directory on each portal application server.

3. Delete the pop31 1 1.zip file.

Note: The Sun Microsystems website from which the drivers are downloaded is external to PeopleSoft,
and its content and layout might change at any time. For assistance in locating files on the Sun
Microsystems website, contact Sun Microsystems.

Integrating With an IMAP Server

Since IMAP is an internet protocol, the configuration required by the portal administrator are:
* Installing the delivered PeopleSoft jar file, com.peoplesoft.pa.pp.jar on the application server.

* Entering the IMAP mail server name and the URL for the IMAP mail inbox on the Email and
Calendar Defaults page.

See Configuring the Primary Email System to Use IMAP.

Designating the Primary Mail System

The administrative information that you assign drives both the Email pagelet and Calendar Events
pagelet. The portal supports Lotus Notes/Domino, Microsoft Outlook Web Access/Exchange, POP3,

and IMAP systems for email, and Lotus and Microsoft for calendars. Remember that only one email and
calendar system is designated as the portal's default system. The default system is considered primary and
is the first email section on a user's pagelet. It is possible to override the system default for an individual
user.

This topic discusses how to configure the Primary Email System.

Note: For the pagelets to be fully functional, you must complete setup procedures for the application and
mail servers.

Pages Used to Assign Mail Servers

Page Name Definition Name Usage
Email and Calendar Defaults Page EO_PE ADMIN Designate the primary email and

calendar system for the portal.

Email and Calendar by User Page EO PE ADMIN OPR Add overriding email and calendar
settings for an individual user ID.
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Related Links

Understanding Application and Mail Server Configuration

Email and Calendar Defaults Page
The Portal Administrator designates the primary email and calendar system.

Use the Email and Calendar Defaults page (EO_PE_ADMIN) to designate the primary email and calendar
system for the portal.

Navigation:
Portal Administration > Pagelets > Email / Calendar > Email / Calendar Defaults

This example illustrates the fields and controls on the Email and Calendar Defaults page. You can find
definitions for the fields and controls later on this page.

Email and Calendar Defaults

Set the default primary email system far the Email pagelet and Calendar Events pagelet. To add
additional, non-primary POP email systems, use the PeopleTools LUREL maintenance utility.

Primary Email System

(¥ Microsoft (Outlook Web Access) ) POP (Mo Calendar)

O Lotus Notes O Imap (No Calendar)
Microsoft Outlook Type Hardware Configuration

(® MS Outlook Exchange 2003 ® Single Box

Y MS Outlook Exchange 2007  Distributed (Different Boxes)

URL for Mail Inbox:

Cutlook Web AccessiExchange Senver LURL

Note: The fields shown on this page vary depending on which email system is selected as the primary
email system.
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Field or Control

Description

Primary E-mail System

Select the default email/calendar system for the portal.
Additional fields display based on your selection. Available
options are:

*  Microsoft (Outlook Web Access)

*  Lotus Notes

*  POP (No Calendar)

*  IMAP (No Calendar)

Configuring the Primary Email System to Use Microsoft Outlook Web

Access

This sections discusses the configuration for Microsoft Outlook Web Access.

This example illustrates the fields and controls on the Email and Calendar Defaults page. You can find
definitions for the fields and controls later on this page.

Email and Calendar Defaults

Primary Email System
& Microsoft (Outlook VWeb Access)
O Lotus Notes

Microsoft Outlook Type

{(®) MS Outlook Exchange 2003
(O MS Outlook Exchange 2007

URL for Mail Inbox;

Set the default primary email system for the Email pagelet and Calendar Events pagelet. To add
additional, non-primary POP email systems, use the PeopleTools LUREL maintenance utility.

Cutlook Wehb AccessiExchange Senver UREL

C POP (No Calendar)
C IMAP (No Calendar)

Hardware Configuration

() Single Box
O Distributed (Different Boxes)

Access the Email and Calendar Defaults page and select the Microsoft (Outlook Web Access) option.

Field or Control

Description

Microsoft Outlook Type

This field applies when you select the Microsoft (Outlook Web
Access) option in the Primary E-mail System group box.

*  MS Outlook 2003

e MS Outlook 2007
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Field or Control

Description

Hardware Configuration

These fields display when you select the Microsoft (Outlook
Web Access) option in the Primary E-mail System group box.

»  Single Box. Select if your hardware configuration is a
single machine setup, that is, the OWA/ASP files are on
the same machine of the Exchange server.

»  Distributed (Different Boxes). Select if your hardware
configuration is for a multiple machine setup, that is,
the OWA/ASP files are on deifferent machines of the
Exchange server.

URL for Mail Inbox

For Microsoft, enter the URL typically used for Outlook Web
Access/Exchange Server URL. The URL should have the
form:

http://<server>/exchange ,replacing <server>
with the Exchange server name.

Use the folder name exchange. The exchange name is the
mapped folder name in the IIS installation. It maps to the
physical folder in which Exchange is installed. Always use
exchange as the folder name in the URL for Mail Inbox field.

Configuring the Primary Email System to Use Lotus Notes
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This sections discusses the configuration for Lotus Notes.

This example illustrates the fields and controls on the Email and Calendar Defaults page. You can find
definitions for the fields and controls later on this page.

Email and Calendar Defaults

Frimary Email System
O Microsoft (Outlook VWeb Access)
(® Lotus Notes

Server;

URL for Mail Inbox;

File Name of Address Book: |Names.nsf

(example: names.nsf)

Setthe default primary email system for the Email pagelet and Calendar Events pagelet. To add
additional, non-primary FPOF email systems, use the PeopleTools LUREL maintenance utility.

C POP (No Calendar)
O IMAP (No Calendar)

Java Enabled Domino server

Required for iMotes only, e.g. http:linotestest peoplesoft.com

Access the Email and Calendar Defaults page and select the Lotus Notes option.
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Field or Control Description

Server This field displays when the Lotus Notes option is selected in
the Primary E-mail System group box.

Enter the server name.

For Lotus Notes, enter the name of a Domino server on the
network. Typically, this is a centralized hub server. This is the
Domino server enabled with additional services and has the
custom view PS_ PORTAL_MAIL LOCATION in the Name
and Address Book.

URL for Mail Inbox Enter a URL (the link on the pagelet transfers the user to this
location in a new browser window).

For Lotus, this field is relevant only for web-enabled iNotes
mail.

File Name of Address Book This field displays when the Lotus Notes option is selected in
the Primary E-mail System group box.

Enter the file name for the Lotus Notes name and address
book.

Configuring the Primary Email System to Use POP
This sections discusses the configuration for POP.

This example illustrates the fields and controls on the Email and Calendar Defaults page. You can find
definitions for the fields and controls later on this page.

Email and Calendar Defaults

Set the default primary email system for the Email pagelet and Calendar Events pagelet. To add
additional, non-primary POP email systems, use the PeopleTools LUREL maintenance utility.

Primary Email System

O Microsoft (Outlook Web Access) ® pop (Ho Calendar)
O Lotus Notes O IMAP (Mo Calendar)
Server pop.mail.yahao.com

POP Mail Server

URL for Mail Inbox: hitp:fimail.yahoo.com
Mail Zerver URL

Access the Email and Calendar Defaults page and select the POP (No Calendar) option.
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Field or Control Description

Server Enter the POP mail server name. For example, for Yahoo!,
enter pop.mail.yahoo.com.

URL for Mail Inbox Enter the mail server URL (the link on the pagelet transfers the
user to this location in a new browser window).

Configuring the Primary Email System to Use IMAP
This sections discusses the email configuration for IMAP.

This example illustrates the fields and controls on the Email and Calendar Defaults page. You can find
definitions for the fields and controls later on this page.

Email and Calendar Defaults

Set the default primary email system for the Email pagelet and Calendar Events pagelet. To add
additional, non-primary FCOF email systems, use the PeopleTools URL maintenance utility.

Primary Email System

) Microsoft (Outlook Web Access) O poP (Mo Calendar)
O Lotus Notes ® map (Mo Calendar)
Server: imap.example.com

IMAP Mail Server
URL for Mail Inbox: hitp:ihwebmail. example.com

Mail Server LIREL

Access the Email and Calendar Defaults page and select the IMAP (No Calendar) option.

Field or Control Description

Server Enter the IMAP mail server name.

URL for Mail Inbox Enter the mail server URL (the link on the pagelet transfers the
user to this location in a new browser window).

Email and Calendar by User Page

Use the Email and Calendar by User page (EO PE_ADMIN OPR) to add overriding email and calendar
settings for an individual user ID.

Navigation:
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Portal Administration > Pagelets > Email / Calendar > Email / Calendar by User

This example illustrates the fields and controls on the Email and Calendar by User page.

Email and Calendar by User

Set the primary email system for selected users to override the system-wide primary email server.

User Override Settings Find | viewa  First B 1 071 [ Last

*User ID: |

Additional E-mail Accounts

{(® Microsoft (Outlook Web Access) O popP (Mo Calendar)

O Lotus Notes O map (Mo Calendar)
Microsoft Outlook Type Hardware Configuration

(&) MS Outlook Exchange 2003 ® Single Box

O MS Outlook Exchange 2007 O Distributed (Different Boxes)

URL for Mail Inbox:
Qutlook Weh AccessiExchange Server URL

Select the user ID for which you want to define overriding email and calendar information. The remaining
fields function like those on the Primary E-mail and Calendar Defaults page. Entries on this page override
the primary email system settings entered on that page for the specified user.

Related Links
Email and Calendar Defaults Page

Support for SSL-Enabled Web Servers

If your web server is SSL-enabled, in addition to specifying an HTTPS URL on the E-mail and Calendar
Defaults page, you must do the following:

* For Microsoft Exchange, in the ASP file change the strProtocol value to /#tps, or change the
isFormBasedAuth flag to true, or both.

*  For POP/IMAP, specify the SSL port number in the mail server URL.

* No extra steps are required for Domino.
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Setting Up Additional Mail Systems

To enable users to add external POP email accounts to their Email pagelets, the portal administrator
must set up a URL identifier and a URL for each POP mail system. Once these entries are stored in the
URL Catalog, the POP mail system appears in the server and URL drop-down list boxes of the pagelet's
Personalize Email Options - Add a Personal Email Account page.

This section discusses how to add and maintain mail system URLs.

Note: The POP mail system must have POP forwarding on a user's individual profile. Each user needs to
set this with the external mail system. Some mail systems automatically activate POP forwarding; some
(such as Yahoo!) require the user to change a profile setting, while others (such as Microsoft Hotmail) do
not allow forwarding. Non-forwarding mail systems do not appear on the Email pagelet.

Pages Used to Set Up Additional Mail Systems

Page Name Definition Name Usage

URL Maintenance Page URL TABLE Add a URL identifier and maintain a
URL for a POP or IMAP mail server.
This definition enables the selection on
the Add a Personal Email Account page
accessed from the Email pagelet.

Related Links
“Working With the Email Pagelet” (Using Portal Features)

URL Maintenance Page

Use the URL Maintenance page (URL TABLE) to add a URL identifier and maintain a URL for a POP
or IMAP mail server.

This definition enables the selection on the Add a Personal Email Account page accessed from the Email
pagelet.

Navigation:

PeopleTools > Utilities > Administration > URLs > URL Maintenance
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This example illustrates the fields and controls on the URL Maintenance page. You can find definitions

for the fields and controls later on this page.

RL Maintenance

URL lientifier:  MAIL_YAHOO

‘Description:  ahoo Mail LFEL

‘URLID: hitpimailyahoo.com

Comiments:

IFEL Fropeties

Field or Control

Description

URL Identifier

Enter a URL identifier. The URL identifier indicates whether
the URL points to a web address or to a POP3 mail server that
cannot be accessed through the web.

For a webmail URL, the URL ID must start with MAIL .

For a POP3 mail server, the URL ID must start with
SERVERMAIL .

Whatever follows the MAIL or SERVERMAIL prefix must
be unique for each MAIL or SERVERMAIL ID.

For example: MAIL YAHOO or SERVERMAIL YAHOO.

Description

This description appears in the Mail Account Server drop-
down list box on the Add a Personal Email Account page. For
example: Yahoo Mail Server or Yahoo Mail URL.

URL

Enter the URL associated with the URL identifier.

Comments

You may optionally enter comments. For example, you may
enter your name and the date on which the URL was enabled
for the Email pagelet.

Related Links

“Working With the Email Pagelet” (Using Portal Features)
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Setting Up Instant Messaging in PeopleSoft
Interaction Hub

Understanding Instant Messaging in PeopleSoft Interaction Hub

The setup tasks described in this topic must be completed before you can use the instant messaging
functionality that is available in the following areas of PeopleSoft Interaction Hub:

* Related contacts.

See “Working With the Related Contacts Pagelet” (Using Portal Features).
e Collaborative Workspace member profiles.

See “Member Profile Page” (Collaborative Workspaces).
» Content Management user profiles.

See “Understanding Managed Content” (Content Management System).

Prerequisites

Users that are utilizing instant messaging functionality will need to have an instant messaging client
installed on the machine from which they’re accessing the PeopleSoft Interaction Hub product. If this
functionality is going to be made available to users of a shared PC, then Oracle recommends that an
instant messaging account be set up on the shared machine that is available for general use by anyone that
has access to the shared PC.

Setting Up Instant Messaging

This topic discusses methods to load instant messaging information using a comma-delimited (CSV)-
formatted file and a component interface.
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Pages Used to Set Up Instant Messaging in PeopleSoft Interaction Hub

Page Name Definition Name Usage

formatted files.

Import Instant Message Users Page EPPRC_IM_IMPORT Run the Import User Instant Message

Information Application Engine process
(EPPRC_IM_IMP) to load user instant
message data contained in CSV-

information.

Maintain Instant Messaging Users Page | EPPRC IM_ADMIN Manually enter user instant messaging

information. Once the Import User
Instant Message Information process
has completed successfully, review
or edit loaded user instant messaging

Import Instant Message Users Page

236

Use the Import Instant Message Users page (EPPRC_IM_IMPORT) to run the Import User Instant
Message Information Application Engine process (EPPRC _IM IMP) to load user instant message data

contained in CSV-formatted files.
Navigation:

Portal Administration > Instant Messaging > Import IM Users

This example illustrates the fields and controls on the Import Instant Message Users page. You can find

definitions for the fields and controls later on this page.

Import Instant Message Users

Select CSY formatted files for uploading user instant message information. To include a file, enter the file's full
path infarmation (Example: citempiSomeFile.csv). The file path must be accessible by the Application Server.

Server Name: PSNT W

Select Files Personalize | Find | view anl | 2 | & First 4 1 of 1 & Last

I File Path Include

Q4 Test Cihrt-retailappsendPAS1files\LoadUser.cav e ] =]
Save Process

Process Monitor

The CSV-formatted file you use to load user instant message data should contain the following
information in this order:

<PeopleSoft Interaction Hub user ID>,<instant message domain>,<domain screen name>

For example, the following user’s instant messaging information should appear in the CSV-formatted file

entry as shown here:

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 20

Setting Up Instant Messaging in PeopleSoft Interaction Hub

Field or Control Description
PeopleSoft Interaction Hub user ID VP1

Instant message domain YAHOO

Domain screen name pat_smith
CSV-formatted file line entry VP1,YAHOO,pat_smith

Entries in the CSV-formatted file are case sensitive. For example, instant message domains must be
capitalized (GTALK, SAMETIME, XMPP, or YAHOO), and the PeopleSoft Interaction Hub user ID and
domain screen name in the CSV-formatted file must use the case formatting of your actual user ID and

screen name.

In addition, there should be no spaces around commas in the CSV-formatted file.

You can generate a CSV-formatted file by creating a spreadsheet formatted like the one shown in the

following example.

This example illustrates a spreadsheet formatted to generate CSV-formatted file.

A | B | C |
1 |BMEADOWS *MPP bmeadows
2 |PAPP _COMNTEMTALXMPF r_taylor
3 |PAPP_EMPLOYEE YAHOO |_jones
4 (PS XMPP |_rnartin
5 |VP1 XMPP p_smith
6 (VP1 YAHOO pat_smith

When you save the spreadsheet, select a Save as type value of CSV (Comma delimited (*.csv).

If you open the file in a text editor, it should appear as shown in the following example.

This example illustrates a CSV-formatted file content.

[P LoadUsers.csv - Notepad
File Edit Format View Help

=10 %]

BMEADOWS , XMPP, bmeadows
PAPP_CONTENTADM, ¥MPP, r_taylor
PAPP_EMPLOYEE, YAHOO, j_jones
PS5, ¥XMPP, 1_martin

VPLl, XMPF, p_smith

VP1l, YAHOO, pat_smith

[

Create one CSV-formatted line entry for each unique user ID and instant message domain combination.
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Field or Control Description

Server Name Select the server you want to use to run the process. Select
a server that can access the designated file path to the CSV-
formatted file.

Select Files

Field or Control Description

ID Enter an identifier for the data in the designated CSV-
formatted file.

File Path Enter the full path to the CSV-formatted file that contains the
user instant message data you want to load. The file path you
enter must be accessible by the server selected in the Server
Name field.

Include Select to include the CSV-formatted file in your run of the
Import User Instant Message Information process.

After the process has completed successfully, review or edit loaded user instant messaging information on
the Manage Instant Messaging page.

Loading Instant Messaging Information Using a Component Interface

Rather than using a CSV-formatted file to load user instant messaging data, you can use the
EPPRC _IM_USER_CI component interface (CI) with the Excel-to-CI spreadsheet load utility to load this
data from a spreadsheet, or any other external application you want to create to interact with the CI.

The Excel-to-CI spreadsheet utility supports the automatic configuration of a Microsoft Excel spreadsheet
to match the properties of a designated CI. For example, the fields related to the CI; PeopleSoft
Interaction Hub user ID, instant message domain, and domain user ID as discussed earlier; appear as
columns in the spreadsheet. After entering data into the spreadsheet, you load it into your PeopleSoft
Interaction Hub database using the associated CI.

See the product documentation for PeopleTools: Component Interfaces, “Using the Excel to Component
Interface Utility.”

Maintain Instant Messaging Users Page
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Use the Maintain Instant Messaging Users page (EPPRC _IM_ADMIN) to manually enter user instant
messaging information.

After the Import User Instant Message Information process has completed successfully, review or edit
loaded user instant messaging information.

Navigation:

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 20 Setting Up Instant Messaging in PeopleSoft Interaction Hub

Portal Administration > Instant Messaging > Maintain IM Users

This example illustrates the fields and controls on the Maintain Instant Messaging Users page. You can
find definitions for the fields and controls later on this page.

Maintain Instant Messaging Users

se the search criteria to filter the displayed Instant Message information, then click "Search’. The Screen Mame
search criteria will return results like the entered freeform text.

User ID: Q
Domain:

Screen Name:

Search
User Information Personalize | Find | view Al | 2 | &3 First B 1-4 or 4 B Last
User D Domain Screen NHame

1 PS5 Q. Cyrnni =]
VP Q, bbreckend =]
WP Q BBreckenridge =]
4 VP Q, bob_breckenridge =]

=]

[S%]

Use the elements at the top of the page to enter user instant messaging information search criteria.
Elements in the scroll area on the page display your search results. You can also use the elements in the
scroll area to add, delete, and edit user instant messaging information.

Field or Control Description

User ID Enter the user ID of the user for which you want to view
instant messaging information.

Domain Select the domain name for which you want to view instant
messaging information.

Screen Name Enter the screen name of the user for which you want to view
instant messaging information.

Search Select to execute a search using any criteria you have entered
in the User ID, Domain, and Screen Name fields. Your search
results are displayed in the lower portion of the page.

User ID Select a user’s PeopleSoft Interaction Hub user ID.
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Field or Control

Description

Domain

Select an instant messaging domain:

GTALK — Google Talk.

SAMETIME — IBM Lotus Sametime.

XMPP — Extensible Messaging and Presence Protocol.

YAHOO — Yahoo! Messenger.

Screen Name

Add or edit a user’s screen name for the selected domain.
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Understanding Internet News Content

PeopleSoft Interaction Hub provides External News pagelets and Feed Reader pagelets that you can
configure to provide access to internet news content. You set up these pagelets to display headlines from
a variety of news sources in a personalized format. You can create more than one version of each type of
pagelet.

External News pagelets are designed to be configured and centrally administered by a portal
administrator. The administrator decides which content providers to use, which categories are visible, and
which users can see those categories. Run the Schedule External News Feed Application Engine process
(EO_PE_EXNEWS) periodically to harvest news headlines and URLs for all categories from the content
provider. Your end users can then personalize their External News pagelets by selecting individual news
categories from the overall list.

You can configure the External News pagelet to receive free and subscription-based news feeds.

A feed—also known as an RSS feed, an XML feed, syndicated content, or a web feed—is frequently
updatedcontent published by a website. Particularly suitable for listing news headlines, feeds have been
adopted by content providers to supply users with a sampling of the content available on their websites.

The Feed Reader pagelet provides the following features:
* News feed title, a link back to the source website, and an optional image or logo.
» Headlines and links to the associated articles on the source website.

*  Optional capability to search for content on the source website.

Note: PeopleSoft cannot guarantee that content providers will continue to support the integration of
internet content. PeopleSoft supports the integration as long as it has a solid partnership with a vendor.
The vendor content descriptions in this topic are subject to change. Check the vendor's website for the
latest content descriptions.

Common Elements Used in Internet News Content

Field or Control Description
Creation Date, Last Update User ID, and Last Update These fields are automatically generated. They are provided
Date/Time for reference.
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Understanding News Feed Configuration

The delivered External News pagelet is pre-configured to gather news content from partners.
Administrative setup involves running the Schedule External News Feed process to gather the news
periodically.

PeopleSoft Interaction Hub offers features that assist each organization in customizing news feeds and
integrating subscription-based news. For example, you can deactivate news categories that are gathered
by the batch process if the news is not appropriate for your users. You can then view the categories and
decide which ones to make available to the rest of the organization. With this feature, you can allow users
to see only business-related news by deactivating all consumer-related topics.

With additional features, you can:
* Create custom news pagelets for specialized news feeds and distribution to selected groups.

For example, you can add customized news feeds about competitors and display them in an existing
External News pagelet or in a newly created pagelet.

* Focus the audience on a specific news feed or category.

For example, you can enable managers to view competitive intelligence.

Understanding Internet News Content Providers
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There are two types of Internet news content providers you can use to supply news on External News
pagelets and RSS News pagelets: free and subscription-based.

Free News Content Providers

You can use PeopleSoft Interaction Hub news-related pagelets with free out-of-the-box solutions from
these content providers to access the news feeds they offer. You can select and view these news feeds
without additional implementation steps.

Provider Sample News Sources Content
Various websites that provide RSS- Motley Fool, Wired, Stockcharts.com, Business, Finance, Technology,
formatted news. and Salon.com. Reference, Arts, Lifestyles, Recreation,

Shopping, and so on.

Related Links
Defining External News Pagelets
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Defining Internet News Content Providers

This section discusses how to define an internet news content provider.

Page Used to Define Internet News Content Providers

Page Name

Definition Name

Usage

News Provider Maintenance Page

EO_PE PROV_PG

Define an internet news content provider
in your system. Maintain news content
provider data, including a URL used to
retrieve the news feed.

News Provider Maintena

nce Page

Use the News Provider Maintenance page (EO_PE PROV_PG) to define an internet news content

provider in your system.

Maintain news content provider data, including a URL used to retrieve the news feed.

Navigation:

Portal Administration > Pagelets > External News > Providers

This example illustrates the fields and controls on the News Provider Maintenance page. You can find

definitions for the fields and controls later on this page.

*Description;

URLID:

Guery URL:

Image URL:

Newsfeed Format:
Content Access Type:
Default Lifespan (in days):
User ID:

Password:

Last Update User ID;
Last Update Date/Time;

*Required Field

News Provider Maintenance

Multex

hitp:ifxmlapi.multexexpress.comimultexapi/04_00/multexapi.aspfapp=p!
¥-schemahttpikmlapi.multexexpress.comimultexapi/04_00/schemas

hitp:iiclientapi.xmlapi.multexexpress.comiclientapi/01_00/peoplesoftbra

| RSS 0.91 XML

| Reaqistration required

30
OracleAPl@a1851

VP1

02/28/2013 8:5714PM

Creation Date: 111312002

Copyright © 1988, 2024, Oracle and/or its affiliates.

243



Working With Internet News Content

Chapter 21

Note: The term provider can refer to both the news feed source (for example, the company), or the
specific query URL(s) that the company provides to access the news. For example, a news feed source
may provide a single query URL value to which different URL parameters can be appended to access
different news categories. Alternatively, a news feed source may supply multiple query URLs, in which
case each query URL becomes its own news feed provider.

Field or Control

Description

URL Enter the URL for the homepage of the source website. This
URL is used to display links to the provider source website on
the External News pagelet and personalization page.

Query URL Enter the URL provided by the source website to retrieve data
for this news feed.

Image URL Enter a URL for a logo or image to display for news feeds for

the source website.

Newsfeed Format

Select the news feed format. The Schedule External News
Feed Application Engine process (EO_PE EXNEWS ) uses
this value to determine how to parse the news feed data.

RSS 0.91 XML.

Content Access Type

Select the type of content access. Selecting any value other
than Free enables you to enter values in the User ID and
Password fields. Available types are:

»  Company Subscription

* Free

*  Registration required

»  User Subscription.

Default Lifespan (in days)

Enter the number of days during which most articles will be
valid in your system. After the specified time, articles may be
purged from your portal database. The recommended life span
is 30 days.

You can override this value for individual articles on the News
Article Maintenance page.

Defining External News Pagelets
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This topic discusses defining and maintaining External News pagelets.
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Pages Used to Define External News Pagelets

Page Name Definition Name Usage
External News Pagelet Publications Page | EO_PE NEWSCOM_SET Define an External News pagelet with a

unique component ID.

News Group Maintenance Page EO_PE NEWSGROUP_PG Define news groups that you want to
use to organize news categories that you
want to make available on the External
News pagelet you are defining.

News Category Maintenance Page EO_PE CATEG PG Define a news category within a news
group.
News Article Maintenance Page EO PE ARTICLE PG View and maintain news feed article

data. You can define an article removal
date that overrides the default article
lifespan set for the article's new provider
on the News Provider Maintenance page.

While you can access news feed article
data on this page, you do not define
article data in your system. News feed
article data is loaded into your system
when you run the Schedule External
News Feed process.

Understanding Defining External News Pagelets
You can also display news feeds on External News pagelets.

To display these news feeds, you must first create a specific instance of an External News pagelet, which
is assigned a unique component ID. Once you have created this pagelet definition, you can create and
associate news groups and categories from news providers with the pagelet. These news groups and
categories are then available on the new pagelet.

You may choose to create a new pagelet for an existing provider, such as Multex, to display specific news
categories to specific users. In essence, you can split off news to specialized communities.

Note: While you can access news feed article data on the News Article Maintenance page, you do not
define article data in your system. News feed article data is loaded into your system when you run the
Schedule External News Feed process.

External News Pagelet Publications Page

Use the External News Pagelet Publications page (EO_PE_ NEWSCOM_SET) to define an external news
pagelet with a unique component ID.

Navigation:
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Portal Administration > Pagelets > External News > Publications

This example illustrates the fields and controls on the External News Pagelet Publications page. You can
find definitions for the fields and controls later on this page.

External News Pagelet Publications

Component 1D 0000000005
*Pagelet Title: Warldwide Mews
Description: Worldwide Mews

Default News Category: 00000000000/, Sample news
For Mew Categories in Newsfeed

Role Name: PAPF_EMPLOYEE 2

Create HomePage FPagelet

Pagelet Folder: Public Access
Mews Registered

Portal Object Name;

Create HomeFage Pagelet

Field or Control Description

Component ID System-generated value that is used to identify the External
News pagelet you are defining. This component ID is used to
identify the pagelet when associating it with news groups and
categories.

Pagelet Title Enter a title for the pagelet that is used to populate the title/
label field for the component reference. This text becomes the
title displayed on the pagelet title bar.

Default News Category You cannot enter a code until you have defined news
categories for this pagelet component ID on the News
Category Maintenance page. Once you have completed this
definition, return to this page to select the code for the default
news category that you want users to see on the External New
pagelet when no personalizations have been defined.

For New Categories in NewsFeed

The field in the For New Categories in NewsFeed group box applies to news loaded through the
Schedule External News Feed process.
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Field or Control

Description

Role Name

Select the default role name to associate with new categories
that are loaded by the Schedule External News Feed process.

This enables you to associate a role with news categories that
are automatically created by the process. Selecting a value
here ensures that you have at least one viewer role assigned to

automatically created categories.

Create Homepage Pagelet

The Create Homepage Pagelet group box displays registry information generated upon saving the page.
You use this information to register the pagelet in the portal registry.

Field or Control

Description

Pagelet Folders

Displays PAPP_NEWS. The system stores all External News
pagelets in this portal registry folder.

Public Access

Select if you want to make access to this External News
pagelet available to all users. You can restrict use of the
pagelet to specific groups of users using the portal registry.

See the product documentation for PeopleTools: Portal
Technology, “Administering Portals.”

Registered Displays as selected once the pagelet has been entered into the
portal registry.
Portal Object Name Displays once the pagelet has been registered and saved.

Create HomePage Pagelet

Click to register the External News pagelet.

News Group Maintenance Page

Use the News Group Maintenance page (EO_ PE NEWSGROUP_PG) to define news groups that you
want to use to organize news categories that you want to make available on the External News pagelet

you are defining.

Navigation:

Portal Administration > Pagelets > External News > Groups
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This example illustrates the fields and controls on the News Group Maintenance page. You can find
definitions for the fields and controls later on this page.

*Description:

Mews Providers
*Provider 1D

News Group Maintenance

Multex Track Folders

Active for all categories

Multex

v EME

Creation Date;
Last Update User ID:
Last Update Date/Time:

*Required Field

10/14/2001
VP1
02/28/2013 9:05:05PM

Field or Control

Description

Description

Enter a news group description.

Active for all categories

Clear this option to disable user access to all categories in the
selected news group without having to disable each individual
category.

Provider ID

Select the providers that you want to associate with the news
group. This establishes an association between the content
provider query URL and the selected news group.

News Category Maintenance Page
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Use the News Category Maintenance page (EO PE CATEG PG) to define a news category within a

news group.

Navigation:

Portal Administration > Pagelets > External News > Categories
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This example illustrates the fields and controls on the News Category Maintenance page. You can find
definitions for the fields and controls later on this page.

News Category Maintenance

*News Category Title: Sample news Active
Provider 1D:
*News Group 1D

Newsfeed Type: | Systern Maintained w

|
URL Parameter: |

Language Code: Enaglish v

URLID:

Wiewer Roles
Select Role Hame
] PAPI_GUEST
PAPP_CUSTOMER
PAPP_EMPLOYEE
PAPP_GUEST
PAPP_SUPPLIER
] PAPP_USER
Creation Date: 09/18/2000
Last Update User ID; WP

Last Update DateTime: 0212812013 9:09:20FPM
*Required Field

Field or Control Description

News Category Title Enter a news category title. For some news providers, the
news category title text must match the news category title
the provider uses. The Schedule External News Feed process
attempts to match this title with the title string from the
provider.

Provider ID Select the associated news provider. The news provider you
select identifies which query URL should be used for the
category.

Providers are defined on the News Provider Maintenance
page.
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Field or Control

Description

News Group ID

Select the news group in which the end user should be able
to access this category when personalizing the External News
pagelet.

News groups are defined on the News Group Maintenance
page.

Newsfeed Type

Select the method to use to load the news category.
SQL Server to XML Load. Reserved for future use.

System Maintained.

URL

Enter a URL that you want to use to override the query URL
value you provided on the News Provider page.

URL Parameter

Enter text you want to be appended to the query URL provided
by the news provider.

Language Code

Select the language for the news category.

Viewer Roles

Field or Control

Description

Select

Select for the roles that you want to be able to view and select
the news category. Users who do not belong to a selected role
cannot access the category when personalizing an External
News pagelet or view articles in the category.

For example, you can use this option to restrict access to
subscription-based content.

Role Name

This is a subset of all PeopleSoft roles defined by an
administrator on the Maintain Viewer Roles page. This is a list
of valid viewers for news, rather than a list of all roles in the
PeopleTools Roles table.

Managing External News Options

This section discusses how to manage external news options.
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Page Name Definition Name

Usage

Manage External News Page EO_PE_CATEG_ADMIN

Set general options for the selected
External News pagelet. For example,
you can determine whether news articles
appear in the current browser window or
in a new window.

There are typically many news
categories available for an External
News pagelet; this page provides a
central location from which you can
administer multiple news categories.

Manage External News Page

Use the Manage External News page (EO_PE_CATEG_ADMIN) to set general options for the selected

External News pagelet.

For example, you can determine whether news articles appear in the current browser window or in a new
window. There are typically many news categories available for an External News pagelet; this page
provides a central location from which you can administer multiple news categories.

Navigation:

Portal Administration > Pagelets > External News > Manage External News

This example illustrates the fields and controls on the Manage External News page. You can find

definitions for the fields and controls later on this page.

Manage External News

Hews Component:

% Mew categories (less than 1 manth old)

0000000005 Worldwide Mews

] Display Article in New Window

*News Group ID

*Default Category Status: On b
Categories marked "new" (days); 30
Category
*\iew Categories: | All v
View Results Personalize | Find | View All | 2 | B8
New MNews Category Title Active
1 Sample news

Multex Track Folders Lv

First 4 1 o 1 B8 | ast
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Field or Control

Description

News Component

Displays the component ID and name of the External News
pagelet for which you are managing external news option.

Default Category Status

Specify the default status for new categories automatically
loaded into your system. You can change their individual
statuses on the News Category Maintenance page.

Categories marked "new" (days)

Enter the number of days for which newly loaded
categories are marked as such on the External News pagelet
personalization page.

Display Article in New Window

Select to have news articles accessed from the External News
pagelet appear in a new browser window. When articles are
displayed in a new browser window, they are not wrapped in
the PeopleSoft Interaction Hub. Clear to display them in the
same browser window.

The default (and recommended setting) is to have news articles
appear in the same browser window.

Category

Field or Control

Description

View Categories

Select a value you want to use to filter the display of
categories. Available values are:

o Al
e Inactive
e New

s Ol

Displays an icon if the news category was added to the
Personalize Worldwide News — Categories (page name
depends on the name of the pagelet you are personalizing)
within the number of days specified in the Categories marked
"new" (days) field.

Active

Select to make news categories accessible to users. Clear to
make them inaccessible. You can also do this individually on
the News Category Maintenance page or by news group on the
New Group Maintenance page.
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Field or Control

Description

News Group ID

Select a value to change the news group that contains the
category. You can do this individually on the News Category
Maintenance page.

Scheduling a News Feed Load

This section discusses how to configure and run the Schedule External News Feed process.

This is a batch process you can configure to periodically load current internet news content headlines.
This periodic load is necessary as news headlines are cached locally in the database to reduce network

traffic.

Page Used to Schedule a News Feed Load

Page Name

Definition Name

Usage

Schedule External News Feed Page

RUN_EO PE EXNW Configure and run the Schedule External

News Feed process.

Schedule External News Feed Page

Use the Schedule External News Feed page (RUN_EO PE EXNW) to configure and run the Schedule

External News Feed process.

Navigation:

Portal Administration > Pagelets > External News > Run External News Feed

This example illustrates the fields and controls on the Schedule External News Feed page. You can find
definitions for the fields and controls later on this page.

Run Control ID::~ MULTEX
User D WP

Mews Providers
Provider

1 | Multex

Schedule External News Feed

Fersonalize | Find |@ | 2| First B4 1 of 1 & | ast

Report Manager  Process Monitor
Run i Schedule

v [+ [=]
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Field or Control

Description

Provider

Select the news provider for which you want to load Internet
news content using the query URL you defined on the News
Provider Maintenance page.

Oracle recommends that you create different run control IDs
to schedule news feed loads from different providers. Each
provider has its own recommended news feed refresh cycle,
such as hourly or twice daily.

Run/Schedule

Click to access the Process Scheduler Request page, where
you can specify process parameters, including the server on
which the process should be run, as well as how often you
want the process to run.

Managing Loaded News Article Content

This section discusses how to manage loaded news article contents.

Pages Used to Manage Loaded News Article Content

Page Name

Definition Name

Usage

News Article Maintenance Page

EO PE ARTICLE PG Review article information for headlines

automatically harvested from a content
provider.

News Article Maintenance Page

Use the News Article Maintenance page (EO_PE_ARTICLE PGQG) to review article information for
headlines automatically harvested from a content provider.

Navigation:

Portal Administration > Pagelets > External News > Articles
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This example illustrates the fields and controls on the News Article Maintenance page. You can find
definitions for the fields and controls later on this page.

Article |D:

Article Headline:
Harvest Date/Time;

Article Summary:

Provider 1D:

Article Source:
Content Type:
URLID:

Additional URL Text:
Article Text:

Access Type:
Publish Dt;
Remove Dt;

Categories
*News Category

News Article Maintenance

1 |0000000000000C, Sample news

00000000000004
Multex news integration has been upgraded, please customize your pagelet to

01/0113 9:00AM

Multex Update

| Multex

FeopleSoft

Text

Free w

04/01/2013 |[H]
01/01/2013 |[H)

k|
FPersonalize | Find | View All | B | i
News Category Title

First B 1 of 1 B Last

[+ [=]

Field or Control

Description

Article ID System-generated value that is used to identify the Article you
are defining.
Article Headline The headline for the article.

Harvest Date/Time

The date and time article was harvested.

Article Summary

Description of the article.
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Field or Control

Description

Provider ID

The associated news provider. Providers are defined on the
News Provider Maintenance page.

Article Source

Source of article.

Content Type Text or URL.
URL Enter a URL that you want to use for the article.
Additional URL Text Enter URL parameter
Article Text Body of the article
Access Type Select the access:

*  Free

*  Registration Required

*  Company Subscription

*  User Subscription
Publish Dt Date article is published.
Remove Dt Date article is to be removed.
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Creating HTML- and JavaScript-Based Pagelets

You can create homepage pagelets based on HTML or JavaScript, as well as HTML objects. Rather than
using PeopleTools to accomplish this, you can use the Manage HTML Pagelets page delivered with the
PeopleSoft Interaction Hub. This page is designed specifically to transform your HTML or JavaScript
code into a pagelet for display within the PeopleSoft Interaction Hub.

Page Used to Create HTML- and JavaScript-Based Pagelets

Page Name Definition Name Usage

Manage HTML Pagelets Page EO_PE HTML PAGELET Create and register HTML-, JavaScript-,
and HTML-object-based homepage
pagelets.

Manage HTML Pagelets Page

Use the Manage HTML Pagelets page (EO_PE HTML PAGELET) to create and register HTML-,
JavaScript-, and HTML-object-based homepage pagelets.

Navigation:

Portal Administration > Pagelets > Internet > Manage HTML Pagelets
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This example illustrates the fields and controls on the Manage HTML Pagelets page. You can find
definitions for the fields and controls later on this page.

Manage HTML Pagelets
Enter the HTML (or provide an URL) below. Specify a name which will be used to register and access
this new pagelet.
*HTML Pagelet Name;  [DMO_DICTIONARY
*Description: sample Derno Dictionary.com
*Pagelet Source Type:  |J3vascript o
HTHNL Area:
=SCRIPT LANGUAGE="JavaScript™ b
<l
function jump2farmi) {
document.dict_form.term.select();
document.dict_form.term focus();
function isblank(s)
I W
Create HomeFage Pagelset
Pagelet Folder: V| [+] Public Access
Registered
Portal Object Hame;
Create HomeFage Pagelet
Last Update Date/Time
Creation Date: Q6222000
Last Update User ID: WP
Last Update Date/Time:  02/28/13 10:24: 44PN
Field or Control Description

HTML Pagelet Name Enter a pagelet name. This label appears in the pagelet's title
bar. This name is used to register the pagelet.
Pagelet Source Type Select the pagelet source type.

HTML
HTML Object

JavaScript
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Field or Control

Description

HTML Area

When the Pagelet Source Type is set to HTML, enter the
HTML code for the pagelet you want to create and register.

When the Pagelet Source Type is set to JavaScript, enter the
JavaScript code for the pagelet you want to create an register.
Once you enter HTML and refresh the page, the URL field no
longer displays.

This field does not appear when the Pagelet Source Type is set
to HTML Object.

HTML Object Name

You can create an HTML object in Application Designer
that contains static HTML. Enter the HTML object name to
reference one of these objects.

Create Homepage Pagelet

Field or Control

Description

Pagelet Folders

Select the pagelet folder in which you want to register the
pagelet.

Public Access

Select to indicate that you want the pagelet to have public
access. When this check box is clear, the security default is to
provide access to only the user who registered the pagelet. You
can modify pagelet security by accessing the content reference.

See the product documentation for PeopleTools: Portal
Technology, “ Administering Portal Homepages and Pagelets.”

Registered This check box displays as selected if the pagelet has already
been registered.
Portal Object Name Displays the object name of a registered pagelet.

Create HomePage pagelet

Click to create and register the pagelet.

Last Update Date/Time

Field or Control

Description

Creation Date

Displays the date on which the selected pagelet was created.
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Field or Control Description

Last Update User ID Displays the user ID of the user who last updated the pagelet.

Last Update Date/Time Displays the date and time at which the pagelet was last
updated.

Obtaining Pagelet Code

You can use your own HTML code to create pagelets on the Manage HTML Pagelets page, or you can
use HTML code supplied by Internet sources. In the following example, a source has supplied the HTML
code to include a source search box pagelet on your homepage.

This example illustrates a search-box pagelet HTML code.

<l-- Begin Search Box --= i
<form action="http:/fcgi.trip. corn/zearch/ cgi-
binfzearch.cgi" methad="get">=

Search for Socks: <input type="text"
name="searchstring"” size="15" maxlength="40">=

<input type="submit" value="Find!"=<hbr>

Insert this HTML code in the HTML Area field on the Manage HTML Pagelets page to create and
register the search box pagelet for use in your PeopleSoft Interaction Hub.
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Understanding Integrated Task List Configuration Requirements

To enable your Integrated Task List feature to work as designed, ensure that your configuration meets the
following requirements:

» Ensure that the Tasks page uses the PAPP. NO NAV_HTML template, or any Hypertext Markup
Language (HTML) template, for registration so that the proxy is automatic.

* Ensure that the Task Details page uses the PAPP. NO NAV_FRAME, or any frame template, for
registration. This enables the File Attachment feature.

* Ensure that the Personalize Tasks page uses the PORTAL HOMEPAGE DESIGNER template, or
any HTML template, to enable the Return to Home link.

*  Ensure that the WORKLIST and WORKLIST DETAIL components are registered in an HTML
template.

* Ensure that you activated public or permission list security for all registered content references.

Understanding Integrated Task List Integration Setup

The Integrated Task List leverages PeopleSoft Integration Broker and XML technology to enable you to
integrate tasks from any system in your implementation. This is also useful to aggregate worklists across
PeopleSoft applications.

To use the Integrated Task List integration features, your must include the following setup in your
configuration:

*  Schedule the Worklist Replicate process according to how frequently near-real-time updates are sent
to and from the portal database.

* Set PeopleSoft Integration Broker for standard operator and user security.

» Specify a file storage location for file attachment functions using the URL Maintenance page in the
portal database (select PeopleTools, Utilities, Administration, URLSs). File attachments can be stored
either on a File Transfer Protocol (FTP) server or in a database table. The URL identifier TASKS is
reserved for the Integrated Task List feature. This identifier is used throughout the task PeopleCode.

The Worklist Replicate process should be run using the PeopleTools Worklist Replicate Application
Engine process (WL _REPLICATE). To set up and run the Worklist Replicate process, you need to set up
Integration Broker and configure routings on the sender and receiver nodes.

See the product documentation for PeopleTools: Workflow Technology.
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Publishing Content from Third-Party
Applications

Understanding Web Services for Incoming Third-Party Content

This section discusses:

* Prerequisites.

» Publication of content from third-party applications to the PeopleSoft Interaction Hub.
* The process flow for publishing content.

* PeopleSoft-delivered objects.

There are two parts to publishing content from third-party applications:

e PeopleSoft.

*  Third-party application.

On the PeopleSoft side, you need to define the PeopleSoft Integration Broker Gateway, nodes, and
routings.

On the third-party side, you must generate and post XML messages containing metadata about the content
you are publishing. PeopleTools provides the Send Master utility that you can use to test posting messages
to Integration Broker.

Note: The PeopleSoft Interaction Hub provides a basic prototype for web services. This is only a sample.
You can adapt this prototype for your organization, but must also take into account additional factors that
might apply in your organization in order to implement web services effectively.

See the product documentation for PeopleTools: Integration Broker,Peoplelools: Integration Broker
Testing Utilities and Tools.
Prerequisites
Before implementing web services, you must have installed:
*  PeopleTools 8.4 or later.
* Portal database.

* PeopleSoft Pure Internet Architecture.
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*  PeopleSoft Application Server and Process Scheduler, configured using PSADMIN (a utility program
that is located in your PeopleTools home directory).

Publication of Content from Third-Party Applications to the PeopleSoft

Interaction Hub

You can publish three types of content from a third-party application to the PeopleSoft Interaction Hub.
Each type of content has a category type, expressed as a code:

Type of Content Category Type
New Publications N (News)

Managed Content R (Regular content)
Categorized Content B (Browse)

The codes are part of the metadata that is used in the XML files that are brought over to the PeopleSoft
Integration Broker.

Related Links

“Understanding News Publications” (Content Management System)
“Understanding Managed Content” (Content Management System)
“Understanding Categorized Content” (Content Management System)
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Publishing Content from Third-Party Applications

The following diagram illustrates the process flow for publishing content from third-party applications to
the PeopleSoft Interaction Hub.

Third-Party Application

Manage content from
various sources using a
third-party application

Push XML to PeopleSoft
Integration Broker

Process and

Managed
Content

Categorized

route XML

:

t

Production Web
Server

Deploy content . Generale
to a server XML metadata
Deployed
content

News

Fublications

I
I
I
I
|
I
I
I
I
[
I
Content !
I
|
I
I
I
I
|
I
I
I
I

View and search
ontent by navigating
to the Content

anagement men

The content publishing process is as follows:

1. Deploy third party, system-managed content to a production server.

2. Create XML file with metadata about content.

3. Push XML to PeopleSoft Integration Broker.

4. Process and route the XML.

5. In the PeopleSoft Interaction Hub, navigate to the Manage Content menu to view the three different

types of content.

PeopleSoft-Delivered Objects

The following objects are delivered with the PeopleSoft Interaction Hub:

Description

Object Name

Message definition for web services.

EPPNV_NEWS_MSG

Message channel for web services.

EPPNV_IN_NEWS

Message node.

Provide any message node, but one node has to be the default

local node.
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Description Object Name

File layout definition for web services. EPPNV_IN NEWS

Setting Up on the PeopleSoft Side

This section discusses how to:

Set up the publish/subscribe servers using the PSADMIN utility.
Set up the PeopleSoft Integration Broker gateway.

Define a message node to represent the third-party application that will be publishing content
messages.

Define message channels.

Setting Up the Publish/Subscribe Servers

To set up the publish/subscribe server:

1.

2.

4,

Access the PSADMIN menu to set up your application server for the database.

In the Configure this domain option, keep selecting the default values by pressing the ENTER key
until you see the message Do you want the Publish/Subscribe servers configured (y/n)?

Be sure that /y]/ is selected.
The system loads the new configuration.

Boot the domain.

See the product documentation for PeopleTools: System and Server Administration.

Setting Up the PeopleSoft Integration Broker Gateway

266

The PeopleSoft Integration Broker Gateway receives incoming data.

To set up the PeopleSoft Integration Broker Gateway:

1.

2.

Select PeopleTools > Integration Broker > Gateways > Find an Existing Value.
Search for an existing value named Local and click Search.

If Local does not already exist, access the Add a New Value page and add Local in the Integration
Gateway ID field. Click Add. This action takes you to the Gateway page.

The Gateway page is blank initially. After you save and click the Load button, this page is populated
with information.

Ensure that the Local Gateway check box is selected.
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5. Enter a URL in the Gateway URL field. If you are using the SendMaster utility, this URL should be
http.//<server hostname>/PSIGW/PeopleSoftListeningConnector.

6. Click the Save button.
7. Click the Load button. A message appears to confirm that the loading process was successful.
8. Click the Refresh button.

9. Click the Save button.

Note: There may be slight variations on different platforms. You may also need to configure the
Integration gateway.properties file for the Gateway.

Defining An External Message Node
Define an external node per the instructions in the Integration Broker PeopleBook, specifying these items:
* Enter EXT as the node name.
* For Node Type, select External.
* Select Active Node.
* Add a routing to the node definition, and in the routing select the appropriate service operation.

*  Go your portal node definitions, access the EXT node you defined, and specify the PeopleTools and
PeopleSoft Interaction Hub release levels.

See the product documentation for PeopleTools: Integration Broker.

Activating Service Operations
Activate the appropriate service operation on the Service Operations page in Integration Broker.

See the product documentation for PeopleTools: Integration Broker.

Setting Up on the Third-Party Side

This section discusses how to:
* (Create the XML file.

* Execute the batch file that will then post the XML file to the PeopleSoft Integration Broker.

Creating the XML File

In the third-party application, you need to create an XML file. The XML file should be comprised of three
sections:

* Record and field definitions that match the PeopleSoft message definition.
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* The PeopleSoft common application message attributes (PSCAMA) record.

* Integration Broker Gateway data.
Record and Field Definitions in the XML that Match the PeopleSoft Message
Definition

The table below lists all the fields that can be used by the message definition. These fields are being sent
by the third-party application and are the only fields shown in the XML sample. At any time, more fields
can be added to the message definition, but they will also need to be added to the XML definition.

This example illustrates the fields used by the Integration Gateway Broker.

Field Hame Alias Include

1 |EPPCM_CATG_TY v
2 |PORTAL MAME |7
3 |EPPCM_CATGID W
4 |EPPCM_COMTENT v
5 |EPPCM_TITLE ™3
§ |DESCR v
7 |EPPCM_ALUTHOR 3
§ |EPPCM_CONT_ST v
3 |EPPNY_PUBLISH_ [+
10 |EPPNY_EXPIRE_D [
11 |EPPCM_SOURCE [
12 |URL [
PSCAMA Fields

Define the structure of the PSCAMA record. PSCAMA is a record that PeopleTools requires for every
level of the message structure during processing.

This table lists the field names and their descriptions that you'll find in the XML files.

Note: The AUDIT ACTN field must have a value of 4 for the purpose of this solution.

Field Name Description

LANGUAGE CD Required. Indicates the language in which the message is
published. When publishing from components, the system
sets this field to the operator's default language code. The
application developer can override this if necessary. The value
in the sample XML file is ENG (English).

AUDIT_ACTN Required. Audit action code that identifies the row of data as
an Add transaction.

BASE LANGUAGE CD Optional. Indicates the base language of the publishing
database. Used by the generic full table subscription
PeopleCode to help determine which tables to update.
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Field Name Description

MSG_SEQ FLG Optional. Indicates whether the message is a header (H),

trailer (T), or contains data (blank). The subscribing database
can use this field to initiate processes. For example, the header
message may cause staging tables to be cleared, while the
trailer indicates that all the data has been received and an
update job should be initiated.

PROCESS _INSTANCE Optional. Process instance of the batch job that created the

message. Along with the publishing node and publication ID,
this field can be used by the subscribing database to uniquely
identify a group of messages from the publishing node.

PUBLISH _RULE ID Optional. Indicates which publish rule was invoked to create

the message. Used by routing PeopleCode to locate the
appropriate chunking rule, which then determines to which
nodes the message gets published.

MSGNODENAME Optional. The node to which the message is published. This

field is passed to the Publish utility by the Application Engine
program. Routing PeopleCode must look for a value in this
field and return that value to the application server.

Integration Broker Gateway Data

Enter the actual data for the record and field definitions that match the PeopleSoft message definition, as
well as the PSCAMA fields.

Sample XML

The following example shows the XML code that you'll find for Company News.

The first section of the sample XML code is where you define the attributes for the Integration
Gateway Broker data. This is where you bring in the information about the record and field definitions
that match the PeopleSoft message definition.

The first section in the example below starts with the <EPPNV_NWS URL class="R"> line and ends
with the </EPPNV_NWS URL> line.

The second section of the sample XML code is where you define the attributes for the PSCAMA
records.

The second section in the example below starts with the <PSCAMA class="R"> line and ends with
the </PSCAMA> line.

The third section of the sample XML code is where you define the actual data for the record and field
definitions as well as for the PSCAMA records.
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The third section in the example below starts with the <Transaction> line and ends with the </

Transaction> line.

<?xml version="1.0"?2>
<EPPNV_NEWS_ MSG>
<FieldTypes>

<EPPNV_NWS URL class="R">

<EPPCM CATG TYPE type="CHAR" />

<PORTAL NAME type="CHAR" />

<EPPCM_CATGID type="NUMBER"/>
<EPPCM_CONTENTID type="NUMBER"/>

<EPPCM_TITLE type="CHAR"/>
<DESCR type="CHAR"/>

<EPPCM_AUTHOR type="CHAR"/>
<EPPCM_CONT_ STATUS type="CHAR"/>
<EPPNV_PUBLISH DATE type="CHAR"/>
<EPPNV_EXPIRE_DATE type="CHAR"/>
<EPPCM_SOURCE type="CHAR"/>

<URL type="CHAR"/>
</EPPNV_NWS_URL>
<PSCAMA class="R">
<LANGUAGE_CD type="CHAR"/>
<AUDIT ACTN type="CHAR"/>

<BASE LANGUAGE CD type="CHAR"/>

<MSG SEQ FLG type="CHAR"/>

<PROCESS_INSTANCE type="NUMBER"/>
<PUBLISH RULE ID type="CHAR"/>

<MSGNODENAME type="CHAR"/>
</PSCAMA>
</FieldTypes>
<MsgData>
<Transaction>
<EPPNV_NWS URL class="R">

<EPPCM CATG TYPE>N</EPPCM _CATG TYPE>
<PORTAL NAME>EMPLOYEE</PORTAL NAME>
<EPPCM CATGID>1052</EPPCM CATGID>

<EPPCM _ CONTENTID>1</EPPCM CONTENTID>
<EPPCM | TITLE>Company News</EPPCM TITLE>
<DESCR>First Quarter Meet1ng</DESCR>
<EPPCM_AUTHOR>VP1</EPPCM AUTHOR>

<EPPCM CONT STATUS>P</EPPCM CONT STATUS>

<EPPNV_PUBLISH DATE>01/15/2003</EPPNV_PUBLISH DATE>
<EPPNV_EXPTRE_DATE>03/31/2003</EPPNV_EXPIRE_DATE>

<EPPCM_SOURCE>VP1</EPPCM SOURCE>
<URL>Http://www.peoplesoft.com</URL>

</EPPNV_NWS_ URL>
<PSCAMA class="R">

<LANGUAGE_CD>ENG</LANGUAGE_ CD>
<AUDIT ACTN>A</AUDIT ACTN>
<BASE_LANGUAGE CD>ENG</BASE_LANGUAGE CD>

<MSG SEQ FLG/>

<PROEESS:INSTANCE>O</PROCESS_INSTANCE>

<PUBLISH RULE ID/>
<MSGNODENAME />
</PSCAMA>
</Transaction>
</MsgData>
</EPPNV7NEW57MSG>

Posting XML Content from Third-Party Applications to PeopleSoft

Integration Broker

To post the XML file to PeopleSoft Integration Broker, use the Send Master utility.

To use Send Master to post an XML file:
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1. Access Send Master.
2. Create a new project and assign a name to the session.
3. Set the Project Type value to X X Integration Broker (MIME).

4. Enter a Server URL value. This should be the same URL you specified when configuring your
PeopleSoft Integration Broker Gateway.

5. Enter a Time out value greater than 0.
6. Access the Headers tab in the Input Information group box.
7. Set the Requesting node value to EXT7. This is the external node you previously configured.

8. Set the external operation name to <Service Operation Name>.VERSION 1, as in
EPPNV_NEWS _MSG.VERSION 1.

9. Set the Operation Type value to async.

10. Enter a Password value, if the requesting node has a password.

11. Set the Destination node value. This may be your target portal database node, for example.

12. Access the Input File tab in the Input Information group box.

13. Open the file containing your sample XML message.

14. Click the Post button to send the message.

15. The Output Information group box displays a response. A MsgID value of 70000 indicates success.

At this point, if you received a MsgID value of /0000, your message has been successfully transmitted to
PeopleSoft Integration Broker.

If the message was valid and PeopleSoft Integration Broker has been configured properly, the message
should have been processed by the Content Management web service, and the new content represented in
the message should have been stored in the PeopleSoft Interaction Hub database.

You can view your message results using the PeopleSoft Integration Broker Monitor. Any message
subscription errors will appear in the monitor.

See the product documentation for PeopleTools: Integration Broker.

Viewing Published Content in the PeopleSoft Interaction Hub

After content has been published in the PeopleSoft Interaction Hub, you can view the content using the
Content Management menu. This topic describes viewing the published content for News Publications,
Managed Content and Categorized Content.
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Pages Used to View Published Content in the PeopleSoft Interaction Hub

Page Name

Definition Name

Usage

“Browse Managed Content Page”
(Content Management System)

EPPCM_HIERTOP_MAIN

View published content for Managed
Content.

Browse News Publications Page

EPPCM_HIERTOP MAIN

View published content for News
Publications.

See “Browse Managed Content Page”
(Content Management System) for
more information on browsing sub-level
managed content.

Browse Categorized Content Page

EPPCM_HIERTOP MAIN

View published content for Categorized
Content.

See “Browse Managed Content Page”
(Content Management System) for
more information on browsing sub-level
managed content.

Related Links

“Understanding News Publications” (Content Management System)
“Understanding Managed Content” (Content Management System)

“Understanding Categorized Content” (Content Management System)

Understanding Enterprise Integration Points for the PeopleSoft
Interaction Hub
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Enterprise integration points (EIPs) are interfaces between PeopleSoft applications and third-party
applications. They allow publication and transfer of data from a third-party application to the PeopleSoft

database.

The PeopleSoft Interaction Hub uses an EIP for web services based on PeopleSoft Integration Broker
gateway technology. The following table lists the message received by the PeopleSoft Interaction Hub.

Message Name

Channel

Message
Subscription
PeopleCode

Record

File Layout

EPPNV_NEWS_MSG

EPPNV_IN_NEWS

EPPNV_NEWS_MSG

EPPNV_NEWS_URL

EPPNV_IN_NEWS

The PeopleSoft Integration Broker gateway uses this EIP. The message name is based on the record,
which is based on the file layout. The message subscription is what is executed when an XML file is
posted to the PeopleSoft Integration Broker gateway for this transaction.
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Note: To research the technical details of any integration point used by PeopleSoft applications, refer
to the Interactive Services Repository that can be found in the Documentation section of the My Oracle
Support website.

The Resource Finder integration used to import participant data is documented in Importing Participant
Data.
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Using Public Web Services

Understanding Public Web Services

These public web services enable an external system to send values to PeopleSoft Interaction Hub to
create content in features such as Collaborative Workspaces, Content Management, and Discussions.
In the case of CWService.FindWorkSpaceByContextData, public web service can also be used to view
PeopleSoft Interaction Hub content from within the external system.

The following public web services are available:
* Collaborative Workspaces: CWService.Create WorkSpace

Enables an external system to create Collaborative Workspaces for use with the PeopleSoft Interaction
Hub database.

* Collaborative Workspaces: CWService.FindWorkSpaceByContextData

Enables an external system to access a Collaborative Workspace based on contextual data defined for
the Collaborative Workspace.

e Collaborative Workspaces: CWService.AddMembers

Enables an external system to add members to a Collaborative Workspace.
* Content Management: CMService.AddContent

Enables an external system to add content to the Content Management feature.
» Discussion Forums: DiscussionService.PostMessage

Enables an external system to post a message to a Discussion Forum.

Enabling Public Web Services

Public web service access to PeopleSoft Interaction Hub APIs requires the use of PeopleSoft Integration
Broker.

To enable public web services, perform the following steps:
1. Enable publish/subscribe on the application server.
Configure the appropriate application server to enable Pub/Sub Servers.

See the product documentation for PeopleTools: System and Server Administration, “Setting
Application Server Domain Parameters.”
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2. Activate the message definition EO PE_ SOAPTOCI.

Using PeopleSoft Application Designer, open the EO_ PE_ SOAPTOCI message. Access the message
properties and ensure that the Use tab Status value is set to Active.

3. Enable the message channel IB_ CHNL.

Using PeopleSoft Application Designer, open the IB. CHNL message channel. Access the message
channel properties and ensure that the Use tab Message Channel Status value is set to Run.

4. Set up the integration broker gateway URL and integrationGateway.properties file.
5. Set up the local portal node.

6. Create a new external node and add EO_PE_SOAPTOCI message transactions to it.
7. Add security to the associated component interfaces and SOAPTOCI web libraries.

Associated component interfaces include EPPCM_ADDCONTENT, EPPCM_GETCONTENT,
EPPCW_ADDMEMBER, EPPCW_CREATEWS, EPPCW_FINDWS, and EPPDF_ADDPOST.

8. Use SendMaster to test SOAP calls to the component interfaces using WSDL.

Using Content Management Public Web Services Schemas

This section presents examples of SOAP requests (this does not represent a complete reference to all
available web services):

* Add content to Content Management with a Save SOAP request.
* Get content in Content Management with a Get SOAP request.

*  Get content in Content Management with a Find SOAP request.

Adding Content with a Save SOAP Request
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Following is an example of a Save SOAP request to add content:

<?xml version="1.0" encoding="UTF-8" ?> <SOAP-ENV:Envelope

xmlns:SOAP ENV="http://schemas.xmlsoap.org/soap/envelope" xmlns:SOAP
ENC="HTTP://schemas.xmlsoap.org/soap/encoding/" xmlns:xsi="http://
www.w3.0rg/2001/XMLSchema-instance”™ xmlns:xsd="http://www.w3.0rg/2001/
XMLSchema" SOAP ENV:encodingStyle="http://schemas.xmlsoap.org/soap/
encoding/"> <SOAP-ENV:Header> <Security Request> <Username>VP1</
Username> <Password>VP1</Password> </Security Request> </SOAP-
ENV:Header> <SOAP-ENV:Body> <Update_CompInth_EPPCM_ADDCONTENT>
<OPRID>VP1</OPRID> <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>
<EPPCM_CATG_TYPE>R</EPPCM_CATG_TYPE> <EPPCM_CATGID>100l</EPPCM_CATGID>
<EPPCM_CONT_TYPE>U</EPPCM_CONT_TYPE> <EPPCM TITLE>Test Sendmaster
Content</EPPCM TITLE> <EPPCM CONT LONG>http://www.yahoo.com</

EPPCM CONT LONG> </Update_CompInth_EPPCM_ADDCONTENT> </SOAP-ENV:Body>
</SOAP-ENV:Envelope>
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The response from PeopleSoft, which uses a cloned SOAPTOCI message, is:

<?xml version="1.0" encoding="UTF-8" ?> <SOAP-

ENV:Envelope xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:SOAP- ENC="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:SOAP- ENV:encodingStyle="http://schemas.xmlsoap.org/
soap/encoding/"> <SOAP-ENV:Header /> <SOAP-ENV:Body>

<Updatedata CompIntf EPPCM ADDCONTENTResponse xmlns= "http://
psfttemp.org"> <notification>The Content saved successfully.

New Content ID = 2261.(18025,1738) </notification> <detail /> </
Updatedata CompIntfc EPPCM ADDCONTENTResponse> </SOAP-ENV:Body> <SOAP-
ENV:Envelope>

Getting Content with a Get SOAP Request

Following is an example of a Get SOAP request to get content:

<?xml version="1.0" encoding="UTF-8" ?> <SOAP-ENV:Envelope
SOAP- ENV:encodingStyle="http://schemas.xmlsoap.org/soap/
encoding/" xmlns:SOAP- ENC:="http://schemas.xmlsoap.org/
soap/encoding/" xmlns:SOAP- ENV:="http://schemas.xmlsoap.org/
soap/envelope/" xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SOAP-ENV:Header> <Security Request> <Username>PS</

Username> <Password>PS</Password> </Security Request> </SOAP-
ENV:Header> <SOAP-ENV:Body> <Get CompIntfc EPPCM GETCONTENT>
<OPRID>VP1</OPRID> <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>
<EPPCM_CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</
EPPCM CATGID> <EPPCM_CONTENTID>2004</EPPCM_CONTENTID> </

Get CompIntfc EPPCM GETCONTENT> </SOAP-ENV:Body> </SOAP-ENV:Envelope>

The response from PeopleSoft is:

<?xml version="1.0" encoding="UTF-8" ?> <SOAP-ENV:Envelope
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" xmlns:xsi="http://
www.w3.0rg/2001/XMLSchema-instance”" xmlns:SOAP- ENC="http://
schemas.xmlsoap.org/soap/encoding/" xmlns:SOAP- ENV="http://
schemas.xmlsoap.org/soap/envelope/" SOAP- ENV:encodingStyle="http://
schemas.xmlsoap.org/soap/encoding/"> <SOAP-ENV:Header /> <SOAP-
ENV:Body> <Get CompIntfc EPPCM GETCONTENTResponse xmlns:="http://
psfttemp.org"> <OPRID>VP1</OPRID> <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>
<EPPCM_CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID>
<EPPCM CONTENI D>2004< /EPPCM_CONTENT ID> <EPPCM TITLE>Test Web

Service CI HTML</EPPCM TITLE> <EPPCM CONT TYPE>H</EPPCM CONT TYPE>
<EPPCM_CONT LONG /> </Get CompIntfc EPPCM GETCONTENTResponse> </SOAP-
ENV:Body> </SOAP-ENV:Envelope>

Getting Content with a Find SOAP Request

Following is an example of a Find SOAP request to get content:
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<?xml version="1.0" encoding="UTF-8" ?> SOAP-ENV:Envelope

SOAP- ENV:encodingStyle="http://schemas.xmlsoap.org/soap/
encoding/" xmlns:SOAP- ENC="http://schemas.xmlsoap.org/soap/
encoding/" xmlns:SOAP- ENV="http://schemas.xmlsoap.org/soap/
envelope/" xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"> <SOAP-
ENV:Header> <Security Request> <Username>PS</Username>
<Password>PS</Password> </Security Request> </SOAP-ENV:Header>
<SOAP-ENV:Body> <Find CompIntfc EPPCM GETCONTENT> <OPRID>VP1</
OPRID> <PORTAL_NAME>EMPLOYEE</PORTAL_NAME> <EPPCM_CATG_TYPE>R</
EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID> </

Find CompIntfc EPPCM GETCONTENT> </SOAP-ENV:Body> </SOAP-ENV:Envelope>

Following is the response from PeopleSoft:

<?xml version="1.0" encoding="UTF-8" ?> <SOAP-ENV:Envelope
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" xmlns:xsi="http://
www.w3.0rg/2001/XMLSchema-instance”" xmlns:SOAP- ENC="http://
schemas.xmlsoap.org/soap/encoding/" xmlns:SOAP- ENV="http://
schemas.xmlsoap.org/soap/envelope/" SOAP- ENV:encodingStyle="http://
schemas.xmlsoap.org/soap/encoding"> <SOAP-ENV:Header />
<SOAP-ENV:Body> <Find CompIntfc EPPCM GETCONTENTResponse
xmlsn="http://psfttemp.org"> <EPPCM GETCONTENT>

<OPRID>VP1</OPRID> <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>
<EPPCM_CATG_TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</

EPPCM CATGID> <EPPCM_CONTENTID>2001</EPPCM_CONTENTID>
<EPPCM_TITLE>MiChele<EPPCM_TITLE> </EPPCM_GETCONTENT>

<EPPCM GETCONTENT> <OPRID>VP1</OPRID> <PORTAL_NAME>EMPLOYEE</

PORTAL NAME> <EPPCM CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</
EPPCM CATGID> <EPPCM_CONTENTID>2004</EPPCM_CONTENTID>

<EPPCM TITLE>Test Web Service CI HTML</EPPCM_TITLE> </

EPPCM GETCONTENT> <EPPCM GETCONTENT> <OPRID>VP1</OPRID)
<PORTAL_NAME>EMPLOYEE</PORTAL_NAME> <EPPCM_CATG_TYPE>R</

EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID>
<EPPCM_CONTENTID>2020</EPPCM_CONTENTID> <EPPCM TITLE>Test Web

Service CI</EPPCM TITLE> </EPPCM GETCONTENT> <EPPCM GETCONTENT>
<OPRID>VP1</OPRID) <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>

<EPPCM_CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID>
<EPPCM_CONTENTID>2023</EPPCM_CONTENTID> <EPPCM TITLE>Test
URL</EPPCM_TITLE> </EPPCM_GETCONTENT> <EPPCM GETCONTENT>
<OPRID>VP1</OPRID) <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>

<EPPCM_CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID>
<EPPCM_CONTENTID>2024</EPPCM_CONTENTID> <EPPCM TITLE>Test URL

from View</EPPCM_TITLE> </EPPCM_GETCONTENT> <EPPCM GETCONTENT>
<OPRID>VP1</OPRID) <PORTAL_NAME>EMPLOYEE</PORTAL_NAME>

<EPPCM_CATG TYPE>R</EPPCM CATG TYPE> <EPPCM CATGID>1001</EPPCM CATGID>
<EPPCM_CONTENTID>2025</EPPCM_CONTENTID> <EPPCM TITLE>Test

URL Derived Record</EPPCM_TITLE> </EPPCM_GETCONTENT> </

Find CompIntfc EPPCM GETCONTENTRespone> </SOAP-ENV:Body> </SOAP-
ENV:Envelope>
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Administering Unified Navigation in
PeopleSoft Interaction Hub

Understanding Unified Navigation

This section provides an overview of:

* Unified navigation in PeopleSoft Interaction Hub.

» The Unified Navigation WorkCenter.

e Default local nodes and portal host nodes.

* Remote content references and templates.

* Remote dashboards.

« Limitations and additional considerations in PeopleTools 8.54.

*  Support information for customers who have not installed PeopleSoft Interaction Hub.

Unified Navigation in PeopleSoft Interaction Hub

Unified navigation provides a framework to federate PeopleSoft applications under a single portal system,
the PeopleSoft Interaction Hub. Using the delivered Unified Navigation WorkCenter page and activity
guide, you can configure and federate portal registries from content provider systems into a unified
system. Your administrators and users will log into the portal system to access local resources on the
portal system as well as remote resources made available through unified navigation. Once unified
navigation is configured, your users and administrators will be able to:

« Access remote content references and resources, which includes:
* Accessing remote navigation pages through the main drop-down menu of the portal system.
* Adding remote content references as My Links (or Favorites) on the portal system.
* Accessing remote dashboards through the main drop-down menu of the portal system.

* Accessing remote WorkCenter pages with remote pagelets through the main drop-down menu of
the portal system.

* Creating related content services in the portal system using the either local or remote content
references.

* Creating related content services in the content provider system using content references local to
that system.
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* Assigning local (to the portal system) or remote content references (from a content provider
system) as related content services (or related actions) to content references on the portal system.

» Assigning local (to the content provider system) or remote content references (from a different
content provider system) as related content services (or related actions) to content references on
the content provider system.

» Tracking usage of remote content references with iTracker.

» Synchronize user system profiles, or user personalization data, or both from the portal system to the
content provider systems.

The following diagram illustrates how content from the content provider system is rendered in the portal
system and identifies which pieces of the page are rendered from which system.
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In this example:

* The URL in the address field indicates that the portal system is the current system and that the content
resides on a content provider node (HRMS).

* The page header (Home and Sign out links, search, and so on), the drop-down menu, and homepage

tabs are generated by the portal system. This ensures that portal functions and navigation remain local
to the portal system.

e The content in the target area of the page comes from the content provider system. (If the content
reference in the content provider system is defined with a specific template, then the content is also

rendered using that template.)

* Related content services defined for the remote content reference are displayed. In this example, the
related content has been defined as related actions.
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Related Links

Remote Content References and Templates

The Unified Navigation WorkCenter

The Unified Navigation WorkCenter provides an activity guide that lists the steps that need to be
completed to configure your portal system for unified navigation.

To access the Unified Navigation WorkCenter, select Portal Administration > Unified Navigation
WorkCenter:

This example illustrates the Unified Navigation WorkCenter with a completed configuration: the portal
system and two remote content provider systems have been federated.

Unified Navigation WorkCenter © « || Status || Diagnostics

Lnifcdiayiugton © ©¥ | Unified Navigation Configuration Status

O 1B Network WorkCenter
) IB Network Setup
~ O Single Signon Setup
B Following are the "In Metwork™ nodes setup in your system:
& Configure Mode for S50

To addiupdate "In Network™ nodes, use "IB Network WorkCenter” link in the Unified Mavigation pagelet.

Single Signon Setup

Message Node Name Description
O Define Trusted Nodes 1 [CamP Portal Node - CAMP
» O Unified Mavigation Setup 2|CUST Portal Mode - CUST
O Unified Navigation Node Network 3 |ELM Portal Mode - ELM
. 4 |EMPL Portal Mode - EMPL
- SelectRemote Content 5[ENTP Portal Node - ENTP
~ O Related Content Setup §loovT Portal Node - COVT
O Local Portal System 7 |[H21JDINF Human Capital Management
8|HRMS Portal Mode - HRMS
9|L21JDINF Enterprise Learning Management
10|P91JDINF PS PA-Local Node
11 |PART Portal Mode - PART
12|PT_LOCAL PT_LOCAL
13|5UPP Portal Mode - SUPP

Following are the Trusted nodes setup in your system:

Message Node Name

Local Node

H21JDINF

1
2
3

L21JDINF

P31JDINF

1

To addiupdate Trusted nodes, use "Define Trusted Modes” link in the Unified Navigation pagelet

Unified Navigation Setup

Following are the Unified Navigation folders setup in your system:

Node Hame Folder Label
1|ELM Enterprise Learning
2|HRMS Human Resources

To add/Update Unified Mavigation folders, use "Configure Drop Down Menu™ link in the Unified Navigation pagelet.

When you click links in the Unified Navigation activity guide pagelet, transaction pages are displayed
within the portal system on which you need to enter information to configure unified navigation. The
Unified Navigation activity guide pagelet presents the tasks in the order that you need to complete them.

Note: In addition, some configuration is required on the content provider systems.

Configuration of unified navigation consists of seven procedures, which are documented in these topics:

1. Complete initial system configuration.
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See Completing Initial System Configuration.

Configure the integration gateway (click the IB Network WorkCenter link in the pagelet).

See Configuring the Integration Gateway.

Define remote nodes (click the Configure Node for SSO link in the pagelet).
See Defining Remote Nodes.
Identify trusted nodes (click the Define Trusted Nodes link in the pagelet).

See Identifying All Trusted Nodes.

Add remote nodes to the integration network (once again, click the IB Network WorkCenter link in
the pagelet).

See Adding Remote Nodes to the Integration Network.

Set up the unified navigation node network and test the single signon configuration (click the Unified
Navigation Node Network link in the pagelet).

See Setting Up Unified Navigation.

Add remote folders to the drop-down menu (click the Configure Drop Down Menu link in the
pagelet).

See Configure Drop Down Menu Page.

After configuration of unified navigation has been completed, you can configure related content to take
advantage of remote content and remote services. Related content can be configured from the Unified
Navigation WorkCenter page:

You can create a service to manage related content for a content provider system.

See Creating a Service to Manage Related Content for a Content Provider System.

You can create and assign related content for the portal system and for content provider systems.

See Creating and Assigning Related Content Within the Unified Navigation Framework.

Note: While the Unified Navigation WorkCenter includes an activity guide pagelet, it uses the standard
WorkCenter template, and not the WorkCenter template for activity guides. Therefore, the Next and
Previous buttons to navigate between tasks are not present. For more information on the icons and
controls available in activity guides, see the product documentation for PeopleTools: Applications User's
Guide, “Using PeopleSoft Application Pages,” Using WorkCenter Pages, Using Activity Guides.

Default Local Nodes and Portal Host Nodes

Unified navigation requires that two types of nodes be defined on both the local portal system and the
remote content provider systems:
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Default local nodes — The default local node designates the system on which the database is installed.
Default local nodes generate security artifacts, such as PS TOKEN, and participate in PeopleSoft
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Integration Broker integrations. In the context of unified navigation, each participating default local
node must have an active definition in the PeopleSoft Interaction Hub system, must be identified to
the integration gateway, must be established as in-network for the integration node network, and must
be established as a trusted node for single signon.

Portal host nodes — A portal host node is the node that hosts a specific portal and the portal’s content.
For example, ERP, HRMS, and EMPL all host the EMPLOYEE portal on PeopleSoft FSCM,
PeopleSoft HRMS, and PeopleSoft Interaction Hub, respectively. In the context of unified navigation,
each participating portal host node must have an active definition in the system and is used as the
content provider node for remote folders and pagelets.

Remote Content References and Templates

When a menu item (content reference) from a content provider system is selected from the drop-down
menu, the information that is displayed comes from multiple sources as follows:

The page header (Home, Sign out, and other links) plus the drop-down menu come from the portal
system.

The target area content is fetched from the content provider system.

The template for the target area content is also fetched from the remote system and is used to render
the target content. However, if a content reference with the same name is registered in the local
portal system, then the template for the local content reference is used to render the remote content
reference. In addition, if the remote content reference is defined without a template, then the default
template for the local portal system is used to render the remote content reference.

When remote content is displayed, the New Window, Help, Customize Page, and other links invoke
actions that are relative to the content provider system or the portal system, depending on which link
is clicked:

* The New Window link opens a new window redisplaying the current content—that is, the header
and drop-down menu come from the portal system and the content comes from the content
provider system.

* The Help link displays the help topic from the help system that is configured for the content
provider system.

* The Personalize Page link replaces the target area with the page personalization information from
the content provider system.

*  The Copy URL icon button copies the URL of the current page—that is, a URL on the portal
system that includes the content provider node and content reference.

Note: Templates from the portal system or from the content provider system are not cached.

Custom Templates

Oracle delivers unified navigation with support for PeopleTools-delivered, iFrame-based templates (for
example, DEFAULT TEMPLATE and PT IFRAME TEMPLATE) and WorkCenter templates.

Note: Unified navigation supports only iFrame templates.
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If your remote content references use custom templates or other PeopleSoft-delivered iFrame templates,
then those templates must conform with the following standards:

*  The template HTML must include the PeopleSoft header and drop-down menu pagelets:

For example, to include the PeopleSoft header, use HTML code similar to the following:

<div>
<pagelet name="UniversalNavigation">
<source node="LOCAL NODE" href="s/WEBLIB PT NAV.ISCRIPTl.FieldFormula.IS=

cript UniHeader Frame?c=%Bind(:5)" /> </pagelet>
</div>

In addition, to include the PeopleSoft drop-down menu, use HTML code similar to the following:

<div>
<pagelet name="Nav">
<source node="LOCAL NODE" href="s/WEBLIB PT NAV.ISCRIPTl.FieldFormula.IS=

cript PT NAV INFRAME?navtype=dropdown&c=%$Bind(:5)" />
</pagelet>
</div>

Important! In both examples, the source element’s node attribute must be set to LOCAL NODE.
Otherwise, unified navigation will fail to operate on the remote content reference.

* For all pagelets included in the template HTML, except for the PeopleSoft header and drop-down
menu pagelets, the source element’s node must be set to the portal host node of the content provider
system:

For example, if the content provider system is PeopleSoft HRMS, set the source element’s node to
HRMS as shown in the following code:

<div id="omtickerpagelet">
<iframe name="NOTETICKER" id="NOTETICKER" frameborder="no" src="">
<pagelet name="NoteTicker">
<source node="HRMS" href="s/WEBLIB OM.NOTE.FieldFormula.IScript disp=

layNoteTicker?0SEC=1&CSEC=1&PSEC=1&LSEC=1&ASEC=1"/>
</pagelet>
</iframe>
</div>

The following HTML code represents a template that has been modified to adhere to the preceding
standards. In this example, the relevant portions of the code are highlighted in bold:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/TR/htmld/stric=

t.dtd">

<html dir="%$Direction" lang="%LanguageISO">

<head>

<meta http-equiv="X-UA-Compatible" content="IE=8">

<meta http-equiv="content-type" content="text/html; charset=UTF-8">

</head>
<body class="PSPAGE" id="ptifrmtemplate">
<div>
<pagelet name="UniversalNavigation">
<source node="LOCAL NODE" href="s/WEBLIB_ PT NAV.ISCRIPT1l.FieldFormula.IScript=

_UniHeader_ Frame?c=var" />

</pagelet>
</div>
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<div>
<pagelet name="Nav'">
<source node="LOCAL NODE" href="s/WEBLIB PT NAV.ISCRIPT1l.FieldFormula.IScript=

PT_NAV_INFRAME?navtype=dropdown&c=var" />
</pagelet>
</div>
<div id="ptifrmcontent">
<div id="ptifrmtarget">
<iframe id="ptifrmtgtframe" name="TargetContent" title="Target Title" frameborde=

r="0" scrolling="auto" onload="ptrc.onLoadTC()" src="">
<target Name="target" params="var"/>
</iframe>
</div>
</div>
<div id="omtickerpagelet">
<iframe name="NOTETICKER" id="NOTETICKER" frameborder="no" src="">
<pagelet name="NoteTicker">
<source node="HRMS" href="s/WEBLIB OM.NOTE.FieldFormula.IScript displayNo=

teTicker?0SEC=1&CSEC=1&PSEC=1&LSEC=1&ASEC=1"/>
</pagelet>
</iframe>
</div>
</body>
</html>

Errors When Accessing Remote Content Through Navigation Pages

When a remote content reference is accessed through a remote navigation page, a “not authorized” error
can occur even though the user is authorized to access to the content reference on the content provider
system. This error usually occurs because the portal registry definition for the remote content reference
uses LOCAL NODE, instead of a specific node. Under unified navigation, LOCAL NODE will resolve
to the portal host node on the portal system, and not a node on the content provider system. Because the
content reference (component and page) does not exist on the portal system, the “not authorized” error
results.

To resolve this issue, you must identify and update content references on the content provider system to
use the portal host node of the content provider system. In the following example for a PeopleSoft HCM
application, a SQL statement updates the node value to HRMS, the portal host node:

update PSPRSMDEFN set PORTAL CNTPRV NAM='HRMS' where PORTAL REFTYPE='C' and PORTAL =

CNTPRV_NAM='LOCAL NODE' and PORTAL NAME='EMPLOYEE';

See Completing Configuration of Remote Content.

Remote Dashboards

Since dashboards are accessed through content references, remote dashboards defined in a content
provider system can be accessed through a remote folder that is configured for unified navigation.

Note: However, because homepages (unlike dashboards) are displayed only when a user directly signs
into a system, homepages from content provider systems are not accessible through unified navigation.

Remote dashboards are subject to the following limitations:

* A pagelet on a remote dashboard will not function properly if the pagelet performs a JavaScript
document.write or document.writeln operation.
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When the portal system's drop-down menu is used to navigate to the remote dashboard, then the menu
breadcrumbs are updated properly. However, if the PeopleCode RedirectURL method is used to load
the remote dashboard, then the menu breadcrumbs are not updated.

See the product documentation for PeopleTools: Portal Technology, “Administering Homepages,
Dashboard Pages and Pagelets,” Understanding Homepages and Dashboard Pages, Peoplelools: Portal
Technology, “Administering Homepages, Dashboard Pages and Pagelets,” Managing Dashboard Pages.

Limitations and Additional Considerations in PeopleTools 8.54

286

Unified navigation can be used with these limitations and additional considerations in PeopleTools 8.54:

Configuration of unified navigation must be completed on the portal system with associated
configuration steps performed on the content provider system. Use of unified navigation features (for
example, navigation to remote content references) must also occur on the portal system.

Note: A PeopleTools license allows for installation of a PeopleSoft Interaction Hub database for the
purpose of configuring and using unified navigation and other restricted uses. See your PeopleTools
license for details. See Licensing Notes for Oracle's PeopleTools 8.54 [ID 1905898.1].

Navigation to menu items on content provider systems is supported through the portal system's drop-
down menu only.

Note: You cannot use homepage menu pagelets such as the Enterprise Menu pagelet or the Main
Menu pagelet to navigate to remote menu items. The remote folders are hidden and will appear in
these pagelets.

Pagelet icon images used in remote pagelets must be copied from the content provider system to
the portal system. In addition, if both systems do not use the same style (for example, one uses
TANGERINE, and the other uses a custom style), the cascading style sheets (CSS) must be copied
from the content provider system to the portal system.

Templates for remote content references must conform to the standards outlined in this document.

See Remote Content References and Templates.

Do not use the following special characters in the labels for a remote folder: { } #.

Unified navigation supports same portal integration only—for example, EMPLOYEE portal to
EMPLOYEE portal, CUSTOMER portal to CUSTOMER portal, or PARTNER portal to PARTNER
portal, and so on. However, you should always use the content provider system's portal host node to
create remote folders or import pagelets.

Remote dashboards must conform to the standards outlined in this document.

See Remote Dashboards.

The minimum PeopleTools release required to implement unified navigation is 8.52. That is, if the
portal system is using PeopleTools 8.53 and if you want to configure unified navigation for a content
provider system that is using PeopleTools 8.49, unified navigation features will not be supported and
the portal system may throw errors. When any of the content provider systems is using a PeopleTools
release lower than 8.52, you must enter the PeopleTools release information in the Tools Release
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field on the Node Definitions page (Portal tab) for the default node and the portal node of the content
provider system.

See Setting Up Single Signon.

*  When you implement single sign on and unified navigation, you must ensure that the Fluid mode and
conditional navigation settings on the portal system match with the settings on the content provider
system. You use the Disable Fluid Mode and the Disable Fluid on Desktop fields on the Web Profile
page (PeopleTools, Web Profile, Web Profile Configuration) to define Fluid mode and conditional
navigation settings. For example, if you select the Disable Fluid Mode check box on the portal
system, you must also define the same settings on the content provider system.

For more information on Fluid mode settings, see the product documentation for Peoplelools: Fluid
User Interface Developer’s Guide.

For more information on conditional navigation, see the product documentation for PeopleTools:
Portal Technology.

*  When you use unified navigation, you must not update the General Settings page of the content
provider system from the portal system. If you update the General Settings page of the content
provider system, the portal host node gets incorrectly updated and users cannot log on to the content
provider system. This issue is seen in releases prior to PeopleTools 8.53.06.

Support Information for Customers Who Have Not Installed PeopleSoft

Interaction Hub

As stated previously, configuration and use of unified navigation features (for example, navigation to
remote content references) must occur on the portal system.

Note: A PeopleTools license allows for installation of a PeopleSoft Interaction Hub database for the
purpose of configuring and using unified navigation and other restricted uses. See your PeopleTools
license for details. See Licensing Notes for Oracle's PeopleTools 8.54 [ID 1905898.1].

However, in certain situations, some peer-to-peer configurations can achieve limited functionality that
resembles what is available with unified navigation. Specifically, you can create a local related content
service on a content provider system using a content reference from a different content provider system
without federating the content provider systems under unified navigation. To achieve this, you must
manually copy the content references from the remote content provider system to the local content
provider system and then manually synchronize security between the two systems.

See the product documentation for PeopleTools: Portal Technology, “Developing and Configuring
Related Content Services.”

Completing Initial System Configuration

You should complete the following steps prior to using the Unified Navigation WorkCenter to configure
unified navigation on your systems:
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On both the portal system and the content provider system, set the authentication domain to the
lowest level domain shared by all sytems—for example, if all systems share the same subdomain,
then .us.mycompany.com would be appropriate; otherwise, use .mycompany.com instead.

See the product documentation for PeopleTools: Portal Technology, “Configuring the Portal
Environment,” Configuring Web Profiles, Configuring General Portal Properties.

Stop and restart each web server after making these changes.
On both the portal system and the content provider system, enable the drop-down menu.

See the product documentation for PeopleTools: Portal Technology, “Administering Portals,”
Managing General Settings for Portals.

Configuring the Integration Gateway

288

To configure the Integration Broker integration gateway and start the setup of the integration network on
your portal system:

1.

Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

In the Unified Navigation pagelet, select the IB Network WorkCenter link to open the integration
network's Configuration Status page.

Alternatively, select PeopleTools > Integration Broker > Integration Network >
Configuration Status.

This example illustrates the Configuration Status page showing that the Integration Network is not
configured.

Configuration Status 7) Help
%
%
X Gateway Mot Configured 17 X Mode Metwark Mot Configured (7 X Mo Domain Active (%

Update Gateway Location Activate Domain
Update Configuration Settings

Reqgister Target Connectors

Select and Configure Modes for the Metwork

Additional Links

Service Configuration
Monitor Setup
System Setup

Mode Network Password

- Configure Server, Schema Mamespaces and Target Locations
- Enable gateway logging and Data View size limit
- Set maximum recursicn level and enable IB Profiling

- Update Integration Node Metwork Password

See the product documentation for PeopleTools: Integration Broker Administration, “Using the

Integration Network,” Using the Configuration Status Page.

3. Click the Gateway Not Configured link.
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The Gateways page appears.

See the product documentation for PeopleTools: Integration Broker Administration, “Using the
Integration Network,” Verifying and Managing Integration Gateway Configuration.

4. Configure the integration gateway:

a. Enter the machine name and complete URL to the PeopleSoftListeningConnector in the Gateway
URL field:

This example illustrates the fields and controls on the Gateways page with a gateway URL
configured.

Gateways

Inbound Gateways!
JM S Administration

Gateway ID LOCAL

Local Gateway ClLoad Balancer

URL hitp:iPIHSERVER. example.com: 80P SIGWIPeopleSofilisteningCaonned Ping Gateway

Gateway Setup Propeties Return to Configuration Status

Load Gatewsay Connectors

b. Click the Ping Gateway button.
The status should return as active.
c. Click the Load Gateway Connectors button to load the gateway connectors.

This example illustrates the fields and controls on the Gateways page with connectors loaded.

(Gateways
Gateway ID LOCAL
Local Gateway [Load Balancer JMS Adrministration
URL hitp#PIHSERVER example. com: 80P SIGWFeopleSofilisteningCanned Fing Gateway
Gateweay Setup Properties Return to Conflguration Status
Load Gateweay Connectors
Connectors Personalize | Find |2 | B First B 1211 or11 O Last
‘Connector ID Description ‘Connector Class Hame
1 |AS2TARGET ASITargetConnector Propeties =l
2 | EXAMPLETARGETCOMME ExampleTargetConnectar Froperties El
3 |FILEOUTPUT SimpleFileTargetCannectar Froperies =]
4 FTPTARGET FTPTargetConnector Fropetties =
5 GETMAILTARGET GethailTargetConnector Froperies =]
& HTTPTARGET HttpTargetConnector Fropetties =
7 [JMSTARGET JMSTargetConnectar Froperies =]
& PSFTH TARGET ApplicationMessagingTargetConnectar Properies El
9 |PSFTTARGET PeopleSofTargetConnector Fropeties =
10 SFTPTARGET SFTPTargetConnectar Properties =]
11 SMTPTARGET EMTPTargetConnectar Froperties [=]
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d.

Click the Save button to save your changes.

5. Click the Gateway Setup Properties link.

6. Log in on the Gateway Properties page.

The PeopleSoft Node Configuration page appears.

See the product documentation for PeopleTools: Integration Broker Administration, “Managing
Integration Gateways,” Setting Oracle Jolt Connection Properties.

a.

b.

Enter the URL to the gateway and other values in the Gateway Default App. Server group box.
At a minimum, enter the values for the default local node in the PeopleSoft Nodes group box.

This example illustrates the fields and controls on the PeopleSoft Node Configuration page.

PeopleSoft Node Configuration ]

URL: hitp:JIPIHSERVER example.com: 80P SIGW/PeopleSofilisteningConnector
Gateway Default App. Server

App Server URL User ID Password Tools Release  Domain Password  Virtual Server Node
[FIHEERVER:G000 WP (I 8.53.01 -
PeopleSoft Nodes Persanalize | Find | viewal | 20| B8 First ] 1.3 073 B Laat
Hode Hame App Server URL User ID Password Tools Release Domain Password
FSFT_PA JFIHSERVER:3000 WP wen 8.53.01 .. Ping Mode =]
Advanced Properties Page
Cancel Save

Click the Save button.

Click the Ping Node button.

The status should return as success.

On the Ping Node Results page, click the Return button.

If you have the information now, you can define other participating nodes in the PeopleSoft Nodes
group box at this time. For each content provider system, create entries for the default local node.
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This example illustrates the PeopleSoft Node Configuration page with a shared gateway
configured.

PeopleSoft Node Configuration

URL: hitp MPIHSERVER. example.corm: 80P SIGWIPeopleSofilisteningConnectar
Gateway Default App. Server

App Server URL User ID Password Tools Release Domain Password  Virtual Server Node

JIPIHSERYER:9000 WP ass 8.53.01 e
PeopleSoft Modes Personalize | Find | view Al | G0 | B2 First B 1-3 or3 B Last
Hode Hame App Server URL User ID Password Tools Release Domain Password
PSFT_EF WFSCMSERVER:9020 Ll ass 8.53.01 . Ping Nade =
PSFT_HR WHCMESERVER:B030 PS .. 85301 e Fing Made =
PSFT_PA JPIHSERVER 8000 Uil e 8.83.01 L) Ping Made [=]

Advanced Properties Page

0|< Cancel Save

Note: Alternatively, you can return to this PeopleSoft Node Configuration page once you have
identified and defined these nodes.

See Understanding Remote Nodes.

g. Save your changes.
h. Then, for each default local node defined, click the Ping Node button.

The status might not return success if the node is not yet defined with the same parameters in both
systems.

Note: If you click the Ping Node button for a any node that is a portal host node, the following
error will result:

Integration Broker Service: Destination node does not match the
local node. (158,500)

7. On the PeopleSoft Node Configuration page, click the Advanced Properties Page link.
The Gateway Properties page appears.

See the product documentation for PeopleTools: Integration Broker Administration, “Managing
Integration Gateways,” Using the integrationGateway.properties File.

a. Enter the full path to the keystore file and enter the encrypted keystore password:
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This example illustrates the fields and controls on the Gateway Properties page.

Gateway Properties

URL  httpedf<webservers: < port: /PSIEW PeopleSoftListeningConnect ar
Gateway Properties

# Example: ;l
+*

#FsecureFilekeystarePath==fileLocation=

#FsecurefilekeystorePasswi==password=

+*

secureFilekeystorePath=ColAppsery_B853websendP 91 B1 501 ipiaconfin/keyvstareipske —

i
secureFilekeystorePasswi=EaNEEED MyLet jBpZGEYG==

+*
= End of Integration Gateway CERTIFICATE Section
*

#

:thITr'nhqfnrmnﬁnh Sartinn Fyamnle I _ILI
4 3

Fassword Encryption

Passwaord Confirm Password

(11 121 1]]} (12 111 1]}
Encrypt Encrypted Password %117 md OtvnHFhyLe 1 jEpZGEY0==
] Cancel

See the product documentation for PeopleTools: Integration Broker Administration, “Managing
Integration Gateways,” Configuring Security and General Properties, PeopleTools: Integration
Broker Administration, “Managing Integration Gateways,” Encrypting Passwords.

b. Click the OK button.

8. On the PeopleSoft Node Configuration page, click the Save button again.
9. Click the OK button.
10. On the Gateways page, click the Return to Configuration Status link.

11. Click the Node Network Not Configured link (or the Node Network Configured link if that is
displayed instead).

12. Ensure that the portal system's default local node is selected as in network (it is selected by default).
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This example illustrates the Node Network page showing the portal’s default local node (PSFT PA)
and one remote default local node (PSFT HR) as in-network.

ode Network

Secure Keystore Value Defined
Metwork Modes (2

Default Local Hode Hade

PSFT_CR
PSFT_FO
PSFT_GF
PSFT_IM
PSFT_LM
PSFT_LS
PSFT_PF
BP
PSFT_CIS
cls

CRM

EIM

EPM
STAF
ELM

SA
PT_LDAP
PT_LOCAL
CUST
EMPL
ENTP
GOVT
PSFT_PA
PART
SUPP
PEFT_HR
HRMS
CAMP

In Hetwiork

iReturn to Configuration Status!

Configured in Active

- Remote Gateway Hode
Gateway Hode - o

13. Click Save, then click the Return to Configuration Status link.

14. Click the No Domain Active link.

The Domain Status page appears.
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This example illustrates the Domain Status page with an activated domain.

Domain Status

Darnain Criteria

Furge Damain Status

Refresh Update
Domains
Failover Failover

= Py Machine Hame
Group Priority

PIHSERVER

Dispatcher Status

Grace Period for all Domains (Minutes)

I anpomains Active

I AN Domains Inactive Failover Disabled

Set Up Failover
MasteriSlave Load Balance

Slave Templates Return to Configuration Status

Persanalize | Find | view el |G 88 First B 1 or1 B Last

Domain
Status

DigenversiappseriPAdl G329

Personalize | Find I@ | | First B 1 071 D Last

Application Server Path Grace Period Slave Indicator

Wiew Domain Gueue Sets

Machine Hame
FIHSERVER

Dispatcher Hame
FEMEGDER

Application Server Path
DaSererstappsendPAST G320 ACT

Status String  Date Time Stamp

a. In the Domains group box, set the status for this machine to Active.

b. Click the Update button to update the domain status.

15. Return to the Configuration Status page (click the Return to Configuration Status link).

The status should show that all three steps have been completed and that your integration gateway and

integration network are configured.

This example illustrates the Configuration Status page showing a configured integration network.

Configuration Status

o Gateway Configured 7 " Node Metwork Configured 7 " Domain Active 7

Update Gateway Location Activate Domain

Update Configuration Settings

Select and Configure Modes for the Metwork

Register Target Connectors

Additional Links

Serice Configuration - Configure Server, Schema Mamespaces and Target Locations
Monitor Setup - Enable gateway logging and Data Wiew size limit
Systermn Setup - Set maximurm recursion level and enahble 1B Profiling

Mode Metwark Password - Update Integration Mode Metwork Password

Important! While this integration network is active, its configuration might not yet be complete if

you have not added all remote nodes to the integration gateway.
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Setting Up Single Signon

This section provides an overview of single signon and remote nodes, and discusses how to:
* Define remote nodes.

* Identify all trusted nodes.

* Adding remote nodes to the integration network.

» Testing single signon.

Understanding Single Signon for Unified Navigation

In a PeopleSoft environment, single signon is deployed for a number of reasons. For users, single signon
provides the ability for them to navigate freely within a environment of multiple applications after being
authenticated only once. For integration of PeopleSoft applications and systems, single signon identifies
those systems that are trusted participants in the integration. With unified navigation, single signon is
deployed for both purposes: to identify those trusted systems and to allow users to navigate freely to
resources on those trusted systems.

Understanding Remote Nodes
The first step to configuring single signon is to define the participating nodes from each content provider

system in the portal system, and conversely, to define the default local node of the portal system in each
content provider system.
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The following diagram illustrates four systems participating in unified navigation: PIH (the portal
system), FSCM, and HCM.

PIH

PSFT_PA (DLN)
EMPL (PHN)
PSFT_EP (RN)
ERP (RN)
PSFT_HR (RN)
HRMS (RN)

FSCM

PSFT_EP (DLN) PSFT_HR (DLN})
ERP (PHN) HRMS (PHN)
PSFT_PA (RN} PSFT_PA (RN)
EMPL {RN) EMPL (RN)
PSFT_HR (RN) PSFT_EP (RN)
HRMS (RN) ERP (RN)

HCM

Under each system, the default local node is highlighted in bold and identified with the notation (DLN).
For example, on the PIH system, the default local node is PSFT_PA. On the HCM system, the default
local node is named PSFT HR. The portal host nodes are identified with the notation (PHN). On the
FSCM system, the portal host node is named ERP. On the HCM system, the portal host node is named
HRMS.

Important! Unified navigation supports same portal integration only—for example, EMPLOYEE portal
to EMPLOYEE portal, CUSTOMER portal to CUSTOMER portal, or PARTNER portal to PARTNER
portal, and so on. However, you should always use the content provider system's portal host node to create
remote folders or import pagelets.

Finally, under each system, the remote nodes that need to be defined are identified with the notation (RN).
For example, on the PIH system, four remote nodes would need to be defined: PSFT EP, ERP, PSFT HR,
and HRMS. On each of the content provider systems, two remote nodes would need to be defined at a
minimum: PSFT PA and EMPL.

In addition, if content from one content provider is to be configured as related content on any other
content provider, then the applicable nodes from each system need to be defined in the other system. For
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example, if salary information from FSCM is to be added as related content on the HCM system, then
PSFT EP and ERP need to be added to HCM as remote nodes; similarly, PSFT HR and HRMS need to
be added to the FSCM system as remote nodes. These optional remote nodes are also designated with
(RN) and are highlighted in italics.

Defining Remote Nodes
This section discusses how to:
* Define remote nodes on the portal system.

* Define remote nodes on a content provider system.

Defining Remote Nodes on the PeopleSoft Interaction Hub System
To define remote nodes on the portal system:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Single Signon Setup section and select the Configure
Node for SSO link to open the Nodes page in the target area.

Alternatively, select PeopleTools > Integration Broker > Integration Setup > Nodes.

3. If the remote node is already defined in the PeopleSoft Interaction Hub database, then select that node
definition. Otherwise, add a new value for the remote node.

4. Select the Node Definitions page:
a. Enter a description for the remote node.
b. Verify that the node type is PIA.

c. For default local nodes only, set the authentication option to Password or Certificate. If the
authentication type is password, enter the password defined for the remote node.

d. Enter the default user ID as defined on the remote node.

Important! If necessary, add a user profile for this default user ID.
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This example illustrates the fields and controls on the Node Definitions page showing a remote
default local node.

Made Definitions Connectars Eoartal WS Security Routings

Mode Hame PSFT_HR Copy MNode
‘Description FSHCHM- Local Mode Fename Mode
‘Node Type PlA i Default Local Mode
OLocal Node Leelete Mode
Active Node
*Authentication Option | Password v/

[ Non-Repudiation
Segment Aware

Mode Password RSN RN R R IR R R R R R R RN E R RN
‘Default User 1D Pa Q,
Hub Node QL
Master Node Q,
Company I

IB Throttle Threshold

Image Name QL
Codeset Group Name Q,
ContactiMotes Properties

Save

See the product documentation for PeopleTools: Integration Broker Administration, “Setting Up
Secure Integration Environments,” Implementing Node Authentication, PeopleTools: Integration
Broker Administration, “Adding and Configuring Nodes,” Defining Node Parameters.

5. Select the Connectors page:

a. Enter the integration gateway in the Gateway ID field. If the remote node will use the locally
defined integration gateway, enter LOCAL as the gateway ID.

b. Enter PSFTTARGET as the connector ID.
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This example illustrates the fields and controls on the Connectors page showing a remote default
local node.

Mode Definitions Connectors Fortal WS Becurity Routings

Hode Hame FSFT_HR Fing Mode

Details

Gateway I LocaL Q PeaopleSoft Modes are canfigured via the

Connector D |PSFTTARGET Q Gateway Setup Properties

‘Delivery Mode Guaranteed Delivery

This connector does not have properies. Lse
Gateways Pade to setup.

Save

See the product documentation for PeopleTools: Integration Broker Administration, “Adding and
Configuring Nodes,” Specifying Gateways and Connectors.

c. For default local nodes only, if the remote node will use the locally defined integration gateway
and you did not add this node to the gateway configuration previously, do so now.

Click the Gateway Setup Properties link to add the remote node to the integration gateway.

See Configuring the Integration Gateway.

After the remote node has been added to the integration gateway, click the OK button to return to
the Connectors page.

6. Select the Portal page:
a. Ensure that a value 1s defined for the Tools Release field.

b. Enter values for the Content URI Text field and the Portal URI Text field as defined for the remote
node.

c. Ensure that the Portal Host Node check box and the Network Node Name field are set on the
portal system and on a participating (remote) system. These fields are set so that the unified
landing page is able to obtain the corresponding IB node for a given portal host node.

Select the Portal Host Node check box and enter the default local node of the remote system in the
Network Node Name field.
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This example illustrates the Portal page showing a remote default local node.

Mode Definitions Connectors Portal WS Security Routings

Node Name PSFT_HR

Details

Description PS HRMS - Local Node Local Node

Tools Release B 54
Application Release HRMS 9.21.00
Example: hitp://someserver/psc/pshome!

Content URI Text hitp:/PFIHSERVER. example.com:80/pscihr

Example: hitp://someserver/psp/psheme/
Portal URI Text hitp/IPIHSERVER.example.com:&0/psp/hr/

[C] Portal Host Node
Hetwork Node Name

Save

See the product documentation for PeopleTools: Portal Technology, “Configuring the Portal
Environment,” Setting Portal Nodes.

d. Save the definition of the remote node.

7. Repeat steps 2 through 6 for each default local node and portal host node that needs to be defined as a
remote node in the portal system.

Defining Remote Nodes on a Content Provider System
To define remote nodes on a content provider system:
1. Select PeopleTools > Integration Broker > Integration Setup > Nodes.

2. If the default local node for the portal system (PSFT PA) is already defined in the content provider
database, then select that node definition. Otherwise, add a new value for PSFT PA.

3. Select the Node Definitions page:
a. Enter a description for the remote node.

b. Verify that the node type is PIA and that the Authentication Option field value is Password or
Certificate. If the authentication type is password, enter the password defined for the remote node.

c. Enter the default user ID as defined on the remote node.
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Important! If necessary, add a user profile for this default user ID.

See the product documentation for PeopleTools: Integration Broker Administration, “Setting Up
Secure Integration Environments,” Implementing Node Authentication, PeopleTools: Integration
Broker Administration, “Adding and Configuring Nodes,” Defining Node Parameters.

4. Select the Connectors page:

a.

Enter the integration gateway in the Gateway ID field. If the remote node will use the locally
defined integration gateway, enter LOCAL as the gateway ID.

Enter PSFTTARGET as the connector ID.

See the product documentation for PeopleTools: Integration Broker Administration, “Adding and
Configuring Nodes,” Specifying Gateways and Connectors.

For default local nodes only, ithe remote node will use the locally defined integration gateway,
click the Gateway Setup Properties link.

Log in on the Gateway Properties page.
Enter the default local node in the PeopleSoft Nodes group box:
Click the Save button.

Click the Ping Node button for the remote node that is the default local node.

Note: A central gateway should be used by all databases in the same portal cluster.

The status should return as success.

Note: If you click the Ping Node button for a remote node that is a portal host node, the following
error will result:

Integration Broker Service: Destination node does not match the
local node. (158,5006)

On the Ping Node Results page, click the Return button.

Click the OK button to return to the Connectors page.

5. Select the Portal page:

a.

Enter values for the Content URI Text field and the Portal URI Text field as defined for the remote
node.

Ensure that a value is defined for the Tools Release field.

Ensure that the Portal Host Node check box and the Network Node Name field are set on the
content provider system. These fields are set so that the unified landing page is able to obtain the
corresponding IB node for a given portal host node.

For each of the local nodes, select the Portal Host Node check box and enter the default local node
of the portal system in the Network Node Name field.
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See the product documentation for PeopleTools: Portal Technology, “Configuring the Portal
Environment,” Setting Portal Nodes.

d. Save the definition of the remote node.
6. Repeat steps 1 through 5 for each portal host node (EMPL, CUST, PART, SUPP, and ENTP) from the
portal system.

7. Repeat steps 1 through 5 for each default local node and portal host node from the other content
provider systems that needs to be defined as a remote node in this content provider database.

8. Repeat steps 1 through 7 on each content provider system.

Identifying All Trusted Nodes

After the remote nodes have been defined on each system, all the default local nodes participating in the
single signon configuration need to be identified on each system.

Identifying Trusted Nodes on the PeopleSoft Interaction Hub System
To identify the trusted nodes on the portal system:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Single Signon Setup section and select the Define
Trusted Nodes link to open the Single Signon page in the target area.

Alternatively, select PeopleTools > Security > Security Objects > Single Signon.

This example illustrates the Single Signon page listing all trusted default local nodes.

Single Signon
Authentication Token expiration time
Expiration Time in minutes: T200 i values are 1 - 10,000

Trust Authentication Tokens issued by these Nodes

Message Hode Hame Description Local Hode

PSFT_EF a, PS5 FOM - Local Mode =]
PSFT_HR aQ, PS HCM - Local Mode =]
PSFT_PA a, PeopleSaft Interaction Huhb 1 =]

See the product documentation for PeopleTools: Security Administration, “Implementing Single
Signon,” Implementing PeopleSoft-Only Single Signon, Working with the Single Signon Page.

3. Add the default local node from each content provider system as a trusted node.

4. Save the list of trusted nodes.

Identifying Trusted Nodes on a Content Provider System

To identify the trusted nodes on a content provider system:
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Select PeopleTools > Security > Security Objects > Single Signon.

See the product documentation for PeopleTools: Security Administration, “Implementing Single
Signon,” Implementing PeopleSoft-Only Single Signon, Working with the Single Signon Page.

Add the default local node (PSFT_PA) from the portal system as a trusted node.

If single signon is also to be implemented between content provider systems, then add the default
local node from each content provider system as a trusted node.

Save the list of trusted nodes.

Repeat steps 1 through 4 on each content provider system.

Adding Remote Nodes to the Integration Network

Once content provider nodes have been defined in the portal system, only default local nodes need to be
added to the integration network to complete the network configuration.

Note: If you added default local nodes from the content provider systems to the integration network
previously, then you might not need to complete this procedure.

See Configuring the Integration Gateway.

To add default local nodes from the content provider systems to the integration network:

1.

Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

In the Unified Navigation pagelet, select the IB Network WorkCenter link to open the integration
network's Configuration Status page.

Click the Node Network Configured link.

Alternatively, select PeopleTools > Integration Broker > Integration Network > Network
Setup.

See the product documentation for PeopleTools: Integration Broker Administration, “Using the
Integration Network,” Viewing Node Network Status.

For each remote node that is a default local node, select the option to make the node in network.
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This example illustrates the Node Network page showing the portal’s default local node (PSFT PA)
and one remote default local node (PSFT HR) as in-network.

ode Network

Secure Keystore Value Defined {Retum to Configuration Status:

Metwiork Modes (2

Configured in Active

- Remote Gateway Hode
Gateway Hode - o

Default Local Hode Hade In Hetwiork

PSFT_CR
PSFT_FO
PSFT_GF
PSFT_IM
PSFT_LM
PSFT_LS
PSFT_PF
BP
PSFT_CIS
cls

CRM

EIM

EPM
STAF
ELM

SA
PT_LDAP
PT_LOCAL
CUST
EMPL
ENTP
GOVT
PSFT_PA
PART
SUPP
PEFT_HR
HRMS
CAMP

5. Save the changes to the integration network.
Testing Single Signon

You can test your single signon configuration from the portal system after the remote nodes have been
defined and added to the integration network. The Unified Navigation Node Network page includes a
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button that allows you to test single signon for each remote node that has been defined as part of the
integration network.

In addition, successfully testing single signon requires that you complete the initial configuration steps.

Related Links

Completing Initial System Configuration

Setting Up Unified Navigation

Setting Up Unified Navigation

This topic discusses setting up unified navigation.

Pages Used to Setup Unified Navigation

Page Name Definition Name Usage

Unified Navigation Node Network Page | PTUN_REMOTENODECFG Test single signon for each remote
node. Optionally, specify whether to
synchronize user system profiles and
user personalization data.

Configure Drop Down Menu Page PTUN _DDMENUCFG Add a remote menu folder or content
reference and configure its location in
the portal system's drop-down menu.

Unified Navigation Node Network Page
To set up the unified navigation node network on the portal system:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Unified Navigation Setup section and click the Unified
Navigation Node Network link to open the Unified Navigation Node Network page in the target
area.
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This example illustrates the fields and controls on the Unified Navigation Node Network page. You
can find definitions for the fields and controls later on this page.

Hode Label
1 PS5 FDM - Local Mode
2 Poral Mode - ERF
3 PSHCM - Local Mode
4 Poral Mode - HRMS

DS_'..-'M-: User Personalization

DSync User System Profile

Unified Navigation Node Network

Unified Mavigation Mode Metwoark (2

Hode Hame
FSFT_EF
ERF
FSFT_HR
HREMS

4 1.4 04 W
Test Single Sign on
Test Single Sign on
Test Single Sign on
Test Single Sign on
Test Single Sign on

Field or Control

Description

Test Single Signon

Click the Test Single Signon button to validate the single
signon configuration for that remote node.

Sync User Personalization

Select this option to synchronize user personalization settings
(My Personalizations settings such as time zone) from the
portal system to all other remote systems defined in this node
network.

Sync User System Profile

Select this option to synchronize user profile settings (My
System Profile settings such as email addresses) from the
portal system to all other remote systems defined in this node
network.

Configure Drop Down Menu Page

306

Configuring the drop-down menu provides access to the menu structure of the remote system within the
main drop-down menu of the portal system. When a remote folder and a content reference is added to
the drop-down menu, it can be added under a unique local parent folder. Alternatively, multiple remote
folders or content references can be added under a single local parent folder.

Note: Prior to PeopleTools 8.54, you could add only remote folders in the portal registry. With
PeopleTools 8.54, you can also add content references to the unified remote folders.

Adding content references to the unified remote folders requires that both the portal system and the
content provider system must be on PeopleTools release 8.54 or later.

To add remote folders and content references to the drop-down menu:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation

WorkCenter page.
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2. In the Unified Navigation pagelet, expand the Unified Navigation Setup section and click the Select
Remote Content link to open the Configure Drop Down Menu page in the target area.

This example illustrates the fields and controls on the Configure Drop Down Menu page. You can find
definitions for the fields and controls later on this page.

Configure Drop Down Menu

Configure Drop Down Menu

Node Name Portal Hame Folder Label
1 CRM EMPLOYEE Customer Relations
2 HRMS EMPLOYEE Human Resources

Pagelet Import

PORTAL_ROOT_OBJECT

PORTAL_ROOT_OBJECT

Find | View Al | B2 First ‘&' 1-20f2 &/ Last

Local Parent Folder Name
Q, PORTAL_ROOT_OBJECT Q &=
Q PORTAL_ROOT OBJECT o #HE

Pagelet Import Find | View All | First ‘&' 10f1 &' Last
*Node Name Portal Hame Import/Synchronize
1 a ImportiSynchronize ] [=]
[ configure PortalHostode
Personalize | Find | View All | 2| [ First ‘&) 10f1 ‘& Last
Message Node Name Status
1
Field or Control Description

Node Name

Select a portal host node from the list of defined content
provider nodes.

Note: While default local nodes are also listed, use the portal
host node for the content provider.

Portal Name

The current portal name is automatically filled in after you
select the remote folder or local parent folder.

Folder Label

Enter the label for the new folder as it will appear in the
PeopleSoft Interaction Hub system's drop-down menu.

Important! Do not use the following special characters in the
labels for a remote folder: { } #.

Folder Name

Click the lookup button, navigate the tree of folders, and select
the remote folder from the content provider node.

Note: The selected remote folder and all menu items and
subfolders contained within it will be available in the drop-
down menu on the PeopleSoft Interaction Hub system.

Local Parent Folder Name

Click the lookup button, navigate the tree of folders, and select
the parent folder on the PeopleSoft Interaction Hub system.

Pagelet Import

The Pagelet Import grid is discussed in the Importing Pagelets
from Content Provider Systems topic.

See Importing Pagelets from Content Provider Systems.
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Field or Control Description

Configure PortalHostNode When you set up a unified navigation system, you must select

the Configure PortalHostNode check box.

In a unified navigation system, the Configure PortalHostNode
field ensures that the Home, Notifications, Logout options on
the portal system’s header point to the portal system.

Configuring Multiple Remote Folders in the Same Local Parent Folder

Two or more remote folders can be configured under the same local parent folder. To configure multiple
remote folders:

L.

2.

308

In the Configure Drop Down Menu grid, click the Add row button to add a new row.

In the Node Name field, enter or select a portal host node from the list of defined content provider
nodes.

In the Folder Label field, enter the label for the new folder as it will appear in the portal system's
drop-down menu.

Important! Do not use the following special characters in the labels for a remote folder: { } #.

In the Folder Name field, click the lookup button, navigate the tree of folders, and select the remote
folder from remote content provider node.

If the next remote folder is on the same remote node, skip to the next step. Otherwise, in the Node
Name field, enter or select a different portal host node from the list of defined content provider nodes.

In the Folder Name field, click the lookup button, navigate the tree of folders, and select the remote
folder from remote content provider node.

Repeat steps 5 and 6 for each remote folder to be added under the local parent folder.

In the Local Parent Folder Name field, click the lookup button, navigate the tree of folders, and
select the local root folder on the PeopleSoft Interaction Hub system.

Click Save to save the configuration.

In the following example, the local folder labelled Self Service includes two remote
folders from different content providers: CRM:CO_EMPLOYEE SELF SERVICE and
HRMS:CO_EMPLOYEE SELF SERVICE.

Configure Drop Down Menu

Configure Drop Down Menu Find | view All | B2 First 4/ 1-30f3 ‘»' Last
Hode Name Portal Hame Folder Label Folder Name Local Parent Folder Name

1 CRM EMPLOYEE gff‘;‘m;r PORTAL_ROOT_OBJECT Q PORTAL_ROOT_OBJECT Q [+ [=]

2 HRMS EMPLOYEE Human Resources PORTAL_ROOT_OBJECT Q@ PORTAL_ROOT_OBJECT Q [# [=]

3 HRMS EMPLOYEE Self Senvice CRM-CO_EMPLOYEE_SELF_SERVICE HRMSCO_EWMPLOYEE_SELF_SERVICE & PORTAL_ROOT_OBJECT a [+ [=
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Completing Configuration of Remote Content
To complete configuration of remote content, you must do the following:
» Update all content reference definitions that specify LOCAL NODE on each content provider system.

* Synchronize security settings for remote folders in the PeopleSoft Interaction Hub system.

Updating All Content Reference Definitions That Specify LOCAL_NODE

On each content provider system, update all content reference definitions that specify LOCAL NODE
as the node name to use the portal host node name instead. For example, on a PeopleSoft HCM content
provider system, the following SQL would update LOCAL NODE to the HRMS node:

update PSPRSMDEFN set PORTAL CNTPRV NAM='HRMS' where PORTAL REFTYPE='C' and PORTAL =

CNTPRV_NAM='LOCAL NODE' and PORTAL NAME='EMPLOYEE';

After updating the content reference definitions, you must delete the application server cache on both
the PeopleSoft Interaction Hub system and the content provider system, and then restart both application
servers.

Synchronizing Security Settings For Remote Folders

Remote folders are added with security set to public in the PeopleSoft Interaction Hub system. Therefore,
to ensure that only authorized users are allowed to see the remote folders in the drop-down menu, you
need to synchronize the new folder's security with the settings from the content provider system. To
synchronize the security settings between the systems, you must manually remove the public setting and
apply the same security settings that exist in the content provider system to the folder’s content reference
definition in the PeopleSoft Interaction Hub system.

Importing Pagelets

Once unified navigation configuration is complete, you can import pagelets from content provider
systems for use in the portal system. Your PeopleSoft Interaction Hub system offers three methods for
importing pagelets:

*  You can import or update all pagelets in bulk from a remote node.

*  You can import or update an individual pagelet for use within a specific PeopleTools feature, such as
homepage tab content, a WorkCenter, or as a related content service.

*  You can use PeopleSoft Interaction Hub-specific facilities to define a source application and import a
specific pagelet.

See Importing Pagelets from Content Provider Systems for details on each of these methods.

Additional Setup for Fluid Mode

After setting up unified navigation, you can set up additional functionality for Fluid mode.

* Select portal host node.
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*  Assign grouplets to delivered landing pages.

Selecting Portal Host Node

When you set up a unified navigation system, on the Configure Drop Down Menu page, you must select
the Configure PortalHostNode check box.

In a unified navigation system, the Configure PortalHostNode field ensures that the Home, Notifications,
Sign Out links on the portal system’s header point to the portal system.

See Configure Drop Down Menu Page.

Assigning Remote Grouplets/Tiles to Delivered Landing Pages

310

When you want to deliver landing pages to your users, an administrator can assign remote grouplets/tiles
to these landing pages.

An administrator uses the Grouplet Search page to search on grouplet/tiles in remote folders and assign
these to the delivered landing pages.

Note: The Grouplet Search page does not search on all categories across the cluster. You must search on
grouplets within a specific node and then add the required grouplet.

Navigation:

1. PeopleTools > Portal > Structure and Content
2. Click Fluid Structure Content.

3. Click Fluid Homepages.

4. Click Edit link of a content reference.

5. Click the Tile Content tab.

6. Click the Grouplet Search button.
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This example illustrates the fields and controls on the Grouplet Search page.

Grouplet Search

This grouplet search will allow the userto search the local and remote grouplets based

an the search criteria and the node selection.

Keywords
Search (2

*Node Name EMPL

Search Category Title -

Search Results
Grouplet Title
Company Mews
My Links
Classic Home
My Favorites
Fluid Home

E =N I s

Mavigator
Recent Places

= O

8 Your Oracle Database in the Cl
9 Company Mews
0

10 Performance

Return

contains

Personalize | Find | | E

Category

PeopleSoft Applications
PeopleSoft Applications
PeopleSoft Applications
PeopleSoft Applications
PeopleSoft Applications
PeopleSoft Applications
PeopleSoft Applications
Mews

MNews

Employee Self Service

EMPL

EMPL
EMPL
EMPL
EMPL
EMPL
EMPL
EMPL
EMPL
EMPL
EMPL

Help

Search

1-10 of 18 Last

Troubleshooting Unified Navigation Setup

This topic discusses the read-only configuration status and Integration Broker diagnostics pages that
display information on the unified navigation setup.

Pages Used to Troubleshoot Unified Navigation Setup

Page Name

Definition Name

Usage

Unified Navigation Configuration Status

Page

PTUN_UNINAVSTATUS

Displays list of nodes that are configured
in the Integration Broker network and in
single signon and folders created in the
PeopleSoft Interaction Hub system.

Integration Broker Diagnostics Page

PTUN_DIAGNOSTICS

Displays detailed information on nodes
configured in the Integration Broker
network and in single signon.
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Unified Navigation Configuration Status Page

The Unified Navigation Configuration Status page is a read-only page that displays the nodes in the
Integration Broker network, the trusted nodes in single signon, and the folders created in the PIH system.

To view the Unified Navigation Configuration Status page:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, click the Unified Navigation WorkCenter link to open the
Unified Navigation Configuration Status page in the target area.
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This example illustrates the nodes in the Integration Broker network, the trusted nodes in single signon,
and the folders created in the PeopleSoft Interaction Hub system.

Status Diagnostics

Unified Navigation Configuration Status

IB Network Setup

Following are the "In Metwork™ nodes setup in your system:

| Message Node Hame Description
1|C21JD103 Customer Relations
2| CAMP Portal Node - CAMP
3|CRM Portal Mode - CRM
4|CUST Portal Mode - CUST
5|EMPL Portal Node - EMPL
6|ENTP Portal Mode - ENTP
7|GOVT Portal Node - GOVT
8 (H21JD103 Human Capital Management
9|HRMS Portal Mode - HRMS
10|P91JD0O13 P3 PA - Local Node
11 |PART Portal Mode - PART
12 |PT_LOCAL PT_LOCAL
13|SUPP Portal Mode - SUPP

To addiupdate "In Network™ nodes, use "IB Network WorkCenter” link in the Unified Navigation pagelet.

Single Signon Setup

Following are the Trusted nodes setup in your system:

| Message Node Hame Local Node
1|C21JD103
2|H21JD103
3|P91JD013 1

To addiupdate Trusted nodes, use "Define Trusted Modes™ link in the Unified Mavigation pagelet.

Unified Navigation Setup

Following are the Unified Mavigation folders setup in your system:

| Hode Hame Folder Label
1|CREM Customer Relations
Z|HRMS Human Resources

To add/Update Unified Mavigation folders, use "Configure Drop Down Menu™ link in the Unified Mavigation pagelet.

Integration Broker Diagnostics Page

The Integration Broker Diagnostics page displays details of the nodes in the Integration Broker network
and the trusted nodes in single signon. The Integration Broker Diagnostics page enables you to review the
details of each active node without having to open the Node Definitions page for each node to check the
values entered in the node. However, if you need to modify any value of a node, you must open the Node
Definitions page.
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To view the Integration Broker Diagnostics page:
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1. Select Portal Adminisration > Unified Navigation WorkCenter to open the Unified Navigation

WorkCenter page.

2. In the Unified Navigation pagelet, click the Unified Navigation WorkCenter link to open the
Unified Navigation Configuration Status page in the target area.

3. On the Unified Navigation Configuration Status page, click the Diagnostics tab.

This example illustrates the nodes in the Integration Broker network and the trusted nodes in the single

signon setup.

Status Diagnostics
Integration Broker Diagnostics
Following are the "In Network™ nodes setup in your system:
IB Network Setup Personalize | Fina | & | =] First ‘4 1-130f13 ‘» Last
Message Node Hame |Description :;;: ﬁ:i:‘: E‘;‘Eeg\:a;ﬁ; ng::gmrm Portal URI Text Content URI Text
1]|c2110102 g!fa‘f‘;:;f PIA  |Ves  |LOCAL  |PSFTTARGET L\pﬂsp&‘é\;ﬁ;;ﬁgr;xan«p\a com:8000 !‘;tg:u:g';ﬁjeqaeer;xamp\e com 8000
A= E}DA?VEP‘ Node- [0 lves  |LocAL  |PSFTTARGET \f;jﬂ;:p;“\jlgl!lizg"?;;xamp\a com:8000 :wptg:n;ggfﬁsaileé;xamp\e com:8000
lerm Z;rvt:?‘ Node- (o Ives  |LOGAL  |PSFTTARGET Llnﬂ;:p‘;“élzwﬁ;T;grgxamp\e com:8000 !‘Ltg:a:gg%f]:-‘;a%egr;xamp\E com:8000
o|cust ;?JRSETWME - [a [ves [Loca  |psrrmamcer \f\pﬂgpp-‘f;\glﬁgzzxamp\a com:8000 :'\ptg:c;'prgﬁgaqegrjxan'\p\e com:8000
HEE E;’J\ﬁj Node - PlA Ves LOCAL PSFTTARGET L\pﬂs::"‘nglyiiE«'fgrﬁxaml:\e.:cm:ECCC !\ptt;:ﬂ?pn;ﬁgggﬁxam:\E com:8000
slente PoraiNode- oy oo [LoGAL  |PSFTTARGET ez mysener exampleconsd000 |repiimysener example com000
7|covt gg‘ﬁ(‘ Node- o e |LOCAL  |PSFTTARGET L‘pnspawﬁgmﬁxam;\e.:m.eccc !‘;ttgl:u:;'gﬁgavféﬁxamp\e com-2000
B . gg:ﬂ pa |ves LocAL |psFrmarcer \f\nﬂspp‘f‘;;li::‘;;):xamp\a com:2000 ::jtg:n;"‘l"\;ﬁ;:?;;xarnp\e com:3000
Management
ofurums :;ﬁ‘smm e es  llocal  |psFrmrcer L‘pﬂspp“"rly j‘:;‘.‘g‘;zxamp\e com:8000 I E;;v;éjxamp\e com:3000
TeEss Eg;‘:\- Local o |ves  |LocaL  |psFrmarceT \f\pﬂsp:p‘f“\j\gl{li;g‘?é;xa\np\a com:8000 :wptg:n";g{ﬁ;aile;;xamp\e com:8000
P P Ezgi Node- [ les  |LocaL L})ﬂé:pi:é\gm;B‘;&éjxamp\a com:8000 !‘wr)tgza‘:ggﬁggréjxamp\e com:8000
12|PT_LocAL PT_LOCAL [PIA |Yes  [LOCAL  |PSFTTARGET
13|supe ;aré:g Mode- o oo [local  |psermamcer L\pﬂspp“l‘égﬁ;S-?éjxamp\e com:8000 I};u;pa:ggﬁjaonfgjxample com:8000
Following are the Trusted nodes setup in your system:
Single Signon Setup Personalize | Find | 21| & First ‘4 1-210f21 '}/ Last
:]n;ds:ﬁ:m h;;aﬁl :::\ee Description Local Hode |Node Type |Active Node ‘G":E‘J";‘)‘f‘g ‘E:n'::gcmr Portal URI Text Content URI Text g::r‘tlenﬂ(lcahun S, P—
1|c21JD103 37i0103]H21D103 PIA Yes LOCAL E?”TMRG ‘,‘p";‘;“;‘;i;:’UE;;“"W‘E':”""EUDU :Lf;:;ﬁ;:g;”mp‘e comB000 |0 g PSADHIN |-

Field or Control

Description

Message Node Name

In the IB Network Setup grid, the Message Node Name
column displays all the active message nodes in the unified
navigation cluster.

Portal URI Text

In the IB Network Setup grid, the Portal URI Text column
displays the URI text for the portal servlet (psp) defined for
the node.

If you need to change this value, click the node name in the
Single Signon Setup grid.

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 26

Administering Unified Navigation in PeopleSoft Interaction Hub

Field or Control

Description

Content URI Text

In the IB Network Setup grid, the Content URI Text column
displays the URI text for the pscontent servlet (psc) defined for
the node.

If you need to change this value, click the node name in the
Single Signon Setup grid.

Node Name

In the Single Signon Setup grid, the Node Name column
displays all the active nodes associated with an active message
node that is configured with single signon in the unified
navigation cluster.

Click a node name to open the Node Definitions page where
you can modify the values if needed.

Related Links
Setting Up Unified Navigation

Setting Up Single Signon

Setting Up Related Content

This section provides an overview of setting up related content and discusses how to:

* Create a service to manage related content for a content provider system.

* Create and assign related content within the unified navigation framework.

Understanding the Setup of Related Content Within Unified Navigation

Related content on a PeopleSoft Interaction Hub system relies on the PeopleTools Related Content
Framework. You use the same PeopleTools pages and methodologies as on any other PeopleSoft
application system. However, with unified navigation, you have additional options for defining remote
resources as related content as well as configuring related content for content references on content

provider systems.

Once unified navigation has been configured to incorporate one or more content provider systems, you
have expanded options for configuring related content including:

¢ Create related content services in the portal system using the either local or remote content references.

Creating a service that allows you to manage related content for a content provider system is an
example of a service that is local to the portal system but is built on a remote content reference.

See Creating a Service to Manage Related Content for a Content Provider System.

* Create related content services in the content provider system using content references local to that

system.
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* Assign local (to the portal system) or remote content references (from a content provider system) as
related content services (or related actions) to content references on the portal system.

*  Assign local (to the content provider system) or remote content references (from a different content
provider system) as related content services (or related actions) to content references on the content
provider system.

For example, this would allow you to assign the content reference for employee expenses from
PeopleSoft FSCM to the content reference for employee information from PeopleSoft HCM.

Creating a Service to Manage Related Content for a Content Provider
System

The Unified Navigation pagelet of the Unified Navigation WorkCenter is delivered with a link that allows
you to manage related content on the (local) portal system. Once unified navigation is configured, you can
create a service on the portal system that will allow you to manage related content for a content provider
system. Once created, this service will appear as a link under the Related Content Service section of the
Unified Navigation pagelet.

The following example illustrates how such a service appears as the HRMS System link in the Unified
Navigation pagelet along with the Manage Related Content for Content References page from the remote

system.
Unified Mavigation WorkCent @ «
Comtent References Fivot Grids
Unified Mavigation o o
Manage Related Content for Content References
18 Network WorkCenter Related Content services are assigned to the following application pages:
» (O Single Signon Setup Search
'::' Configure hode for 550 Content References Find | viewall [0 First * 1-20 0786 * Last
O Define Trusted Modes Content Reference Edit Remove
= O Unified Mavigation Setup 1 Content Reference Edit Rermove
O Unified Mavigation Mode Metwork 2 Accumulators Edit Remaove
O Select Rermote Content 3 Administer Cycle Edit Remove
~ O Related Content Setup 4 Applicant Lists Edit Remove
O Local Portal Systern 5 Approve Budgeted Salary Change Edit Rermove
O HRMS System 6 Approve Documents (Hidden) Edit Remaove
T Approve Overtime Edit Femove
8 Approve Promaotion (Hidden) Edit Remave
9 Approve Salary Change (Hidden) Edit Remaove

To create a service that allows you to manage related content for a content provider system:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Related Content Setup section and click the Local
Portal System link to open the Manage Related Content Configuration page in the target area.

Alternatively, select PeopleTools > Portal. Related Content Service > Manage Related Content
Service.

3. Click the Create a New Related Content Service link to create a new service.
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4. Specify a new service ID, for example, RCSETUPHRMS, and click Add.

Note: This new service will be similar to the delivered RCSETUPLOCAL service.

5. In the Service Name field, enter a value that identifies the content provider system—for example,
HRMS System.

6. Ensure that PeopleSoft Component is the selected URL type.
7. In the Node Name field, select the portal host node from the content provider system.
8. Select the following component parameters:

*  Menu Name: PTCSSERVICES

e Component Name: PTCS SRVCFGSRCHGBL

*  Market: GBL

* Page Name: PTCS SRVCFG SRCH

9. In the Service URL Parameters group box, enter the following parameter and value:
*  Parameter Name: UniNavRcPglt

* Description: true

10. Retain the other default values for this service.

11. Save the new service definition. The following shows a completed service definition, which will
result in the FSCM System link appearing in the Unified Navigation pagelet:
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This example illustrates the fields and controls on the Define Related Content Service page.

Define Related Content Service

Serice Information (2

Senice ID RCSETUPHRMS

‘Service Name HRMS System Object Owner ID Q,
Description @
‘URL Type | Peoplesaoft Component “ Wirite help text

= URL Information

‘Node Name HRMS QL
Component Parameters
‘Menu Name PTCSSERVICES aQ ‘Market |GBL QO
‘Component Name PTCS_SRYWCFGERCHGBL Q Page Name |FTCS_SRWCFG_SRCH Q
CIpost mapping definition data Escape URL Parameters

Mote: parameter names are caze-sensitive.

Service URL Parameters |@ First B4 1 of 1 8 Last

'‘Parameter Hame Henuined 'Description
Flag
1 UnikavRePolt O |true =
Show Formed URL Test Related Content Service

Display Options

CIRrefresh O New Window
Select Security Options

MPublic Access CIRrelated Content Provider Security [CJrelated Content Consumer Security

DApp Class Required

See the product documentation for PeopleTools: Portal Technology, “Developing and Configuring
Related Content Services,” Defining Related Content Services, Creating and Maintaining PeopleSoft
Component Related Content Service Definitions.

Creating and Assigning Related Content Within the Unified Navigation
Framework

This section provides high-level procedures for how to:
+ Create related content services.
* Assign related content to application pages on the portal system.

* Assign related content to application pages on a content provider system.

Creating Related Content Services

Creating a related content service within PeopleSoft Interaction Hub uses standard Related Content
Framework pages delivered in PeopleTools. However, you can begin from the Unified Navigation
WorkCenter as documented here:
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1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Related Content Setup section and select one of the
following links:

* To create a service on the portal system, click the Local Portal System link.

* To create a service on a content provider system, click the link for that system—for example,
FSCM System—if one has been created.

See Creating a Service to Manage Related Content for a Content Provider System.

3. Click the Create a New Related Content Service link.
4. Add a new value.

The Define Related Content Service page is displayed.
5. Define the related content service:

* For a service on the portal system, you can base the service on a local resource or on a content
reference from a content provider system.

* For a service on a content provider system, you can base the service on a resource local to that
content provider system.
The PeopleTools PeopleBooks contain detailed information on creating various types of related content

services.

See the product documentation for PeopleTools: Portal Technology, “Developing and Configuring
Related Content Services,” Defining Related Content Services.

Assigning Related Content to Application Pages on the Portal System

Assigning related content within PeopleSoft Interaction Hub uses standard Related Content Framework
pages delivered in PeopleTools. However, you can begin from the Unified Navigation WorkCenter as
documented here:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Related Content Setup section.
3. To assign related content on the portal system, click the Local Portal System link.
4. Click the Assign Related Content to Application Pages link.
The Select a Content Reference page is displayed.
5. Browse the menu structure and select a content reference on the portal system.
The Assign Related Content page is displayed.

6. Assign one of the following service types from the following sources:
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* Content reference — From the portal system or from a content provider system.

+ Pagelet — From the portal system.

* Service — From the portal system.
The PeopleTools PeopleBooks contain detailed information on assigning related content to a content
reference.

See the product documentation for PeopleTools: Portal Technology, “Developing and Configuring
Related Content Services,” Assigning and Managing Related Content Services.

Assigning Related Content to Application Pages on a Content Provider System

Assigning related content within PeopleSoft Interaction Hub uses standard Related Content Framework
pages delivered in PeopleTools. However, you can begin from the Unified Navigation WorkCenter as
documented here:

1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Related Content Setup section.

3. To assign related content on a content provider system, click the link for that system—for example,
FSCM System—if one has been created.

See Creating a Service to Manage Related Content for a Content Provider System.

4. Click the Assign Related Content to Application Pages link.
The Select a Content Reference page is displayed.

5. Browse the menu structure and select a content reference on the content provider system.
The Assign Related Content page is displayed.

6. Assign one of the following service types from the following sources:

* Content reference — From the content provider system or from a different remote content provider
system.

* Pagelet — From the content provider system or from a different remote content provider system.
* Service — From the content provider system.
The PeopleTools PeopleBooks contain detailed information on assigning related content to a content
reference.

See the product documentation for PeopleTools: Portal Technology “Developing and Configuring Related
Content Services,” Assigning and Managing Related Content Services.
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Importing Pagelets from Content Provider Systems

Once unified navigation configuration is complete, you can import pagelets from content provider
systems for use in the portal system. Your PeopleSoft Interaction Hub system offers three methods for

importing pagelets:

* You can import all pagelets in bulk from a remote node. After importing pagelets, if changes are made
to one or more pagelets on the content provider system, you can update the pagelets in bulk.

*  You can import or update an individual pagelet for use within a specific PeopleTools feature, such as
homepage tab content, a WorkCenter, or as a related content service.

*  You can use PeopleSoft Interaction Hub-specific facilities to define a source application (remote
node) and import a specific pagelet.

Note: Templates that are used by the imported pagelets must be copied from the content provider systems
to the PeopleSoft Interaction Hub database.
See Remote Content References and Templates.

Pages Used to Import Pagelets from Content Provider Systems

Page Name

Definition Name

Usage

Pagelet Import Page

PTUN_DDMENUCFG

Import or update pagelets in bulk from a
content provider system.

Pagelet Search Page

PTUN PGLTSRCH SEC

Import or update a single pagelet to be
used within that PeopleTools feature—
for example, on a homepage tab or in a
WorkCenter.

Defining Source Application Page

EPPPB_SOURCE_APPS

Define a content provider as a source
application.

Add Pagelet Page

EPPPB_CP_ADD

Select a pagelet definition from a source
application and add it to the portal
system or to a specific workspace.

Pagelet Import Page

Use the Pagelet Import page (PTUN_DDMENUCFG) to import or update all of the pagelets from a
content provider system making them available for use on the portal system.

Note: Security is checked at runtime and does not have to be manually copied for imported pagelets.

Navigation:
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1. Select Portal Administration > Unified Navigation WorkCenter to open the Unified Navigation
WorkCenter page.

2. In the Unified Navigation pagelet, expand the Unified Navigation Setup section.

3. Click the Select Remote Content link to open the Configure Drop Down Menu page in the target
area.

The Pagelet Import section is displayed beneath the Configure Drop Down Menu section.

This example illustrates the fields and controls in the Pagelet Import section of the Configure Drop Down
Menu page. You can find definitions for the fields and controls later on this page.

Pagelet Import
Fagelset Import Find | Wigw Al Iﬁ| First 1 of 1 28 Last
'Hode Hame Portal Hame Import/Synchronize
1 HRMS EMFLOYEE ImportrSynchronize =
Field or Control Description
Node Name Select a portal host node from the list of defined content

provider nodes.

Portal Name The current portal name is automatically filled in after you
select the remote folder.

Import/Synchronize Click the Import/Synchronize button to import all pagelets
from the content provider into the portal system.

After importing pagelets, if changes are made to one or more
pagelets on the content provider system, click the Import/
Synchronize button to update the pagelets in bulk.

Pagelet Search Page

Use the Pagelet Search page (PTUN_PGLTSRCH_SEC) to import or update a single pagelet to be used
within that PeopleTools feature—for example, on a homepage tab or in a WorkCenter.

Navigation:
*  On the Tab Content page, click the Pagelet Search button.
*  On the Configure WorkCenter Page page, click the Select button in the Pagelets grid.

* On the Assign Related Content page, select Pagelet as the service type and click the Select button.
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This example illustrates the fields and controls on the Pagelet Search page showing a completed search on
a remote node.

Pagelet Search
Thiz pagelet search will allow the userto search the local and remote pagelet's based on
the search criteria and the node selection.
keywords
Search (7
*Iode MName ERF b
Search by Title v/ containg |project Search
Search Results Personalize | Find |2 | B First * 1-90r3 2 Last
Pagelet Title Category Origin
1 Manage Project Accounting Cross-Financials ERF
2 Top Projects Project Costing ERP
3 Project Transactions Pivot Froject Costing ERF
4 Project Amount By Department Grants ERF
A Expiring Projects General Ledger ERF
B Manage Programs & Projects Cross-Financials ERF
T lssue Priority by Project Frogram Managemeant ERF
2 Project Revenue Yariance General Ledger ERF
9 Critical Issues by Project Frogram Management ERF

Defining Source Application Page
This topic discusses how to:
* Define a content provider as a source application.
* Add a content provider pagelet as a homepage pagelet.

* Add a content provider pagelet as a workspace pagelet.

Define Source Applications Page

Use the Define Source Applications page (EPPPB_SOURCE APPS) to define a content provider as a
source application.

Navigation:

Portal Administration > Pagelets > Consume Pagelet
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This example illustrates the fields and controls on the Define Source Applications page. You can find
definitions for the fields and controls later on this page.

Source Applications
‘I

1 |[CUSTOMER

2 |[EMFLOYEE

3 |PARTMER

4 |SUPFLIER

g [FSCHM

Save

Source Application Definitions

Define Source Applications

Define the source applications to look for pagelet definitions.

‘Description

CUSTOMER Fortal
EMPLCYEE Partal
FPARTHER Partal
SUPPLIER Portal
FSCM Systermn

Add Pagelet

Find |2 First B 1.5 075 B L act
"Content Provider 'Site Hame
| Always use local w | | CUSTOMER v| [+ [=]
| Always use local v | EMPLOYEE v| # =
| Always use local | | PARTNER v| # =
| Always use local v | | SUPPLIER v| & =
|ERP v | | EMPLOYEE v| [# [=]

Use the Define Source Applications page to define a content provider system as a source application.

Field or Control

Description

ID Specify an ID for the content provider system.

Description Specify a description of the content provider system.

Content Provider Select the portal host node from the content provider system.
Important! The default local node of the content provider
system must be defined as a trusted system in the single signon
configuration.

See Identifying All Trusted Nodes.

Site Name Specify the corresponding portal for the portal host node.
Note: The default value is the EMPLOYEE portal.

Save Click the Save button to save your changes.

Add Pagelet Click the Add Pagelet button to add a content provider pagelet

as a homepage pagelet on the portal system.
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Add Pagelet Page

Use the Add Pagelet page (EPPPB_CP_ADD) to select a pagelet definition from a source portal and add
it to a template.

Navigation:
* Click the Add Pagelet button on the Define Source Applications page.
*  Click the Add Related Pagelet button on the workspace Administration - Modules page.

This example illustrates the fields and controls on the Add Pagelet page. You can find definitions for the
fields and controls later on this page.

Add Pagelet
Select a pagelet definition from the selected source application, and add it to the current site.
‘Source Application: | FECM System V|
'Pagelet Folder: | Billing " |
‘Pagelet Name: | Irwaice Analvsis by Month w |
Fagelet
‘Pagelet ID: EF_IMYOICE_AMALYSIS_BY_MOMTH
‘Pagelet Title Invoice Analysis by Month
Description:
‘Pagelet Folder: | Feoplesoft Applications d

= Pagelet Security

O Publish as Public

@ Publish with Security Roles ] Author Access

Selected Security Find | viewal |2 First B 1 o1 B gt

‘Type Hame Description

| Permission List % | ALLPAGES Q@ All pages and wehlibs [=]
Workspace Tabs Find | view sl |2 First B 125 or5 B Laat
Select Workspace Tab 'Pagelet Behavior

O Administration | Optional v |

] Guest | Optianal v |

] Investor | Optianal v |

My Page | Optional - Default v|

] RemuotelnifiedDashboard | Ciptional Lr |

Save Cancel FPreview Pagelet
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Use the Add Pagelet page to add an already defined pagelet to be available as a homepage pagelet.

Field or Control Description
Source Application Select the portal registry that is the source of the pagelet
definition.

To select the portal registry from the node of a content
provider system, that node must already be defined as a source
application.

See Defining Source Application Page.

Pagelet Folder Select the portal folder that is the source of the pagelet
definition.

Pagelet Name Select the pagelet definition.

Pagelet Name Displays the ID of the pagelet.

Pagelet Title Displays the title of the pagelet, which you can modify.

Description (Optional) Enter a description for the pagelet.

Pagelet Folder Select the folder in which the pagelet definition will be stored.
PeopleSoft Applications is the default folder for homepage
pagelets.

Pagelet Security Select a pagelet security option:

*  Publish as Public — Select to designate that all users can
access the pagelet.

»  Publish with Security Roles — Select to use the already
assigned role- or permission list-based security for the
pagelet.

Author Access Select to provide the pagelet author with access to the pagelet
regardless of any security restrictions assigned to the pagelet.
This access is granted based on the author’s user ID.

Select Select one or more homepage tabs for this pagelet:
*  Administration

*  Guest

»  Investor Portal

* My Page
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Field or Control Description

Pagelet Behavior Select the default behavior for the pagelet:

*  Optional — The pagelet will not automatically appear on
the homepage. However, it is available for selection when
users personalize their homepages. This setting should not
be used for guest homepage pagelets because guest users
do not have personalization privileges.

*  Optional-Default — The pagelet will appear on all user
homepages if they have access to the pagelet. The pagelet
can be removed when users personalize their homepages.

This setting should not be used for guest homepage
pagelets because guest users do not have personalization
privileges.

*  Required — The pagelet will appear on all user
homepages if they have access to the pagelet. The
placement of the pagelet cannot be changed and the
pagelet cannot be removed from the homepage.

*  Required-Fixed — The pagelet will appear on all user
homepages if they have access to the pagelet. The
placement of the pagelet can be changed, but it cannot be
removed from the homepage.

Note: Once a pagelet definition has been added, the definition is modifiable on the Content Ref
Administration page through Structure and Content, similar to other pagelet definitions.

See the product documentation for PeopleTools: Portal Technology, “Administering Portals,”
Administering Content References, Defining Content References.

Adding a Content Provider Pagelet as a Workspace Pagelet

When a content provider has been defined as a source application, pagelets from that content provider can
be added to workspaces and workspace templates.

See “Administering Workspace Modules” (Collaborative Workspaces).

See “Adding or Editing Related Pagelets in a Template” (Collaborative Workspaces).

Unified Navigation Support for Fluid Mode

PeopleSoft provides the PeopleSoft Fluid User Interface as a significant improvement to the PeopleSoft's
"classic" user interface. PeopleSoft Interaction Hub enhances the unified navigation functionality to
support PeopleSoft Fluid User Interface.

For more information on PeopleSoft Fluid User Interface, see the product documentation for PeopleTools:
Fluid User Interface Developer s Guide.

Important! Unified navigation features for Fluid mode are supported on PeopleTools release 8.54 and
later releases.
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Understanding Unified Navigation Support for Fluid Mode

328

Unified navigation functionality supports the following features for Fluid mode:

Unified Branding

You can apply common branding themes across a cluster. For further information on branding, see
Branding.

Unified Header Widgets

When you access a remote Fluid page, the branding themes and links in the header such as Home,
Notifications, and Sign Out are based on the PeopleSoft Interaction Hub system context. This ensures that
the Home, Notifications, and Sign Out links on the header point to the PeopleSoft Interaction Hub system.

Unified Navigation Bar (NavBar)

When you access a remote Fluid page, the Navigation Bar (NavBar) is based on the PeopleSoft
Interaction Hub system context. Additionally, the widgets on the NavBar such as Recent Places,
Navigator, and Favorites point to the PeopleSoft Interaction Hub system.

Unified Registry Support

The NavBar menu displays a unified registry that includes multiple remote content references and folders.
The remote folders must be set up on the PeopleSoft Interaction Hub system for NavBar menu to display
the unified registry.

Prior to PeopleTools 8.54, you could add only remote folders in the portal registry. With PeopleTools
8.54, you can also add content references to the unified remote folders.

Note: Adding content references to the portal registry requires that both the PeopleSoft Interaction Hub
system and the content provider system must be on PeopleTools release 8.54 or later.

You do not need to perform additional configuration to display a unified registry on NavBar. You use the
Unified Navigation WorkCenter to create the unified registry as you would use for Classic mode.

See Setting Up Unified Navigation.

Unified Local or Remote Tiles Support for Landing Pages and Navigation Bar
(NavBar)

Unified navigation supports search on remote grouplets/tiles across the PeopleSoft Interaction Hub and all
content provider systems in a cluster.

If you want to deliver landing pages for users, an administrator can assign remote grouplets/tiles to these
landing pages, by using the Grouplet Search page. See Assigning Remote Grouplets/Tiles to Delivered

Landing Pages.

A user can search on remote tiles to personalize a homepage or NavBar. See Personalizing Remote
Landing Pages and Navigation Bar.
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Unified Fluid Homepages

In a clustered environment, the PeopleSoft Interaction Hub system’s homepage renders Fluid homepages
defined in all content provider databases, except the PeopleTools delivered DEFAULT LP page. The
default homepage (DEFAULT LP) is loaded from the PeopleSoft Interaction Hub system.

PeopleSoft Interaction Hub provides the following features for Fluid homepages:

* The PeopleSoft Interaction Hub system’s homepage displays available fluid homepages from all
systems when you click the homepage title in the header.

»  User personalization data is saved in the same database as the fluid homepage. When a user
configures a remote homepage, the personalization data is stored on the remote database.

* The content of landing pages with the same system label is merged at runtime and only the merged
landing page is displayed. System label refers to the CREF label specified in the Structure and
Content page.

When a user performs any of these actions—add, delete, reorder, drag and drop tiles—on a merged
homepage, the user data on all original homepages is updated and saved in the respective databases.
For example, if the homepage is merged from an ELM homepage and an HCM homepage, the user
data on ELM and HCM homepages is updated. The user data of the ELM homepage is saved in the
ELM database, and the user data of the HCM homepage is saved in the HCM database.

* An administrator can assign a remote or merged fluid homepage as the default homepage based on
portal registry or user attributes through the branding theme assignment.

See “Branding User Attributes” (Branding).

* The Add to Homepage option in the Action Menu, adds the current transaction page to any local,
remote, or merged fluid homepage.

Remote Related Content
Adding related content is similar to how related content is set up in Classic mode.

See Setting Up Related Content.

Runtime Security for Remote Grouplets or Tiles

The Fluid framework provides runtime security for remote grouplets/tiles, so administrators do not have
to manually synchronize security for grouplets and landing pages.
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This graphic shows unified navigation support for Fluid mode.

Team Time

T

Common branding theme across a cluster

lil Request Absence

i Header links point to

I View Requests = @ portal system

T e Classic Home

Ii-! Absence Balances

Financials Supply Chain >
@ Manage Exceptions 1
My Favorit
v ravorites Human Resources 3
@ Reporting Locations
E Enterprise Components )
Navigator
Remote folders/CREFs
PeopleSoft | gisplayed in NavBar
oe—x
Remote/local widgets on NavBar I-
My Content »
Classic Home
Content Management 5
U Investor Portal >
Internal Controls Enforcer )

Personalizing Remote Landing Pages and Navigation Bar

You can personalize the remote landing pages and Navigation Bar by adding remote tiles. Tiles provide
access to PeopleSoft applications.

Personalizing involves:
* Adding a remote tile to a Fluid homepage.
* Adding a remote tile to the Navigation Bar (NavBar).

See the product documentation for PeopleTools: Applications User's Guide, Managing Fluid Homepages.

Add Tile Page (Fluid Homepage)

330

The Add Tile page displays categories from the PeopleSoft Interaction Hub system and all content
provider systems of a cluster.

Use the Add Tile page to add local or remote tiles to a homepage.
Navigation:

1. Navigate to any fluid homepage.

2. Select the Action menu.

3. Select Personalize.
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4. Click Add Tile.

This graphic illustrates the tiles from content provider systems that are available for selection in the Add
Tile feature on the Personalize Homepage

Add Tile X
Bearch »)
People Soft Applications 3
Categories from

=| PeopleSoft Interaction

News > Hub system
—
PeopleSoft Applications (Financials/Supply -\
Chain) 4
PeopleSoft Applications (Human Capital
Management) 4
Categories from content

> provider system
Manager Self Service (Human Capital
Management) ?
Employee Self Service (Human Capital s

Management)

You can use the Search field to search on individual tiles.

See the product documentation for PeopleTools: Applications User's Guide, Managing Tiles.

Add Tile Page (NavBar)

When you personalize a NavBar, the data is saved only on the PeopleSoft Interaction Hub system.

The Add Tile page displays categories from the PeopleSoft Interaction Hub system and all content
provider systems of a cluster.

Use the Add Tile page to add a remote tile to NavBar.

Navigation:
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1. Navigate to a portal header or a fluid homepage.
2. Click NavBar.
3. Select Personalize NavBar.

4. Click Add Tile.

Chapter 26

This example illustrates the tiles from content provider systems that are available for selection in the Add

Tile page invoked from NavBar.

A Q¥ =

~ Cancel ‘ Add Tile

Search

PeopleSoft Applications

MNews

PeopleSoft Applications (Financials/Supply
Chain)

PeopleSoft Applications (Human Capital
Management)

Manager Self Service (Human Capital
Management)

Employee Self Service (Human Capital
Management)

®

You can use the Search field to search on individual tiles.
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Setting Up the Notification Window

Notification Window consolidates new events occurring in PeopleSoft system in real time. The feature
notifies you on a new alert or an event that requires your attention while you are logged in. It also collates
all notifications when you are offline and displays them in a single window when you login. You can
select a notification to open the corresponding content reference and proceed with the action. You can also
select from dynamic labels to take quick actions on a notification item.

You as an administrator can configure the notification settings to control a notification for a particular
event like TriggerBusinessEvent or SendNote. You can enable or disable the notification for an event.
See Manage Notification section in the product documentation for PeopleTools: System and Server
Administration, “Using the Push notification Window”.

Also see the product documentation for PeopleTools: PeopleCode Language Reference for information on
TriggerBusinessEvent.

The Notification window icon is located at top right corner on the Fluid header along with home and
Navbar icons. A badge with a number on top of the Notification window icon indicates the number of
new notifications received. You can click the icon to open a modal window with Actions and Alerts tab.
Click on any actionable item to open the corresponding page to complete the action. Each item on the
Notification window has an Action Panel attached to it from where you can access Dynamic Label links.

The advantage of the Notification window in a clustered system is:

» Notifies you of any change in the content provider system.

» Enables you to access the remote content system pages from actionable notification items.
To setup the notification window in PeopleSoft Interaction Hub:

1. Verify the Push Notification settings are configured in content systems and PeopleSoft Interaction
Hub.

For more information on configuring Push Notification and Inter-Domain events, see the product
documentation for PeopleTools: System and Server Administration, “Setting Up Push Notification
Configurations”.

2. Verify the domain status for PeopleSoft Interaction Hub and other content systems are Active. Click
PeopleTools > Integration Broker > Service Operations Monitor > Administration > Domain
Status to verify and activate domains.

For more information see the product documentation for PeopleTools: Integration Broker
Administration, “Activity 4: Activating Pub/Sub Server Domains”.

3. Configure routings for PeopleSoft Interaction Hub and other content systems for the service
operations associated with PTPN IB_PUBLISH. The service operations associated with
PTPN_IB_PUBLISH service are:

« PTPN ASYNC PUBLISH

« PTPN_PUBLISH
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4. Click on a Service Operation link on Services page to open the Service Operation page where you can
add a new routing. To add a new routing;:

a. Select the Routings tab on Service Operations page.
b. Enter Routing Name and click the Add button. The IB Routings Definitions page appears.

For detailed information on the IB Routings Definitions page, see the product documentation for
PeopleTools: Integration Broker, “Configuring Routing Definitions”.

While defining the routings, keep in mind that in both the PeopleSoft Interaction Hub system and
content provider system, the Sender Node name is content system node name. The Receiver Node
name is Interaction Hub node name. Also note:

* The Direction is Inbound in PeopleSoft Interaction Hub system because the notification is
received by the Interaction Hub node.

* The Direction is Outbound in content provider system because the notification is sent by the
content provider system.
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Administering Multiple Application
Instances in Unified Navigation

Understanding Multiple Application Instances in Unified
Navigation

Unified navigation provides a framework to federate PeopleSoft applications under a single portal
system, the PeopleSoft Interaction Hub. Additionally, you can configure multiple instances of the same
application in PeopleSoft Interaction Hub. For example, your business need may require you to host
multiple instances of an application such as Recruiting, Time and Labor EMEA, and Time and Labor
APAC in a single PeopleSoft Interaction Hub system and direct a user to the appropriate instance to
complete a task. In such a scenario, the multi-instance functionality allows you to configure multiple
instances of a single application and experience seamless access to an instance based on security.

Important! This topic provides documentation on the multi-instance framework. The examples of
multi-instance setup and navigation-group split are provided for illustration purpose only. For the actual
implementation of the multi-instance setup and navigation group split, you mus¢ consult documentation
specific to your application.

Configuring multiple instances of the same application includes the following steps:
* Configure unified navigation (prerequisite).

* Add custom property in web profile.

» Configure a navigation group.

* Configure pagelets from different instances into the dashboard or WorkCenter.

* Configure related actions.

Setting Up Multiple Application Instances

This topic discusses how to set up multiple instances of an application in PeopleSoft Interaction Hub.

For purpose of illustrating the use of multi-instance setup, this topic describes a sample scenario that will
be referenced when discussing the steps in multi-instance setup. This sample scenario does not attempt
to cover all the business requirements that you may need in your organization. Your multi-instance setup
may vary from this sample scenario.
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Sample Scenario to lllustrate Multi-Instance Setup

This sample scenario has four HCM databases that are split based on product areas and geographical
regions.

The four databases and their portal nodes are listed here:
* HR Core
Portal Node: HRMS
e Recruiting
Portal Node: HRMS RECRUIT
* Time and Labor EMEA
Portal Node: HRMS EMEA
* Time and Labor APAC
Portal Node: HRMS APAC
The HR Core is the primary application and the Recruiting, Time and Labor EMEA, and Time and Labor
APAC are participating instances.

Prerequisite

Before attempting to set up multiple instances of an application, you must ensure that you have
successfully configured unified navigation on your portal system for the application that requires a multi-
instance setup.

Custom Properties Page

The EnableNavigationGroup custom property must be added in the portal system, the core application
system, and in the participating instances. This custom property must be added in the default web profile
of the portal system, the core application system, and the participating instances.

Use the Custom Properties tab of Web Profile Configuration page to add the EnableNavigationGroup
custom property in the default web profile.

Navigation:

PeopleTools > Web Profile > Web Profile Configuration and click the Custom Properties tab.
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This example illustrates the fields and controls on the Web Profile Configuration - Custom Properties

page.
] | virtual Addressing Cookie Rules Caching Debugging Look and Feel Custom Properties
Profile Hame: TEST
Custom Properties Find | View All First ‘4 1-7of 7 '*' Last
*Property Name Validation Type Property Value
EnableNavigationGroup Boolean = true [+ [=]
EnablePCModal Boolean - true [+][=]
PPMConsole Boolean - frue [+ (=]
auditPwD String - dayaff +][=]
checkForDuplicateCookies Boolean - false +][=]
noDefaultSignonForWorkdflow Boolean - false ﬂ ﬂ
parallelLoading Boolean - frue +][=]
Field or Control Description
Property Name Enter EnableNavigationGroup.
Validation Type Select validation type as Boolean.
Property Value Select property value as true.

Note: By default, navigation group is not enabled in the PeopleSoft Interaction Hub. If you want to
set up multiple instances, you must enable the EnableNavigationGroup property in the Web Profile
Configuration page.

Multi Instance Configuration Page
Use the Multi Instance Configuration page to define the core application and the participating instances.
Navigation:

Portal Administration > Navigation Group Configuration
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This example illustrates the fields and controls on the Multi Instance Configuration Page. You can find
definitions for the fields and controls later on this page.

Multi Instance Configuraticn

1 Core Node Definition

Personalize | Find | View Al | B4 | Ll First ‘' 10f1 ‘*' Last
*Core Application Name *Message Hode Name *Portal Name
1 @ EMPLOYEE (+]
Multi Instance Configuration
Core Application Name -
Personalize | Find | View All | £ =% First ‘4/ 10of1 ‘“*' Last
Portal Name Node Name Node Type
1 [EMPLOYEE a - [+ [=]
Personalize | Find | View Al | B | E First '4' 10f1 '/ Last
*Portal Object Name “Label *Node Name *Portal Name Delete
1 Q Q, [EmPLOYEE B [+]
Core Node Definition
Field or Control Description

Core Application Name

The name of the core application for which you need to set up
multiple instances. The core application is the content provider

system in unified navigation.

Message Node Name The message node of the core application.
For example, HRMS.
Portal Name The portal on which the unified navigation cluster is created.

The portal name is populated by default based on your unified

navigation configuration.

On clicking Save, the core application information is
saved and is available for selection in the Multi Instance

Configuration section.
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Field or Control

Description

Core Application Name

The core application name entered in the Core Node Definition

section is available for selection.

Portal Name The portal on which the unified navigation cluster is created.
The portal name is populated by default based on your unified
navigation configuration.

Node Name Select a node.

For example, select HRMS,
Node Type Choose a node type from the following:

Participant - the node that represents the participating
instances, for example, HRMS RECRUIT,

Portal - the node that represents the portal system, for
example, EMPL.

Primary - the node that represents the core application, for
example, HRMS.

Portal Object Name

The application instance that you want to include in the multi-

instance setup.

For example, HC TIME AND LABOR.

Label The label entered here is visible on the folder structure.
For example, Time and Labor EMEA.
Node Name The node applicable for the instance.

For example, HRMS_EMEA.

When you configure a navigation group, an Application Engine program is invoked that synchronizes the
navigation group data across the participating application instances in the unified navigation cluster and

updates the portal registry.

The navigation group must be configured for each portal in a unified navigation cluster. For example,
if you are logged into the EMPLOYEE portal and configure a navigation group, the configuration is
applicable only to the EMPLOYEE portal. You must log on to each participating portal and configure the

navigation group for each portal.
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When you add or delete folders and content references (CREFs), you must update the navigation group so
that the AE program is invoked to synchronize the navigation group and portal registry across the unified
navigation cluster.

PeopleSoft Interaction Hub provides you the flexibility to configure a functional navigation group or a
user based navigation group.

Navigation Group Based on Functional Split

In a functional split, all users who log into the multi-instance system are directed to a specific instance by
default.

For example, when you select the Recruiting folder and label it as Global Recruiting, and set the node
to HRMS_ RECRUIT, all users are directed to the recruiting instances hosted in HRMS_ RECRUIT by
default. The AE program creates a new recruiting folder with label as Recruiting Global.
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This example illustrates the folder structure when you create navigation group based on functional split.

=

W W W W D @ W W @ 5

= Recruiting

Administration
Employee Referrals
Postings

Reports

[Browse Applicants]
[Browse Job Openings]
[Search Applicants]
[Search Applications]
[Search Job Openings]
[Create Applicant]
[Create Job Opening]
[Applicant Lists]
[Interview Calendar]
[Pending Approvals)
[Saved Searches]

ecruiting Global

Administration
Employee Referrals
Postings

Reports

[Browse Applicants]
[Browse Job Openings]
[Search Applicants]
[Search Applications]
[Search Job Openings]
[Create Applicant]

Navigation Group Based on User Level Split

In a user-level split, you direct a user to an appropriate instance.

For example, two instances of Time and Labor are set up in the multi-instance system based on
geographical location (EMEA and APAC) and user is directed to the appropriate instance based on the
geographical location.
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This example illustrates the folder structure when you create navigation group based on user-level split.

NUI Structure Content
Company Directory
Manager Dashboard
Talent Summary

Org Chart Viewer

Self Service

Manager Self Service
Recruiting

Workforce Administration
Benefits
Compensation

Stock

Time and Labor
Time and Labor APAC
Time and Labor EMEA

) [+ [+) [#P] [+D [+) [+ |[+) [#] [+) [+] [+]} [+} [+]) [+] [+ [+ [+ E E

Payroll for North America

Global Payroll & Absence Mgmt

Payroll Interface
Workforce Development

Synchronizing Security

In a multi-instance unified navigation cluster, to access the folders and content references specified in the
navigation group, additional roles and permission lists are required to authorize access for users.

Security administrators must create additional roles and permission lists to synchronize security across the

multi-instance unified navigation cluster.
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Configuring Pagelets for Multi-Instance Cluster

When you create a navigation group, only the content reference URLs are resolved automatically on the
multiple instances of an application. You must manually configure pagelets from the multiple instances
into the dashboard or WorkCenter.

To configure pagelets from multiple instances:

1.

Navigate to the Manage Dashboard Pages page (PeopleTools > Portal > Dashboard > Manage
Dashboard Pages), and click the Pagelets button for the required dashboard.

On the Tab Content page, click the Pagelet Search button.
On the Pagelet Search page, enter the appropriate node name, and click Search.

Add the pagelet.

Configuring Related Actions for Multi-Instance Cluster

In a multi-instance unified navigation cluster, if related actions are available for different instances, you
must configure the related actions separately to point to the different instances. In such a case, for users
who have access to only one instance, a single related action pointing to the specific instance will be
available, but for users who have access to both the instances, two related actions will be available, so the
user can choose the instance they want to navigate to.

To configure related actions separately for different instances:

1.

Navigate to the Define Related Content Service page (PeopleTools > Portal > Related Content
Service > Define Related Content Service) and select the required service definition.

Click the Copy Service Definition button.

Enter a service ID and an appropriate label for the service.

Click Save.

Navigate to the newly created service definition.

Enter the appropriate node in the Node Name field, and click Save.
Assign the service definition to the appropriate pages.

Repeat steps 1—7 to configure related actions for another instance.
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Profiles

Understanding Business Attribute Usage

This feature enables Interaction Hub administrators to configure business attributes that are associated
with portal users by way of the Portal User Profile. These business attributes can include items such as
department, job code, location, and so on. Business attributes can be used as controls within PeopleSoft
Interaction Hub; for example, you can use them to control access to Managed Content. This enables you
to target content to a specific subset of users, based on the business attributes assigned to that content and
the specific attribute value associated with each user. For example, if you define a business attribute for
department, you can designate which department a managed content item is associated with, then only
portal users whose user ID is associated with that department would be permitted access to that item.

The business attribute data can be imported from PeopleSoft applications, such as PeopleSoft HCM, or
other applications. A set of predefined business attributes for PeopleSoft HCM are provided as sample
data, but you can create your own, as needed. To do so you must be familiar with the record structure for
that data, because when you configure a business attribute, you must identify the domain table name and
key that attribute is based on. Examples provided within this documentation are for configuring and using
this feature with PeopleSoft HCM.

Maintaining Business Attributes

Administrators use the Profile Configuration page to set up and maintain business attributes. Using this
page, they define the business attributes, designate the database records that contain their values, specify
the key field, and indicate whether the attribute is used to control access to managed content.

Assigning Business Attributes to Users

The business attributes that a user is associated with are stored in the PeopleSoft Interaction Hub User
Profile table (EPPCW_PROF HDR and EPPCW_PROF _ ATT). To assign business attributes to users,
you can import the data into the User Profile table. You can use the User Business Data Attributes page to
view the attributes associated with a specific user ID.

The User Business Data Attributes page relies on the PeopleSoft User ID to retrieve user profile details.
If the data source that populates the User Profile table does not contain the PeopleSoft User ID, it will be
necessary to make an association between the User Profile key and the PeopleSoft User ID. For example,
in the delivered sample User Profile data source, the HCM Workforce integration contains EMPLID

to identify employees, but not the related PeopleSoft User ID. The PSOPRDEFN table, whose key is
based on the PeopleSoft User ID, provides a ready-made association between the PeopleSoft User ID
and the EMPLID. Therefore, this association requires the EMPLID to be populated in the PSOPRDEFN
table in the Interaction Hub database. The handler that loads the User Profile can then determine which
PeopleSoft User's profile is being updated.
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Note: PeopleTools associates the EMP profile type with the PERSONAL DATA table which does not
exist in the Interaction Hub database, therefore even if EMPID are populated in Interaction Hub, they are
not displayed on the PeopleTools User Profiles page. A dummy record, EPPCW_PERS DATA has been
added for the EMP user type in Interaction Hub to display EMPIDs on the page. It is not necessary for
the EPPCW_PERS DATA table to be populated as its purpose is only to fulfill the requirement that the
profile type is assigned to a valid table in order for the EMPID to display.

Syncing New Users

New users are synchronized from the HCM database using Integration Broker services such as the
PeopleTools USER_PROFILE XFR Service Operation.

For new hires, it is possible that in HCM the employee's job data are entered into the system before an
operator id is assigned to the employee. The job data gets synced to the Interaction Hub, provided the
Integration Broker integration configuration is completed.

See, Populating the PeopleSoft Interaction Hub User Profile Table.

The Interaction Hub User Profile handler cannot tell which operator id the incoming job attributes belong
to, because the association does not exist in Interaction Hub. The handler allows the job data to be

stored until the operator id is created in HCM and synced into Interaction Hub, at that time the incoming
operator id is assigned to the job data in the Interaction Hub User Profile table. This scenario is handled
by activating the handler Portal update user profile of the USER_PROFILE XFR service operation.

For more details on transferring users between databases and setting up user profile types, see the product
documentation for PeopleTools: Security Administration, “Transferring Users Between Databases”.

See the product documentation for PeopleTools: Security Administration, “Setting Up User Profile
Types”.

Implementation Steps

The steps to implement business attribute controls are:

* Maintain business attribute definitions.

* Load the business attribute data tables.

* Populate the PeopleSoft Interaction Hub User Profile table.

* Add new business attributes.

You use the links listed in the Related Links area for more information about these implementation steps.

Related Links
Adding the Portal User Roles to All User IDs

Prerequisites

The following items are required to use business attributes:
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* Configure the Integration Broker integration gateway.
» Setup and activate single sign-on (this provides for PeopleTools User Profile synchronization).

See the product documentation for PeopleTools: Security Administration, “Working with User
Profiles Across Multiple PeopleSoft Databases.”

Maintaining Business Attribute Definitions

This topic discusses defining business attributes and reviewing assigned business attributes.

Pages Used to Maintain Business Attribute Definitions

Page Name Definition Name Usage
Profile Configuration Page EPPCW_PROF_CONFIG Define business attributes.
User Business Data Attributes Page EPPCW_VIEWPROFILE Review assigned business attributes.

Profile Configuration Page
Use the Profile Configuration page (EPPCW_PROF_CONFIG) to define business attributes.
Navigation:
Portal Administration > Profile Management > Profile Configuration

This example illustrates the fields and controls on the Profile Configuration page - Attributes tab. You can
find definitions for the fields and controls later on this page.

Profile Configuration
User Business Data Attributes Personalize | Find | | = First B4 1-4 of 4 B8 Last
Aftributes | Selection Details
*Attribute 1D *Attribute Label *Prompt Table *Key 1 Key 2 Key 3 Key 4

1 |BUSIMESSUNIT Business Unit BUS_UNIT_TBL_HAQ, |BUSINESS_UNIT |Gy Q Q Q [=]

2 [COMPANY Company COMPANY_TBL  |Q, [COMPANY Q Q Q Q =

3 [DEPARTMENT Department DEPT_TBL @ [seTD Q@ [oepTID Q aQ aQ =]

4 |LOCATION Location LOCATION_TBL Q, |SETID Q) [LOCATION Q Q, Q =
Field or Control Description
Attribute ID Enter a unique identifier for the attribute. This field is used as

the attribute key.

Attribute Label Enter a description for the attribute. This is the label that a
portal user sees when they select an attribute to assign to
managed content items.
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Field or Control Description

Prompt Table Select the record name of the table that contains the values for
the attribute.

Key 1 Select the field that is the primary key for the associated
prompt table.
Key 2, Key 3, Key 4 Select additional key fields, if applicable.

This example illustrates the fields and controls on the Profile Configuration page - Selection Details tab.
You can find definitions for the fields and controls later on this page.

Profile Configuration

User Business Data Attributes Personalize | Find |@ | H First 4] 1-4 pf 4 D Last
Aftributes Selection Details F=H
Display Order Active Secure Content
1 10 (=]
2 20 (=]
3 30 (=]
4 40 (=]
Field or Control Description
Display Order Enter a value to specify the order in which the attribute

appears in the User Business Data Attributes page. Attributes
appear in ascending order based on their display order value.

Active Select to enable usage of the business attribute. Only active
attributes appear on the Member Profile page.

Secure Content Select to enable use of the attribute to secure access to
managed content.

See “Administering Content Management Business Attribute
Security” (Content Management System).

User Business Data Attributes Page

Use the User Business Data Attributes page (EPPCW_VIEWPROFILE) to review assigned business
attributes.

Navigation:
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Portal Administration > Profile Management > View Profile

This example illustrates the fields and controls on the User Business Data Attributes page.

User Business Data Attributes

UserID: |VP1 ') Search
Yice President of Finance
= User Business Data Attributes Find First Kl 1-4 of 4 [+ Last
Employment Record: KLUO106-0
Business Unit: Ls004 GBI BU for LU=004
Company: GBI Glokbal Business Institute 9999
Department: 10000 Human Resources
Location; KUMYOO Corporation Headquarters

Last Updated: 2013-03-01

Employment Record: KLU0106-1

Business Unit: Us004 GBI BLU for US004

Company: GBI Glokbal Business Institute 9999
Department: 13000 Finance and Administration
Location; KUDEDD Delaware Cperations

Last Updated: 2013-03-01

Employment Record: KUO106-2

Business Unit: Us004 GBI BLU for US004

Company: GBI Glokal Business Institute 9999
Department: 10000 Human Resources

Location:; KUMYOO Corporation Headquarters

Last Updated: 2013-03-01

Employment Record: KL01068-3

Business Unit: Us004 GBI BLU for US004

Company: GBI Global Business Institute 29949
Department; 14000 Administration

Location:; KUMYOO Corporation Headquarters

Last Updated: 2013-03-01

Select a User ID for which to review attribute values, then click Search.

Loading Business Attribute Tables

These topics provide an overview of the business attribute table loading procedure and discuss how to:
» Use a DataMover script to load business attributes.

» Use the PeopleSoft Publish utility to load business attributes.
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* Synchronize business attributes.

See the product documentation for PeopleTools: Data Management, "Using the Publish Utility."

Understanding the Business Attribute Table Loading Procedure

System administrators are responsible for importing the record definition of the business attribute

tables into the PeopleSoft Interaction Hub database, if they do not already exist, as well as running the
necessary integrations to load the tables. This step needs to be done only once, at implementation time.
The tables are used to retrieve the description of the attributes for display on the User Business Data
Attributes page. System administrators can use PeopleSoft DataMover scripts or other utilities to export
the business attribute source table contents and import them into the Interaction Hub tables, or use some
of the more common integrations that may already exist. For example, when the business attributes data
source is PeopleSoft HCM, you can use the HR COMPANY FULLSYNC service operation, which uses
Integration Broker to transport data from PeopleSoft HCM to another node, to load the Company table.
For ongoing synchronization, the incremental service operations could be used. The following example
describes how to load the business attributes from PeopleSoft HCM.

Loading Business Attributes from PeopleSoft HCM
To load business attribute data from PeopleSoft HCM to PeopleSoft Interaction Hub:

1. Using Application Designer, login to the PeopleSoft HCM database, copy the record definition of the
business attribute table and any defined subrecords into a project, then export the project to a file.

For example, for the Department business attribute, you would export the record PS DEPT TBL and
its Related Language record.

2. Using Application Designer, login to the PeopleSoft Interaction Hub database, import the project from
the previous step and build the record definition.

Note: Steps 1 and 2 have been completed for these sample delivered PeopleSoft HCM 9.1 records:
BU UNIT TBL HR, COMPANY TBL, DEPT TBL, LOCATION TBL. If you are using a different
record version due to a different PeopleSoft HCM release or patch level, you will need to export

the record definition from PeopleSoft HCM and import that record definition into the PeopleSoft
Interaction Hub database.

3. For the initial data load, populate the tables using either a DMS script or the PeopleSoft Publish
utility.
Using a DataMover Script to Load Business Attribute Data
To use a DataMover (DMS) script:
1. Using DataMover, log in to the PeopleSoft HCM database and export the table to a flat file.

2. Using DataMover, log in to the PeopleSoft Interaction Hub database and import the file from the
previous step.
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Sample Export DMS Script

This is an example of a DMS script to export company data from PeopleSoft HCM.

set log c:\temp\company exp.log;
set output c:\temp\company.dat;
export COMPANY TBL;

export COMPNY TBL LANG;

Sample Import DMS Script

This is an example of a DMS script to import the company data that was exported from PeopleSoft HCM
into PeopleSoft Interaction Hub.

set log c:\temp\company imp.log;
set UPDATE DUPS;

set input c:\temp\company.dat;
import *;

Using the PeopleSoft Publish Utility to Load Business Attribute Data
To use the PeopleSoft Publish utility:
1. Configure Integration Broker in PeopleSoft HCM.
2. Configure Integration Broker in PeopleSoft Interaction Hub.
3. Run the PeopleSoft Publish utility in PeopleSoft HCM.

4. Verity the results in the PeopleSoft Interaction Hub database.

Note: In some cases, improved performance with FULLSYNC messages can be achieved by decreasing
the message size to be within the range of 25,000—100,000 bytes.

The following sample configuration describes the steps for the BU UNIT TBL HR full sync.

Configuring Integration Broker in PeopleSoft HCM
To configure Integration Broker in PeopleSoft HCM:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Service and select
BUS UNIT HR FULLSYNC.

2. Select the default service operation and set it to active.

3. Activate the routing to publish to the PeopleSoft Interaction Hub node. If no routing exists, add one.

Configuring Integration Broker in PeopleSoft Interaction Hub

To configure Integration Broker in PeopleSoft Interaction Hub:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Service.
2. Select and activate service BUS UNIT HR FULLSYNC.

If none exists, add a new service.
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Select and activate the default service operation.

« Ifthis is a new service, add an asynchronous one-way service operation
BUS UNIT HR _FULLSYNC.VERSION 1 using the corresponding message for the service.

» Ifno message exists, add a rowset-based message called BUS UNIT HR FULLSYNC, version
VERSION 1 and add record definition BUS_UNIT TBL_ HR to the root.

» If the service operation already exists for the Resource Finder feature and it uses a nonrowset-
based message, continue to next step. A new handler will be created downstream to update the
business attribute table.

* Set the Queue name to match the one for the service operation in HR, for example, HR _SETUP.
Verify that the service operation permission is set. If none exists, set the service operation security to
use permission list PAPP9000.

Activate handler. Depending on whether a handler already exists or not, proceed as follows:

» Ifno handler exists, add an application package/class in Application Designer using the sample
handler PeopleCode provided in “Sample Business Attributes Service Operation Handler
PeopleCode.” The application package is usually the same name as the service.

See Case 1: A Nonrowset-Based Message Does Not Exist for the Service Operation in PeopleSoft
Interaction Hub.

In PIA, add a handler to the service operation with the new application class.

» Ifahandler already exists for the Resource Finder feature, in Application Designer add a new
application class to the existing application package using the sample handler PeopleCode in
“Sample Business Attributes Service Operation Handler PeopleCode.”

See Case 2: A Nonrowset-Based Message Exists in PeopleSoft Interaction Hub for the Same-
Name Service Operation in PeopleSoft HCM.

In PIA, add a new handler to the service operation with the newly added application class.

Activate the routing.
If none exists, generate an Any-to-Local routing on the General tab of the Service Operation.

Select the Routing Parameters tab and verify the EXTERNAL alias matches the expected incoming
message name and version (BUS UNIT HR FULLSYNC.VERSION 1 in this example).

Running the PeopleSoft Publish Utility in PeopleSoft HCM

To run the PeopleSoft Publish utility, complete these steps in PeopleSoft HCM:

1.

2.

Navigate to Enterprise Components > Integration Definitions > Full Data Publish Rules.

Select Service Operation BUS UNIT HR FULLSYNC and verify that it is active. Select Create
Message Header and Create Message Trailer if they are not already selected.

Navigate to Enterprise Components > Integration Definitions > Initiate Processes > Full Data
Publish.
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4. Add a run control or use an existing one.

5. Set Service Operation to BUS UNIT HR FULLSYNC and click Run.
6. Select the Full Table Data Publish process and click OK.

7. Verify process goes to Success.

8. Navigate to PeopleTools > Integration Broker > Service Operations Monitor >
Monitoring > Asynchronous Services.

9. Select the Publication Contracts page and verify transaction(s) are successful.

Verifying the Results in the PeopleSoft Interaction Hub Database
To verify the results, in PeopleSoft Interaction Hub complete these steps:

1. Navigate to PeopleTools > Integration Broker > Service Operations
Monitor > Monitoring > Asynchronous Services.

2. Select the Subscription Contracts page and verify transaction(s) are successful.

3. Verify the User Profile has been populated by querying the BUS UNIT TBL HR table.

Synchronizing Business Attributes

For incremental synchronization of the business attributes, repeat steps 1, 2, and 4 in Using the PeopleSoft
Publish Utility to Load Business Attribute Data, using service operation BUS UNIT HR SYNC.

See Using the PeopleSoft Publish Utility to Load Business Attribute Data.

Populating the PeopleSoft Interaction Hub User Profile Table

A sample integration based on the Workforce service operation is provided to populate job-related data
from the PeopleSoft HCM database. You must configure Integration Broker for the source database and
the PeopleSoft Interaction Hub database, then run the PeopleSoft Publish utility for the source database,
and verify the results in the PeopleSoft Interaction Hub database.

To populate the PeopleSoft Interaction Hub User Profile table using the delivered service:
1. Configure Integration Broker in PeopleSoft HCM:
a. Navigate to PeopleTools > Integration Broker > Integration Setup > Service .
b. Open the WORKFORCE FULLSYNC service.
c. Select the default service operation WORKFORCE FULLSYNC.INTERNAL and set it to active.
d. Add arouting from PeopleSoft HCM to PeopleSoft Interaction Hub.

e. Select the Routing Parameters tab, and enter the following values to transform the transaction to
the VERSION 2 service operation:
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Field or Control Description

External Alias WORKFORCE_FULLSYNC.VERSION_2
Message.Ver into Transform 1 WORKFORCE_FULLSYNC.INTERNAL

Message.Ver out of Transforms WORKFORCE_FULLSYNC.VERSION_2

Note: Some earlier PeopleSoft HCM 9.1 builds have WORKFORCE FULLSYNC.VERSION 2
as the default service operation version instead of WORKFORCE _FULLSYNC.INTERNAL.

In that case the transformation step is not needed, as the external alias should

match the service operation external alias in PeopleSoft Interaction Hub

(WORKFORCE _FULLSYNC.VERSION 2).

Note: If a routing already exists for the Resource Finder integration, a separate routing should be
created since the Resource Finder routing requires the WORKFORCE FULLSYNC.VERSION 2
to be transformed to WORKFORCE FULLSYNC.VERSION 1

2. Configure Integration Broker in PeopleSoft Interaction Hub:
a. Navigate to PeopleTools > Integration Broker > Integration Setup > Service.
b. Open the WORKFORCE FULLSYNC service.
c. Select the service operation WORKFORCE FULLSYNC V2.VERSION 2 and set it to active.
d. Activate the handler.
e. Activate the Any-to-Local routing.

f. Select the Parameters tab and verify External Alias = WORKFORCE FULLSYNC.VERSION 2.

3. In PeopleSoft HCM, run the PeopleSoft Publish utility:
a. Navigate to Enterprise Components > Integration Definitions > Full Data Publish Rules.

b. Select the WORKFORCE FULLSYNC service and select the Create Message Header and
Create Message Trailer options if they are not already selected.

c. Navigate to Enterprise Components > Integration Definitions > Initiate Processes > Full
Data Publish.

d. Add a run control, or use an existing one.
e. Set Service Operation to WORKFORCE FULLSYNC and click Run.
f. Select the Full Table Data Publish option and click OK.

g. Verify the process status updates to Success.
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h. Navigate to PeopleTools > Integration Broker > Service Operations Monitor >
Monitoring > Asynchronous Services.

i.  Go to the Publication Contracts page and verify the transactions are successful.

4. Verify the results in PeopleSoft Interaction Hub.

a. Access PeopleTools > Integration Broker > Service Operations
Monitor > Monitoring > Asynchronous Services.

b. Access the Subscription Contracts page and verify the transactions are successful.

c. Verify the user profile has been populated by querying the EPPCW_PROF HDR table.

Incremental Synchronization of User Profile
Repeat steps 1, 2, and 4, using WORKFORCE_SYNC instead of WORKFORCE FULLSYNC:

* In PeopleSoft HCM, use the service operation WORKFORCE SYNC.VERSION 2 or
WORKFORCE_SYNC.INTERNAL transformed to VERSION 2.

* In PeopleSoft Interaction Hub, use service operation WORKFORCE SYNC V2.VERSION 2.

Adding New Business Attributes

The delivered service operation, WORKFORCE FULLSYNC_V2.VERSION 2, extracts only
these business attributes for all active jobs from PeopleSoft HCM: business unit, company,
department, and location. To add additional business attributes, you can either modify the delivered
WORKFORCE FULLSYNC V2.VERSION 2 service, or create a custom service.

Modifying the WORKFORCE_FULLSYNC_V2.VERSION_2 Service Operation

To modify the delivered WORKFORCE FULLSYNC V2.VERSION 2 service operation to extract
additional user profile attributes:

1. Access the Profile Configuration page by selecting Portal Administration > Profile
Management > Profile Configuration, and define the new business attributes.

See Profile Configuration Page.

2. Load the business attributes table.

See Loading Business Attribute Tables.

3. Modify the transform programs XSLT WORKFORCEUSERPROFILE FS (for the full sync) and
XSLT WORKFORCEUSERPROFILE SYNC (for the incremental) sync as follows:

a. In Application Designer, open HTML object.

b. Locate the “attribute” element XSLT, for example: <xsl:element name="attribute">.
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c. Within the “attribute” element, duplicate an “attribute” child element and update attributeName,
fieldName, fieldValue.

The following example shows these elements:

<xsl:element name="attribute">
<xsl:attribute name="attributeName">BUSINESSUNIT</xsl:attribute>

<xsl:element name="attributeField">

<xsl:attribute name="fieldName">BUSINESS UNIT</xsl:attribute>

<xsl:attribute name="fieldValue"><xsl:value-of
select="(PER_ORG_ASGN/JOB[HR STATUS='A']) [last ()]/BUSINESS UNIT"/></xsl:a=>

ttribute>
</xsl:element>

Refer to the “Sample XSLT for the WORKFORCE FULLSYNC User Profile Message” section
for details on the delivered XSLT.

4. Load the User Profile table.

See Populating the PeopleSoft Interaction Hub User Profile Table.

Creating a Custom Service
To create your own custom service:

* Access the Profile Configuration page by selecting Portal Administration > Profile
Management > Profile Configuration, and define the new business data attributes.

See Profile Configuration Page.

¢ Load the business data attributes table.

See Loading Business Attribute Tables.

* Create a service to publish from the source database.

If the source database is a PeopleSoft database, you can use the delivered
WORKFORCE_ FULLSYNC as a model for your custom service, making any changes required for
your specific situation.

* In PeopleSoft Interaction Hub, create a XSL transformation to transform the incoming XML, if
applicable.

You can use the delivered XSLT WORKFORCEUSERPROFILE FS as a model for the Full
Sync XSL transformation and XSLT WORKFORCEUSERPROFILE SYNC as a model for the
Incremental Sync XSL transformation.

Sample XSLT for the WORKFORCE_FULLSYNC User Profile Message

This section includes an example of XSLT for the WORKFORCE FULLSYNC User Profile message.
The XSLT has the following structure:

e For each transaction, there is a top “profile” element.

e The “profile” element has an attribute “profileType”, such as Employment record.
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*  The “profile” element has child elements “profileKeys” and “attributes.”

* The “profileKey” elements are nested within “profileKeys” and represent the values that uniquely
identify each profile occurrence.

e The “attribute” elements are nested within the “attributes” element. The related attribute
“attributeName” identifies individual user profile attributes, for example, BUSINESSUNIT.

* The “profileKey” and “attributeField” have attribute pairs “fieldName” and “fieldValue”, for example,
attributeField fieldName=BUSINESS UNIT, fieldValue= xsl:value-of select="(PER_ORG_ASGN/
JOB[HR STATUS="A’])[last()]/BUSINESS UNIT.

<xsl:for-each select="WORKFORCE FULLSYNC/MsgData/Transaction">

<xsl:element name="profile">
<xsl:attribute name="profileType">EMPLOYMENT RCD</xsl:attribute>

<xsl:element name="profileKeys">

<xsl:element name="profileKey">

<xsl:attribute name="fieldName">EMPLID</xsl:attribute>

<xsl:attribute name="fieldValue"><xsl:value-of
select="PER_ORG_ASGN/EMPLID"/></xsl:attribute>

</xsl:element>

<xsl:element name="profileKey">
<xsl:attribute name="fieldName">EMPL RCD</xsl:attribute>
<xsl:attribute name="fieldValue"><xsl:value-of
select="(PER ORG ASGN/JOB[HR STATUS='A']) [last()]/EMPL RCD"/></xsl:attribute>
</xsl:element>

</xsl:element>

<!-- Identify Attribute -->
<xsl:element name="attributes">

<xsl:element name="attribute">
<xsl:attribute name="attributeName">BUSINESSUNIT</xsl:attribute>

<xsl:element name="attributeField">
<xsl:attribute name="fieldName">BUSINESS UNIT</xsl:attribute>
<xsl:attribute name="fieldValue"><xsl:value-of
Select:"(PER_ORG_ASGN/JOB[HR_STATUS:'A'])[last()]/BUSINESS_UNIT"/></xSl:attribute>
</xsl:element>
</xsl:element>

<xsl:element name="attributes">

<xsl:element name="attribute">
<xsl:attribute name="attributeName">DEPARTMENT</xsl:attribute>

<xsl:element name="attributeField">
<xsl:attribute name="fieldName">SETID</xsl:attribute>
<xsl:attribute name="fieldValue"><xsl:value-of
select:"(PER_ORG_ASGN/JOB[HR_STATUS:'A'])[last()]/SETID_DEPT"/></XSl:attribute>
</xsl:element>

<xsl:element name="attributeField">
<xsl:attribute name="fieldName">DEPTID</xsl:attribute>
<xsl:attribute name="fieldValue"><xsl:value-of
select="(PERﬁORGﬁASGN/JOB[HRﬁSTATUSz'A'])[last()]/DEPTID"/></xsl:attribute>
</xsl:element>
</xsl:element>
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PeopleSoft-Delivered Security Data

Summary of Delivered Security Data

The following list provides an overview of important security information:

* Every component, PeopleCode Web library, interface, registry item, and so on, specific to PeopleSoft
Interaction Hub is assigned to two permission lists. These permission lists are:

* A system administer permission list in the form xxxx9000.
*  One of the feature-specific permission lists in the form xxxxNNNN.
» Pagelet permission lists include the pagelet, the personalization, and usually the enhancement pages
that are accessible from the pagelet.
* PeopleSoft Interaction Hub security for each feature is divided into three groups:
¢ Administrator
Feature implementation and set up.
Highest security level.
*  Manager
Feature maintenance, distribution, and usage.
Medium security level.
*  User
Feature access, viewing, and usage.
Low security level.
* All logged on user IDs (except for the Guest user) must contain the roles PeopleSoft User and
PAPP_USER, or a cloned version of the roles.

* The GUEST user ID must contain the roles PeopleSoft Guest and PAPP_GUEST, or a cloned version
of the roles.

* The required roles (PAPP_USER, PAPP_GUEST, PeopleSoft User, and PeopleSoft Guest) contain
specific permission lists that are necessary to access the base portal features.

You can adjust cloned roles to as needed, but you must keep the following permission lists on the
specified role:
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*  PTPT1000 is necessary to access the PeopleTools portal base features (included in the role

PeopleSoft User).

»  PAPPO0000 is necessary to access the PeopleSoft Interaction Hub base features (included in the

roles PAPP_USER and PAPP_GUEST).

* PAPPO0001 is necessary for the Guest tab (included in the role PAPP_ GUEST).

*  PAPP0002 is necessary for the homepage Personalization (included in the role PAPP_USER).

Note: When enabling role grant security, you must include the roles PeopleSoft User and PAPP_USER.
These roles are required for access to base portal functionality.

Permission Lists and Roles Cloned When Creating Sites

When you create sites, the system clones and uses special permission lists and roles on the site. This

section describes:

» Permission lists cloned when creating sites.

* Roles cloned when creating sites.

Permission Lists Cloned When Creating Sites

When you create a site, the system clones and uses the following permission lists on the site content and
folder definitions. The Installation Options page lists which permission lists to clone during site creation.
These are delivered as PAPP5000, PAPP5060, PAPP5070. The generated permission lists are listed in the

following table, where XXX represents the site name.

Permission List

Description

SITE_XXX_ADM

Gives site-specific access for the site administrator to set
navigation defaults, set security access to the site, and review
and override Branding elements for the site. It is generated by
cloning PAPP5000 during site creation.

SITE XXX _PUB

Gives site-specific access for publishing menu items in the
navigation of the site. It is generated by cloning PAPP5060
during site creation.

SITE_XXX_VWR

Gives site-specific access to view the site. It is generated by
cloning PAPP5070 during site creation.

Roles Cloned When Creating Sites

When you create a site, the following roles are generated and assigned site-specific permission lists.
These roles are attached to the appropriate user who is assigned security access to the site.
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Role Description

SITE XXX ADM Gives site-specific access for the site administrator to set
navigation defaults, set security access to the site, and review
and override Branding elements for the site. It contains

the matching permission list SITE XXX ADM which is
generated during site creation.

SITE XXX PUB Gives site-specific access for publishing menu items in the
navigation of the site. It contains the matching permission list
SITE_XXX PUB which is generated during site creation.

SITE_XXX_VWR Gives site-specific access to view the site. It contains the
matching permission list SITE_XXX_ VWR which is
generated during site creation.

Related Links

Permission Lists with Special Uses

Permission Lists

This section describes:
»  Permission lists that have special meaning and usage in PeopleSoft Interaction Hub.

* All permissions delivered with PeopleSoft Interaction Hub.

Permission Lists with Special Uses

The following table describes permission lists that have special meaning and usage in PeopleSoft
Interaction Hub.

Permission List Description

PAPP9000 Includes every delivered PeopleSoft Interaction Hub object
(excluding Pagelet Wizard and Resource Finder objects).

This permission list is included in the role PAPP_SYSTEM
ADMIN.

PAPX9000 Includes every delivered Resource Repository object.

This permission list is included in the role PAPP_SYSTEM
ADMIN.
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Permission List

Description

PAPP0000

Required to access the PeopleSoft Interaction Hub base
features.

This permission list is included in the roles PAPP_USER and
PAPP_GUEST.

PAPX0000

Required to access the Resource Repository base features.

This permission list is included in the roles PAPP_USER and
PAPP_GUEST.

PAPP0001

Required for the Guest tab.

This permission list is included in the role PAPP_GUEST.

PAPP0002

Required for Personalize Content and Layout links on the
homepage and the My Links feature in the portal header.

This permission list is included in the role PAPP_USER.

PAPQnnnn

Required for access to Internal Controls Enforcer Portal
items in the left navigation and for access to Internal Controls
Enforcer pagelets.

PAPJnnnn

Required for access to EnterpriseOne applications from the
PeopleSoft Interaction Hub.

PTPT1000

Required to access the PeopleTools base portal features.

This permission list is included in the PeopleTools role
PeopleSoft User.

If you use a cloned version of this permission list, make sure
to retain the needed iScripts and component interfaces security
required to access the portal and end-user base access items,
such as changing a password.

PTPT1400

Required to access the PeopleTools base portal features for a
guest user.

This permission list is included in the PeopleTools role
PeopleSoft Guest.

Delivered Permission Lists

The following table lists all permission lists delivered with PeopleSoft Interaction Hub.
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Permission List

Description

Usage

PAPP0000

Base PeopleSoft Interaction Hub objects.

Base access to the navigation and
template iScripts (Web Libraries), portal
search results page, Take a Survey page,
Workspace error access page, Site
Manager error access page, template
pagelets (Content Ratings, Related
Information, Related Contacts), menu
item file attachment viewer pages, and
the Language Selection pagelet.

This permission list is required for all
users, including GUEST.

PAPP0001

Base Guest objects.

Access the homepage tab Guest Page and
the Sign On pagelet.

This permission list is required for the
GUEST user.

PAPP0002

Logged in user access.

Access the homepage Personalize
Content and Layout pages, and My Links
pages, the user profile pages, and the
Related Discussion Template pagelet.

Required access for all users, except
Guest.

PAPP0010

PeopleTools Notification.

Access the email notification pages from
the PeopleTools Notify button.

PAPP1000

External News pagelets.

Access the integrated External News
feed and RSS News pagelets.

PAPP1100

Company News pagelets.

Access the News Publication pagelets,
pagelet personalization, and pagelet
enhancement pages for viewing sections
and published articles.

PAPP1110

Company Promotions pagelet.

Access the Company Promotions pagelet
and pagelet personalization.

PAPP1120

Web Magazine pagelet.

Access the Web Magazine pagelet and
Web Magazine viewing.

PAPP1130

Promotions by Role pagelet.

Access the Promotions by Role pagelet.

To access the results page, roles with
this permission list must also include
permission list PAPP2030 (Manage
Company Promotions).
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Permission List

Description

Usage

PAPP1140

My Managed Content Pagelet.

Access the My Managed Content pagelet
and pagelet personalization.

Note: To access the links on this pagelet,
roles with this permission list must

also include permission list PAPP2010
(Access Content Management).

PAPP1150

My News Content Pagelet.

Access the My News Content pagelet.

Note: To access the links on this pagelet,
roles with this permission list must

also permission list PAPP2010 (Access
Content Management). To access the
Review for Publishing link, roles with
this permission link must also include
permission list PAPP2020 (Publish News
Articles).

PAPP1160

Submitted Promotions pagelet.

Access the Submitted Promotions
pagelet.

To access the links on this pagelet,
roles with this permission list must
also include permission list PAPP4110
(Submit Promotion Items).

PAPP1170

Poll Pagelet.

Access published Poll pagelets to
respond to the current poll question.

Note: Users must be included in the Poll
definition's respondent roles to respond
or view any given poll. Users do not
need member privileges or access to the
Poll definition in order to respond to a
poll question.

PAPP1200

Tasks pagelet.

Access the Integrated Task List
pagelet, pagelet personalization,
pagelet enhancement pages, and to
the PeopleTools Worklist and Worklist
Details pages.

Note: To access links for action items,
roles with this permission list must
also include permission list PAPP5600
(Access Action Items).
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Permission List

Description

Usage

PAPP1210

View Community Calendars.

View Community Calendars in display-
only mode. Access the Community
Calendar search results page. Calendar
access is restricted by member privileges
on the Calendar definition.

Note: This permission list is required
to view the links on the Pagelet Wizard
generated Community Calendar pagelets.

PAPP1300

Email/Calendar pagelets.

Access the Email and Calendar pagelets
and pagelet personalization pages.

PAPP1500

Internet Information pagelets.

Access the Internet HTML pagelets and
associated component interfaces and web
libraries.

PAPP1600

Saved Searches pagelets.

Access the Saved Searches pagelets,
pagelet personalization, and pagelet
enhancement Search Results pages.

PAPP2000

Access Published Content.

Access the Content Management
published content viewer pages,
hierarchy viewer pages, and Browse
by Category viewer pages. Content and
folder access is restricted by member
privileges on the Folder definition, or
content viewer roles on the Content
definition, or folder viewer roles on the
Folder definition.

Note: This permission list is needed for
all users when Content Management
folders and content items are published
as menu items in the left navigation or
published as pagelets or available from
the portal search.

PAPP2010

Access content management.

Access the hierarchy management
pages, hierarchy search pages, content
definition pages, folder definition
pages, the My Content Status pages,
and the content web services. Content
Management access and actions are
restricted by member privileges on the
Folder definition, or to users listed as
Top Administrators for the Content
Management feature.
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Description

Usage

PAPP2020

Publish News Articles.

Access the News Publications Publish
Articles page, the Unpublish Articles
page, and the Choose Top Stories page.

Note: To access the pages for viewing
and editing content, roles with this
permission list must also include
permission list PAPP2010 (Access
Content Management)

PAPP2025

Administer News content.

Administer News Publication articles
and images. These pages allow the user
to delete, add, and update news articles
and images, ignoring the privilege set or
status of the content.

This permission list should only
be granted to high-level content
administrators.

To access the pages for viewing and
editing news content, roles with this
permission list must also include
permission list PAPP2010 (Access
Content Management).

PAPP2030

Manage Company Promotions.

Manage Company Promotions by
publishing submitted promotions, and
inquiring on viewer roles assigned to
Company Promotion items.

PAPP2035

Administer Company Promotions.

Administer Company Promotions by
creating and updating promotion targets
and categories.

PAPP2045

Run Categorization Spider.

Run the Categorization Spider process
to pull categories and content into the
Categorized Content feature.

Note: Users with this permission
list should also be listed as a Top
Administrator for the Categorized
Content feature.

PAPP2050

Administer Content Management.

Administer Managed Content by
assigning top category administrators,
creating privilege sets, assigning viewer
roles, and defining attachment locations.

This permission list should only
be granted to high-level content
administrators.
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Description
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PAPP2070

Review Content Access/Location.

Review Content stored in the Content
Management system. The inquiry lists
where the content can be accessed, who
can access the content, and a preview of
the content for users who are viewing
members for this content. Access the
Render Content URL page to generate
the content's rendering URL for use in
third-party applications.

PAPP2080

Query Content Management.

Access the Content Management tables
and views on the PeopleSoft Interaction
Hub query tree.

Note: This permission list should
only be granted to high level content
administrators to limit access to all
content.

PAPP2300

Administer External News.

Administer External News by creating
and updating External News publication
pagelets, providers, groups, categories,
articles, and news feed batch process.

PAPP2310

Manage External News.

Manage External News by changing the
publish and expire dates of news feed
articles to remove offensive articles.

PAPP2700

Administer Web Magazine.

Administer Web Magazine by

creating and updating Web Magazine
publications, issues, sections, categories,
images, and articles.

PAPP2800

Administer Integrated Tasks.

Administer the Integrated Task

pagelet by access to the PeopleTools
Worklist, Worklist Details, and Worklist
administration pages.

PAPP3100

Administer Weather pagelet.

Administer Weather pagelet by getting a
customer ID or running the Update City
List process.

PAPP3200

Administer HTML pagelets.

Administer HTML pagelets by creating
and registering HTML pagelets.

PAPP3300

Administer Email/Calendar pagelet.

Administer the Email and Calendar
pagelets by defining the email and
calendar system and user values.
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Description

Usage

PAPP3550

Administer integration content.

Access the SOAP to component interface
iScripts (WEBLIB) web services.

PAPP3560

Administer integration workspaces.

Access the Collaborative Workspace
component interface web services.

PAPP4000

Query Portal Registry.

Access PeopleSoft Query and the Portal
Registry navigation and homepage tables
on the PeopleSoft Interaction Hub query
tree.

PAPP4001

Run portal registry processes.

Access the run control pages and
processes for Registry Load, Menu
Import, Portal Security Sync, and Sync
Navigation Collections.

PAPP4002

Administer Homepage Tabs.

Administer the Homepage Tab Layout
and Content definition.

Note: The user must have the Portal
Administrator role or have the site-
specific administrator role to modify
the tab definition from the Configure
Homepage menu item.

PAPP4003

Administer Portal Settings.

Administer the Portal General Settings
page to set the site and node templates,
the folder navigation options, and the
portal search options.

PAPP4004

Run Processes.

Access to Process Monitor and the
delivered process groups. Use as the
process profile permission list on the
User Profile definition page.

PAPP4005

Publish Pagelets to Sites.

Access the component to copy pagelet
content references from one site to
another.

PAPP4006

Run Base User Processes.

Access the delivered base user
process group for alert and subscribed
notifications.

Note: Use this permission list as the
process profile permission list on the
User Profile definition page for end-
users.
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Permission List Description Usage

PAPP4010 Administer Pagelet Personalization. Administer Pagelet Personalization by
setting any user's preferences for the
following pagelets: Weather, External
News, RSS News, Stock Quotes,
Community Calendars, Managed
Content, Discussion Forums, and Pagelet
Wizard pagelets.

PAPP4020 Manage Menu Item Requests. Manage menu item requests by
approving or rejecting requests, and
defining the users notified by email for
submitted requests.

PAPP4025 Administer Menu Item Requests. Administer menu item requests by
approving or rejecting requests,
registering approved requests, and
defining the users notified by email for
submitted requests.

PAPP4040 Administer Privilege Sets. Administer the Privilege Set definitions
for Collaborative Workspaces,
Community Calendars, Action Items,
Polls, and Discussion Forums.

Note: Use permission list PAPP2050
(Administer Content Management) to
administer the Content Management
Privilege Sets

PAPP4050 Administer Portal Search. Administer Search by defining search
indexes, search groups, search run
controls and search notification.

Note: Search groups determine which
search collections are associated with a
specific search results page.

PAPP4060 Administer Viewer Roles. Administer Viewer Roles by listing
the roles available to secure News
Publication articles and Company
Promotion items.

Note: This permission list should
only be granted to high level content
administrators.

PAPP4080 Query Navigation. Access the Portal Registry navigation
tables on the PeopleSoft Interaction Hub
query tree.
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Permission List

Description

Usage

PAPP4100

Submit Menu Item requests.

Submit Menu Item Requests to
request items to be added to the portal
navigation.

PAPP4110

Submit promotion items.

Submit company promotion items.

PAPP4120

Submit news articles.

Submit News Articles for publication.

Note: This permission list is needed to

enable the Submit Article link on News
Publication pagelets that allow submits
from the pagelet.

PAPP4130

Take a survey.

Take a survey. Access is limited to the
survey definition's distribution group.

PAPP4200

Logon Statistics pagelet.

Access the Logon Statistics pagelet.

PAPP4300

Manage Content Ratings.

Manage Content Ratings by creating
content rating questions, assigning menu
items to the content rating definition,
and viewing the respondent results of the
content rating questions.

PAPP4310

Access Poll definitions.

Access Poll Definitions. Poll Definition
access and actions are restricted

by member privileges on the Poll
Definition.

PAPP4350

Administer Content Ratings.

Administer Content Ratings by assigning
Result Viewers, setting non registered
URL's, and inquiring on the invisible
iTracker results.

PAPP4355

Administer Poll definition.

Administer Poll Definitions by assigning
member privileges or deleting a poll.
These Poll Definition actions are not
restricted by member privileges.

PAPP4360

Create Poll Definitions.

Create Poll Definitions and assign
member privileges to the created poll.

PAPP4400

Access Account Signon Utility.

Access the Account Signon Utility
by updating the stored user ID and
password.
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PAPP4450

Administer Account Signon Utility.

Administer the Account Signon Utility
by creating the Sign On forms and URLs
to access external secured sites.

PAPP4500

Administer portal options.

Define installation, system, and registry
options.

PAPP4600

Administer context assignment.

Administer Context Manager by
assigning the default template pagelets as
well as the individual template pagelets
to a specified Menu Item.

PAPP4680

Query Context Manager.

Access the Context Manager tables and
views on the PeopleSoft Interaction Hub
query tree.

PAPP4700

Manage Related Content.

Manage Related Content by adding
Related Content online to Menu Items
that are assigned a Related Content
template pagelet.

This permission list is for general page
access. Access to add content to a
Menu Item/Related Content publication
combination is restricted via assigned
Topic Experts as well as access to the
Menu Item in the navigation.

PAPP4710

Review Related Content.

Access the Related Content Inquiry
Pages listing content according to the
assigned Topic Expert or the Menu Item.

PAPP4750

Administer Related Content.

Administer Related Content by creating
or updating Related Content Publications
and assigning the Topic Experts to add
the content.

PAPP4800

Discussion Forums pagelet.

Access the Discussion Forums pagelet
and pagelet personalization. The
displayed forums are limited by member
privileges on the Forum definition.

PAPP4810

Access Discussion Forums.

Access Discussion Forums. Discussion
Forum access and actions are restricted
by member privileges on the Forum
definition.

PAPP4820

Access Guest Discussion Forums.

View Discussion Forums in display-only
mode. Access is restricted by member
privileges on the Forum definition.
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Description
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PAPP4850

Administer Discussion Forums.

Administer Discussion Forums by
assigning member privileges, editing
metadata or deleting a Forum. These
Discussion Forum actions are not
restricted by member privileges.

PAPP4855

Manage Related Discussions.

Administer Related Discussions template
pagelet by assigning moderators.
Contributor and viewer privileges are
automatically granted to all users who
can access the Menu Item that contains
the related discussion.

PAPP4860

Create Discussion Forums.

Create Discussion Forums and assign
member privileges to the created Forum.

PAPP4910

Define pagelets with the Wizard.

Create, delete, and clone Pagelet Wizard
pagelets definitions. Pagelet Wizard
access and actions are restricted by the
security on the Pagelet Wizard definition.

PAPP4920

Define Pagelet Wizard data.

Create and update Pagelet Wizard
footers, headers, and categories and
review existing pagelet definitions.

PAPP4950

Administer Pagelet Wizard.

Create and update Pagelet Wizard data
types, display formats, transform types,
and pagelet XSL. Create Data Mover
scripts to export and import pagelet

definitions.

PAPP5000

Administer Site - Template.

This permission list is the Site Manager
template permission list for site
administrators. This permission list is
cloned for each created site. It grants
site-specific access to the following:
define site navigation defaults, define
site security, define visible site features,
configure homepage display, override
allowed branding elements, view
Branding queries, and publish pagelets to
multiple sites.

PAPP5050

Create sites / Allow overrides.

Create portal sites and assign allowed
Branding overrides using the Site
Wizard.
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Permission List

Description

Usage

PAPP5060

Publish in Sites - Template.

This permission list is the Site Manager
template permission list for site
publishers. This permission list is cloned
for each created site. It grants site-
specific access to the following: manage
a site's navigation by publishing men
items to the site, update the content IDs
used in existing Pagelet Wizard Content
Management pagelets, create Action
Item Lists, create Community Calendars,
create and access Poll Definitions, create
and access Content Management, and
create Discussion Forums.

Note: Users with this permission

list should also have the following
permission lists (delivered on the base
user role PAPP_USER): PAPP4810
(Access Discussion Forums), PAPP5600
(Access Action Items), PAPP1210 (View
Community Calendars) and PAPP5500
(Access Community Calendars).

PAPP5070

View Sites - Template.

This permission list is the Site Manager
template permission list for site viewers.
This permission list is cloned for

each created site. It is a placeholder
permission list for the site-specific home
link to access the created site.

PAPP5100

Maintain Branding roles.

Assign security roles to Branding
themes.

PAPP5150

Maintain Branding data.

Create and maintain Branding themes,
headers, and footers.

PAPP5160

Maintain Branding layouts.

Create and maintain Branding layouts.

PAPP5180

Query Branding.

Access the Branding tables and views
on the PeopleSoft Interaction Hub query
tree. Access the Branding Query menu
items.

PAPP5200

Manage Navigation Collections.

Manage Navigation Collections by
creating and updating Navigation
Collection definitions.

Note: This permission list does not grant
access to delete Navigation Collections.
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Permission List

Description

Usage

PAPP5250

Administer Navigation Collections.

Administer Navigation Collections
by creating, updating and deleting
Navigation Collections definitions.

PAPP5300

Access Workspaces.

Access Collaborative Workspaces.
Access is granted to: links, members,
documents, polls, search and browsing.
Workspace access and actions are
restricted by member privileges on the
workspace definition. Note: Users with
this permission list should also have the
following permission lists (delivered

on the base user role PAPP_USER):
PAPP4810 (Access Discussion Forums),
PAPP5600 (Access Action Items),
PAPP1210 (View Community Calendars)
and PAPP5500 (Access Community
Calendars).

PAPP5350

Administer Workspaces.

Create and administer Collaborative
Workspaces and Templates. Administer
Workspace categories, and batch import
Workspaces. Administer existing
Workspaces by activating, deactivating,
or deleting a workspace. These
Workspace actions are not restricted by
member privileges on the Workspace
definition. Workspace access is restricted
by member privileges on the Workspace
definition.

PAPP5360

Manage Workspaces.

Create and manage Collaborative
Workspaces. Manage existing
Workspaces by activating, deactivating,
or deleting a workspace. Workspace
access and actions are restricted by
member privileges on the Workspace
definition.

PAPP5400

Access My Alerts.

Access to the user-defined alerts.

PAPP5450

Administer Alerts.

Administer Alerts Notifications
including the Notification batch process,
and defining features, email options, and
alert subscriptions.

PAPP5500

Access Community Calendars.

Access Community Calendars. Calendar
access and actions are restricted by
member privileges on the Calendar
definition.
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PAPP5550

Administer Community Calendars.

Administer Community Calendars

by assigning member privileges or
deleting a Calendar. These actions are
not restricted by member privileges.

PAPP5560

Create Community Calendars.

Create Community Calendars and assign
member privileges to calendars.

PAPP5600

Access Action Items.

Access Action Items. Action Item access
and actions are restricted by member
privileges on the List definition or the
assigned user.

PAPP5650

Review Action Items.

Review Action Items. Action Item access
and actions are restricted by member
privileges on the List definition or the
assigned user.

PAPP5655

Administer Action Items.

Administer Action Item Lists by
assigning member privileges or deleting
a List. These actions are not restricted by
member privileges.

PAPP5660

Create Action Item list.

Create Action Item lists and assign
member privileges.

PAPP9000

All PeopleSoft Interaction Hub objects.

Access all PeopleSoft Interaction Hub-
owned objects excluding Resource
Finder.

PAPP9900

System setup data.

Access to the pages displaying system
data that should not be changed or
customized.

PAPP9999

Demo examples and testing.

Access to delivered demo, testing, and
SDK material.

PAPX0000

Base Repository objects.

Base access to Resource Finder profile
display and the Related Resources
template pagelets. Required access for all
users, including Guest.

PAPX1000

Resource Finder pagelet.

Access the Resource Finder pagelet and
pagelet enhancement Search Results

pages.
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PAPX2050 Manage Resource profiles. Manage Resource profiles by updating
or creating a profile definition (create an
Employee profile type).

PAPX2060 Administer Repository. Administer Resource Finder Repository
by creating profile attributes or entering
a profile not obtained from a feed.

PAPX2070 Administer Repository Search. Administer Resource Finder Repository
Search Collections.

PAPX9000 All Repository objects. Access to all Resource Finder Repository
objects.

PAPX9999 Demo examples and testing. Testing Resource Finder application
classes.

Roles

This section describes:
* Roles that have special usage in PeopleSoft Interaction Hub.

* Roles associated with major PeopleSoft Interaction Hub areas.

¢ Viewer roles.

¢ All delivered roles.

Roles with Special Uses

The following table lists roles that have special meaning and usage in PeopleSoft Interaction Hub.

Note: In PeopleSoft Interaction Hub 9, the base object permission lists have been streamlined to include
only those components that all users need and are cannot access directly from the left navigation.
Additional permission lists have been created for some components and added to the PAPP_USER role.
The components My Discussion Forums, My Alerts, and Browse by Category were removed from the
PAPPO0On permission list. This enables you to disable a given feature by removing the feature's base
permission list from the PAPP_USER role.

Role

Description/Usage

PAPP_USER

Must be assigned to every user ID, except the default signon
user ID GUEST.
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Role Description/Usage

PeopleSoft User Must be assigned to every user ID, except the default signon
user ID GUEST.

PAPP_GUEST Must be assigned to the default signon user ID GUEST.

PeopleSoft Guest Must be assigned to the default signon user ID GUEST.

PAPP_SYSTEM_ADMIN

Used only during installation and implementation and is
assigned to VP1 and PS.

PeopleSoft Administrator

Used only during installation and implementation and is
assigned to VP1 and PS. It gives access into all the pages
regardless of the user's assigned permission lists.

Portal Administrator

Used in the production system. It gives access to the portal
registry structure (content references and folder references),
but not the actual component/pages and pagelets.

Be aware that users who have this role will see all pagelets and
all menu items (all content references), but they may not be
able to access the actual pages.

If a user with this role attempts to access a pagelet or a page
where they do not have that pagelet or pages's security, a "You
are not authorized" error message displays.

Roles Associated with Major PeopleSoft Interaction Hub Areas

The major areas within PeopleSoft Interaction Hub are associated with roles. These areas and roles
contain overlap. The major areas and roles are shown in the following table.

Area Role Description

Content PAPP CONTENT ADMIN Administer internally-created and
external content, including External
News, Internal News, Context Manager
and Content Management.

Navigation PAPP NAVIGATION ADMIN Administer how users navigate the portal

sites, including Menu Items requests,
manage navigation, Portal Registry
Load, and Navigation Collections.

Users who have this role should also
have the role of Portal Administrator.
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Area

Role

Description

Portal sites

PAPP_PORTAL_ADMIN

Administer the portal and portal sites,
including install options, site creation,
Logon Statistics, Search, Menu Items

requests, manage navigation, Portal

Registry Load, Navigation Collections,
Collaborative Workspaces, Branding,
Account Signon Utility, pagelet

Personalization, and Context Manager.

Users who have this role should also
have the role of Portal Administrator.

Presentation

PAPP_DISPLAY_ADMIN

Administer the presentation of portal
sites, including Branding, Pagelet Wizard
headers/footers, default templates, and
homepage tab layouts.

Resource Finder

PAPX REPOSITORY_ADMIN

Administer the Resource Finder
Repository feature.

Security

PAPP_SECURITY_ADMIN

Administer portal row-level security,
including Manage Content privilege
sets, Viewer roles, Related Context topic
experts, Discussion moderators, pagelet
Personalization, and Menu Item Inquiry.

Users who have this role may also have
the role of Security Administrator.

Integration

PAPP_INTEGRATION_ADMIN

Administer integration content in
PeopleSoft Interaction Hub, including
external content, Internet content, email,
account signon utility, and Pagelet
Wizard.

Viewer Roles

The following roles are delivered as viewer roles, and are used by Content Management to secure
individual content items for viewing. To change which roles are designated as viewer roles, select Portal
Administration, Content, Viewer Roles.

Role

Usage / Long Description

PAPP_CUSTOMER

Access to applicable customer homepage pagelets and
assigned content viewing.

PAPP EMPLOYEE

Access to applicable employee homepage pagelets, assigned
content viewing, submit pages (promotions, articles, menu
items), and edit account signon information.
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Role Usage / Long Description

PAPP_GUEST Access to applicable Guest homepage pagelets, assigned
content viewing, Guest homepage tab, and base PeopleSoft
Interaction Hub access.

PAPP_SUPPLIER Access to applicable supplier homepage pagelets and assigned
content viewing.

Delivered Roles

The following table lists the roles delivered with PeopleSoft Interaction Hub.

Role Description Usage/Long Description

PAPP_ACCOUNT SIGNON ADMIN | Account signon administrator. Administer the User Account Signon
Utility.

PAPP_AUTHOR Content author. Access the submit pages for News,

Promotions, and Menu Items. Access
Content Management common pages,
where the privilege sets limit the access.

PAPP_BRANDING_ADMIN Branding administrator. Administer the Branding feature.
PAPP_COMPANY_PROMOTIONS Company Promotions administrator. Administer the Company Promotions
ADMIN feature.

PAPP_CONTCATG_ADMIN Content Categorization administration. Administer the Content Categorization

feature manually.

PAPP_CONTENT_ADMIN Content administrator. Administer internally created and
external content, including External
News, Internal News, Context Manager
and Content Management.

PAPP_ CONTENT _MANAGER Content Manager. Manage internally created and external
content, including External News,
Internal News, Context Manager and
Content Management.

PAPP_CONTENT_RATINGS ADMIN | Content Ratings administrator. Administer the Content Ratings related
context feature.
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Role

Description

Usage/Long Description

PAPP_CONTENT USER

Content Management user.

Access Content Management common
pages, where assigned privilege sets
limit the access. Access the Managed
Content pagelet, the News Article In-
Box pagelet, and the Submit News
Article page.

Use this role as a general access role,
then create additional roles to assign
to the privilege sets within each created
category.

PAPP_CONTEXT ADMIN

Related Context administrator.

Administer the Context Manager feature
including the contextual content.

PAPP CONTEXT MANAGER

Related Context Manager.

Manage the contextual content used with
the Context Manager feature.

PAPP_CUSTOMER

Portal Customer.

Access to applicable Customer
homepage pagelets and assigned content
viewing.

PAPP_DEMO_ADMIN

Demo/Test Items administrator.

Sample. Administer the sample features,
including the Demo Item pagelet and
Context Manager Item tester.

PAPP_DISCUSSIONS_ADMIN

Discussions administrator.

Administer Related Discussions and the
Discussions Forum feature.

PAPP_DISPLAY_ADMIN

Presentation administrator.

Administer the presentation of the portal
sites, including Branding, Pagelet Wizard
headers/footers, default templates, and
homepage tabs layout.

PAPP EMAIL CALENDAR ADMIN

Email / Calendar administrator.

Administer the Email and Calendar
pagelets.

PAPP_EMPLOYEE

Portal employee.

Access to applicable employee
homepage pagelets, assigned content
viewing, submit pages (Promotions,
Articles, Menu Items), find a resource,
and edit account signon information.

PAPP_EXTERNAL NEWS ADMIN

External News administrator.

Administer the External News pagelet.

PAPP_GUEST

Guest user access.

Access to applicable Guest homepage
pagelets, assigned content viewing,
Guest homepage tab, and base
PeopleSoft Interaction Hub access.
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Description

Usage/Long Description

PAPP_GUEST ADMIN

Guest user administrator.

Administer pagelet Personalization for
a Guest user, or any user, and access the
Guest homepage tab.

PAPP_INSTALL OPTIONS ADMIN

Install options administrator.

Administer the Install Options for the
PeopleSoft Interaction Hub features.

PAPP_INTEGRATED TASKS ADMIN

Integrated tasks administrator.

Administer the Tasks pagelet.

PAPP_INTEGRATION_ADMIN

Integration administrator.

Administer integration content in the
PeopleSoft Interaction Hub, including
External Content, Internet Content,
Email, Account Signon Utility, and
Pagelet Wizard.

PAPP INTERNET PAGELETS
ADMIN

Internet pagelets administrator.

Administer Internet pagelets.

PAPP_LDAP

LDAP default access.

Contains the required permission
lists needed to access the PeopleSoft
Interaction Hub database.

Use as the default role for LDAP access.

PAPP_LOGON_STATISTICS_ADMIN

Logon statistics administrator.

Review user logon statistics through the
User Logon Statistics pagelet.

PAPP NAVIGATION ADMIN

Navigation administrator.

Administer how users navigate the
portal, including, Menu Items requests,
Portal Registry Load, and Navigation

Collections.

Users who have this role should also
have the Portal Administrator role.

PAPP NAVIGATION MANAGER

Navigation manager.

Manage submitted menu items and
Navigation Collections.

PAPP_NEWS_PUBLICATIONS
ADMIN

News Publication administrator.

Administer the Content Management
News Publication feature.
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Role

Description

Usage/Long Description

PAPP_PAGELET ADMIN

Pagelet administrator.

Administer the creation of pagelets
using pagelet wizard. Administer
Navigation Collections. Administer
Integration pagelets. Assign user pagelet
personalization.

Users who have this role should also
have the Portal Administrator role and
the Pagelet User role.

PAPP_PAGELET USER

Pagelet access user.

Access the homepage pagelets.

To configure the layout of a homepage
tab, the user must be either assigned the
Portal Administrator role, or the user
must have access to PAPP4002 as well as
all of the homepage pagelet permission
lists on the homepage tab.

PAPP_PORTAL_ADMIN

Portal administrator.

Administer the portal and portal sites,
including install options, site creation,
Logon Statistics, Search, Menu Items

requests, navigation collections, Portal

Registry Load, Branding, Account
Signon Utility, pagelet Personalization,
alerts and Context Manager.

Users who have this role should also
have the Portal Administrator role.

PAPP_PUBLISHER

Content publisher.

Manage, review, and publish content
to a viewing audience in the New
Publications and Company Promotions
features.

PAPP RELATED CONTENT ADMIN

Related Content administrator.

Administer features of Context Manager.

PAPP_SEARCH_ADMIN

Search administrator.

Administer the portal Search feature.

PAPP SECURITY_ ADMIN

Security administrator.

Administer portal row-level security,
including Managed Content privilege
sets, viewer roles, related context topic
experts, Discussion moderators, pagelet
Personalization, and Menu Item inquiry.

Users who have this role may also have
the Security Administrator role.
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PAPP_SITE MGMT ADMIN

Site Management administrator.

Administer the Site Management
feature, including creating sites and site
Branding.

Users who have this role should also
have the Portal Administrator role.

PAPP_SUPPLIER

Portal supplier.

Access to applicable supplier homepage
pagelets and assigned content viewing.

PAPP SYSTEM_ADMIN

PeopleSoft Interaction Hub system
administrator.

Access to all PeopleSoft Interaction Hub
objects.

PAPP_USER

PeopleSoft Interaction Hub user.

Access the base objects in the PeopleSoft
Interaction Hub. Every user in the
system, other than Guest, must be
assigned this role along with the
PeopleSoft User role.

PAPP_WEB_MAGAZINE ADMIN

Web Magazine administrator.

Administer the Web Magazine pagelet
and content.

PAPP  WORKSPACE ADMIN

Workspace Administrator.

Administer and create collaborative
workspaces.

PAPP_WORKSPACE_MANAGER

Workspace Manager.

Manage collaborative workspaces.

PAPP_ WORKSPACE USER

Workspace User.

Access the Collaborative workspace
components.

Individual workspaces are also secured
by members to that workspace.

PAPX PROFILE MANAGER

Resource profile manager.

Manage the Resource Finder profiles.

PAPX_REPOSITORY_ADMIN

Repository administrator.

Administer the Resource Finder feature.

PAPX SEARCH _ADMIN

Profile Search administrator.

Administer the Resource Profile Search.

Delivered Roles and Associated Permission Lists

You can obtain this information online, including any security fixes, by using the delivered PeopleSoft
Query PAPP_SECURITY_ROLE PERM.
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User IDs

This section discusses:

» User IDs with special uses in PeopleSoft Interaction Hub.

* User IDs delivered with PeopleSoft Interaction Hub.

User IDs with Special Uses

The following table lists user IDs with special uses in PeopleSoft Interaction Hub.

User ID Description

GUEST The default signon user.

PS The system administrator to access all of the PeopleSoft
Interaction Hub database and the HRMS database.

VP1 The system administrator to access all of the PeopleSoft
Interaction Hub database and the FSCM, EPM, and CRM
databases.

Delivered PeopleTools Roles

The following table shows the delivered PeopleTools roles and their associated permission lists.

PeopleTools Role PeopleTools Permission List Permission List Description

PeopleSoft User PTPT1000 PeopleSoft-User

PeopleSoft Guest PTPT1400 PeopleSoft-Guest

Security Administrator PTPT1100 Maintain Security

PeopleTools PTPT1200 PeopleTools

PeopleSoft Administrator **special ** Behind-the-scenes coding

Portal Administrator PTPT1300 Behind-the-scenes to PeopleSoft
Interaction Hub

Portal Manager PTPT1600 Pagelet Wizard, Navigation Collections
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Adding the Portal User Roles to All User IDs

To navigate and use common features and pages, every user ID (except for the Guest user IDs) must
include the delivered roles PAPP_USER and PeopleSoft User. During a PeopleTools upgrade, the
role PeopleSoft User is added to all existing roles. You can update the existing user IDs to include the
PAPP_USER role with the delivered PeopleSoft Data Mover script PORTAL ADD ROLE.DMS.

Note: Every newly created user ID should include both roles PeopleSoft User and PAPP_USER. Guest
user IDs should not include these roles. After running the script, manually update the Guest user ID by
replacing the PeopleSoft User role and the PAPP_USER role with the PeopleSoft Guest role and the
PAPP_GUEST role.

Use PeopleSoft Data Mover to update the existing user IDs in PeopleSoft Interaction Hub to include the
necessary PAPP_USER role.

There are two ways to start PeopleSoft Data Mover:

* Using the Data Mover shortcut in your PeopleSoft program group, as in Start > Programs >
<PeopleSoft Group> > Data Mover.

This access method only applies to the Windows Development Environment.
* Using the command line interface.

This executes PeopleSoft Data Mover in a console for Windows and a Telnet session for UNIX.
To update the user IDs:
1. Start PeopleSoft Data Mover and sign on to the PeopleSoft Interaction Hub database.

2. Open the script PORTAL ADD ROLE.DMS in the PS APP HOME/scripts directory.

Note: If the PeopleSoft Interaction Hub files were not installed in a separate PS APP. HOME
location, then this file will be found in PS_ HOME instead.

3. Run the script against the PeopleSoft Interaction Hub database.
4. Close PeopleSoft Data Mover.

See the product documentation for PeopleTools: Data Management.
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Using Common Functions That Reference a
Password Data Store

Understanding Common Functions that Reference a Password
Data Store

The common functions discussed in this topic can be combined to reference a password database store.
These functions can help achieve a sign on point between the portal and other target system software.

For each target system (email, web-based, and so forth), the user ID and password are stored and usually
encrypted. When attempting to access information through PeopleSoft Interaction Hub features that need
to retrieve information from these target systems, such as the Email pagelet, the PeopleSoft Interaction
Hub performs the connection to the system using the user credentials stored in the password data store.

Note: This is a one-way integration. No data is written to the target system, such as Microsoft Exchange.
A login is performed and data is retrieved, but user credentials or data is never updated in the target
system.

The PeopleSoft Interaction Hub uses these functions for third-party email and calendar integration:
e InsertUpdateUsrNamePsswd.

Used for inserting and updating.
*  GetUsrNamePsswd.

Returns the user name and password that are associated with a Uniform Resource Locator (URL)
identifier and a portal user ID.

* DeleteUsrNamePsswd.
Used for deleting.

For example, when accessing the Email pagelet, the Get function is called. It retrieves the user credentials
from the data store, which can then be passed to the target system. The Insert/Update is used when the
user sets up the pagelet for the first time, or subsequently updates his user ID or password. The Delete is
used when the user deletes these stored credentials from the password data store.

Related Links
Understanding Basic Email and Calendar Setup Steps
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Understanding the Interactive Flow for a Sign On Password Data

Store

The following diagram illustrates a way in which the InsertUpdateUsrNamePsswd, GetUsrNamePsswd,

and DeleteUsrNamePsswd common functions could be used.

Calling
Frogram

Passes unencrypted
data to function

Function:
InsertUpdateUsrMamePsswd

Calling
Frogram

Function encrypts
EOQ_PE_USER_NAME and
EOQ_PE_PASSWORD, and
determines whether an update or
insert is needed.

Passes unencrypted
data to function

Function:
GetUsrMamePsswd

Calling
Program

Function searches for URL_ID and
PRTL_USER_ID. When an entry is
found, the function decrypls the entry
and passes back values using the

EQO_PE_USER_NAME and
EQ_PE_PASSWORD variables,

Passes unencrypted
data to function

Function:
DeleteUsrNamePsswd

A4
d
rd Data
Iy

Function searches for entry using
UEL_ID and PRTL_USER_ID.
When an entry is found, it's
deleted from the table,
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Common Functions

This section discusses the common functions used to reference a password data store.
InsertUpdateUsrNamePsswd

Syntax

InsertUpdateUsrNamePsswd (URL_ID, EO PE USER NAME, EO PE PASSWORD)

Description

InsertUpdateUsrNamePsswd takes the URL identifier (URL ID) and the portal user ID
(PRTL_USER _ID) and searches the table for an entry that already exists. If an entry exists, an update is
performed; if no entry exists, a new entry is inserted.

The values for the user ID (EO_PE USER NAME) and password (EO_PE PASSWORD) that are
associated with the URL_ID and PRTL_USER_ID are encrypted when placed in the table.

This is the technical design in PeopleCode:

Function InsertUpdateUsrNamePsswd(&URL ID, &EO PE USER NAME, &EO_ PE PASSWORD)
&found = "";
&PRTL_USER ID = %Userld;

§EO_PE USER NAME = Encrypt ("", &EO PE USER NAME);
§EO_PE PASSWORD = Encrypt ("", &EO_PE_PASSWORD) ;

SQLExec ("select EO_PE USER NAME from PS_EO PE SS_LOGIN

where URL ID = :1 and PRTL USER ID = :2", &URL ID, &PRTL USER _ID,
&found) ;
If &found = "" Then

SQLExec ("INSERT INTO PS EO PE SS LOGIN( URL ID, PRTL USER_ID,

EO_PE USER NAME, EO PE PASSWORD) values(:1, :2, :3, :4)",
&URL_ID, &PRTL USER ID, &EO PE USER NAME, &EO_PE PASSWORD) ;

Else

SQLExec ("UPDATE PS EO PE SS LOGIN SET EO PE USER NAME = :1,
EO_PE PASSWORD = :2 WHERE URL ID = :3 AND PRTL USER ID = :4",
&EO_PE USER NAME, &EO PE PASSWORD, &URL ID, &PRTL USER ID);
End-If;

End-Function;

Parameters

Parameter Description

URL_ID URL identifier.

EO PE USER NAME User name that is needed to access the account that is
referenced by the URL _ID.
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Parameter Description
EO_PE PASSWORD Password that is associated with the EO_ PE_ USER_NAME.
Returns

The function returns no value.

Example

In this example, the function is used with hardcoded values. In most cases, variables are used as
parameters.

InsertUpdateUsrNamePsswd("Yahoo Mail Account", "Name", "Password");

Name and password are encrypted and placed in the table. The table appears as follows:

URL_ID PRTL_USER_ID EO_PE_USER_NAME EO_PE_PASSWORD

Yahoo_Mail_Account Portal Login Name ASDFG#$%MDSF ASKDKFI@W#$RFGMS
GetUsrNamePsswd

Syntax

390

GetUsrNamePsswd (URL_ID, EO PE USER NAME, EO PE PASSWORD) ;

Description

GetUsrNamePsswd takes the URL _ID and PRTL_USER_ID and searches the table for the associated
EO PE USER ID and EO PE PASSWORD. GetUsrNamePsswd decrypts EO PE_USER 1D and
EO PE PASSWORD. The decrypted user ID and password are passed back.

This is the technical design in PeopleCode:

Function GetUsrNamePsswd(&URL ID, &EO PE USER NAME, &EO PE PASSWORD)
&PRTL_USER_ID = $UserId;
SQLExec ("select EO PE_USER NAME, EO PE_PASSWORD from
PS EO PE SS LOGIN where URL ID = :1, and PRTL USER ID = :2",
&URL_ID, &PRTL USER ID, &EO_PE USER NAME, &EO PE_PASSWORD) ;

&EO_PE USER NAME = Decrypt("", &EO_PE USER NAME);
&EO_PE PASSWORD = Decrypt ("", &EO PE PASSWORD) ;

End-Function;
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Parameters

Parameter Description

URL_ID URL identifier.

EO PE USER NAME Empty variable that is used to store the value for the user name
that is associated with the URL _ID.
The decrypted value can be retrieved from the function
without using a return.

EO PE PASSWORD Empty variable that is used to store the value for the password
that is associated with the URL_ID.
The decrypted value can be retrieved from the function
without using a return.

Returns

The function returns no value.

Example
The value for URL _ID is hardcoded. Usually, this parameter is a variable.
&UserName = "";

&Password ="";

GetUsrNamePsswd("Yahoo Mail Account”, UserName, Password);

DeleteUsrNamePsswd

Syntax

DeleteUsrNamePsswd (&§URL _ID) ;

Description

DeleteUsrNamePsswd deletes entries in the table by searching with the URL_ID and the
PRTL USER_ID and removing those items when it finds a match.

This is the technical design in PeopleCode:

Function DeleteUsrNamePsswd (&URL_ID)

&PRTL USER ID = %UserId;

SQLExec ("Delete from PS EO PE SS LOGIN Where URL ID = :1 and
PRTL USER ID = :2", &URL ID, &PRTL USER ID);
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End-Function;

Chapter 30

Parameters

Parameter Description
URL ID URL identifier.
Returns

The function returns no value.

Example

In this example, the value for URL_ID is hardcoded. Usually, this parameter is a variable.

DeleteUsrNamePsswd("Yahoo Mail Account");
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Sample Business Attributes Service
Operation Handler PeopleCode

Case 1: A Nonrowset-Based Message Does Not Exist for the
Service Operation in PeopleSoft Interaction Hub

This topic provides sample PeopleCode for business attributes service operations. This sample
PeopleCode calls functions from the PeopleSoft-delivered subscription library which processes rowset-
based transactions. The sample code can be copied into an application class for Business Data Attributes
handlers.

Examples are provided for full synchronization and incremental synchronization.

Full Synchronization
Use this example for full synchronization:

/* Start of sample code */
import PS PT:Integration:INotificationHandler;

class BusUnitTblHRFullSync implements PS PT:Integration:INotificationHandler
method BusUnitTblHRFullSync();
method OnNotify (& MSG As Message);

end-class;

Declare Function Subscribe FullReplication PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG P>

C FieldFormula;
Declare Function Delete Existing Data PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG PC Fie=

ldFormula;

/* constructor */
method BusUnitTblHRFullSync
end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS_ PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */

Local Message é&msg;
Local Rowset &msgRowset;

&msg = & MSG;
&msgRowset = &msg.GetRowset () ;

Evaluate &msgRowset (1) .PSCAMA.MSG SEQ FLG.Value
When "H"
Delete Existing Data (&msg);
Break;
When "T"
rem K,k kkk ok kk kK put COde for Cleanup here *******************;
Break;
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When-Other
Subscribe FullReplication (&msg);
Break;

End-Evaluate;

end-method;
/* End of sample code */

Incremental Synchronization

Use this example for full synchronization:

/* Start of sample code */
import PS PT:Integration:INotificationHandler;
class BusUnitTblHRSync implements PS PT:Integration:INotificationHandler
method BusUnitTblHRSync() ;
method OnNotify (& MSG As Message) ;
end-class;
Declare Function Subscribe IncrReplication PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG P=

C FieldFormula;

/* constructor */

method BusUnitTblHRSync

end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS_PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */

Local Message é&msg;
&msg = & MSG;
Subscribe IncrReplication (&msg) ;
end-method;
/* End of sample code */

Case 2: A Nonrowset-Based Message Exists in PeopleSoft
Interaction Hub for the Same-Name Service Operation in
PeopleSoft HCM

394

Examples of these service operations are ones used by the Resource Finder feature where the service
operation is defined with a rowset-based message in PeopleSoft HCM but uses a nonrowset-based
message in PeopleSoft Interaction Hub, such as COMPANY_FULLSYNC, DEPT FULLSYNC,
LOCATION _FULLSYNC, PERSON BASIC FULLSYNC. To leverage the PeopleSoft subscription
utilities which process rowset-based transactions:

1. Create a rowset-based message in PIA (this message will be used in the handler PeopleCode.

2. Because the message needs to be assigned to a default service operation, create a “dummy” service
and service operation of the same name for the message (no routing and handler need to be defined).

For example, for the Company business data integration, use COMPANY FULLSYNC RS
VERSION 1 as there is already a message with the name COMPANY FULLSYNC VERSION 1

3. Insert this message name in string variable &sMsgName and the version in &sMsgVer in the sample
code below.

Peoplecode examples are provided below for full synchronization and incremental synchronization.
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Full Synchronization

The following sample is for full synchronization:

/* Start of sample code */
import PS PT:Integration:INotificationHandler;

class CompanyFullSync implements PS PT:Integration:INotificationHandler
method CompanyFullSync () ;
method OnNotify (& MSG As Message);

end-class;

Declare Function Subscribe FullReplication PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG P=

C FieldFormula;
Declare Function Delete Existing Data PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG PC Fie=

ldFormula;

/* constructor */
method CompanyFullSync
end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */

Local Message é&msg;

Local Rowset &msgRowset;

Local XmlDoc &inXMLDoc;

Local boolean é&ret;

Local string &sMsgName = "<insert rowset-based message name>";
Local string &sMsgVer = "<insert message version>";

/* instantiate variable for rowset-based message */
&msg = CreateMessage (@ ("Message." | &sMsgName)) ;
&msgRowset = &msg.GetRowset () ;

/* substitute incoming XML root name to rowset-based message name */
&inXMLDoc = & MSG.GetXmlDoc () ;
&inXMLDoc.DocumentElement.NodeName = &sMsgName;

/* copy XML to message rowset */
&ret = &inXMLDoc.CopyToRowset (&émsgRowset, &sMsgName, &sMsgVer);

/* call library function to update table */
Evaluate &msgRowset (1) .PSCAMA.MSG SEQ FLG.Value
When "H"
/* If the current message is the header msg, then prepare the table for inser=

t */
Delete Existing Data (&msg) ;
Break;
When "T"
rem * Kk k ok ok k ok ok kk put Code for Cleanup here *******************;
Break;

When-Other
Subscribe FullReplication (&msg);
Break;
End-Evaluate;
end-method;

/* End of sample code */
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Incremental Synchronization

The following sample is for full synchronization:

/* Start of sample code */
import PS PT:Integration:INotificationHandler;
class CompanySync implements PS PT:Integration:INotificationHandler
method CompanySync () ;
method OnNotify (& MSG As Message);
end-class;
Declare Function Subscribe IncrReplication PeopleCode FUNCLIB EOEIP.SUBSCRIBE MSG P>

C FieldFormula;

/* constructor */

method CompanySync

end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */

Local Message &msg;

Local Rowset &msgRowset;

Local XmlDoc &inXMLDoc;

Local boolean &ret;

Local string &sMsgName = "<insert rowset-based message name>";
Local string &sMsgVer = "<insert message version>";

/* instantiate variable for rowset-based message */
&msg = CreateMessage (@ ("Message." | &sMsgName)) ;
&msgRowset = &msg.GetRowset () ;

/* substitute incoming XML root name to rowset-based message name */
&inXMLDoc = & MSG.GetXmlDoc () ;
&inXMLDoc.DocumentElement .NodeName = &sMsgName;

/* copy XML to message rowset */
&ret = &inXMLDoc.CopyToRowset (&msgRowset, &sMsgName, &sMsgVer);

Subscribe IncrReplication (&msg) ;

end-method;
/* End of sample code */
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